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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド
1 信号発生器概要
注意 機器の故障または性能劣化を防ぐため、 RF （無線周波数） 入力は、 大33 dBm （2W） の逆電力レベ  

ル （N5173N/83Bでは27 dBm （0.5 W）） を超えてはな り ません。 www.keysight.comの 『信号発生  
器の故障を防ぐための ヒ ン ト 』 も参照し て く ださい。

• 信号発生器の特徴 （2ページ）

• 動作モード （4ページ）

• 正面パネルの概要 （5ページ）

• 正面パネル・ディスプレイ （10ページ）

• 背面パネル概要（N5171B、N5172B、N5181B、N5182B）（13ページ）

• 背面パネル概要（N5173BおよびN5183B）（23ページ）
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信号発生器概要 
信号発生器の特徴 
信号発生器の特徴
• N5171B/N5181B、 RFアナロ グ ・ モデル ： 9 kHz～1 （N5171Bのみ）、 3、 または、 6 GHz （それぞれ、 オ  

プシ ョ ン501、 503、 506）

• N5172B/N5182B、 RFベク ト ル ・ モデル ： 9 kHz～3または6 GHz （それぞれ、 オプシ ョ ン503およびオプ  
シ ョ ン506）

• N5173B/N5183B、 マイ ク ロ波アナロ グ ・ モデル ： 9 kHz～13、 20、 31.8または40 GHz （それぞれ、 オプ  

シ ョ ン513、 520、 532および540）

• 電子減衰器 （N5172B、 N5172B、 N5181B、 N5182B）

• 機械減衰器 （N5173BまたはN5183B、 オプシ ョ ン1E1）

• ベク ト ル ・ モデルは リ ス ト 掃引の波形を内蔵可能

• オー ト ・ レベ リ ング制御 （ALC）

• リ アルタ イ ム変調フ ィ ルタ リ ング

• 8648/ESGコード対応

• 10 MHz基準発振器、 外部出力付き

• 2チャ ンネル ・ パワー ・ メ ーター ・ デ ィ スプレ イ

• ユーザー設定可能な 大出力制限 

• ユーザー平坦度補正

• 外部アナロ グI/Q入力 （ベク ト ル ・ モデル）

• 拡張組立交換

• GPIB、 USB 2.0、 100Base–T LANイ ン ターフ ェース

• ダ イナ ミ ッ ク ・ レンジが大きい、 深度の大きい振幅変調

• 手動出力検索 （ALCオフ）

• SCPIおよびIVI–COM ド ラ イバー 

• 複数の信号発生器を使用する際の複数ベースバン ド発生器の同期化 （マス タ/ス レーブ ・ セ ッ ト ア ッ プ）

• Signal Studio Software使用によ り 、ベク ト ル・モデルは802.11WLAN、W- CDMA、cdma2000、1xEV- DO、  

GSM、 EDGEなどを発生可能

• リ アルタ イ ム ・ ベースバン ド発生器 （オプシ ョ ン660）

• パルス列発生器 （オプシ ョ ン320）

• LFマルチフ ァ ン ク シ ョ ン発生器 （オプシ ョ ン303）

• 狭パルス変調、 内部パルス発生器を含む （オプシ ョ ンUNW）

• アナロ グ差分I/Q出力 （ベク ト ル ・ モデル、 オプシ ョ ン １ EL）

• アナロ グ変調 ： AM、 FM、 M （オプシ ョ ンUNT）

• 大200 MSa/sまでの任意I/Q波形再生 （ベク ト ル ・ モデル、 オプシ ョ ン656/657）
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 信号発生器概要   
信号発生器の特徴
• 外部AM、 FM、 M入力 （オプシ ョ ンUNT）

• 広帯域AM （ベク ト ル ・ モデル、 オプシ ョ ンUNT）

• 柔軟な基準入力、 1～50 MHz （オプシ ョ ン1ER）

• 位相干渉性のためのLO入/出力 （オプシ ョ ン012）

• 位相雑音障害 （ベク ト ル ・ モデル、 オプシ ョ ン432）

• 拡張のラ イセン ス ・ キー ・ ア ッ プグレード （オプシ ョ ン099）

ハード ウ ェア、 フ ァームウ ェア、 ソ フ ト ウ ェア、 ド キュ メ ンテーシ ョ ンの特長およびオプシ ョ ンの詳細につい
ては、 信号発生器に付属のデータ ・ シー ト をご覧 く ださ い。 データ ・ シー ト はKeysight TechnologiesのWeb 
サイ ト 、 http://www.keysight.com/find/X- Series_SGから も入手でき ます。 
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信号発生器概要 
動作モード 
動作モード
モデル と イ ン ス ト ールされているオプシ ョ ンに応じ て、 Keysight X- Series信号発生器では、 次の 大4種類 

の基本的な動作モード を使用でき ます ： 連続波(CW)モード、 掃引信号モード、 アナロ グ変調モード、 デジタ

ル変調モード。

連続波
こ のモード では、 信号発生器は連続波信号を生成し ます。 信号発生器は単一の周波数および出力水準に設定
されます。 アナロ グ ・ モデル とベク ト ル ・ モデルの両方が、 CW信号を生成可能です。

掃引信号
こ のモード では、 信号発生器は周波数帯域および/または出力水準で掃引を行います。 アナロ グ ・ モデル とデ
ジ タル ・ モデルの両方が、 リ ス ト 掃引およびステ ッ プ掃引機能を提供し ます。

アナログ変調
このモード では、 信号発生器は CW 信号をアナログ信号で変調し ます。 使用可能なアナログ変調方式は、 イ ン

ス ト ールされたオプシ ョ ンによ り 異な り ます。 

オプシ ョ ンUNTでは、AM、FM、M変調が使用でき ます。これらの変調の一部は組み合わせて使用でき ます。 

注記 Mod On/Offハード キーと LED機能は、 オプシ ョ ンUNTがイ ン ス ト ールされた機器のみで有効です。

14. Mod On/OffとLEDを参照し て く ださい。

オプシ ョ ン303は、 7台の波形発生器から構成されるマルチフ ァ ン ク シ ョ ン発生器を提供し ます。

オプシ ョ ンUNWは標準および狭パルス変調機能を提供し ます。

デジタル変調（オプション65ｘを使用するベクトル・モデルのみ）
こ のモード では、 信号発生器はCW信号を任意I/Q波形で変調し ます。 I/Q変調はベク ト ル ・ モデルのみで使

用でき ます。 内部ベースバン ド発生器 （オプシ ョ ン65 ｘ ） によ り 、 次のデジ タル変調フ ォーマ ッ ト が追加さ
れます ：

• カ ス タ ム任意波形発生器モー ド は、 単独変調キ ャ リ アまたは複数の変調搬送波を生成でき ます。 各変調

搬送波波形は、 出力する前に計算し て作成し てお く こ と が必要です。 こ の信号作成は、 内部ベースバン
ド 発生器で行われます。 作成された波形は、 保存し て再読取でき ます。 これによ り 、 テス ト 信号を繰 り
返し再生でき ます。 詳細については、「任意波形発生器の使用」（338ページ）を参照し て く ださい。

• カス タ ム ・ リ アルタ イ ム波形発生器モード は、 単独変調搬送波または複数の変調搬送波を生成でき ます。
各変調搬送波波形は、 出力する前に計算し て作成し てお く こ と が必要です。 こ の信号作成は、 内部ベー
スバン ド 発生器で行われます。 作成された波形は、 保存し て再読取でき ます。 これによ り 、 テス ト 信号
を繰 り 返し再生でき ます。詳細については、「任意波形発生器の使用」（338ページ）を参照し て く ださい。

• マルチ ト ーン ・ モード は、 大64個の連続波信号 （または ト ーン） を生成し ます。 ツー ト ーン ・ モード
と同様に、 信号の周波数間隔と振幅は調整可能です。 詳細については、「カスタム・マルチトーン波形の
作成」（371ページ）を参照し て く ださい。
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 信号発生器概要   
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• ツー ト ーン ・ モード は、 異なる2つの連続波信号 （または ト ーン） を生成し ます。 信号の周波数間隔と振
幅は調整可能です。 詳細については、第14章、マルチトーンおよびツートーン波形（オプション430）を

参照し て く ださい。

• デュ アルARBモード は、 内部ベースバン ド発生器にあ る ARB メ モ リ ーに書き込まれた、 波形セグ メ ン ト

のシーケン ス再生を制御する ために使用されます。 これらの波形は、 カ ス タ ム任意波形発生器生器モー
ド を使って内部ベースバン ド発生器で作成する こ と、 または、 リ モー ト ・ イ ン ターフ ェース経由で ARB
メ モ リ ーにダウ ン ロードする こ と ができ ます。詳細については、「デュアルARBプレイヤー」（146ページ）
を参照し て く ださい。 

正面パネルの概要

1. ホストUSB

こ のユニバーサル ・ シ リ アル ・ バス （USB） を使用し て、 データ転送用のUSBフ ラ ッ シュ ・ ド ラ イブ （UFD）

を接続し ます。 信号発生器をシャ ッ ト ・ ダウ ン/再起動し な く て も、 USBデバイ ス を接続し た り 、 取 り 外し た
り でき ます。 測定器の背面パネルにはデバイ スUSBコネ ク ター （15ページを参照） も あ り 、 このコネ ク ター

を使って機器を リ モー ト 制御する こ と も可能です。

コネ ク ター タ イプA

USBプロ ト コル 2.0

22. 電源スイッチとLED 

21. MoreとLED 

20. Return 

18. ノブ 

19. Incr Set 

15. Page Down 

16. I Input（ベク
トル・モデルの
み） 

17. Q Input（ベクトル・
モデルのみ） 

12. RF 
Output
（N5171B、
N5172B、
N5181B、
N5182B） 

13. RF On/OffとLED 

14. Mod On/OffとLED 

7. メニュー 

11. Preset
とUser 
Preset 

9. Local 

Cancel/(Esc) 

5. 矢印とSelect 

6. Page Up 

8. Trigger 

4. テンキーパッド 3. ソフトキー 

2. ディスプレイ 

1. ホストUSB 10. Help   
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2. ディスプレイ
LCD画面には、 現在の機能に関する情報が表示されます。 状態表示、 周波数および振幅設定、 エラー ・ メ ッ
セージなどの情報が表示されます。 デ ィ スプレ イの右側には、 ソ フ ト キーのラベルが表示されます。「正面パ
ネル・ディスプレイ」（10ページ）も参照し て く ださい。

3. ソフトキー
ソ フ ト キーは、 キー左側のラベルに表示されている機能を有効にし ます。

4. テンキーパッド
テンキーパッ ド は、0～9のハード キー、小数点ハード キー、 マイナス記号ハード キー、バッ ク スペース ・ ハー

ド キーから構成されます。「数字とテキストの入力および編集」（45ページ）を参照し て く ださい。

5. 矢印とSelect

Select と矢印ハード キーを使って、 信号発生器のデ ィ スプレ イ上に表示されている項目を選択して編集する こ
と ができ ます。「数字とテキストの入力および編集」（45ページ）を参照し て く ださい。

6. Page Up

表エデ ィ タ で、 前のページを表示する には こ のハー ド キーを使用し ます。「例：表エディターの使用」（46
ページ）を参照して く ださい。 テキス ト がデ ィ スプレ イ領域の1ページに収ま り き ら ない場合は、 このキーと

Page Downキー （8ページ） を併用し てテキス ト を ス ク ロールし ます。
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 信号発生器概要   
正面パネルの概要
7. メニュー
これらのハード キーは、 測定器の機能を設定し た り 、 情報にア ク セルするためのソ フ ト キー ・ メ ニューを開
き ます。

8. Trigger

ト リ ガー ・ モード が Trigger Key に設定されている場合にこ のハード キーを押すと、 リ ス ト 掃引やステ ッ プ掃 
引などの機能に対する ト リ ガー ・ イベン ト が即時開始されます。

9. Local Cancel/(Esc)

こ のハード キーを押すと、 リ モー ト 操作がオフにな り 、 信号発生器は正面パネル制御に戻 り ます。 また、 ア
ク テ ィ ブ機能の入力や長い処理 （IQ校正など） をキ ャ ンセルし ます。

10. Help

ハード キーやソ フ ト キーの説明を表示するには、 このキーを使用し ます。「キーの説明の表示」（44ページ）を

参照し て く ださい。

11. PresetとUser Preset

これらのハード キーは、 信号発生器を既知の状態 （工場設定またはユーザー定義） に設定し ます。「信号発生
器のプリセット」（44ページ）を参照し て く ださい。

69ページを参照

62ページを参照

47ページを参照

75ページを参照

129ページを参照ベクトル・モデル
のみ有効

47ページを参照

50ページを参照

27ページを参照

81ページを参照

145ページを参照

74ページを参照

86ページを参照
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信号発生器概要 
正面パネルの概要 
12. RF Output（N5171B、N5172B、N5181B、N5182B）

12. RF Output（N5173B、N5183B）

13. RF On/OffとLED

こ のハード キーは、 RF OUTPUTコネ ク ターのRF信号の動作状態を切 り 替えます。 RF （無線周波数） 出力を 
オンにする と、 RF On/Off LEDが点灯し ます。

14. Mod On/OffとLED

こ のハード キーは、 ア ク テ ィ ブ変調フ ォーマ ッ ト によ る出力搬送信号の変調のオン/オフを切 り 替えます。 こ
のハード キーを使用し て、 フ ォーマ ッ ト を設定し た り 、 ア ク テ ィ ブにする こ と はでき ません （「搬送信号の変
調」（60ページ）を参照）。

出力変調をオンにする と、 MOD ON/OFF LEDが点灯し ます。

注記 Mod On/Offハード キーと LED機能は、 オプシ ョ ンUNTがイ ン ス ト ールされた機器のみで有効です。

15. Page Down

表エディ タで、 次のページを表示するにはこのハード キーを使用し ます。「例：表エディターの使用」（46ペー
ジ）を参照して く ださい。 テキス ト がデ ィ スプレ イ領域の1ページに収ま り き ら ない場合は、 このキーと Page
Upキー （6ページ） を併用し てテキス ト を ス ク ロールし ます。

コネ ク ター 標準 ： 

オプシ ョ ン １ EM ： 

イ ンピーダン ス ：

N型 （ メ ス） 

背面パネル出力 
50 

破損レベル 50 Vdc、 2 Wの 大RFパワー

コネ ク ター オプシ ョ ン513/520 ： 

オプシ ョ ン532/540 ： 

オプシ ョ ン1ED
オプシ ョ ン1EM ： 

イ ンピーダン ス ：

オス精密APC- 3.5 
オス精密2.4 mm 
N型 （ メ ス） 

背面パネル出力 
50 

破損レベル 0 Vdc、 0.5 Wの 大RFパワー
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16. I Input（ベクトル・モデルのみ）

「I/Q変調」（204ページ）も参照し て く ださい。

17. Q Input（ベクトル・モデルのみ）

「I/Q変調」（204ページ）も参照し て く ださい。

18. ノブ
ノ ブを回すこ と によ り 、 数値を増減し た り 、 強調表示を リ ス ト の次の桁や文字または項目に移動させる こ と
ができ ます。「正面パネルのノブの分解能」（30ページ）も参照し て く ださい。

19. Incr Set

こ のハード キーを使用し て、 現在ア ク テ ィ ブ機能の増分値を設定する こ と ができ ます。 増分値は、 ノ ブの現
在の比率設定に応じ て、 ノ ブを回すたびにア ク テ ィ ブ機能の値がどれだけ変化するかにも影響し ます （「正面
パネルのノブの分解能」（30ページ）を参照）。

20. Return

こ のハード キーを押すこ と によ って、キーを押す前の状態に戻すこ と ができ ます。複数の階層を持つ メ ニュー
では、 Returnキーを押すと前の メ ニュー ・ ページに戻 り ます。

21. MoreとLED

メ ニューにソ フ ト キー ・ ラベルをすべて表示でき ない場合は、 More LEDが点灯し、 ラベルの下にMoreメ ッ 
セージが表示 されます。 次のラベル ・ グループを表示するには、 Moreハード キーを押し ます。

22. 電源スイッチとLED

こ のス イ ッチによ って、 待機モード または電源投入モード を選択し ます。 待機位置にする と、 黄色のLEDが
点灯し、 信号発生器の機能はすべてオフにな り ます。 信号発生器は電源に接続されたま まなので、 一部の内
部回路によ って多少の電力が消費されます。 オン位置にする と、 緑色のLEDが点灯し、 信号発生器の機能が

オンにな り ます。

コネ ク ター タ イプ ： BNC （ メ ス） イ ンピーダン ス ： 50 

信号 外部から供給されたI/Q変調のアナロ グ同相成分。 

信号レベルは、  = 0.5 Vrms （校正済み出力レベル）。

破損レベル 1 Vrms

コネ ク ター タ イプ ： BNC （ メ ス） イ ンピーダン ス ： 50 

信号 外部から供給されたI/Q変調のアナロ グ直角位相成分。 

信号レベルは、  = 0.5 Vrms （校正済み出力レベル）。

破損レベル 1 Vrms
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正面パネル・ディスプレイ

1. アクティブ機能領域
こ の領域には、 現在ア ク テ ィ ブ機能が表示されます。 例えば、 周波数がア ク テ ィ ブ機能の場合、 現在の周波
数設定が表示されます。 現在ア ク テ ィ ブ機能に対応する増分値があ る場合は、 その値も表示されます。 

2. 周波数領域
こ の領域には、 現在の周波数設定が表示されます。

3. インジケーター
イ ンジケーターは、信号発生器の一部の機能の状態と エラー状態を示し ます。1つのイ ンジケーターの位置が

複数のイ ンジケーターによ って用いられる場合も あ り ます。 こ の場合、 同じ イ ンジケーター位置を使用する
機能が同時にア ク テ ィ ブになる こ と はあ り ません。

イ ンジケーターは どのよ う な場合に表示されるか...

M 位相変調がオンの場合。 周波数変調をオンにし た場合、 Mに代わってFMイ ンジケーターが表示されます。

ARB ARB発生器がオンの場合。 ARBが動作中で、 ト リ ガー待ち中ではあ り ません。

ALC OFF ALC回路がオフの場合。 ALCがオンで、 出力レベルを維持でき ない場合は、 UNLEVELイ ンジケーターが同じ位置に表

示されます。

AM 振幅変調がオンの場合。

ARMED 掃引が開始され、 信号発生器が掃引 ト リ ガー ・ イベン ト を待っている場合。

ATTNHOLD 減衰器ホール ド 機能がオンの場合。 こ の機能がオンになっている と、 減衰器の現在の設定が維持されます。

AWGN リ アルタ イ ムI/Qベースバン ド相加性白色ガウ ス雑音がオンの場合。

5. エラー・メッセージ領域 6. テキスト領域 

 
7. ソフトキー・ラベル領域 

4. 振幅領域 3. インジケーター 2. 周波数領域 1. アクティブ機能領域 

スクロール・バー
テキストが一画面
に収まりきらない
場合は、スクロー
ル・バーがここに
表示されます。
Page Upキーと
Page Downキー
を使用して、テキ
ストをスクロール
します。
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BBG DAC DACオーバーフ ローが発生し ている場合は、 BBG DACイ ンジケーターがオフにな る まで、 ラ ン タ イ ム ・ ス ケー リ ング

調整を実行し て く だ さい。 別のイ ンジケーター、 UNLOCKは同じ位置に表示され、 BBG DACイ ンジケーターよ り も優先

されます （下のUNLOCKを参照し て く だ さい）。

CHANCORR 内部チャ ンネル補正がオンになっている場合。

DETHTR ALC検出器の ヒ ーターの温度が規定温度に達し ていない場合。 ALC仕様を満たすには、 ヒ ーターの温度が規定温度で

あ る必要があ り ます。

DIGBUS デジ タル ・ バスが使用されている場合。

DIGMOD カ ス タ ム任意波形発生器がオンの場合。

ERR エ ラー ・ メ ッ セージがエ ラー待ち行列に置かれている場合。 このイ ンジケーターは、 エ ラー ・ メ ッ セージをすべて表
示するか、 エ ラー待ち行列を ク リ アする までオフにな り ません （「エラー・メッセージの読込み」（74ページ）を参照

し て く だ さい）。

EXTREF 外部周波数基準が適用されている場合。

FM 周波数変調がオンの場合。 位相変調をオンにし た場合、 FMに代わってMイ ンジケーターが表示されます。

I/Q I/Qベク ト ル変調がオンの場合。

L 信号発生器が リ スナー ・ モード にあ り 、 GPIB、 USBまたはVXI- 11/ソ ケ ッ ト (LAN)イ ン タ フ ェース経由で情報やコマン

ド を受信し ている場合。

M–TONE マルチ ト ーン波形発生器がオンになっている場合。

MULT 周波数乗数が設定されている場合 （「周波数乗数の設定」（123ページ）を参照し て く だ さい）。

OFFS 出力オフセ ッ ト が設定されている場合 （「出力オフセットの設定」（121ページ）を参照し て く だ さい）。

PN 位相雑音障害がオンになっている場合。

PULSE パルス変調がオンの場合。

R 信号発生器がGPIB、 USBまたはVXI- 11/ソ ケ ッ ト (LAN)イ ン タ フ ェース経由で リ モー ト 制御されている場合。 信号発

生器が リ モー ト ・ モー ド の場合、 キーパ ッ ド はロ ッ ク されます。 キーパ ッ ド を ロ ッ ク解除するには、 Localを押し ま

す。

REF 出力基準が設定されている場合 （「出力基準の設定」（122ページ）を参照し て く だ さい）。

RF OFF 信号発生器のRF （無線周波数） 出力がオンになっていない場合。

S 信号発生器がGPIB、 USBまたはVXI- 11/ソ ケ ッ ト (LAN)イ ン タ フ ェース経由でサービ ス ・ リ ク エス ト (SRQ)を出し た

場合。

SWEEP 信号発生器が現在、 リ ス ト ・ モード またはステ ッ プ ・ モー ド で掃引を行っている場合。

SWMAN 信号発生器が手動掃引モード にあ る場合。

T 信号発生器が ト ーカー ・ モー ド にあ り 、 GPIB、 USBまたはVXI- 11/ソ ケ ッ ト (LAN)イ ン タ フ ェース経由で情報を送信

し ている場合。

T–TONE ツー ト ーン波形発生器がオンになっている場合。

UNLEVEL 信号発生器が適切な出力レベルを維持でき ない場合。 このイ ンジケーターが表示されて も、 測定器に異常があ る と は
限 り ません。 正常に動作し ている場合で も レベルな し条件が発生する可能性があ り ます。 ALC回路がオフの場合は、

同じ位置にALC OFFと い う 別のイ ンジケーターが表示されます （上のALC OFFを参照し て く だ さい）。

UNLOCK いずれかのフ ェーズ ・ ロ ッ ク ・ ループがフ ェーズ ・ ロ ッ ク を維持でき ない場合。 どのループがロ ッ ク でき ないかは、
エ ラー ・ メ ッ セージを検証し ます （「エラー・メッセージの読込み」（74ページ）を参照し て く だ さ い）。

WATRG 現在の変調モー ド が任意波形 ト リ ガーを待っている場合。

WINIT 信号発生器がシングル掃引の開始されるのを待っている場合。

イ ンジケーターは どのよ う な場合に表示されるか...
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信号発生器概要 
正面パネル・ディスプレイ 
4. 振幅領域
こ の領域には、現在の出力パワー・ レベル設定が表示されます （RF Outputがオフの場合、 この領域はグレー 
表示にな り  ます）。

5. エラー・メッセージ領域
こ のエ リ アには、 略語化されたエ ラー ・ メ ッ セージが表示されます。 複数の メ ッ セージが発生し た場合は、

新の メ ッ セージの表示のみが残 り ます。「エラー・メッセージの読込み」（74ページ）を参照し て く ださい。

6. テキスト領域
こ の領域には、 信号発生器のステータ ス情報 （変調ステータ スなど） やその他の情報 （掃引 リ ス ト やフ ァ イ
ル ・ カ タ ロ グなど） が表示されます。 この領域を使って、 管理情報 （情報の入力、 フ ァ イルの表示/削除） な

どの機能を実行する こ と もでき ます。

7. ソフトキー・ラベル領域
こ の領域には、デ ィ スプレ イの右隣にあ る ソ フ ト キーの機能を定義する ラベルが表示されます。 ソ フ ト キー・
ラベルは、 選択された機能に応じ て変化し ます。
12 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 信号発生器概要   
背面パネル概要（N5171B、N5172B、N5181B、N5182B）
背面パネル概要（N5171B、N5172B、N5181B、N5182B）

1. AC電源コンセント
AC電源コード ・ コ ンセン ト には、 信号発生器に付属の三つ叉のAC電源コード を接続し ます。 電源設定要件

および電源コード の詳細については、 『入門ガイ ド』 を参照し て く ださい。

注意 不揮発性 メ モ リ ーに永続的に保存されていないデータ、GPIB設定または現在のユーザーの機器状態

が消失する こ と を防ぐため、 信号発生器は、 必ず正面パネルの電源ボタ ン または適切なSCPIコマン

ド か ら電源オフ し て く だ さ い。 ラ ッ ク ・ システムに設置された信号発生器は、 機器の正面パネル ・
ス イ ッチではな く システム ・ ラ ッ ク電源ス イ ッチで電源オフ される と、 機器が適正に電源オフ され
なかったために、 Error- 310を表示し ます。

4. SWEEP OUT 

2. EXT 1と
EXT 2 

5. PULSE 

6. TRIG 1と2 

7. REF IN 

9. GPIB 10. LAN 

11. デバイスUSB 

8. 10 MHz OUT 

1. AC電源コンセント 

オプション
１EMのみ 
8ページを
参照

デジタル変調コネクター（ベクトル・モデルのみ）（16ページ）

12. ホストUSB 

13. SDカード 3. LF OUT 
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 13



信号発生器概要 
背面パネル概要（N5171B、N5172B、N5181B、N5182B） 
2. EXT 1とEXT 2

3. LF OUT

4. SWEEP OUT

5. PULSE

6. TRIG 1と2

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 外部から供給される 1 Vpの、 表示された深度を生成する信号。

破損レベル 5 Vrmsおよび10 Vp

コネ ク ター BNC （ メ ス） イ ンピーダン スは50 

信号 電圧範囲 ： 0～＋5 Vp

オフセ ッ ト ： - 5 V～＋5 V （公称値）

詳細については、 81ページを参照し て く だ さい。

コネ ク ター BNC （ メ ス）  

2 kの負荷を駆動可能。

イ ンピーダン ス  <1 

信号 電圧範囲 ： 掃引幅に関係な く 0～＋10 V
掃引モード ： 掃引の開始＝0 V、 掃引の終了＝＋10 V
CWモード ： 出力な し

これは多目的な コネ ク ターです。 信号ルーテ ィ ングの選択については、 52ページ と 129ページを参照し て

く ださい。

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 外部供給 ： 1 V = オン、 0 V = オフ

破損レベル 0.3および＋5.3 V

コネ ク ター BNC （ メ ス） ハイ イ ンピーダン スZ

信号 手動掃引モード のポイ ン ト ・ ツー ・ ポイ ン ト と か、 外部掃引モード のLF掃引と か、 ト リ ガー動作用

の外部からのTTLまたはCMOS信号。 

立ち上が り エ ッ ジまたは立ち下が り エ ッ ジで ト リ ガーする こ と ができ ます。

破損レベル 0.5および+5.5 V
14 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 信号発生器概要   
背面パネル概要（N5171B、N5172B、N5181B、N5182B）
7. REF IN

工場設定モード では、 信号発生器はこのコネク ターの有効基準信号を検出して、 内部基準動作から外部基準動
作に自動的に切 り 替わ り ます。「信号発生器のプリセット」（44ページ）を参照し て く ださい。オプシ ョ ン1ER
（柔軟な基準入力） を使用する場合は、使用する外部基準周波数を信号発生器に明示的に知らせる必要があ り
ます。 正面パネルから、 または リ モー ト ・ イ ン ターフ ェース経由で情報を入力し ます。

8. 10 MHz OUT

9. GPIB

こ のコネ ク ターは、 外部コ ン ト ローラ などの互換デバイ ス と の通信を可能し、 信号発生器の リ モー ト 制御に
使用可能な3つのコネ ク ターの う ちの1つです （10. LANおよび11. デバイスUSBも参照し て く ださい）。

10. LAN

信号発生器はこのコネ ク ターを経由したローカル ・ エ リ ア ・ ネ ッ ト ワーク (LAN)ベースの通信をサポー ト し て

いるので、 LANに接続し ている コ ンピ ュータによ って リ モー ト からプロ グ ラ ムでき ます。 LANイ ン タ フ ェー

スは、autoMDIXをサポー ト し ます。信号発生器は1本のケーブルで 大100 mに制限されています(100Base-T)。 
LANの詳細については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。

11. デバイスUSB

このユニバーサル・シ リ アル・バス(USB)コネク ターを使用してPCを接続し、信号発生器を リ モー ト 制御し ます。

12. ホストUSB

こ のユニバーサル ・ シ リ アル ・ バス （USB） を使用し て、 データ転送用のUSBフ ラ ッ シ ュ ・ ド ラ イブ （UFD)
を接続し ます。 信号発生器をシャ ッ ト ・ ダウ ン/再起動し な く て も、 USBデバイ ス を接続し た り 、 取 り 外し た

り でき ます。 

13. SDカード
セキ ュ ア ・ デジ タル （SD） 不揮発性 メ モ リ ー ・ カード を挿し込みます。

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 1 ppm以内のタ イ ムベース基準からの、 外部供給される3.5～＋20 dBmの信号。

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 4 dBmよ り 大きい公称信号レベル。

コネ ク ター タ イプB

USBプロ ト コル バージ ョ ン2.0

コネ ク ター タ イプA

USBプロ ト コル 2.0
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信号発生器概要 
背面パネル概要（N5171B、N5172B、N5181B、N5182B） 
デジタル変調コネクター（ベクトル・モデルのみ）

I OUT、Q OUT、 OUT、  OUT

注記  OUTおよび  OUTにはオプシ ョ ン1ELが必要です。

コネ ク ター タ イプ ： BNC （ メ ス） イ ンピーダン ス ： 50  
DC結合

信号

 I OUT 内部ベースバン ド発生器からのI/Q変調のアナロ グ同相成分。

 Q OUT 内部ベースバン ド発生器からのI/Q変調のアナロ グ直角位相成分。

  OUT I OUTコネ ク ター と の併用によ り 、 平衡a ベースバン ド信号を供給し ます。

a平衡信号は、別々の2本の導線に存在する、グランドに対して対称で、極性が逆（位相が180°異なる）の信号です。

  OUT Q OUTコネ ク ターと の併用によ り 、 平衡aベースバン ド信号を供給し ます。

破損レベル > 1 Vrms DC原点オフセ ッ ト 代表値<10 mV

出力信号レベル （50 負荷終端）

• 0.5 Vpk （代表値）、 I/Qベク ト ルの1単位長に相当

• 0.69 Vpk （2.84 dB） （代表値）、 /4 DQPSKのピーク に対応する 大波高因子、  ＝ 0.5

• 0.71 Vpk （3.08 dB） （代表値）、 /4 DQPSKのピーク に対応する 大波高因子、  ＝ 0.35

• 代表値1 Vp–p （ 大）

I Q

I Q

I

Q
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 信号発生器概要   
背面パネル概要（N5171B、N5172B、N5181B、N5182B）

 

BB TRIG 1とBB TRIG 2

EVENT 1

PAT TRIG

DIGITAL BUS I/O

Keysight Technologiesの信号発生ソ フ ト ウ ェアによ って使用されるバス。 このコネ ク ターは汎用目的で使用 
する ものではあ り ません。 信号発生ソ フ ト ウ ェア ・ オプシ ョ ンがイ ン ス ト ールされている場合にのみ信号が
存在し ます （詳細についてはhttp://www.keysight.com/find/signalcreationをご覧 く ださ い）。

注記 X- SeriesのDigital BUS I/Oコネ ク ターは、Keysight Technologies N5106A PXB MIMOレシーバー・     
テス ターと組み合わせて動作させる場合に使用し ます。

コネ ク ター BNC( メ ス） 公称イ ンピーダン スは50 

信号 任意または リ アルタ イ ム ・ ベースバン ド発生器I/O （マーカーまたは ト リ ガー入力など） 用に リ

ザーブされています。

コネ ク ター BNC （ メ ス） イ ンピーダン ス ： 50  （公称値）

信号 データ ・ パターン、 フレーム、 タ イ ムス ロ ッ ト の開始を ト リ ガーするのに用いる こ とができ るパルス。 
±1タ イ ム ス ロ ッ ト まで調整可能。 分解能＝1ビ ッ ト  

マーカー 

各任意波形ポ イ ン ト には、 対応するマーカー ・ オン/オフ条件があ り ます。 
マーカー 1レベル＝＋3.3 V CMOSハイ （正極を選択し た場合）、 –3.3 V CMOSロー （負極を選択し

た場合）。 
任意波形でマーカー 1がオンになる と、 このコネ ク ターで出力が発生し ます （「波形マーカーの使用」
（161ページ）を参照し て く ださい）。

破損レベル < 4 および > ＋8 V

コネ ク ター BNC （ メ ス） イ ンピーダン ス ： 50  （公称値）

信号 TTL/CMOS ローから TTL/CMOSハイ、 または、 TTL/CMOSハイから TTL/CMOS ロー ・ エ ッ ジでの ト

リ ガー。 
このコネ ク ターへの入力は、 内蔵のデジ タル変調パターン発生器のシングル ・ パターン出力開始や、

連続的に出力されているパターンの停止と 再同期を ト リ ガーし ます。 ト リ ガーとデータ ・ ビ ッ ト ・ ク

ロ ッ ク を同期させる ために、 ト リ ガー ・ エ ッ ジが ラ ッ チ され、 内部データ ・ ビ ッ ト ・ ク ロ ッ ク の立

ち下が り エ ッ ジの間にサンプ リ ング されます。 
これは全ARB波形発生器 ト リ ガの外部 ト リ ガーです。

小 ト リ ガー入力パルス幅 （ハイ またはロー） = 100 ns

小 ト リ ガー遅延 （ ト リ ガー ・ エ ッ ジから フ レームの第1ビ ッ ト ） = 1.5～2.5ビ ッ ト ・ ク ロ ッ ク周期

破損レベル < 4 および > ＋8 V
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信号発生器概要 
背面パネル概要（N5171B、N5172B、N5181B、N5182B） 
AUX I/Oコネクター
この メ ス36ピン ・ コネク ターは、 内部ベースバン ド発生器を備えた機器のみで使用可能です （オプシ ョ ン653、
655、 656、 657）。 これらのオプシ ョ ンの1つがない信号発生器には、 こ のコネ ク ターはあ り ません。 

AUX I/Oコネ ク ターは、 X- Series信号発生器を、 補完 （補助） 信号情報を送受信する こ と によ って、 外部機 

器と のイ ン ターフ ェース を可能にし ます。 こ の情報は、 以下のよ う な、 非RF関連信号です ：

• 任意波形再生か ら外部機器への出力マーカーで、 波形変更を ト リ ガーまたは応答する ために外部機器に

送信される。

• リ アルタ イ ム信号生成パーソナ リ テ ィ ーから外部デバイ スへの信号マーカーの出力。 例えば、 フ レーム ・

マーカーなどの信号、 パルス/毎秒および偶数秒が、 信号発生パーソナ リ テ ィ ー （CDMA、 3GPP、 GNSS、

LTEなど） によ ってはサポー ト される場合があ り ます。

• 信号発生器が、 信号発生パーソナ リ テ ィ ー （CDMA、 3GPP、 LTE、 など） 次第で、 生成される信号の特
性を変更する原因と なる、 被試験デバイ スからの入力信号。

表1-1（20ページ）は、 AUX I/O コネ ク ター経由でア ク セスでき る入出力を リ ス ト し ます。 補助信号によ っ 
て制御が可能な特定の機能は、 あ る リ アルタ イ ム信号発生パーソナ リ テ ィ ー と 別のパーソナ リ テ ィ ーでは、
大幅に異な り ます。 追加情報は、 それぞれの リ アルタ イ ム信号発生パーソナ リ テ ィーのド キュ メ ンテーシ ョ ン
を参照し て く ださい。

注記 AUX I/Oコネ ク ターは、 標準3.3V TTL信号レベルをサポー ト し ます。 信号は、 大50 MHzまでの、   

小上昇および下降時間が 3 ns のデータ ・ レー ト をサポー ト し ます。 接続されていないピンには、 

いずれも、 3.3 Vへの弱いプルア ッ プがあ り ます。

18 1

1936

AUX I/Oコネク ターは、 シールド付きの.050シ リ ーズ ・ ボード ・ マウン ト ・ コネク ターです。

背面パネルの36ピン ・ コネク ター （メ ス） を正面から見た図

AUX I/Oに適合する コネ ク ターの メ ーカー ・ パーツ番号は、 3M® 10136- 3000 （ワ イヤー ・ マウ ン ト ・

プラ グ） です。
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 信号発生器概要   
背面パネル概要（N5171B、N5172B、N5181B、N5182B）
マーカー（ピン1～4） 
各任意波形ポイントには、対応するマーカー・オン/オフ条件があります。 
それぞれのリアルタイム信号は、SPCIコマンドまたはリアルタイム・パーソナリティーを使用して、出力マーカー信号
までルーティングすることができます。 
マーカ・レベル＝＋3.3 Vハイ（正極を選択した場合）、0Vロー（負極を選択した場合）。

イベント1（ピン1） 
ピン1は、データ・パターン、フレーム、タイムスロットの開始をトリガーするのに用いることができるパルスを出力し
ます。 
±1タイムスロットまで調整可能。分解能＝1ビット

Data Clock Out （ピン7） 
ピン7は、内部ベースバンド発生器に使用されます。このピンを経由して、シリアル・データを同期させるためのCMOS
ビット・クロック信号が送られます。 

Data In （ピン23） 
ピン23は、デジタル変調アプリケーションに使用される、外部供給CMOS対応信号データ入力を受け付けます。推定入
力は、CMOSハイがデータ1に相当し、CMOSローがデータ0に相当する、CMOS信号です。

大入力データ ・ レー ト は50 Mb/sです。 データは、 DATA CLOCK立下り エッジで有効である こ とが必要です。

Symbol Sync In （ピン25） 
ピン25は、デジタル変調アプリケーションに使用される、外部供給符号同期信号を受け付けます。 

Data Clock In （ピン29） 
ピン29は、デジタル変調アプリケーションに使用される、外部供給CMOS対応信号データ-・クロック入力を受け付けま
す。推定入力は、上昇エッジが、開始データ・ビットと整列するMCOSビット・クロック信号です。立下りエッジは、
DATAおよびSYMBOL SYNC信号をクロックするために使用されます。

大ク ロ ッ ク ・ レー ト は50 MHzです。 

イベント2（ピン31） 
ピン31は、外部機器ゲーティング用のデータ許可信号を出力します。出力は、外部データが、内部で発生したタイムス
ロットにクロックされる際に適用されます。データは、信号がローのときに許可されます。

Data Out （ピン33） 
ピン33は、内部ベースバンド発生器に使用されます。このピンは、内部データ発生器からのデータ（CMOS）、または、
データ入力時の外部供給信号を出力します。 

Symbol Sync Out （ピン35） 
ピン35は、内部ベースバンド発生器に使用されます。このピンは、符号同期化用、1データ・クロック期間幅のCMOS符
号クロックを出力します。 
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信号発生器概要 
背面パネル概要（N5171B、N5172B、N5181B、N5182B） 
表1-1 AUX I/Oコネクター設定 

MXGおよびEXG AUX I/Oコネ ク ター設定

ARBおよびARBベース ・

アプ リ ケーシ ョ ン 
リ アルタ イ ム ・ 

カス タ ム変調

リ アルタ イ ム ・ 

アプ リ ケーシ ョ ン

BERT機能 

ピン# 入力 出力 入力 出力 入力 出力 入力 出力

1 マーカー (1) イベン ト 1 マーカー (1)

2 マーカー (2) マーカー (2)

3 マーカー (3) マーカー (3)

4 マーカー (4) マーカー (4)

5

6 AUX 
Strobe

7 データ ・

ク ロ ッ ク

出力

10 MHz
ク ロ ッ ク

8 AUX(0)

9 AUX(1)

10 AUX(2)

11 AUX(3)

12 AUX(4)

13 AUX(5)

14 AUX(6) AUX I/O

15 AUX(7) BER 
Meas 

Enda

16 AUX(8) BER Sync 

Lossa

17 AUX(9) BER Test 

Outa
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 信号発生器概要   
背面パネル概要（N5171B、N5172B、N5181B、N5182B）
18 AUX(10) BER Gate 

Outa

19 AUX(11) BER No 

Dataa

20 GND GND GND GND GND GND

21 AUX(12)

22 GND GND GND GND GND GND

23 Data 
Input

AUX(13)

24 GND GND GND GND GND GND

25 Symbol 
Sync 
Input

AUX(14)

26 GND GND GND GND GND GND

27 Burst 
Input

AUX(15)

28 GND GND GND GND GND GND

29 Data 
Clock 
Input

AUX Sample 
Clock

30 GND GND GND GND GND GND

31 イベン ト 2

32 GND GND GND GND GND GND

33 Data Out AUX Out(1)

34 GND GND GND GND GND GND

表1-1 AUX I/Oコネクター設定（続き）

MXGおよびEXG AUX I/Oコネ ク ター設定

ARBおよびARBベース ・

アプ リ ケーシ ョ ン 
リ アルタ イ ム ・ 

カス タ ム変調

リ アルタ イ ム ・ 

アプ リ ケーシ ョ ン

BERT機能 

ピン# 入力 出力 入力 出力 入力 出力 入力 出力
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信号発生器概要 
背面パネル概要（N5171B、N5172B、N5181B、N5182B） 
35 Symbol 
Sync 
Output

AUX Out(2)

36 GND GND GND GND GND GND

a表示された設定は、AUX I/Oコネクター用のERROR OUT信号設定用です（BERT > I/O Setup > Aux I/O Out）。Helpハードキー
を押し、それぞれの信号設定用に、Reference OutまたはPN9を押します。 

表1-1 AUX I/Oコネクター設定（続き）

MXGおよびEXG AUX I/Oコネ ク ター設定

ARBおよびARBベース ・

アプ リ ケーシ ョ ン 
リ アルタ イ ム ・ 

カス タ ム変調

リ アルタ イ ム ・ 

アプ リ ケーシ ョ ン

BERT機能 

ピン# 入力 出力 入力 出力 入力 出力 入力 出力
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 信号発生器概要   
背面パネル概要（N5173BおよびN5183B）
背面パネル概要（N5173BおよびN5183B）

1. AC電源コンセント
AC電源コード ・ コ ンセン ト には、 信号発生器に付属の三つ叉のAC電源コード を接続し ます。 電源設定要件

および電源コード の詳細については、 『入門ガイ ド』 を参照し て く ださい。

注意 不揮発性 メ モ リ ーに永続的に保存されていないデータ、GPIB設定または現在のユーザーの機器状態

が消失する こ と を防ぐため、 信号発生器は、 必ず正面パネルの電源ボタ ン または適切なSCPIコマン

ド か ら電源オフ し て く だ さ い。 ラ ッ ク ・ システムに設置された信号発生器は、 機器の正面パネル ・
ス イ ッチではな く システム ・ ラ ッ ク電源ス イ ッチで電源オフ される と、 機器が適正に電源オフ され
なかったために、 Error- 310を表示し ます。

4. SWEEP OUT 

2. EXT 1とEXT 2 5. PULSE 

6. TRIG 1と2 

7. REF IN 

9. GPIB 10. LAN 

11. デバイスUSB 

8. 10 MHz OUT 

1. AC電源コンセント 

オプション
１EMのみ 
8ページを
参照

12. ホストUSB 

13. SDカード 3. LF OUT 

14. ALC INPUT 

15. Z AXIS OUTPUT 
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信号発生器概要 
背面パネル概要（N5173BおよびN5183B） 
2. EXT 1とEXT 2

3. LF OUT

4. SWEEP OUT

5. PULSE

6. TRIG 1と2

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 外部から供給される 1 Vpの、 表示された深度を生成する信号。

破損レベル 5 Vrmsおよび10 Vp

コネ ク ター BNC （ メ ス） イ ンピーダン スは50 

信号 電圧範囲 ： 0～＋5 Vp

オフセ ッ ト ： - 5 V～＋5 V （公称値）

詳細については81ページを参照し て く だ さい。

コネ ク ター BNC （ メ ス）  

2 kの負荷を駆動可能。

イ ンピーダン ス  <1 

信号 電圧範囲 ： 掃引幅に関係な く 0～＋10 V
掃引モード ： 掃引の開始＝0 V、 掃引の終了＝＋10 V
CWモード ： 出力な し

これは多目的な コネ ク ターです。 信号ルーテ ィ ングの選択については、 52ページ と 129ページを参照し て

く ださい。

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 外部供給 ： 1 V = オン、 0 V = オフ

破損レベル 0.3および＋5.3 V

コネ ク ター BNC （ メ ス） ハイ イ ンピーダン スZ

信号 手動掃引モード のポイ ン ト ・ ツー ・ ポイ ン ト と か、 外部掃引モード のLF掃引と か、 ト リ ガー動作用

の外部からのTTLまたはCMOS信号。 

立ち上が り エ ッ ジまたは立ち下が り エ ッ ジで ト リ ガーする こ と ができ ます。

破損レベル 0.5および+5.5 V
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 信号発生器概要   
背面パネル概要（N5173BおよびN5183B）
7. REF IN

工場設定モード では、 信号発生器はこのコネク ターの有効基準信号を検出して、 内部基準動作から外部基準動
作に自動的に切り 替わ り ます。「信号発生器のプリセット」（44ページ）を参照して く ださい。 オプシ ョ ン1ER
（柔軟な基準入力） を使用する場合は、使用する外部基準周波数を信号発生器に明示的に知らせる必要があ り
ます。 正面パネルから、 または リ モー ト ・ イ ン ターフ ェース経由で情報を入力し ます。

8. 10 MHz OUT

9. GPIB

こ のコネ ク ターは、 外部コ ン ト ローラ などの互換デバイ ス と の通信を可能し、 信号発生器の リ モー ト 制御に
使用可能な3つのコネ ク ターの う ちの1つです （10. LANおよび11. デバイスUSBも参照し て く ださい）。

10. LAN

信号発生器はこ のコネ ク ターを経由し た ローカル ・ エ リ ア ・ ネ ッ ト ワーク (LAN)ベースの通信をサポー ト し

ているので、 LAN に接続している コンピ ュータによ って リ モー ト からプログラ ムでき ます。 LAN インタ フェー

スは、autoMDIXをサポー ト し ます。信号発生器は1本のケーブルで 大100 mに制限されています(100Base-T)。 
LANの詳細については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。

11. デバイスUSB

こ のユニバーサル ・ シ リ アル ・ バス(USB)コネ ク ターを使用し てPCを接続し、 信号発生器を リ モー ト 制御し

ます。

12. ホストUSB

こ のユニバーサル ・ シ リ アル ・ バス （USB） を使用し て、 データ転送用のUSBフ ラ ッ シ ュ ・ ド ラ イブ （UFD)
を接続し ます。 信号発生器をシャ ッ ト ・ ダウ ン/再起動し な く て も、 USBデバイ ス を接続し た り 、 取 り 外し た

り でき ます。 

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 1 ppm以内のタ イ ムベース基準からの、 外部供給される3.5～＋20 dBmの信号。

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 4 dBmよ り 大きい公称信号レベル。

コネ ク ター タ イプB

USBプロ ト コル バージ ョ ン 2.0

コネ ク ター タ イプA

USBプロ ト コル 2.0
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信号発生器概要 
背面パネル概要（N5173BおよびN5183B） 
13. SDカード
セキ ュ ア ・ デジ タル （SD） 不揮発性 メ モ リ ー ・ カード を挿し込みます。

14. ALC INPUT

こ の入力コネ ク タ - は、 負の外部検出器レベ リ ングに使用し ます。

15. Z AXIS OUTPUT

こ のBNC （ メ ス） コネ ク ターは、 ステ ッ プ/ リ ス ト 掃引の再 ト レースおよびバン ド ・ ス イ ッチ ・ イ ン ターバル
の間に、 +5 V （公称値） のレベルを供給し ます。 ステ ップ/ リ ス ト 掃引中に、 このBNC （メ ス） コネク ターは、 

RF 周波数がマーカー周波数に一 致し、 輝度マーカー ・ モード がオンになっている と きに、 –5 V （公称値）  
レベルを供給し ます。 この信号はオペアンプ出力から導かれる ため、 負荷イ ンピーダン スは5 k以上であ る 

必要があ り ます。

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは100 

信号 - 0.2 mV～- 0.5 V

破損レベル - 12～1 V

コネ ク ター BNC （ メ ス） 公称イ ンピーダン スは50 

信号 4 dBmよ り 大きい公称信号レベル。
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
2 プリファレンスの設定とオプションの有効化
Utility メ ニューからは、ユーザ操作/ リ モー ト 操作用のプ リ フ ァ レン スや機器オプシ ョ ンを有効化するための

メ ニューにア ク セスでき ます。

ディスプレイの設定（28ページ）

正面パネルのノブの分解能（30ページ）

電源投入とプリセット（29ページ）

オプションの有効化（39ページ）

GPIBアドレスとリモート言語（32ページ）
LANインタフェースの設定（33ページ）
LANサービスの有効化：「ブラウザー」、「ソケット」、「VXI–11」（34ページ）
リモート言語の設定（35ページ）

ユーザー・プリファレンス

リモート操作用プリファレンス

時間/日付の設定（30ページ）

ファームウェアのアップグレード（31ページ）

ハードウェア・アセンブリのインストールおよび取り外し用ソフトキー（41ページ）

基準発振器のチューニング（31ページ）
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プリファレンスの設定とオプションの有効化 
ユーザー・プリファレンス 
ユーザー・プリファレンス
Utility メ ニューから、 以下のユーザー ・ プ リ フ ァ レン ス を設定でき ます ：

• 以下のディスプレイの設定
• 「電源投入とプリセット」（29ページ）

• 「正面パネルのノブの分解能」（30ページ）

ディスプレイの設定

注記 X- Series信号発生器は、 デ ィ スプレ イ を初期設定し て工場から出荷されます。 自動試験環境 （ATE）

ユーザーには、 初期設定以外のデ ィ スプレ イ設定の方が都合がよいかも知れません。 信号発生器の
デ ィ スプレ イ を長時間ア ク テ ィ ブにし てお く 必要がない場合には、 ス ク リ ーン ・ セーバー ・ モード
を使用し てデ ィ スプレ イの寿命を延長する こ と を考えて く ださ い。 

注記 輝度を 小値に設定する と、 デ ィ スプレ イが暗すぎて ソ フ ト キーが見えない場合があ り ます。 この
状態が発生し た ら、 上図を参照し てBrightness ソ フ ト キーの位置を確認し、 デ ィ スプレ イがよ く 見
える よ う に値を調整し て く ださい。

範囲：0～100

範囲：1～12時間（1時間のインクリメンタルで）

Light Only：ディスプレイのライトをオフにし、テキストは低輝度で表示
したままにします。 

Light & Text：ディスプレイのライトとテキストをオフにします。
ディスプレイが長期間変化しない場合は、このモードを使用してテキス
トがディスプレイに焼きつかないようにします。

オンにすると、リモート制御バスによっ
て実行されたコマンドに応じて、信号発
生器のディスプレイが更新されます。

色なし、高い輝度

Utility > Display 

合わせて、セキュア・ディスプレイの使用（394ページ）を参照し
てください。

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

394ページ

明るい背景に黒い 
テキスト。

暗い背景に明るい
テキスト。
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 プリファレンスの設定とオプションの有効化   
ユーザー・プリファレンス
電源投入とプリセット

プリセット後の所定のGPIB言語を選択します。
『プログラミング・ガイド』および『SCPI Command 
Reference』も参照してください。

Utility > Power On/Preset 

恒久設定の復元（電源のオフ-
オン*、プリセット、再読取に
よる影響を受けないもの）を
工場設定に復元します。

8648が、プリセット言語またはリモート言語のどちらかとして
選択されている場合のみ使用可能です（32ページを参照してく
ださい）。

*注意 
データのロス、不揮発性メモリーに永続的に保存されていないGPIB設定または現在のユーザーの機器状態が消失す
ることを避けるため、X-Series信号発生器は、必ず正面パネルの電源ボタンまたは適切なSCPIコマンドから電源オ
フしてください。ラックシステムに設置された X-Series信号発生器は、機器の正面パネルスイッチではなくシステ
ム・ラック電源スイッチで電源オフされると、機器が適正に電源オフされなかったために、Error-310を表示します。

注記
ユーザー・プリセットを定義するには、機器に所定の設定をして、User Preset > Save User Presetを押します。
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プリファレンスの設定とオプションの有効化 
ユーザー・プリファレンス 
正面パネルのノブの分解能

時間/日付の設定

信号発生器のフ ァームウ ェアは、 時間と日付
を ト ラ ッ キングして、 時間/日付基準点に設定
されている 新の時間と日付を使用し ます。

時間または日付を先に延ばして設定する
時間または日付を先に延ばし て設定する と、 イ ン ス ト ールされている タ イ ムベースのラ イセン ス を使い果し
て し まい、 信号発生器の時間/日付基準点を リ セ ッ ト する こ と に注意し て く ださい。 信号発生器の現在の基準
点よ り 後の時間または日付を新たに設定し た場合は、 その日付が新たな基準点と な り ます。 後で日付を戻す
と、 次の節で説明する よ う な リ ス ク を冒すこ と にな り ます。

時間や日付を変更する と、 タ イ ムベー

スの ラ イ セン スがイ ン ス ト ールされて

いない場合で も、 信号発生器の期限付

き ラ イ セン ス使用能力に不都合な影響

が及ぶ可能性があ り ます。

現在の機能の増分値をアクティブ・エントリーに設定します。

Utility >  
Instrument Adjustments 

増分値とステップ/ノブ比が、ノブの1回転ごとにアクティブ機能の値がど
れだけ変化するかを決定します。

例えば、アクティブ関数の増分値が10 dB、ステップ/ノブ比が50:1の場合 
は、ノブの1回転ごとにアクティブ機能は0.2 dB（10 ｄBの1/50）で変化  
します。 

ノブ1回転ごとの変化量を変更するには、増分量またはステップ/ノブ比、
あるいは両方を変更します。

各キーの詳細については、44ページで説明されて
いるキーのヘルプを使用してください。

 31ページ

 30ページ

ALC変調器のバイアス調整を実行します。ALCを開ループ・
モードで使用している場合、このことにより温度と湿度に
起因する開ループ・パワー・ドリフトが補正されます。

SCPIコマンド：
:CALibration:ALC:MODulator:BIAS

Utility >  
Instrument Adjustments >注意

元の時間/日付基準点

時間

新たな時間/日付基準点
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 プリファレンスの設定とオプションの有効化   
ファームウェアのアップグレード
時間または日付を戻して設定する
時間を戻し て設定する と、 信号発生器は時間が基準点から戻し た こ と を検知し ます。 時間を数時間以上戻し
て設定する と、 た と え時間を戻す時点でイ ン ス ト ールされている ラ イセン スがな く て も、 信号発生器は期限
付き ラ イセン ス を使用でき な く な り ます。 こ の場合、 ク ロ ッ ク を元の時間まで進めるか、 単にその分の時間
だけ待つこ と によ り 、 信号発生器が再び期限付き ラ イセン ス を使用する こ と を可能にでき ます。

基準発振器のチューニング

ファームウェアのアップグレード
新しいフ ァーム ウ ェア ・ リ リ ースの情報については、 http://www.keysight.com/find/upgradeassistantをご

覧 く ださい。

内部VCTXCO発振器の周波数をチューニングします。 
ユーザーが指定した値は、工場でチューニングされた値をオフセットしま
す（値は工場校正のDAC値に加算されます）。チューニング値0は、工場
校正値を設定します。
範囲（–8192～8192）は、正面パネルのキーパッド、ノブ、またはリモー
ト・コマンドで設定できます。 

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

『SCPI Command Reference』も参照してください。

Utility > Instrument Adjustments 
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プリファレンスの設定とオプションの有効化 
リモート操作用プリファレンス 
リモート操作用プリファレンス
信号発生器の リ モー ト 操作の詳細については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。

GPIBアドレスとリモート言語

33ページ

34ページ

注記
USBも使用可能です。設定が不要なため、メニューには示されていません。

リモートでの機器の使用法の詳細については、『プログラミング・ガイド』を参照してください。

所定の言語を選択します。 

この設定は恒久的でなく、機器プリセットを実行するとクリア
されます。ほとんどの場合、Utility > Power On/Preset > 
Languageで恒久的に言語を変更するのが最善です。35ページ
を参照してください。

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。

オンを選択して、押したキーの関連SCPIコマンドを表示します。

オンを選択し、この後実行されるすべてのSCPIコマンドを、
ログにコピーします。
オフを選択してログの取得を停止します。オフを選択しても、
ログは消去されません。
ログを消去するには、Clear SCPI Logソフトキーを押します。
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 プリファレンスの設定とオプションの有効化   
リモート操作用プリファレンス
LANインタフェースの設定

注記 
信号発生器をLANに接続する場合は、
100Base-T LANケーブルを使用してください。 

信号発生器をPCに直接接続する場合は、クロス
オーバー・ケーブルを使用してください。

リモートでの機器の使用法の詳細については、
『プログラミング・ガイド』を参照してくださ
い。また、 www.keysight.comで、次のよくある
質問からトピックを検索してください：
『Keysight MXG用ハードウェアの設定とインス
トール』。

Utility > I/O Config

値は『プログラミング・
ガイド』にリストされて
います。

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。

 34ページ
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プリファレンスの設定とオプションの有効化 
リモート操作用プリファレンス 
LANサービスの有効化：「ブラウザー」、「ソケット」、「VXI–11」

機器のファイル・シス
テムへのリモート・ア
クセス（ブラウザー）
を有効化します。

ブラウザーを使って信号
発生器を制御します。

Utility > I/O Config

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

License Manager Serverを
オンにすると、装置ライセ
ンスの更新が可能になり、
追加の機器のセキュリティ
を無効化します。

詳細については、『プログラミング・
ガイド』を 参照してください。
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 プリファレンスの設定とオプションの有効化   
リモート操作用プリファレンス
リモート言語の設定

図2-1 N5171B/72B/81B/82B

Utility > I/O Config

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

所定のリモート言語を選択します。

『SCPI Command Reference』を参照してください。
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プリファレンスの設定とオプションの有効化 
リモート操作用プリファレンス 
図2-2 N5173B/83B

Utility > I/O Config

各キーの詳細については、44ページで説明されているキーの
ヘルプを使用してください。

所定のリモート言語を選択します。

『SCPI Command Reference』を参照してください。
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 プリファレンスの設定とオプションの有効化   
リモート操作用プリファレンス
プリセット言語の設定

図2-3 N5171B/72B/81B/82B

Utility > Power On/Preset 

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

所定のリモート言語を選択します。

29ページ

『SCPI Command Reference』を参照してください。
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プリファレンスの設定とオプションの有効化 
リモート操作用プリファレンス 
図2-4 N5173B/83B

Utility > Power On/Preset 

各キーの詳細については、 44ページで説明されているキーの
ヘルプを使用してください。

所定のリモート言語を選択します。

29ページ

『SCPI Command Reference』を参照してください。
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 プリファレンスの設定とオプションの有効化   
オプションの有効化
オプションの有効化
オプシ ョ ンを有効にするには次の2つの方法があ り ます ： 

• ラ イセン ス ・ マネージ ャー ・ ソ フ ト ウ ェア ・ ユーテ ィ リ テ ィ ーを使用する ：

1. ユーテ ィ リ テ ィ ーを実行し、 プロ ンプ ト に従います。

2. www.keysight.com/find/LicenseManagerからユーテ ィ リ テ ィ ーをダウ ン ロード し、 外部USBフ ラ ッ

シュ ・ ド ラ イブ(UFD)から ラ イセン ス(.lic)フ ァ イルを選択し ます。

• 『プロ グ ラ ミ ング ・ ガイ ド』 に説明されたSCPIコマン ド を使用する。
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プリファレンスの設定とオプションの有効化 
オプションの有効化 
オプションおよびライセンスの表示
Utility >  
Instrument Info

サービス・ソフトウェア・ライセンスが 

一部の機器オプションからの Signal Studio
波形ライセンスがここに表示されま
す。チェック・マークはオプション
が使用可能であることを示します。

各キーの詳細については、44ページで説明
されているキーのヘルプを使用してください。

アプリケーションがここに表示されます。

ここに表示されます。
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 プリファレンスの設定とオプションの有効化   
ハードウェア・アセンブリのインストールおよび取り外し用ソフトキー
ハードウェア・アセンブリのインストールおよび取り外し用ソフトキー
Utility > More 2 of 2 > Service

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

RF（無線周波数）出力の
パワー・メーターを使用
して、出力減衰器の作動
を確認します。

Enhanced Factory Calibrationまたは
Factory Calibrationのどちらかを選択し
て、ご使用の機器を校正してください。

Enhanced Factory Calibrationには、 
パワー・メーターおよびスペクトル・ 
アナライザーが必要です。

Factory Calibrationはパワー・メーター
のみを使用します。

ソフトキーが使用
できるかどうかは信
号発生器のモデルに
よって異なります。

ソフトキーが使用
できるかどうかは信
号発生器のモデルに
よって異なります。
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プリファレンスの設定とオプションの有効化 
ハードウェア・アセンブリのインストールおよび取り外し用ソフトキー 
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
3 基本操作
こ の章では基本的な正面パネルの操作を紹介し ます。 リ モー ト 操作の詳細については、 『プロ グ ラ ミ ング ・
ガ イ ド』 を参照し て く ださ い。

• 信号発生器のプリセット （44ページ）

• キーの説明の表示 （44ページ）

• 数字とテキストの入力および編集 （45ページ）

• 周波数および出力（振幅）の設定 （47ページ）

• ALC帯域幅制御の設定 （49ページ）

• 掃引出力の設定 （50ページ）

• 搬送信号の変調 （60ページ）

• ファイルによる操作 （62ページ）

• エラー・メッセージの読込み （74ページ）
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基本操作 
信号発生器のプリセット 
信号発生器のプリセット

キーの説明の表示

信号発生器を既知の状態に戻すには、PresetまたはUser Presetを押します。 

Presetは工場設定で、User Presetはカスタム・プリセットです**（44ページも参照してください）。 

継続性設定（プリセット、ユーザー・プリセット、電源のオフ、オンの影響を受けない設定*）をリセットするには、 
以下を押します：Utility > Power On/Preset > Restore System Defaults。

*注意 
データのロス、不揮発性メモリーに永続的に保存されていないGPIB設定または現在のユーザーの機器ステートが
消失することを防ぐため、MXGは、必ず正面パネルの電源ボタンまたは適切なSCPIコマンドで電源オフしてくだ
さい。ラック・システムに設置されたMXGは、機器の正面パネル・スイッチではなくシステム・ラック電源スイッ
チで電源オフされると、機器が適正に電源オフされなかったために、Error –310を表示します。

**保存された各状態ファイルに異なる名称を設定することで1つ以上のユーザー・プリセットを作成できます。（図3-9（72ページ）
を参照してください）。

Helpハードキーによりハードキーまたはソフトキーの説明を表示できます。
ヘルプ・テキストを表示するには：

1. Helpを押します。
2. 目的のキーを押します。 
ヘルプが表示され、キーの通常機能は実行されません。
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 基本操作   
数字とテキストの入力および編集
数字とテキストの入力および編集

数字の入力およびカーソルの移動

アルファ符号の入力
Data entryソ フ ト キーが様々な メ ニューで表 

示されます。文脈で意味が不明瞭な場合、ヘ
ルプキーを使用し て （44ページで説明され

ています） 説明を表示し ます。 表のヘルプ
と し てアルフ ァ表の横にあ る ソ フ ト キーを
使用し ます。

アルフ ァ符号を受け入れるデータを選択する
と、 右側にメ ニューの一つが表示されます。

矢印キーまたは ノ ブを使用し て目的の文字
を強調表示し てから、Selectハード キー （ま

たはアルフ ァ表の横にあ る ソ フ ト キー） を
押し ます。 エラーを修正するには、 Bk Spま 

たはClear Textを使用し ます。

入力を終了するには、 Enterソ フ ト キーを押

し ます。

こ の メ ニューのサブセ ッ ト は16進符号と し て表示されます。文字 メ ニューはAからFまでのみ表示し ます （そ
の他の値についてはテンキーパッ ド を使用し ます）。

上/下矢印キーにより、選択された（強調表示された）数値を増加/減少させ、カーソルを垂直に移動させます。

負の値を入力するには、
負号を数値の前後いずれかに

Backspaceによりカーソルが左へ移動し、
進むにつれて文字が削除されます。

左/右矢印キーにより、カーソルを水平に移動させます。

Page up/downキーにより、ディスプレイ領域内のデータ表を上や下に

 

数字キーおよび小数点を使用して、数字データを入力します。

注記：ノブを回転して数値を増減
させるか、強調表示された桁または 
文字を変更するか、または連続するリ 
ストや項目をステップ実行します。

入力します（このキーはトグルです）。

各キーの詳細については、44ページを参照
してください。

Selectハードキーを使用して、アルファ符号を入力する際の入力部を選択しま
す。一部のメニューでは、Selectキーはターミネータの役割も果たし、Enterソ
フトキーに相当します。

「正面パネルのノブの分解能」（30ページ）も参照してください。

移動させます。

アルファ表内ではな
く、アクティブな値の
範囲内でカーソルを移
動させて、アルファ表
をオフにします。

保存されている機器ステート・ファ
イルにコメントを追加/編集します
（69ページを参照してください）。

注記：ファイル名は25文字までに制限されています。
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基本操作 
数字とテキストの入力および編集 
例：表エディターの使用
表エデ ィ ターは設定作業を簡素化し ます。 以下の手順では、 List Mode Values表エデ ィ ターを使用し て、 基  

本的な表エデ ィ ター機能を説明し ます。

1. 信号発生器をプ リ セ ッ ト し ます ： Presetを押し ます。

2. 表エデ ィ ターを開き ます ： Sweep > More > Configure List Sweepを押し ます。

信号発生器が以下の図で表示されるエデ ィ ターを表示し ます。

3. 目的の項目を強調表示し ます ： 矢印キーまたは ノ ブを使用し てカーソルを移動させます。 

4. （オプシ ョ ン） ア ク テ ィ ブ機能領域で選択された項目を表示し ます ： Selectを押し ます。

5. 値を修正し ます ：

• 値がア ク テ ィ ブ機能領域に表示されている場合、 ノ ブ、 矢印キー、 またはテンキーパッ ド を使用し て
値を修正し ます。

• 値がア ク テ ィ ブ機能領域に表示されていない場合、テンキーパッ ド を使用し て目的の値を入力し ます
（入力後、 ア ク テ ィ ブ機能領域に表示されます）。

6. 入力を終了し ます ：

• 使用可能な場合、 目的のユニ ッ ト を押し ます。
• ユニ ッ ト が表示されていない場合、 Enter （使用可能な場合） またはSelectを押し ます。

修正された項目は表内に表示されます。

カーソル

表エディター用ソフトキー 
表エディター名称 表項目

編集するアクティブな項目を表示し
ます。

強調表示により選択された項目を示します。これをアクティブ（編集可能）
な項目にするには、Selectを押すか、または目的の値を入力するだけです。

表項目はデータ・フィール
ドとも呼ばれます。

表項目の値を読み込み、移動、修正、お
よび保存するために使用します。各キー
の詳細については、キーのヘルプを使用
してください：Helpハードキーを押して
から、目的のキーを押します。

アクティブ機能領域

現在/総ページ数

別のメニューが利
用可能であること
を示します。二番
目のメニューを表
示するには、More
を押します。

（ベクトル・モデルのみ）
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 基本操作   
周波数および出力（振幅）の設定
周波数および出力（振幅）の設定
図3-1 FrequencyおよびAmplitudeソフトキー

 

121ページ

次のメニューを表示するには、Moreを押します。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

48ページ

『SCPI Command Reference』を参照してください。

Atten/ALC 
Controlメ
ニューを開
きます。

最適化信号対ノイズ比率の状態(Optimize S/N)をオンまたはオフにできます。
最適化信号対ノイズ比率ソフトキーにより、減衰器とALC設定を変更し、最適な信号対ノイ
ズ比率性能を提供しますが、RF（無線周波数）出力は変更しません。 
注意：最適化信号対ノイズ比率の状態が有効な場合、一部の高調波歪みのレベルが増加する
可能性があります。この増加した高調波歪みはACPRとEVMを劣化させる可能性があります。
注記：このモードは減衰器のホールド(Atten Hold)およびいずれかの変調タイプと相互排他的 
になります。最適化信号対ノイズ比率がアクティブ（オン）になっているときに減衰器のホー
ルドまたはいずれかの変調が有効である場合、設定競合エラーが生成されます。

49ページ

このソフトキーは、残ってい
る機器におけるユーザーが決
定する最大出力レベルを設定
します。

BBGを搭載するベクト
ル・モデルで利用可能
です。
ハードウェア・マー
カーを搭載するもの、
または外部BNCの使用
するものの、2つの出力
レベルを機器に選択さ
せることができます。

97ページ

Amplitudeモードでは、このメニューは
正面パネルのキーパッドで数値が入力
されると自動的に表示されます。

Frequencyモードでは、このメニュー
は正面パネルのキーパッドで数値が入
力されると自動的に表示されます。

RF（無線周波数）出力信
号の現在の相対位相をゼ
ロ基準として設定します。
その後の調整全てはこの
調整に関連します。

dBuVemfは、値を
dBuV単位の起電力
として確定します。
Emfは読み込み無し
での出力電圧です。
このユニットは外付
けのみです。内部表
現は、インクリメン
ト値およびディクリ
メント値と同様に
dBm単位で表現し
ます。 
注記：dBuV、mV、
およびnVemf は同
様に振る舞います。
（つまり、値は外部
のみになります。内
部表現は、インクリ
メント値およびディ
クリメント値と同様
にdBm単位で表現
します）。

このモードで非調和性能を改善することができます（低スプリアス・レスポンス
モード）。 

注記：このモードが有効な場合、源の安定した信号のスピードおよび動作を切り
替える機器が影響を受けます。

減衰器とALC設定を最適な性能へ修正し
ます。これはRF（無線周波数）出力を
変更しません 。

ベクトル・モデルで
使用可能。
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基本操作 
周波数および出力（振幅）の設定 
例：700 MHz、-20 dBm連続波出力の設定
1. 信号発生器をプリセットします。
信号発生器はその最大の特定周波数と最小の出力レベルを表示します （正面パネル・ディスプレイ領域 
は10ページに表示されています）。

2. 周波数を700 MHzへ設定します：Freq > 700 > MHzを押します。 

信号発生器はディスプレイの FREQUENCY 領域とアクティブ・エントリ領域の両方に 700 MHzを表示しま  
す。

3. 振幅を-20 dBmに設定します：Amptd > –20 > dBmを押します。

ディスプレイは、AMPLITUDE領域で -20 dBmに変更し、振幅値はアクティブ・エントリになります。別の  
機能キーを押すまでは、振幅はアクティブ機能のままになります。

4. RF（無線周波数）出力をオンにします：RF On/Offを押します。

RF（無線周波数）出力LEDが点灯し、700 MHz、-20 dBm CW信号がRF（無線周波数）出力コネクターで利   
用できます。

外部基準発振器の使用
外部基準を使用する場合は、狭帯域幅モードまたは広帯域幅モードが選択できます。

 

各キーの詳細については、44ページで説明されているキーの
ヘルプを使用してください。

範囲：1 ～ 50 MHz

2 MHzより下で保証された動作を実現するには、Narrow帯域幅を選択します。Wide帯域
幅を使用した場合は、2 MHzより下の周波数での動作は保証されません。

Freq > More

図3-2広帯域幅モードで近傍位相雑音が優れていることを示します。使用する外部基準に
ノイズやスプリアスがある場合は、狭帯域幅モードを使用してください。
Wide帯域幅を選択した場合は、2 MHzより低い周波数を選択すると、信号発生器に警告
メッセージを表示されます。

信号発生器の内部基準発振器を使用します。

REF INコネクターを使用して、その周波数基準を取得します。注
記：基準が接続されていなかったり、誤った周波数に合わせたりす
るとエラー画面が表示されます。
信号が背面パネルのREF INコネクターに存在しなければ、信号発生
器の内部基準を使用します。外部信号がある場合、その信号を基準
として使用します。
ベースバンド・ジェネレータ・クロックを基準発振器として使用し
ます。BBGを搭載するベクトル・モデルで利用可能です。
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 基本操作   
ALC帯域幅制御の設定
図3-2 外部基準発振器の使用

ALC帯域幅制御の設定

図3-3 Amplitudeソフトキー

次のメニューを表示するには、
Moreを押します。

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

『SCPI Command Reference』を参照
してください。

自動ALC帯域
幅モードを有
効化します
（自動）。
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基本操作 
掃引出力の設定 
掃引出力の設定
信号発生器には周波数および振幅ポイ ン ト のセ ッ ト によ る、 2つの掃引方法があ り ます。

ステ ッ プ掃引 （52ページ） では、 1つの選択された周波数/振幅から別の周波数/振幅に向って リ ニアまたはロ

グ掃引され、 掃引中に リ ニア/ ロ グ間隔のポイ ン ト （ステ ッ プ） で休止状態にな り ます。 掃引は、 順方向/逆
方向に行 う こ と も、 手動で変更する こ と もでき ます。 

リ ス ト 掃引 （55ページ） では、 周波数と振幅を、 一定でない間隔で入力し た り 、 非直線的な昇順または降順

で入力し た り 、 ラ ンダム順で入力し た り でき ます。 リ ス ト 掃引では、 現在のステ ッ プ掃引値を コ ピーし た り 、
任意波形を掃引に含めた り （ベク ト ル機器で）、 リ ス ト 掃引データ をフ ァ イル ・ カ タ ロ グ （67 ページ） に保
存する こ と も可能です。
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 基本操作   
掃引出力の設定
図3-4 Sweepソフトキー

各ポイントでの トリガーを待つこと
なく掃引します。 ポイント・トリガー
は最初の掃引の前に持続時間だけ休
止します。125ページを参照してく
ださい。

TTL/CMOS信号をコネクター内の
トリガーに適用します。

源として選択したものに、定期的
にトリガー・イベントを発生させ
ます。

シングル掃引によるタイマー・ト
リガーを使用すると最初の掃引前
に遅延が発生します。125ページ
を参照してください。

リモート・コマンドでのトリガー

Down により周波数/
振幅の停止から開始
まで掃引します。
 
Upにより周波数/振幅
の開始から停止まで
掃引します。

55ページ

選択された掃引タイプが、表示されるパラメーターを決定します。 
ステップ掃引の選択によりステップ・スペーシング（リニアまたはログ）
も表示します。

ベクトル・モデル：
Sweep Type = List
の場合使用可能

60ページ

掃引中は、掃引パラメーター（周波数、振幅またはその両方）がグレーになり、パラメーター掃引として変更されます。

プログレス・バー：非常に速い掃引では
ランダムに掃引したり、逆方向に掃引し
たりするように見える場合があります。

52ページ

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

 52ページ
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基本操作 
掃引出力の設定 
ルーティング信号
Sweep > More > More > Route Connectors

掃引手順
ステ ッ プ掃引では、 1つの選択し た周波数/振幅から別の周波数/振幅に向って リ ニアまたはロ グ掃引され、掃

引中に リ ニア/ ロ グ間隔のポイ ン ト （ステ ッ プ） で休止状態にな り ます。 掃引は、 順方向/逆方向に行 う こ と
も、 手動で変更する こ と もでき ます。 

図3-5 Signal Routingソフトキー

これらのソフト
キーは、BBGを搭
載したベクトル・
モデルでのみ使用
できます。

非ステップまた
はリスト掃引信
号をルーティン
グします（すな
わち、SCPIコマ
ンド開発）。

Source Settledは
Trig Out Polarity 
Neg Posソフト
キーの選択には
影響されません。

ステップまたは
リスト掃引信号
をルーティング
します。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

Markers 1から4を背
面パネルのベース 
バンドBNCコネク
ターへルーティング
するためのメニュー
を開きます。

信号をTrig Out（Trig 1 または Trig 2）背面パネル・コネ
クターへ以下の通りにルーティングします：
None： 信号は、Trig 1 またはTrig 2 BNCへルーティング
されません
Sweep Trigger Out：掃引トリガー出力信号（トリ
ガー・ハンドシェイク）
Source Settled：源安定信号
Pulse Sync：パルス変調同期化信号
Pulse Video：パルス変調映像信号
LXI：LXIトリガー出力
Sweep Run：掃引実行信号（掃引が実行中です）
Other Trigger BNC：別のトリガー BNCでの信号
Pulse BNC：PULSE IN BNCでの信号
Swept Func Done：掃引機能掃引完了信号
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 基本操作   
掃引出力の設定
図3-6 Sweepソフトキー

例：連続、リニア・ステップ掃引の設定

1. 機器をプ リ セ ッ ト し、 掃引/ リ ス ト ・ メ ニューを開き ます ： Preset > SWEEPを押し ます。

連続はデフ ォル ト の掃引反復選択であ り 、 リ ニアはデフ ォル ト のステ ッ プ ・ スペーシング選択であ るた
め、 これらのパラ メ ーターを設定する必要はあ り ません。

2. ステ ッ プ掃引 メ ニューを開き ます ： Configure Step Sweepを押し ます。

3. 以下のパラ メ ーターを設定し ます ：

出力 ： 500 ～ 600 MHzおよび20 ～ 0 dBm、 6つの均一にスペーシング されたポイ ン ト それぞれで500 msの持続       

時間での連続的に掃引を行 う 信号。

開始周波数500 MHz ： Freq Start > 500 > MHzを押し ます

停止周波数600 MHz ： Freq Stop > 600 > MHzを押し ます

掃引開始時の振幅、 20 dBm ： Amptd Start > 20 > dBmを押し ます

掃引終了時の振幅、 0 dBm ： Amptd Stop > 0 > dBmを押し ます。

6つの掃引ポ イ ン ト ： # Points > 6 > Enterを押し ます

各ポ イ ン ト での持続時間、 500 ミ リ 秒 ： More > Step Dwell > 500 > msecを押し ます

持続時間 = 信号が安定し、掃引が次のポイントに移動する前に
測定を行うことができる時間です。

（ポイント間の時間は持続時間、処理時間、スイッチング時間、
セトリング時間の合計です。）

Lin = ステップは掃引全体を均一にスペーシングします。
出力は線形に変化します。

Log = ステップ・スペーシングは掃引全体を対数的に増加
させます。出力は指数関数的に変化します。

ステップ掃引とリスト掃引の持続時間は個々に設定され
ます。

各キーの詳細については、44ページで説明
されているキーのヘルプを使用してください。

周波数でのリニア・ステップ掃引に関するステップ・サイ
ズを設定します（周波数ポイント間の差）。
注記：ステップ・サイズの設定により、現在の開始および
停止周波数に基づく、ステップ掃引でのポイント数が決定
されます。ステップ・ポイントの整数により、開始および
停止周波数間の正確なリニア掃引を生じさせるため、ス
テップ・サイズは調整することができます。

周波数間でAtten Holdを自動的にオンにして機械減衰器の保護を有効にするか、ま
たはステップ掃引を動作させます。
これにより不均一なRF（無線周波数）出力が特定の掃引設定で発生する場合があ
ります。この減衰器の保護を無効にすると、掃引はオート・レベリング制御(ALC)
と各掃引ポイントでの出力減衰の両方を最適に掃引できるようになります。
減衰器保護が無効になると、ステップ持続時間が安全上の注意通りに最小50 msに
設定されます。 

[:SOURce]:SWEep:ATTen:PROTection[:STATe] ON|OFF|1|0
[:SOURce]:SWEep:ATTen:PROTection[:STATe]?
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 53



基本操作 
掃引出力の設定 
4. 周波数および振幅の掃引 ： Return > Return > Sweep > Freq Off On > Amptd Off Onを押し ます。

周波数/振幅の開始から周波数/振幅の終了まで、連続掃引が開始されます。SWEEPイ ンジケーターが表示
を行い、 掃引の進行状況は周波数デ ィ スプレ イ、 振幅デ ィ スプレ イ、 プロ グレ ス ・ バーに表示されます。

5. RF （無線周波数） 出力をオンにし ます ： RF On/Offを押し ます。 

RF LEDが点灯し、 連続掃引がRF （無線周波数） 出力コネ ク ターで利用可能にな り ます。
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 基本操作   
掃引出力の設定
リスト掃引
リ ス ト 掃引では、 周波数と振幅を、 一定でない間隔で入力し た り 、 非直線的な昇順または降順で入力し た り 、
ラ ンダム順で入力し た り でき ます。 リ ス ト 掃引では、 現在のステ ッ プ掃引値を コ ピーし た り 、 波形を掃引に
含めた り （ベク ト ル機器で）、 リ ス ト 掃引データ をフ ァ イル ・ カ タ ロ グ （67 ページ） に保存する こ と も可能
です。 持続時間は各ポイ ン ト で編集可能です。 よ り 速い切 り 替え速度については、 リ ス ト 掃引を使用し ます。

図3-7 List Sweep Configurationソフトキーおよびディスプレイ

56ページを参照してください 

選択された掃引により信号発生器が使用する持続時間を決定します。ステップ掃引持続時間
は各ポイントで同一です。リスト掃引持続時間は各ポイントで異なる場合があります。

持続時間 = 信号が安定し、掃引が次のポイントに移動する前に測定を行うことができる時間
です。

ポイント間の時間 = 持続時間、処理時間、スイッチング時間、セトリング時間の合計です。 

各ラインは、掃引での対応
するポイントを定義しま
す。例えば、ライン1はポ
イント1を定義します。

52ページ

ベクトル・モデルで使用可能、 
さらに 
Sweep Type = Listの場合のみ利
用可能です。

選択された掃引タイプの 
パラメーターを表示します
（56ページを参照してく
ださい）

ベクトル・モデルのみ

52ページ

各キーの詳細については、 
44ページで説明されているキー 
のヘルプを使用してください。
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基本操作 
掃引出力の設定 
例：ステップ掃引データを使用するリスト掃引の設定
1. 目的のステ ッ プ掃引を設定し ますが、 掃引をオンにし ないで く ださ い。 この例では 53ページで設定され

ている ステ ッ プ掃引を使用し ています。

2. SWEEP メ ニューで、 以下の リ ス ト へ掃引タ イプを変更し ます ： 
SWEEP > Sweep Type List Stepを押し てListを強調表示し ます。 

デ ィ スプレ イは以下の通 り 、 掃引 リ ス ト ・ パラ メ ーターを表示し ています。

3. リ ス ト 掃引 メ ニューを開き ます ： More > Configure List Sweepを押し ます。

4. メ ニ ューから以前に設定された値を ク リ ア し、 ステ ッ プ掃引で定義されたポ イ ン ト を リ ス ト にロー ド し
ます ： More > Preset List > Preset with Step Sweep > Confirm Presetを押し ます。 

デ ィ スプレ イは、 示されている通 り 、 ステ ッ プ掃引よ り ロード し た値で更新し ます。

5. 周波数および振幅を掃引し ます ： SWEEP （ハード キー） > Sweep > Freq Off On > Amptd Off Onを押し ます。

掃引の設定によ り 掃引関数をオンにし ます。 連続掃引が開始されます。 デ ィ スプレ イ上で、 SWEEPイ ン
ジケーターが表示され、 プロ グレ ス ・ バーが掃引の進行状況を表示し ます。

6. まだオンになっていない場合、 RF （無線周波数） 出力をオンにし ます ： RF On/Offを押し ます。 
RF （無線周波数） 出力LEDが点灯し、連続掃引がRF （無線周波数） 出力コネ ク ターで利用可能にな り ます。

ベクトル・モデル：

リストのプリセットにより以前に
選択した波形をクリアします。 

リスト掃引波形の選択に関する情
報については、「例：リスト掃引
ポイントの編集」（57ページ）を
参照してください。

波形はベクトル・モデル
上で利用可能です。
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 基本操作   
掃引出力の設定

 

例：リスト掃引ポイントの編集
表エデ ィ ターに習熟し ていない場合、 46ページを参照し て く ださい。

1. 目的の リ ス ト 掃引を作成し ます。 こ の例では、 以前の例で作成された リ ス ト 掃引を使用し ています。

2. 掃引がオンであ る場合、 オフにし ます。 掃引がオンの時に リ ス ト 掃引パラ メ ーターの編集をする と、 エ
ラーが生じ る こ と があ り ます。 

3. 掃引タ イプが リ ス ト に設定されている こ と を確認し ます ： SWEEP > Sweep Type List Stepを押し てListを強    

調表示し ます。 

4. List Mode Values表エデ ィ ターで、 ポイ ン ト 1の持続時間 （列1で定義） を100 msへ変更し ます ：

a. More > Configure List Sweepを押し ます。
b. ポイ ン ト 1の持続時間を強調表示し ます。

c. 100 > msecを押し ます。

表内の次の項目 （ポイ ン ト 2の周波数値） を強調表示し ます。

5. 選択し た周波数値を445 MHzへ変更し ます ： 445 > MHzを押し ます。

6. ポイン ト 4とポイン ト 5の間に新しいポイン ト を追加します：行4の任意のエン ト リ を強調表示して、 Insert Row 
を押し ます。 

これによ り 、 行4のコ ピーが行4の下に挿入され、 新しいポイ ン ト 5が作成され、 後続の行の番号が付け直
されます。

7. 周波数値をポイ ン ト 5から1行ずつ下にずら し ます ： 行5の周波数エン ト リ を強調表示し、 More > Insert 
Itemを押し ます。

これによ り 、 強調表示された周波数値のコ ピーが行6に挿入され、 行6 と 7の元の周波数値が1行ずつ下に

ずれます。 新しい行8には周波数値だけが含まれます （パワーと持続時間のエン ト リ は下にずれません）。

8. 行5の今も ア ク テ ィ ブな周波数値を590 MHzに変更し ます ： 590 > MHzを押し ます。 行5のパワーがア ク   
テ ィ ブなパラ メ ーターにな り ます。

9. ポイ ン ト 5の新しいパワー値(2.5 dBm)を挿入し て、ポイ ン ト 5 と6の元のパワー値を1行下にずら し ます： 

Insert Item > 2.5 > dBmを押し ます。 

10. ポイ ン ト 8のエン ト リ を完成する ために、 既存の値のコ ピーを下にずら し て、 ポイ ン ト 7の持続時間の複
製を挿入し ます ： 行7の持続時間を強調表示し て、 Insert Itemを押し ます。

11. アナロ グ測定器の場合は、 ステ ッ プ14に移動し て く ださ い。 ベク ト ル測定器の場合は、 ステ ッ プ12を続

けて実行し て く ださい。
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基本操作 
掃引出力の設定 
12. ポイ ン ト 2の波形を選択し ます ：

a. ポイ ン ト 2の波形エン ト リ を強調表示し て、 More > Select Waveformを押し ます。 
信号発生器が以下の例で表示される通 り 、 利用可能な波形を表示し ます。

b. 目的の波形を強調表示し （こ の例では、 SINE_TEST）、 Select ハード キーまたは Select Waveform ソ フ 
ト キーを押し ます。

13. 必要に応じ て、 選択し たい波形が残存するポイ ン ト にステ ッ プ 12 を繰 り 返し ます。 以下の図ではこれが

どのよ う に表示されるかの例を表示し ています。

14. 掃引をオンにし ます ： 
Return > Return > Return > Sweep > Freq Off On > Amptd Off On > Waveform Off Onを押し ます。

15. まだオンになっていない場合、 RF （無線周波数） 出力をオンにし ます ： 
RF On/Offを押し ます。 

デ ィ スプレ イ上に SWEEP イ ンジケーターが表示され、 信号発生器が掃引中であ る こ と が示されます。 ま

た、 プロ グレ ス ・ バーには掃引の進捗状況が示されます。 

注記 測定器が手動掃引の場合 （60ページ）、 ア ク テ ィ ブ行 （上の図では行6） が選択された （手動） ポイ ン

ト であ り 、 RF （無線周波数） 出力をオンにする と信号発生器はこの選択された設定を出力し ます。

波形を選択するか、 

または 

変調なしを選択します。

空のエントリはCW（変調なし）
を選択したのと同じです。
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 基本操作   
掃引出力の設定
例：シングル掃引の使用
1. ステ ッ プ掃引 （53ページ） または リ ス ト 掃引 （56ページ） を設定し ます。

2. List/Sweep メ ニューで、 掃引の繰 り 返し をシングルに設定し ます ： 
Sweep Repeat Single Contを押し てSingleを強調表示し ます。

これを ト リ ガーする まで掃引は発生し ません。

デ ィ スプレ イ上にWINITイ ンジケーターが表示され、 掃引の開始待ち中であ る こ と が示されます。

3. まだオンになっていない場合、 RF （無線周波数） 出力をオンにし ます ： RF On/Offを押し ます。

4. 掃引を開始し ます ： Single Sweepを押し ます。

RF （無線周波数） 出力コネ ク ターでは、 設定し た掃引が1回だけ繰 り 返されます。 

信号発生器の掃引時には、 SWEEP イ ンジケーターがWINITに代わってデ ィ スプレ イ上に表示され、 プロ
グレ ス ・ バーには掃引の進捗状況が示されます。 

掃引の終了時に、 プロ グレ ス ・ バーは消え、 WINITイ ンジケーターがSWEEPに代わって表示されます。
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基本操作 
搬送信号の変調 
例：掃引の手動制御
1. ステ ッ プ掃引 （53ページ） または リ ス ト 掃引 （56ページ） を設定し ます。

2. Sweep/Listメ ニューで、 掃引のためパラ メーターを選択し ます ： Sweep > parameter > Returnを押し ます。

3. 手動モード を選択し ます ： More > Manual Mode Off Onを押し ます。

手動モード を選択し た場合、 現在の掃引ポイ ン ト が選択された手動ポイ ン ト にな り ます。

4. まだオンになっていない場合、 RF （無線周波数） 出力をオンにし ます ： RF On/Offを押し ます。

5. 目的のポイ ン ト を選択し て出力し ます ： Manual Point > number > Enterを押し ます。

プロ グレ ス ・ バーは選択されたポイ ン ト を指示するため変わ り ます。

6. ノ ブま たは矢印キーを使用し てポ イ ン ト 間を移動し ます。 各ポ イ ン ト を選択する と、 RF （無線周波数）

出力がその選択の設定に変わ り ます。

搬送信号の変調
搬送信号を変調するには、 

• ア ク テ ィ ブ変調フ ォーマ ッ ト  
と

• RF （無線周波数） 出力の変調を有効にする必要があ り ます

例
1. 信号発生器をプ リ セ ッ ト し ます。

2. AM変調をオンにし ます ： AM > AM Off On （オプシ ョ ンUNTが必要です） を押し ます。

信号パラ メ ーターの設定前後で変調フ ォーマ ッ ト をオンにでき ます。

変調フ ォーマ ッ ト が生成されますが、 まだ搬送信号を変調し ません。

信号が生成する と、 変調フ ォーマ ッ ト がア ク テ ィ ブであ る こ と を示す、 フ ォーマ ッ ト 名を表示し ている
イ ンジケーターが表示されます。

選択した掃引ポイント（この例ではポイント6個の
うちの3番目）のパラメータにより、RF（無線周
波数）出力コネクターに出力される信号が定義さ
れています。

手動ポイントを入力すると、プ
ログレス・バーが移動し、選択
したポイントで停止します。

SWMANインジケーターが
掃引が手動モードである
ことを示しています。

手動モードをオンにした場合は、現在
の掃引ポイントが手動ポイントになり
ます。

現在の掃引パラメーターは
停止し、選択したポイント
を表示しています。
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 基本操作   
搬送信号の変調
3. RF （無線周波数） 出力の変調を有効にし ます ： LEDが点灯する まで、 Mod On/Offキーを押し ます。

ア ク テ ィ ブ変調フ ォーマ ッ ト な しで変調を有効にする場合、 その後変調フ ォーマ ッ ト をオンにする まで
搬送信号は変調し ません。

注記 変調をオフにするには、 Mod On/Off キーを、 LEDがオフになる まで押し ます。 

 
Mod On/Offキーがオフになる と、 アクテ ィ ブ変調フォーマッ ト があっても搬送信号は変調されません。

4. 変調された搬送波をRF （無線周波数） 出力コネ ク ターで利用可能にするには、 RF On/Offキーを、 LEDが

点灯する まで押し ます。

以下も参照し

て く ださい ：

「カスタム・デジタル変調（オプション431）」（317ページ） 
「パルス変調の使用（オプションUNWまたは320）」（129ページ） 
「I/Q変調」（204ページ）

 

インジケーターはアクティブ AM変調を示しています

AM変調フォーマット・オン。

点灯しているLEDは、すべての
アクティブ変調フォーマットが
搬送波を変調できることを示し
ています。
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基本操作 
ファイルによる操作 
同時変調

注記 Keysight X- Series 信号発生器は同時変調が可能です。 全ての変調タ イプ （AM、 FM、 fM、 パルス、 

I/Q） では同時変調を有効にでき ますが、 い く つか例外があ り ます。 表3-1を参照し て く ださい。

ファイルによる操作

• Fileソフトキー （63ページ）

• 保存済みファイルのリストの表示 （64ページ）

• ファイルの保存 （66ページ）

• 保存済みファイルの読込み（再読取）（67ページ）

• ファイルのメディアから別のメディアへの移動 （68ページ）

• 機器ステート・ファイルでの操作 （69ページ）

• デフォルト・ストレージ・メディアの選択 （73ページ）

信号発生器は機器ステー ト ・ フ ァ イル、 ラ イセン ス ・ フ ァ イル、 リ ス ト 掃引フ ァ イルなどの複数のタ イプの
フ ァ イルを認識し ます。 フ ァ イルは信号発生器の内部ス ト レージまたはUSB メ デ ィ アのいずれかに保存でき

ます。 こ の節では信号発生器のフ ァ イル ・ メ ニューへの移動方法、 フ ァ イルの表示、 保存、 読み込み、 移動
方法についての概要を提供し ます。

Keysight MXGおよびEXGの不揮発性内蔵 メ モ リ ーはMicrosoft対応のフ ァ イル ・ ア ロ ケーシ ョ ン ・ テーブル 
(FAT)フ ァ イル ・ システムに従って配分されています。 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。

以下も参照し て く ださい ：波形セグメントの保存、読み込み、および再生 （148ページ）。

表 3-1 同時変調タイプの組み合わせ

AMa

aリニアAMおよび指数関数AMは同時にオンにできません。第4章を参照してください。

FM fM パルスb

bパルス変調ではオプションUNWが必要です。第6章を参照してください。

I/Q

AM - - x x x x

FM xc

cFMとfMを同時に有効にはできません。

- - 不適用 x x

fM xc 不適用 - - x x

パル

ス

x x x - - x

I/Q x x x x - -
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 基本操作   
ファイルによる操作
Fileソフトキー

機器の操作パラメーター（69ページを参照してください）。
List Mode Values表エディターからの掃引データ。

ユーザー平坦度校正補正。

注記：利用可能なファイルタイプファイル・タイプはインストールされているオプションによります。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

削除するには確認 
が必要です。

USBが接続されている場合のみ使用
できます（すなわち、外部USBが接
続されていない場合は、ソフトキー
はグレー表示になります）。

73ページ

選択されているファイルにより、
このキーが変更します。 
67ページを参照してください。

現在のディレクトリを

68ページ

68ページ

確認が必要
です

ディスプレイは現在のディレクトリがデフォルトのストレージ・パスであっ
たときに示しています。 
デフォルトのストレージ・パスの設定に関する情報については、73ページ
を参照してください。

USBメディアを機器に接続すると、信号発生器はUSB MediaメニューとExternal USB Storage attached（外部USBストレージが接続されています）というメッ 
セージを表示します。USBメディアを取り外すと、External USB Storage detached（外部USBストレージが取り外されています）というメッセージが表示され 
ます。USBメディアを接続せずにExternal Mediaメニューをオープンした場合は、信号発生器はExternal Media Not Detected（外部メディアが検出されません） 
というメッセージを表示します。

信号発生器では、USBメディア
のフォーマットとファイル・
パーミッションの変更はできま
せん。これらの操作は、コン
ピュータを使って実行します。

現在のディレクトリが最上
位のディレクトリではない
ときのみ利用可能です。

選択されているストレージ・メ
ディアに応じて、内部または
USBファイルを表示します。 

64ページ

IQファイルを表示
します
FSKファイルを
表示します

FIRファイルを
表示します

Pulse Trainファイルの
リストを表示します。

Bitファイルを
表示します

393ページ

表示します
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基本操作 
ファイルによる操作 

 

ARB Fileソフトキー

保存済みファイルのリストの表示
こ の節の内容は、 デフ ォル ト のス ト レージ ・ メ デ ィ アがAutoに設定されている と仮定し ています （73ページ
を参照）。

信号発生器に保存されているファイルのリストの表示
1. USB メ デ ィ アが接続されている場合は、 取 り 外し ます。 信号発生器のス ト レージ ・ メデ ィ アが内部に切 り

替わ り 、 フ ァ イル ・ カ タ ロ グを使用し て信号発生器に保存されている フ ァ イルを参照でき る よ う にな り
ます。

2. 目的のフ ァ イル ・ カ タ ロ グを選択し ます ： File > Catalog Type > 目的のカ タ ロ グ （この例では All） を押し    
ます。 選択されたフ ァ イルが、 フ ァ イル名のアルフ ァベッ ト 順に表示されます （下の図を参照）。 

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

波形ファイルと対応するマーカ/
ヘッダ情報。

注記：利用可能なファイル・タイプはインストールされ
ているオプションによります。

選択されたファイル・
カタログとストレー
ジ・メディア
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 基本操作   
ファイルによる操作

 

USBメディアに保存されているファイルのリストの表示

USB メ デ ィ アが接続されている場合は、 USB メ デ ィ ア上のフ ァ イルを表示するには、 フ ァ イル ・ カ タ ロ グを
使用する方法 （選択し た タ イプのフ ァ イルだけを表示） と、 USBフ ァ イル ・ マネージ ャーを使用する方法 （す

べてのフ ァ イルを表示） があ り ます。

フ ァ イル ・ カ タ ロ グの使用 ：

• USB メ デ ィ アが接続された状態で、 目的のフ ァ イル ・ カ タ ロ グを選択し ます ： > Catalog Type >目的のカ タ    
ロ グを押し ます。 選択されたフ ァ イルが、 フ ァ イル名のアルフ ァベッ ト 順に表示されます。 

USBフ ァ イル ・ マネージ ャーの使用 ：

• USBメディ アが接続された状態で、USBフ ァ イル ・ マネージャーを開き ます： File > More > USB File Manager     
を押し ます。 
USB メ デ ィ ア上のデフ ォル ト ・ デ ィ レ ク ト リ が表示されます （下の図を参照）。 USB メ デ ィ アを接続する

と、 デ ィ スプレ イは直接にこの メ ニューを表示し ます。

Page UpとPage Downハード
キーを使って、ディレクトリの 
内容をスクロール表示します。
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基本操作 
ファイルによる操作 
ファイルの保存
測定器パラ メ ーターを保存するには、 い く つかの メ ニューが使用でき ます。 例えば、 機器ステー ト 、 リ ス ト 、
波形を保存でき ます。

• 機器ス テー ト ・ フ ァ イルには測定器の設定が保存されています。 こ のタ イプのフ ァ イルの場合は、 Save
ハード キーを使用し ます （図3-8（69ページ）を参照）。

• 他のタ イプのデータの場合は、 フ ァ イル作成用 メ ニューにあ るLoad/Storeソ フ ト キー （下記を参照） を使

用し ます。 

45ページで説明されているように、この
メニューを使ってファイル名を入力します。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

ファイル・タイプ
リスト
ステート
波形
ユーザー平坦度
ユーザー・プリセット
パルス列

保存元
Sweepメニュー
Saveメニュー
Modeメニュー
Amplitudeメニュー
User Presetメニュー
Pulse Trainメニュー

ファイル長（拡張子を含む）
内部メディア： 25文字
USBメディア： 39文字
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 基本操作   
ファイルによる操作
保存済みファイルの読込み（再読取）
保存済みフ ァ イルの読込み （再読取） には複数の方法があ り ます。

• 機器ステー ト ・ フ ァ イルの場合は、 Recallハード キーを使用し ます （図3-8（69ページ）を参照）。

• 他のタ イプのデータの場合は、 フ ァ イル作成用 メ ニューにあ るLoad/Storeソ フ ト キー （下記を参照） を使

用し ます。 

USBメディアからのファイルの読込み

USB メ デ ィ アから フ ァ イルを読み込むには、 下に示すUSBフ ァ イル ・ マネージャーを使用し ます。

ファイル・タイプ
リスト
ステート
波形
ユーザー平坦度
ユーザー・プリセット
パルス列

再読取元
Sweepメニュー
Saveメニュー
Modeメニュー
Amplitudeメニュー
User Presetメニュー
Pulse Trainメニュー

選択されているファイルによ
り、このキーが変更します。 

信号発生器がファイルを認識できない場合は、
ファイルの使用方法を選択する必要があります。

ファイル・タイプ
リスト
ステート
波形
ユーザー平坦度
ユーザー・プリセット
ライセンス
パルス列

拡張子
.list
.state
.waveform
.uflat
.uprst
.lic
.ptrain

ファイルを強調表示してSelectを押す...

リストを読込み、掃引を開始する
機器ステートを読み込む
波形を読込み、再生する
ユーザー平坦度を読込み、適用する
ユーザー・プリセットを読込み、実行する
購入したライセンスをインストールする
パルス列を読込み、適用する

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

 
  Copy & Select User Flatness
  Copy & Play Waveform
  Copy & Play Sequence
  Enter Directory
  Recall Instrument State
  Load List
  Load Pulse Train
  Install licenses
  No action（USBを切断）
  Use As

File > Catalog Type > <type> > More > USB File Manager 

または
File > More > USB File Manager

または
USBメディアを挿入
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基本操作 
ファイルによる操作 
ファイルのメディアから別のメディアへの移動
USB メ デ ィ ア ・ マネージ ャーを使用し てフ ァ イルをUSB と内部 メ デ ィ ア間で移動し ます。

波形またはこのソフト
キーを表示する不明な
ファイル・タイプの選択。

File > Catalog Type > <type> > More > USB File Manager

または
File > More > USB File Manager

または
USBフラッシュ・ドライブ(UFD)を挿入します

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

選択されているファイルによ
り、このキーが変更します。
67ページを参照してください 

メニューが利用可能かどうかは
選択したファイルによります。 

確認が必要です

Catalog Typeメニュー
63ページ

確認が必要です

ディレクトリ階層を1つ上に
移動します これらのソフトキーは、

BBG を搭載したベクト
ル・モデルでのみ使用
できます。

これらのソフト
キーは、BBG を
搭載したベクト
ル・モデルでの 
み使用できます。

ファイル・タイプが認識
された場合は、
「Filename.xxx copied to 
Internal Storage」が表示
されます。
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 基本操作   
ファイルによる操作
機器ステート・ファイルでの操作
• 機器ステートの保存 （70ページ）

• ユーザー・プリセットの保存 （70ページ）

• 機器ステートの再読取 （70ページ）

• 機器ステートと関連する波形ファイルの再読取 （71ページ）

• 機器ステートと関連するリスト・ファイルの再読取 （71ページ）

• 保存済みの機器ステートの移動またはコピー （72ページ）

図3-8 ソフトキーの保存と再読取

以下の情報はステー ト ・ フ ァ イル内に保存されません ：

システム ・ セキ ュ リ テ ィ ・ レベル 掃引 リ ス ト ホ ス ト 名 リ モー ト 言語 漸増値

システム ・ セキ ュ リ テ ィ ・ 
レベル ・ デ ィ スプレ イ

パルス列 リ ス ト IPア ド レ ス FTPサーバー ARBフ ァ イル

システム ・ セキ ュ リ テ ィ ・ レベル
状態

デ ィ スプレ イ ・ 
ステー ト のオン/オフ

サブネ ッ ト ・ 
マス ク

マニ ュ アルDHCP MAC

ウ ェブ ・ サーバー (HTTP) フ ァ イル デフ ォル ト ・
ゲー ト ウ ェ イ

VXI–11 SCPI ユーザー出力補正

Sockets SCPI (TELNET) I/Q校正データ

信号発生器に保存する場合、機器の設定（ステート）は機
器ステート・メモリー * に保存されます。機器ステート・
メモリーは10シーケンス（0～9）に分割され、各シーケン
スは100個のレジスタ（00～99）から構成されます。

SaveやRecallメニューのDeleteソフトキーを使って、特定
のレジスタの内容やステート・ファイル・カタログの全
シーケンスの内容を削除することができます。 

この信号発生器は削除の確認が必要です。

*注意 
データのロス、不揮発性メモリーに永続的に保存されてい
ないGPIB設定または現在のユーザーの機器ステートが消
失することを防ぐため、MXG は、必ず正面パネルの電源
ボタンまたは適切なSCPIコマンドで電源オフしてくださ
い。ラック・システムに設置されたMXGは、機器の正面
パネル・スイッチではなくシステム・ラック電源スイッチ
で電源オフされると、機器が適正に電源オフされなかった
ために、Error –310を表示します。各キーの詳細については、 

44ページで説明されているキー
のヘルプを使用してください。
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基本操作 
ファイルによる操作 
機器ステートの保存
1. 信号発生器をプ リ セ ッ ト し て、 以下を設定し ます ：

2. （オプシ ョ ン、 ベク ト ル ・ モデルのみ） 波形を これらの設定に関連づけます ： 

a. Mode > Dual ARB > Select Waveformを押し ます。

b. 目的のフ ァ イルを強調表示し て、 Select Waveform を押し ます。 フ ァ イルが リ ス ト されていない場合、 

フ ァ イルを内部または外部 メ デ ィ アからBBG メ デ ィ アへ移動させる必要があ り ます。 148ページを参
照し て く ださい。 

3. 目的の メ モ リ ー ・ シーケン ス を選択し ます （こ の例では、 1） ： Save > Select Seq > 1 > Enterを押し ます。

4. 目的のレジス タ を選択し ます （こ の例では、 01） ： Select Reg > 1 > Save Regを押し ます。 

波形が現在選択されている場合、 機器ステー ト の保存によ り 波形フ ァ イル名へのポ イ ン ターも保存され
ます。 

5. シーケン ス1のレジス タ01への説明コ メ ン ト を追加し ます ： 

Add Comment to Seq[1] Reg[01]を押し、コ メ ン ト を入力し てEnterを押し ます。Recallを押すと、Saved States     
リ ス ト にコ メ ン ト が表示されます。 機器ステー ト が波形に関連づけ られる と、 コ メ ン ト 内の波形名の入
力によ り 、 どの機器ステー ト がどの波形に適用されるか簡単に特定でき ます。 

ユーザー・プリセットの保存
ユーザー ・ プ リ セ ッ ト は機器ステー ト ・ フ ァ イルの特別な タ イプです。

1. 信号発生器をプ リ セ ッ ト し て、 希望通 り に設定し ます。

2. User Preset > Save User Presetを押し ます。

これによ り 、 USER_PRESET と名付け られたステー ト ・ フ ァ イルを保存し ます。 これで信号発生器が
ユーザー ・ プ リ セ ッ ト 情報を含むフ ァ イル と し て認識し ます。

異なる名前で複数のプ リ セ ッ ト 状況を設定でき ます。

1. ユーザー ・ プ リ セ ッ ト を保存し た後、 USER_PRESET以外の他の名前に変更し ます （72ページを参照し
て く ださい）。 

2. USER_PRESETフ ァ イルをその都度名前を変更し、 希望するだけユーザー ・ プ リ セ ッ ト を保存し ます。

3. 目的のフ ァ イルにUSER_PRESETの名前をつけます。

機器ステートの再読取
1. 信号発生器をプ リ セッ ト し ます。

2. Recallを押し ます。

Select Seqソ フ ト キーは 後に使用したシーケンスを表示し、 ディ スプレ イはそのシーケンス内のレジス タ
に保存されている ステー ト 全てを リ ス ト し ます。 RECALL Regはアクテ ィ ブ ・ エン ト リ です。 

3. 目的の機器ステー ト を選択し ます ： 

目的のステー ト が現在選択されているシーケンスに リ ス ト されている場合、 目的の番号 > Enterを押し ます。 

リ ス ト されていない場合、 Select Seq >目的の番号 > Enter > RECALL Reg >目的の番号 > Enterを押し ます。

• 周波数 ： 800 MHz • 振幅 ： 0 dBm • RF ： オン
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 基本操作   
ファイルによる操作
機器ステートと関連する波形ファイルの再読取 

1. 目的のフ ァ イルが存在し ている こ と、 BBG メ デ ィ ア内にあ る こ と を確認し て く ださい （148ページ）。 

波形フ ァ イルがBBG メ デ ィ ア内にない場合は、 この手順を実行する と エラーが発生し ます。

対応する波形フ ァ イルを持つ機器ステー ト を再読取し て も、 波形名が再読取されるだけです。 すでに削
除されている波形フ ァ イルが再現された り 、 内部またはUSB メ デ ィ アにあ る フ ァ イルがBBG メ デ ィ アに

ロード された り する こ と はあ り ません。

2. 目的の機器ステー ト を再読取 り ます （前の例を参照）。

3. 機器ステー ト と一緒に再読取する波形フ ァ イルの名前を表示し ます ： Mode > Dual ARBを押し ます。

名前は、 選択し た波形で表示されます。 

4. 波形フ ァ イルをオンにし ます ： Mode > Dual ARB > ARB Off Onを押し ます。

機器ステートと関連するリスト・ファイルの再読取 

機器ステー ト の再読取は リ ス ト 掃引設定のみを再読取し ます。 周波数および振幅値は再読取されません。 リ
ス ト ・ フ ァ イルはフ ァ イル ・ カ タ ロ グから読み込むので、 リ ス ト ・ フ ァ イルを保存する際に、 わか り やすい
名前 （ 長25文字） を付ける よ う にし ます。

1. 目的の機器ステー ト を再読取 り ます （前の例を参照）。

2. 目的の リ ス ト ・ フ ァ イルを読込みます ： 

a. Sweep > More > Configure List Sweep > More > Load/Storeを押し ます。

b. 目的のフ ァ イルを強調表示し て、 Load From Selected File > Confirm Load From Fileを押し ます。

機器コメントのコメント編集
Saveキーで保存し た機器ステー ト のコ メ ン ト を変更するには、 以下の手順を使用し ます。 これはStateカ タ ロ
グに表示される フ ァ イル名 （フ ァ イルの メ モ リ ー位置） と は異な り ます。

1. Saveを押し ます。

2. 目的のレジス タ を強調表示し ます。

3. Edit Comment In Seq[n] Reg [nn]を押し ます。

4. Re–SAVE Seq[n] Reg[nn]を押し ます。 

これによ り 、 以前に保存し た機器ステー ト 設定が新しいコ メ ン ト で上書き されます。 
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基本操作 
ファイルによる操作 
保存済みの機器ステートの移動またはコピー

図3-9 機器ステート・ファイル・カタログ

ユーザー作成のステー ト ・ フ ァ イルのデフ ォル ト 名は、 フ ァ イルの メ モ リ ー位置 （シーケン ス と レジス タ）
です。

フ ァ イルを移動するには、 目的のシーケン ス と レジス タに名前を変更し ます。 既存のフ ァ イル と同じ名前を
付ける こ と はでき ません。 ステー ト ・ フ ァ イルの名前を有効でないシーケン ス／レジス タ名に変更し た場合
は、 Save メ ニューにもRecall メ ニューにも フ ァ イルは表示されません。

シーケンス レジスタ

信号発生器は、USER_PRESETという名前のファイルだけをユーザー・プリセット情報として認識します（70ページ）。 
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 基本操作   
ファイルによる操作
デフォルト・ストレージ・メディアの選択
信号発生器を設定し てユーザー ・ フ ァ イルを内部ス ト レージまたは外部USB メ デ ィ アに保存でき ます。 自動

でUSB メ デ ィ アおよび内部ス ト レージに切 り 替え るには、 USB メ デ ィ アが取 り 付け られているかど う かによ

り 、 Automatically Use USB Media If Presentを選択し ます。 機器内にすべての機密情報を保存する こ と を防ぐに     
は、Use Only USB Mediaを選択し ます。USB メ デ ィ アにすべての機密情報を保存する こ と を防ぐには、Use Only    
Internal Storageを選択し ます。

こ の選択は電源を入れ直し て もプ リ セ ッ ト を行って も変更されません。

File > More > 

現在の選択

機器内のメモリーが使用されており、USBメディアは無視されています。

正面パネルのUSBコネクターに取り付けられているメディアが使用され
ており、ユーザー・データは内部ストレージに保存されていません。

これは推奨される選択です。USBメディアが正面パネルに取り付けら
れている場合、それが選択されているメディアです。USBメディアが
取り付けられていない場合、内部ストレージが使用されます。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

USBメディアが取り付けられて有効である場合、USBメディア上のディ
レクトリを選択して全てのファイル操作に使用します。
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基本操作 
エラー・メッセージの読込み 
エラー・メッセージの読込み
エラー状況が発生し た場合、 信号発生器は正面パネル ・ デ ィ スプレ イ ・ エラー待ち行列およびSCPI （ リ モー

ト ・ イ ン ターフ ェース） エラー待ち行列にそのエラーを報告し ます。 上記2つの待ち行列が個別に表示され、

管理されます。 SCPIエラー待ち行列の情報については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。

エラー・メッセージ・
フォーマット

特性 正面パネル ・ デ ィ スプレ イ ・ エ ラー待ち行列

容量 （エ ラー数） 30

オーバーフ ロー処理 新しいエ ラーが入って く る たびに、 も古いエ ラーが破棄されます。

エン ト リ の表示 以下を押し ます ： Error > View Next （またはPrevious） Error Page

待ち行列の ク リ ア 以下を押し ます ： Error > Clear Error Queue(s)

未解決問題a

a解決されるべきエラーです。たとえば、アンロックです。

待ち行列が ク リ ア された後に再報告されます。

エ ラーな し
待ち行列が空の場合 （待ち行列内のすべてのエ ラーが読み込まれたか、 待ち行列が ク リ ア された場合）、 以
下の メ ッ セージが待ち行列に表示されます ： 
待ち行列にエ ラー ・ メ ッ セージがない    0の0

エラー番号 エラー・メッセージ
エラー説明（ディスプレイには不完全
な状態で表示される場合があります）

222               範囲外のデータ;          下限に ク リ ッ プ された値。  

ユーザーが特定限度を超過している偏差、深度、または内部
ソース周波数を入力したことを示しています 

エラー・メッセージ・ファイルに説明があります（388ページを参照
してください）（これは機器上に表示されません）

メッセージ番号と詳しい説明

newは、最後に表示されてから生成
されたメッセージを示しています。

このインジケーターは、未読メッセージを示します。

エラー・メッセージは、発生と同時にディス 
プレイの左下に表示されます。
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
4 アナログ変調の使用（オプションUNT）

注記 Mod On/Offハード キーと LED機能は、 オプシ ョ ン UNTがイ ン ス ト ールされた信号発生器のみで有 
効です。

こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（ 43ページ）を参照し て、 その章の 
情報に習熟し て く ださ い。

• 内部変調源の使用 （78ページ）

• 外部変調源の使用 （79ページ）

• DCオフセットの削除 （79ページ）

• 広帯域AMの使用 （80ページ）

• LF（低周波）出力の設定（オプション303）（81ページ）
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アナログ変調の使用（オプションUNT） 
アナログ変調波形 
アナログ変調波形
信号発生器は、 4つのタ イプのアナロ グ変調 ： 振幅、 周波数、 位相、 パルス を持つRFキ ャ リ アを変調でき ま

す。 パルス変調の情報については、第6章、「パルス変調の使用（オプションUNWまたは320）」（ 129ページ） 
を参照し て く ださい。

利用可能な内部波形は以下を含みます ：

正弦  調整可能な振幅および周波数を もつ正弦波

三角形 調整可能な振幅および周波数を もつ三角波

正方形 調整可能な振幅および周波数を もつ方形波

正のラ ンプ波 調整可能な振幅および周波数を もつ正の進行ラ ンプ波

負のラ ンプ波 調整可能な振幅および周波数を もつ負の進行ラ ンプ波

アナログ変調ソース
信号発生器は以下の内部および外部変調入力ソース を提供し ます。 他に断 り がない限 り 、 内部変調源は上に
一覧されている5つの波形を生成し ます。

Ext1およびExt2  外部適用信号は変調入力と し て利用されます。 機器の背面パネルのEXT1またはEXT2コ
ネ ク ターへ信号を接続し ます。

Func Gen 1 内部関数発生器からの正弦波。 オプシ ョ ン 303 を搭載する機器は、 上に一覧されている

追加の波形選択肢があ り ます。

Func Gen 2 Func Gen 2はFunc Gen 1 と同様の機能があ り ます。 オプシ ョ ン303を搭載する機器で    

使用可能です。

Dual Func Gen 個々に調整可能な周波数 と セカ ン ド ・ ト ーン用ピー ク 振幅パーセンテージ設定を もつ
デュ アル波形。 オプシ ョ ン303を搭載する機器で使用可能です。 

Swept Func Gen 調整可能な開始および停止周波数、掃引時間、および掃引 ト リ ガー設定を持つ掃引波形。

オプシ ョ ン303を搭載する機器で使用可能です。

Noise Gen 1 & 2 ピーク間の値と し て生成された調整可能な振幅を もつ ノ イ ズ （RMS値は表示されている
値のおよそ80%です）。 一様分布およびガウ ス分布が利用でき ます。 オプシ ョ ン303を搭

載する機器で使用可能です。
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 アナログ変調の使用（オプションUNT）   
アナログ変調ソース
図4-1 アナログ変調用ソフトキー

79ページ79ページ 79ページ

各キーの詳細については、44ページで説明されている
キーのヘルプを使用してください。
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アナログ変調の使用（オプションUNT） 
内部変調源の使用 
内部変調源の使用
1. 信号発生器をプ リ セ ッ ト し ます。

2. 搬送波(RF)周波数を設定し ます。

3. RF振幅を設定し ます。

4. 変調を設定し ます ：

5. 変調をオンにし ます ：

適切な変調イ ンジケーターが現れ、 変調を有効にし た こ と が示されます。

6. RF （無線周波数） 出力をオンにし ます。

RF （無線周波数） 出力LEDが点灯し、 RF （無線周波数） 出力コネ ク ターから信号が送信されている こ と が示

されます。

変調が適切に作動していない可能性がある場合、「RF（無線周波数）出力に変調がない」（383ページ）を参照
し て く ださい。

「搬送信号の変調」（60ページ）も参照し て く ださい。

AM FM M

a. AMを押します

b. AMタ イプ （線形または指数関数） を設定し

ます ： AM Typeでご希望のタ イプを強調表示

し ます。

c. AMモー ド （ノ ーマルまたはデ ィ ープ） を設

定し ます。 デフ ォル ト はデ ィ ープです。
Normalを選択するとMoreでご希望のタイプ
を強調表示できます。   

d. AM深度を設定し ます ：    AM Depth > 値

デフ ォル ト  0.01%

範囲  0.01 ～ 100%

e. レー ト を設定し ます ： 
More > Setup AM Source > AM Rate > 値 > 
周波数の単位

a. FM/Mを押し ます。

b. 偏差を設定し ます ： 
FM Dev > 値 > 周波数の単位

c. レー ト を設定し ます ： 
More > Setup FM Source > FM Rate > 
値 > 周波数の単位

a. FM/M > FM/Mを押し ます

b. BW （ ノ ーマルまたはハイ） を設定

し ます ： FM Mでご希望のタ イプを

強調表示し ます。

c. 偏差を設定し ます ： 
M Dev > 値 > pi rad

d. レー ト を設定し ます ： 
More > Setup M Source > M Rate > 
値 > 周波数の単位

AM FM M

AM Off Onソ フ ト キーをオンにし ます FM Off Onソ フ ト キーをオンにし ます M Off Onソ フ ト キーをオンにし ます
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 アナログ変調の使用（オプションUNT）   
外部変調源の使用
外部変調源の使用

DCオフセットの削除
外部適用されているFM、 またはM信号でオフセッ ト を消去するには、 DCFMまたはDCM校正を実施し ます。

注記 内部生成された信号について こ の校正を実施でき ますが、通常、 DCオフセ ッ ト は内部生成された信

号の特性ではあ り ません。

1. ご希望の変調を設定し、 オンにし ます。

2. FM/M > FM Source > Ext1 or Ext2 > More > Setup FM Source > Ext DC Calを押し ます。

DC信号が適用された校正を実施する と、 DC信号によ る偏差をい く らか取 り 除き、 適用されているDC水準が

新しいゼロ基準点にな り ます。 DC信号を切断する と き、校正を も う 一度実施し てキ ャ リ アを正確なゼロ基準

に リ セ ッ ト し ます。

背面パネルの入力は13ページ
に記述されています

AM、FM または M入力

デフォルト

現在選択されている変調です。
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アナログ変調の使用（オプションUNT） 
外部変調源の使用 
広帯域AMの使用
広帯域AMはI/Q変調システムのI入力を使用し ます。 広帯域AMがオンの と き、 I/Qはオンにな り I/Qソースは
外部に設定されています。 I/Qがオフ、 またはI/Qソースが内部に設定されている場合、 広帯域AMはオフにな

り ます。

注記 9 kHzから5 MHzの間の周波数については、 広帯域AMはオフにな り ます。

図4-2 広帯域AMソフトキー・メニュー

広帯域AMの設定
1. ご希望の変調タ イプを設定し て有効にし ます。

2. AM > AM Path 1 2 WB を押し てWBにし ます。

AM > AM Path 1 2 WB

広帯域AM機能を有効および無
効にします。
注記：I/Qがオフ、またはI/Q
ソースが内部に設定されてい
る場合、広帯域AMはオフにな
ります。

各キーの詳細については、 44ページで説
明されている キーのヘルプを使用し て く
ださい。

広帯域AMが有効な場合、上記フィールドが
アクティブになります。
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 アナログ変調の使用（オプションUNT）   
LF（低周波）出力の設定（オプション303）
LF（低周波）出力の設定（オプション303）
信号発生器には低い周波数(LF)出力があ り ます。 LF （低周波） 出力ソースは内部変調源または内部関数発生

器の間で切 り 替える こ と ができ ます。

内部変調(Int Monitor) をLF （低周波） 出力ソース と し て使用、 LF （低周波） 出力はRF （無線周波数） 出力を  
変調する ために使用されている内部ソースからの信号を複製し ます。この信号用の固有変調パラ メ ーターは、
AM、 FM、 またはM メ ニューによ り 設定されています。 内部ソース （AM、 FM、 またはM） は信号を提供

する ためLF （低周波） 出力に設定する必要があ り ます。

LF （低周波） 出力ソース と し て関数発生器を使用し て、 内部変調源の関数発生器節はLF （低周波） 出力へ直
接働きかけます。 周波数および波形は LF （低周波） 出力 メ ニューから設定され、 AM、 FM、 または M メ

ニューからは設定されません。 以下の選択肢から波形を選択でき ます ：

利用可能な内部波形は以下を含みます ：

正弦  調整可能な振幅および周波数を もつ正弦波

三角形 調整可能な振幅および周波数を もつ三角波

正方形 調整可能な振幅および周波数を もつ方形波

正のラ ンプ波 調整可能な振幅および周波数を もつ正の進行ラ ンプ波

負のラ ンプ波 調整可能な振幅および周波数を もつ負の進行ラ ンプ波

パルス 調整可能な期間および幅を もつパルス

LF（低周波）出力変調源
信号発生器は以下の変調入力ソース を提供し ます。 他に断 り がない限 り 、 内部変調源は上に一覧されている
5つの波形を生成し ます。

Int Monitor  AM、 FMまたはM設定を使用し ます。

Func Gen 1 内部関数発生器の波形 

Func Gen 2 内部関数発生器の波形

Dual Func Gen 個々に調整可能な周波数 と セカ ン ド ・ ト ーン用ピー ク 振幅パーセンテージ設定を もつ
デュ アル波形。 オプシ ョ ン303を搭載する機器で使用可能です。 

Swept Func Gen 調整可能な開始および停止周波数、掃引時間、および掃引 ト リ ガー設定を持つ掃引波形。

オプシ ョ ン303を搭載する機器で使用可能です。

Noise Gen 1 & 2 ピーク間の値と し て生成された調整可能な振幅を もつ ノ イ ズ （RMS値は表示されている
値のおよそ80%です）。 一様分布およびガウ ス分布が利用でき ます。 オプシ ョ ン303を搭

載する機器で使用可能です。

DC LF （低周波） 出力BNCソース と し てDC電圧水準を選択し ます

注記 LF Out Off Onソ フ ト キーはLF （低周波） 出力の操作状態を制御し ます。 ただし、 LF （低周波） 出力ソー   
ス選択はInt Monitorであ る場合に、 出力制御方法は3つあ り ます。 変調源 （AM、 FM、 M） オン/オ 

フキー、 LF （低周波） 出力オン/オフキー、 またはMod On/Offソ フ ト キーを使用でき ます。

RF On/Offハード キーはLF OUTPUTコネ ク ターに適用されません。
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内部変調源によるLF（低周波）出力の設定
こ の例では、 内部FM変調はLF （低周波） 出力ソースです。 図4-3（82ページ）を参照し て く ださ い。

注記 内部変調(Int Monitor) はデフ ォル ト のLF （低周波） 出力ソースです。

LF（低周波）出力ソースとしての内部変調の設定
1. Presetを押し ます。

2. FM/M ハード キーを押し ます。

3. FM Dev > 75 > kHzを押し ます。

4. More > Setup FM Source > FM Rate > 10 > kHzを押し ます。 

5. Return > Return > FM Off Onを押し ます。 

偏差10 kHzおよび75 kHzのレー ト によ る FM信号を設定し ています。 FMイ ンジケーターがア ク テ ィ ブ化さ  

れ、 周波数変調を有効化し た こ と が示されます。

低周波数出力の設定
1. LF Outハード キーを押し ます。

2. LF Out Amplitude > 3 > Vを押し ます。 

3. LF Out Off Onを押し ます。

Int Monitorソース選択 （デフ ォル ト ・ ソース） を使用し て周波数が変調された3ボル ト の正弦波 （デフ ォル ト  

波形） 出力と し てLF （低周波） 出力信号を設定し ま し た。

図4-3 FMをもつLF（低周波）出力ソースの設定

各キーの詳細については、 
44ページで説明されている キーのヘ
ルプを使用し て く ださい。

Int Monitorソース を利用するLF （低周波）

出力 （デフ ォル ト の選択）。

LF （低周波） 出力ソース と し て 

のFM変調

FMおよびLFイ ンジケーターは周波数変調がLF （低周波） 出力ソー

スであ る こ と を示し ています
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 アナログ変調の使用（オプションUNT）   
LF（低周波）出力の設定（オプション303）
関数生成ソースをもつLF（低周波）出力の設定
こ の例では、 関数発生器はLF （低周波） 出力ソースです。

LF（低周波）出力ソースとしての関数発生器の設定
1. Presetを押し ます。

2. LF Outハード キーを押し ます。

3. LF Out Source > Func Gen 1を押し ます。

波形の設定
1. Setup LF Out Source > LF Out Waveform > Sineを押し ます。

2. LF Out Freq > 500 > Hzを押し ます。

3. Returnを押し ます。

これによ り LF （低周波） 出力 メ ニューの 上部へ戻 り ます。 

低周波数出力の設定
1. LF Out Amplitude > 3 > Vを押し ます。

これによ り LF （低周波） 出力振幅を3 Vに設定し ます。

2. LF Out Off Onを押し ます。

図4-4（83ページ）では、 LF （低周波） 出力が、 3 V正弦波を提供し ている関数発生器を使用し て信号を送
信し ている こ と を表示し ています。 

図4-4 LF（低周波）出力ステータス・ディスプレイ

各キーの詳細については、 
44ページで説明されている キーのヘ
ルプを使用し て く ださい。LF （低周波） 出力構成

LF （低周波） 出力イ ンジケーター
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
5 性能最適化
こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準と周波数の
設定などの機能を まだ十分に操作でき ない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の

情報に習熟し て く ださい。

• デュアル・パワー・メーター・ディスプレイの使用 （86ページ）

• パワー・メーター・サーボの使用 （94ページ）

• 平坦度補正の使用 （97ページ）

• 内部チャンネル補正の使用（N5172B/82B専用）（106ページ）

• 外部レベリングの使用（N5173B/83B専用）（109ページ）

• レベリングなし動作モードの使用 （117ページ）

• 出力オフセット、基準、乗数の使用 （121ページ）

• フリー・ラン、ステップ持続時間、タイマー・トリガーの使用 （125ページ）

• USBキーボードの使用 （127ページ）
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デュアル・パワー・メーター・ディスプレイの使用
デュアル ・ パワー ・ メーター ・ ディ スプレ イは、 現在の周波数、 および、 どれか1つまたは2つのパワー ・ セン

サーの出力の表示に使用でき ます。 デ ィ スプレ イは、 現在の周波数と パワー ・ センサーで測定された出力を、
大型の中央デ ィ スプレ イ と、 デ ィ スプレ イの右上隅に表示し ます。 図5-1、 図5-2および図5-3 を参照し て く
ださい。

図5-1 校正済みパワー・センサー AおよびB用デュアル・パワー・メーター・ディスプレイ
オンにすると、パ
ワー・メーターの読み
値は、たとえ、別の機
器機能（すなわち、掃
引、AM、など）が選
択されても、常時表示
されます。

この領域は、デュア
ル・パワー・メーター
の校正周波数と現在の
出力測定値の主ディス
プレイです。
チャンネルAまたは
チャンネルBパワー・
センサー、もしくは、
両方が表示されてい
て、AMPTDまたは
FREQソフトキーが押
された場合は、大型パ
ワー・メーター測定値
は表示されたまま残り
ます。
1回目の接続後、接続
が正常であれば、パ
ワー・センサーのモデ
ル番号とシリアル番号
が表示されます。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。
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 性能最適化   
デュアル・パワー・メーター・ディスプレイの使用
図5-2 デュアル・パワー・メーター・ディスプレイ・メニュー

88ページを参照してください 

チャンネルAのパワー・センサーを 
有効にします。

チャンネルBのパワー・センサーを
有効にします。

チャンネルBはチャンネルAと同様
に設定されます。88ページを参照
してください。 

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。
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図5-3 パワー・センサー・チャンネルの設定

AUX Fctn  パワー ・

メ ーター測定 

Sockets LAN：IPポート
を5025（標準）または
5023（telnet）プログラ
ミングに設定します。パワー・メーターのIPアドレス

またはLAN-GPIBゲートウェイ
のIPアドレス（Sockets LANお
よびVXI–11 LANのみ）を設定
します。

ソフトキーが有効かどうかは、選

択された接続タイプによります。 

VXI–11 LAN：使用されるパワー・
メーターのデバイス名を入力する
ためのメニューが開きます。

パワー・メーター接続タイ
プを有効にします：
Sockets LAN、VXI–11 
LAN、または、USB。

注記：VXI–11ソフトキー
は、GPIBコネクター
（LAN-GPIBゲートウェイ経
由）が付いたパワー・メー
ターとリモート通信するた
めに使用します。

USB U2000Aシリーズのパワー・
センサーには、校正用のセンサー
は必要ありません。

MXG/EXGは、USB U2000Aシ
リーズ・パワー・センサーの
「内部」ゼロを使用します。
USB U2000A シリーズ・パ
ワー・センサーのドキュメン
テーションを参照してくだ 
さい。

Zero SensorおよびCalibrate 
Sensorソフトキーは、測定の間
は無効になります。

チャンネルAが校正された周波数を選択
します。

パワー・センサーが接続された外部
パワー・メーターのチャンネルを選
択します。

現在のチャンネルのdB単位のパワー・
オフセットを有効にします。

平均化を有効にします。機器の
デフォルトは、1024ポイントを
使用する自動の設定です。

注記 ： この図はチャ ンネルAを表し ます。 チャ ンネルBも同様です。

各キーの詳細については、44ページで説明
されているキーのヘルプを使用してください。
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 性能最適化   
デュアル・パワー・メーター・ディスプレイの使用
例：デュアル・パワー・メーターの校正
次の例では、 U2004A USBパワー ・ センサーがチャンネルAに接続され、 また、 N1912A P- シ リ ーズ ・ パワー ・  

メーターと8482Aパワー ・ センサーがチャンネルBに接続され、 必要に応じてゼロ調整と校正が行われます。

信号発生器で ：

1. ステ ッ プ掃引をセ ッ ト ア ッ プし ます。「掃引出力の設定」（50ページ）。

注意 継続する前に、 RF （無線周波数） 出力パワーがオフであ る こ と を確認し て く ださい。 

2. チャ ンネルAパワー ・ センサーの接続 ： USBセンサーを信号発生器に接続し ます。 MXG/EXGは、 下部

に、 以下のよ う な メ ッ セージを表示するはずです。 
USB TMC488 device (USB POWER SENSOR,MY47400143) connected

図5-4    MXG/EXGがU2000 USBパワー・センサーとの接続を表示

3. Aux Fctn > Power Meter Measurements > Channel A Setup > Connection Settings > Connection Type > USB 
Device (None) > USB POWER SENSOR (MY47400143)の順に押し ます

4. Return > Zero Sensorを押し ます

異なる シ リ アル番号の U2000 シ リ ーズのパワー ・ センサーが、 初回に信号発生器に接続される と、 診断
ダ イ ア ロ グ ・ ボ ッ ク スが開き ます （図5-5を参照）。 U2000が信号発生器に認識される と、 U2000パワー ・

センサーは、 機器にソ フ ト キーと し て保存され、図5-5のダ イ ア ロ グ ・ ボ ッ ク スは表示されません （この

メ ッ セージを見た らDONEを押し ます）。

図5-5    USBセンサー用診断ダイアログ・ボックス 

信号発生器にRunning Calibration(s)バーが表示されます。図5-6（90ページ）を参照し て く ださい。
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デュアル・パワー・メーター・ディスプレイの使用 

      
図5-6    Running Calibration(s)バー（センサーのゼロ調整）

注記 U2000シ リ ーズUSBパワー ・ センサーには、 50 MHzの校正は不要です。 U2000シ リ ーズ ・ パワー ・ 

センサーを使用し て校正を試みる と、 信号発生器は次のよ う な メ ッ セージを表示し ます ： 
The U2000 series power sensor does not require a 50 MHz calibration.図5-7     
（90ページ）を参照し て く ださい。

図5-7    U2000パワー・センサー用に表示された診断ダイアログ・ボックス

5. Return > Return > Channel A と押し てオンにし ます。

現在のパワー ・ メ ーター ・ センサーの読み値は測定器デ ィ スプレ イのChA部、 および、 デ ィ スプレ イの右
上部分のPower Meterの下に表示されるはずです。 図5-8を参照し て く ださ い。

各キーの詳細につ
いては、44ペー
ジで説明されてい
るキーのヘルプを
使用してください。

各キーの詳細に
ついては、 
44ページで説明
されているキー
のヘルプを使用
してください。
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 性能最適化   
デュアル・パワー・メーター・ディスプレイの使用
図5-8    MXG/EXGに表示されたチャンネルAパワー・センサー

6. N1912A P- シ リ ーズ ・ パワー ・ メ ーター （チャ ンネルBパワー ・ センサー） で ： N1912A P- シ リ ーズ ・ パ  
ワー ・ メ ーターをLANに接続し ます。

7. パワー ・ メ ーター ・ センサーをパワー ・ メ ーターのチャ ンネルBに接続し ます。

注記 N1912Aにチャ ンネルBを使用する こ と を推奨し ますが、 必須ではあ り ません。 この方法によ り 、 信

号発生器デュ アル ・ デ ィ スプレ イ と の一貫性が実現されます。 この例では、 信号発生器のチャ ンネ
ルA位置はU2004Aによ り すでに使用されています。

8. パワー ・ センサー入力を、 パワー ・ メ ーターの50 MHz基準に接続し ます。

9. Channel B Setupを押し ます。

10. Connection Settings > Sockets と押し ます。

11. IP Address > 所定のIP address > Enterの順に押し ます。

注記 パワー ・ メ ーターのIPア ド レ スが、 デ ィ スプレ イのChBセ ク シ ョ ンに表示されているはずです。

図5-9    IPアドレスが入力された、チャンネルBパワー・センサー

12. Return > Channel Settings > External Power Meter Channel と押し てBに設定し ます。

各キーの詳細につい
ては、44ページで
説明されているキー
のヘルプを使用して
ください。

各キーの詳細につ
いては、44ペー
ジで説明されてい
るキーのヘルプを
使用してください。
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13. 信号発生器で ： チャ ンネルBを押し てOnにし、 またOffに戻し ます。 このこ と によ り 、 信号発生器が外部

パワー ・ メ ーターに対し て初期化されます。

14. Return > Zero Sensorを押し ます

外部パワー ・ メ ーターの使用中にZero SensorまたはCalibrate Sensorソ フ ト キーを押すと、 診断ダ イ ア  
ロ グ ・ ボ ッ ク スが表示されます （図5-10（92ページ）を参照し て く ださい）。 

パワー ・ センサーがパワー ・ メ ーターの50 MHz基準に接続されている こ と を確認し ます。

図5-10    チャンネルB用診断ダイアログ・ボックス

15. Doneを押し ます

Running Calibration(s)バーが次のよ う に表示されます ： Zeroing Sensor Please wait...
（センサーのゼロ調整中、 お待ち く ださ い...）。 

16. Running Calibration(s)バーが消えた ら ： Calibrate Sensorを押し ます 

パワー ・ センサーがパワー ・ メ ーターの50 MHz基準に接続されている こ と を確認するために、 診断ダ イ 
ア ロ グ ・ ボ ッ ク スが表示されます （図5-11（92ページ）を参照し て く ださい）。

図5-11    校正用の診断ダイアログ・ボックス

各キーの詳細につい
ては、44ページで
説明されているキー
のヘルプを使用して
ください。

各キーの詳細につ
いては、44ペー
ジで説明されてい
るキーのヘルプを
使用してください。
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17. Doneを押し ます

校正のプロ グレ ス ・ バーが表示されます。 図5-12（93ページ）を参照し て く ださ い。

図5-12    Running Calibration(s)バー（センサーの校正）

18. Return > Channel Bを押し てOnにし ます。

19. 現在のパワー ・ メ ーター ・ センサーの読み値は信号発生器デ ィ スプレ イの ChB セ ク シ ョ ン と、 デ ィ スプ

レ イの右上隅のPower Meterの下 と、 パワー ・ メ ーターのパワー ・ センサー読み値の左側に表示されるは 

ずです。

図5-13    MXG/EXGに表示されたチャンネルBパワー・センサー

20. これで、 パワー ・ センサーを測定設定に接続する準備ができ ま し た。

各キーの詳細につ
いては、44ペー
ジで説明されてい
るキーのヘルプを
使用してください。

各キーの詳細につ
いては、44ページ
で説明されている
キーのヘルプを使
用してください。
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パワー・メーター・サーボの使用
パワー ・ メ ーター ・ サーボ ・ モー ド は、 パワー ・ メ ーターの読み値を ソースの出力パワーの調整に使用し、
一定のDUT出力パワーを維持し ます。

サーボ ・ ループはDUTの出力パワーを測定し、 それをユーザー規定の基準パワーと比較し て ソースの出力を
調整し、 セ ト リ ング誤差以内のユーザー規定パワー ・ レベルを達成し ます。 サーボ ・ ループは、 ユーザー規
定パワー ・ レベル達成の試みが20回失敗する と中止されます。

図5-14 パワー・メーター・サーボ・メニュー

各キーの詳細については、44ページで説明されて
いるキーのヘルプを使用してください。

88ページを参照
してください 

許容セトリン
グ誤差を設定
します。

システムは、パワー・レベルを、パ
ワー・メーターの読み値に従って自
動的に調整します。

Onceモードは、何れかの遷移（振幅
または周波数の変化）の終わりのみ
に調整を実行します。調整が実行さ
れ、パワー誤差が補正されると、次
の遷移まではそれ以上の調整は実行
されません。

ContinuousはOnceモードと同じよ
うに調整を実行し、値が指定された
セトリング誤差より大きく異なると、
定期的なパワーの調整を続けます。

N5173B/83B専用

N5173B/83B
専用

パワー・メーター・サーボ・
モードでレベリングする際に
は相対初期パワーを設定しま
す。0 dBのデフォルト値は、
必要と判断されるパワー（出
力パワー、オフセットおよび
基準に基づく）でシステムが
起動することを意味します
が、このことは特定のケース
でパワー・オーバーシュート
を招く場合があります（特に
オフセットが適切に設定され
ていない場合）。この値は、
デバイスをパワー・オーバー
シュートから保護するため
に、目標パワーより低い測定
/調整サイクルを開始するた
めの追加安全マージンの指定
を可能にします。
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 性能最適化   
パワー・メーター・サーボの使用
パワー・メーター・サーボ設定
以下の手順は、 信号発生器のパワー ・ メ ーター ・ サーボ ・ モード を使用するための基本的な設定です。 

注意 以下で説明される設定は、 使用可能な設定例の1つです。 ご使用のDUTの制限を考慮し、 DUTが過

大な出力に曝されないよ う 保護するための注意を適用し て く ださい。

1. 機器を、 図5-15に示す通 り に接続し ます。

図5-15    パワー・メーター・サーボ設定

2. 信号発生器周波数と振幅を、 ご使用のデバイ スの所定の設定に合わせます。 

注記 適な結果が得られ、 DUTへのス ト レ スが軽減される よ う に、 振幅オフセ ッ ト はデバイ スの適切な

ゲイ ン と一致する よ う に設定し て く ださ い。 例えば、 DUTがゲイ ン20 dBの増幅器であれば、 振幅 

オフセ ッ ト を20 dBに設定し ます。 
 
AMPTD > More > Amptd Offsetを押し、 数値を入力し ます。

3. 信号発生器で、 AMPTD > Leveling Control > Power Meter Servo Configurationを押し ます。

4. チャ ンネルAセ ッ ト ア ッ プを押し て、 パワー ・ メ ーターを設定し ます。パワー・センサー・チャンネルの
設定 （88ページ） を参照し て く ださい。

5. Return > Return > Settling Error と押し ます。 セ ト リ ング誤差値を設定し ます。 

6. Return > Return > Leveling Modeを押し ます。 レベ リ ング ・ モード を選択し ます。 

 
Power Meter Onceは、 何れかの遷移 （振幅または周波数の変化） の終わ り のみに調整を実行し ます。 調  

整が実行され、 パワーが補正される と、 次の遷移まではそれ以上の調整は実行されません。 
 

各キーの詳細については、
44ページで説明されている
キーのヘルプを使用してくだ
さい。

パワー・センサー

方向性結合器
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性能最適化 
パワー・メーター・サーボの使用 
Power Meter Continuousは、Onceモード と同じ よ う に調整を実行し、値が指定されたセ ト リ ング誤差よ  
り 大き く 異なる と、 定期的なパワーの調整を続けます。

これらのパラ メ ーターが設定される と、 サーボ ・ ループが連動し、 DUTの出力パワーを レベル調整し ます。 

例
次の例は、 振幅オフセ ッ ト 設定の重要さ を強調し ています。 振幅オフセ ッ ト は、 DUTが過大なパワーに曝さ

れないよ う に保護するからです。

こ の例では、 ソースの振幅オフセ ッ ト は20 dBで、 ソースの振幅は25 dBmにプロ グ ラ ム されています。 この  
オフセ ッ ト がプロ グ ラ ム されたレベルから差し引かれ、実際のソース出力パワーを5 dBmにし ます。例えば、 

パワー ・ メ ーターが24.5 dBmを測定する場合、 パワー ・ メ ーターの測定値が望ま しい25 dBmよ り 0.5 dBm   
低いため、 出力パワーは0.5 dBmに調整されます。 新しいソース出力パワーは5.5 dBm と な り ます。 パワー ・  
メ ーターが、 次に24.97 dBm を測定する と、 測定された値がセ ト リ ング誤差0.2 dBの半分以内であ るため、  

それ以上の調整はされません。 

連続レベ リ ング ・ モード を使用する場合には、 パワー ・ メ ーター読み値は監視され、 測定が指定されたセ ト
リ ング誤差の外側まで ド リ フ ト する と、 ソースの出力パワーが調整されます。

こ の例を続ける と、 振幅オフセ ッ ト がデフ ォル ト 値の0 dBのま まであれば、 出力パワーは25 dBmであ るは  

ずですが、 パワー ・ メ ーター測定値は 40 dBm の結果と な り ます （増幅器がすでに圧縮状態にあ る と仮定し 
ます）。 アルゴ リ ズムではソース ・ パワーは15 dB低減されるはずであ り 、 出力は10 dBm、 また、 測定結果  

は29.5 dBm と なる可能性があ り ます。さ らに4.5 dBが低減された こ と は、20 dBの振幅オフセ ッ ト （5.5 dBm    
のソース出力パワー） と同じ結果を導いています。 ただし、 中間では、 DUTはス ト レ ス を受け、 既定された
その作動範囲を超えているかも知れません。
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 性能最適化   
平坦度補正の使用
平坦度補正の使用
ユーザー平坦度補正によ り 、 大1601個の連続する リ ニア間隔または任意間隔の周波数ポイ ン ト のRF （無線

周波数） 出力振幅をデジ タル調整し て、 ケーブル、 ス イ ッチまたは他のデバイ スの外部損失を補償する こ と
ができ ます。 Keysight N1911A/12A、 E4419A/B、 または、 U2000 Seriesパワー ・ メ ーター /センサーを使用  
し て測定システムを校正する こ と によ り 、 パワー ・ レベルの変動や損失が発生する周波数に対し てパワー ・
レベル補正表を自動的に作成でき ます。 パワー ・ メ ーター /センサーに対する接続タ イプ と し ては、 Sockets
LAN、 VXI–11 LAN、 USB、 GPIB （E5810Aゲー ト ウ ェ イ または同等のLAN–GPIBゲー ト ウ ェ イ を使用し た 

VXI–11 LAN経由） がサポー ト されています。

注記 GPIB付きパワー ・ メーターには、Connection Type VXI–11ソ フ ト キーおよびLAN-GPIBゲー ト ウ ェ  
イ を使用してパワー ・ メーターを制御する こ と が必要です。 『Keysight 接続ガイ ド USB/LAN/GPIB 接

続ガ イ ド （E2094–90009）』、 『Keysight よ く あ る質問 「LAN に接続する方法は？」』、 『E5810A ユー
ザー ・ ガ イ ド』 または同等のLAN/GPIBゲー ト ウ ェ イ機器のガ イ ド を参照し て く ださ い。

Keysight N1911A/12AまたはE4419A/Bパワー・ メ ーター、 または、U2000A/01A/02A/04Aパワー・ センサー 

をお持ちでない場合、 も し く は、 ご使用のパワー ・ メ ーターにLAN、 GPIBまたはUSBイ ン ターフ ェースがな

い場合には、 補正値は信号発生器に手入力する こ と ができ ます。

異なる補正配列を、異なるテス ト ・ セッ ト ア ップまたは異なる周波数範囲に使用可能にするために、個別のユー
ザー平坦度補正表を信号発生器のメモ リ ー・ カタ ログに保存して、要求に応じて再読み取りする こ とができます。

次節のステ ッ プに従ってユーザー平坦度補正を作成し、 信号発生器のRF （無線周波数） 出力に適用し ます

（101ページを参照し て く ださい）。

その後、「ユーザー平坦度補正配列の再読み取りと適用」（105 ページ）のステ ッ プに従って、 ユーザー平坦
度補正を メ モ リ ー ・ カ タ ロ グから再読み取 り し、 信号発生器のRF （無線周波数） 出力に適用し ます。
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平坦度補正の使用 
図5-16 User Flatness Correctionソフトキー

確認

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。

101ページ
を参照して
ください 

ユーザー平
坦度校正 
を開始し 
ます。
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 性能最適化   
平坦度補正の使用
ユーザー平坦度補正配列の作成
この例では、 ユーザー平坦度補正配列を作成し ます。 平坦度補正配列には、 500 MHzから1 GHzまでの、 10個  

の周波数補正対 （指定された各々の周波数に振幅の補正値） が含まれます。 

Keysight N1911A/12AまたはE4419A/Bパワー ・ メーターおよびE4413Aパワー ・ センサーは、 規定された補正 

周波数で RF （無線周波数） 出力振幅を測定し、 結果を信号発生器に転送するために使用されます。 （A U2000 
シ リ ーズのパワー ・ メ ーター /センサーを、 パワー ・ メ ーターと E4413Aパワー ・ センサーの代わ り に使用す

る こ と ができ ます。） 信号発生器は、 パワー ・ メ ーターからパワー ・ レベル ・ データ を読み取 り 、 補正値を計
算し、 補正対をユーザー平坦度補正配列に保存し ます。

所定のKeusightパワー ・ メ ーターをお持ちでなければ、 または、 ご使用のパワー ・ メ ーターにLAN、 GPIBま

たはUSBイ ン ターフ ェースがない場合には、 補正値を手動で入力する こ と ができ ます。 

必要機器
• Keysight N1911A/12AまたはE4419A/Bパワー ・ メ ーター （パワー ・ センサー U2000A/01A/02A/04Aに 

はパワー ・ メ ーターは不要です）

• Keysight E4413A Eシ リ ーズCWパワー ・ センサーまたはU2000A/01A/02A/04Aパワー ・ センサー

• 必要に応じ て、 GPIB、 LANまたはUSBイ ン ターフ ェース ・ ケーブル

• 必要に応じ て、 アダプターおよびケーブル

注記 特定のパワー ・ メ ーター /センサーの操作情報は、 それぞれの操作ガイ ド を参照し て く ださい。

機器の接続
機器を、「機器の接続」（100ページ）に示す通 り に接続し ます。

注記 ユーザー平坦度補正配列を作成するプロセスの間、 パワー ・ メ ーターは信号発生器から リ モー ト 操
作されます。
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平坦度補正の使用 
機器の接続
• Keysight N1911A/12AまたはE4419A/Bパワー ・

メ ーターa

• Keysight U2000A/01A/02A/04Aパワー ・ センサー a

a操作情報は、パワー・メーター /センサーのドキュメンテーションを参照してください。

• 必要に応じ て、 LAN、 GPIBまたは

USBイ ン ターフ ェース ・ ケーブル

• 必要に応じ て、 アダプターおよびケー

ブル

LAN、GPIB*およびUSB接続は使用可能であれば
便利です。ご使用のパワー・メーターにLAN、
GPIBまたはUSBがない場合は、本節の補正値入
力ステップに説明された通り、補正値を手動で入
力してください。

*パワー・メーターのGPIB制御には、LAN-GPIB
ゲートウェイと接続タイプVXI–11の使用が必要で
す。『Keysight接続ガイドUSB/LAN/GPIB接続ガイ
ド（E2094–90009）』、『Keysightよくある質問
「LANに接続する方法は？」』、『E5810Aユーザー・
ガイド』または同等のLAN/GPIBゲートウェイ機
器のガイドを参照してください。

パワー・ 
センサー

パワー・メーター 
（該当する場合）

信号 
発生器

テストされるデバイス

出力 入力

入力ポート

RF（無線周波数）出力

ケーブル 
と別の、
デバイス

平坦度 
補償済み 
出力ポート

LAN/ 

注記：Keysight U2000シリーズUSB
センサーは、信号発生器正面パネル
のUSBポートに直接接続します（す
なわち、パワー・メーターは該当し
ません）。

USB互換パワー・メーター /
センサー（例えば、
N1911A/12Aパワー・メー
ターおよびU2000Aシリーズ
USBパワー・センサー）接続
用USBポート。

GPIB E5810A
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 性能最適化   
平坦度補正の使用
図5-17 Configure Power Meterメニューのソフトキー

基本手順
1. ユーザー平坦配列を作成し ます。

a. パワー ・ メ ーター /センサーを設定し ます

b. 機器を接続し ます

c. 信号発生器を設定し ます

d. ユーザー平坦度補正値を入力し ます

2. 必要に応じ て、 ユーザー平坦度補正データ を保存し ます。

3. ユーザー平坦度補正をRF （無線周波数） 出力に適用し ます。

AMPTD  More  User Flatness  
Configure Power Meter

ソケットLAN：IPポートを5025
（標準）または5023（telnet）プロ
グラミングに設定します。

パワー・メーターのIPアドレスま
たはLAN-GPIBゲートウェイのIP
アドレス（ソケットLANおよび
VXI–11 LANのみ）を設定します。

VXI–11 LAN：使用されるパワー・
メーターのデバイス名を入力する
ためのメニューが開きます。

パワー・メーター接続タイ
プを有効にします：ソケッ
トLAN、VXI–11 LAN、また
は、USB。

注記：VXI–11ソフトキー
は、GPIBコネクター
（LAN-GPIBゲートウェイ経
由）が付いたパワー・メー
ターとリモート通信するた
めに使用します。

USB U2000Aシリーズのパワー・
メーターには、校正用のセンサー
は必要ありません。

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

メニューを開い
てUSBデバイ
ス名を入力しま

ソフトキーは、選択された
Connection Typeに依存し
ます。

指定された外部パワー・
メーターへの接続を試み、
「*IDN?」コマンドを実行
します。結果が「接続済
み、ただし、*IDN?応答な
し」であれば、IPアドレス
は何かに接続されました
が、ソケット・ポートまた
はVXI-11デバイス名が正し
くありません。
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U2000A/01A/02A/04Aパワー・センサーの設定
1. パワー ・ センサーを、 信号発生器正面パネルのUSBポー ト に接続し ます。 「機器の接続」（100ページ）を 

参照し て く ださい。

2. 信号発生器のソ フ ト キーを使用し て、 パワー ・ センサーをゼロ調整し ます。

注意 パワー ・ メ ーターのゼロ調整を実行する前に、 信号発生器のRF （無線周波数） 出力が所定の振幅に
設定されている こ と を確認し ます。 信号発生器のゼロ調整の間は、 RF （無線周波数） 出力振幅の確
認は行われません。

注記 信号発生器のRF （無線周波数） 出力LEDは、 パワー ・ センサーのゼロ調整中には変化はあ り ません

（例えば、 RF （無線周波数） 出力 LED が、 パワー ・ センサーのゼロ調整開始前に点灯し ていれば、

LED はゼロ調整 / 校正の間も点灯し たま まです）。 ただし、 実際には機器のフ ァーム ウ ェ アは、 RF
（無線周波数） 出力の電源をオフに切 り 替えています。 

特定のパワー ・ センサーの操作情報は、 その操作ガイ ド を参照し て く ださい。

E4419A/BおよびN1911A/12Aパワー・メーターの設定
1. パワー ・ メ ーターの リ モー ト 言語にSCPIを選択し ます。

2. パワー ・ センサーをパワー ・ メ ーターを使用し てゼロ調整および校正し ます。 信号発生器またはパワー ・
メ ーターの正面パネルのソ フ ト キーを使用し ます。

3. パワー ・ センサーの校正係数を、 必要に応じ てパワー ・ メ ーターに入力し ます。

4. パワー ・ メ ーターの校正係数配列を有効にし ます。

注記 信号発生器のRF （無線周波数） 出力LEDは、 パワー ・ センサーのゼロ調整中には変化はあ り ません

（例えば、 RF （無線周波数） 出力 LED が、 パワー ・ センサーのゼロ調整開始前に点灯し ていれば、
LED はゼロ調整 / 校正の間も点灯し たま まです）。 ただし、 実際には機器のフ ァーム ウ ェ アは、 RF
（無線周波数） 出力の電源をオフに切 り 替えています。

使用する特定のパワー ・ メーター /センサーの操作情報は、 それぞれの操作ガイ ド を参照して く ださい。

例：10個の補正値を使用する500 MHzから1 GHzの平坦度補正配列

ユーザー平坦度配列の作成

1. 信号発生器を設定し ます ：

a. 信号発生器をプ リ セ ッ ト し ます。

b. 信号発生器の接続タ イプをパワー ・ メ ーター /センサーに合わせて設定し ます。

i. AMPTD > More > User Flatness > Configure Power Meter > Connection Settings > Connection Type > 
所定のconnection typeの順で押し ます。

ii. 接続タ イプがUSBの場合 ：

1. センサーをゼロ調整し ます。

2. ステ ッ プcに進みます。
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も し く は 
 
Sockets LANまたはVXI–11 LANの場合 ： Power Meter IP Address > power meter IP addressまたは
LAN–GPIB gateway IP address > Enter と押し ます。

iii. Sockets LANの場合 ： Power Meter IP Port > 所定のIP port > Enterを押し ます。

も し く は

VXI–11の場合 ： PM VXI–11 Device Name > 所定のdevice name > Enterを押し ます。

パワー ・ メ ーターに直接接続する場合は、 パワー ・ メ ーターの ド キ ュ メ ンテーシ ョ ンに指定され
ている通 り 、 デバイ ス名を入力し ます。 通常は、 「inst0」 ですが、 一部のパワー ・ メ ーターで

は、大文字/小文字が区別されます。ご使用のパワー・ メ ーターの ド キ ュ メ ンテーシ ョ ン、『Keysight
接続ガ イ ド USB/LAN/GPIB接続ガイ ド （E2094–90009）』、 および、 『Keysightよ く あ る質問 「LAN
に接続する方法は？」』 を参照し て く ださ い。

LAN- GPIBゲー ト ウ ェ イ経由で接続する場合は、パワー・ メ ーターのSICLア ド レ ス を入力し ます。
通常、 それは 「gpib0,13」 ですが、 こ こ で 「gpib0」 はゲー ト ウ ェ イの GPIB SICL イ ン ター 

フ ェース名、 また、 「13」 はパワー ・ メ ーターの GPIB ア ド レ ス名です。 『Keysight 接続ガ イ ド

USB/LAN/GPIB 接続ガイ ド （E2094–90009）』、 『Keysight よ く あ る質問 「LAN に接続する方法
は？」』、 『E5810Aユーザー ・ ガイ ド』 または同等のLAN/GPIBゲー ト ウ ェ イ機器のガイ ド を参照

し て く ださい。

c. ユーザー平坦度表エデ ィ ターを開き、 校正配列をプ リ セ ッ ト し ます ： 
Return > Configure Cal Array > More > Preset List > Confirm Preset with Defaultsの順に押し ます。

d. Step Array メ ニューで、 所定の平坦度/補償済み開始および停止周波数、 および、 ポイ ン ト の数を入 
力し ます ： 

e. 前のステ ッ プで設定し たステ ッ プ配列を持つユーザー平坦度補正配列を投入し ます ： 

Return > Load Cal Array From Step Array > Confirm Load From Step Dataの順に押し ます。

f. 出力振幅を0 dBmに設定し ます。

g. RF （無線周波数） 出力をオンにし ます。

次の順に押し ます More > Configure Step Array > 

Freq Start > 500 > MHz >

Freq Stop > 1 > GHz >

# of Points > 10 > Enter
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2. パワー ・ メ ーターをRF （無線周波数） 出力に接続し て、 補正値を入力し ます ：

ユーザー平坦度補正配列のタ イ ト ルにはUser Flatness:(UNSTORED)と、 名前な しで表示され、 現在 
のユーザー平坦度補正配列データがフ ァ イル ・ カ タ ロ グに保存されていないこ と を表し ます。

任意 ： ユーザー平坦度補正データ を保存し ます

1. Load/Store > Store to Fileを押し ます。

2. フ ァ イル名を入力し （こ の例では、 FLATCAL1）、 Enterを押し ます。

ユーザー平坦度補正配列フ ァ イルは、 これで、 フ ァ イル ・ カ タ ロ グにUSERFLATフ ァ イル と し て保存され
ます。 カ タ ロ グに保存されたユーザー平坦度補正フ ァ イルは、 何れも、 再読み取 り し、 補正配列に読み
込んでRF （無線周波数） 出力に適用し、特定のRF （無線周波数） 出力平坦度要求を満たすこ と ができ ます。

3. Returnを押し ます。

RF （無線周波数） 出力における平坦度補正の有効化

• Return > Flatness Off Onを押し ます。

UF イ ンジケーターが、 デ ィ スプレ イのAMPLITUDE領域に表示され、 配列の中の補正データが RF （無線

周波数） 出力に適用されます。

LAN、 GPIBまたはUSB接続のパワー ・ メ ーターの場合 手動

i. 補正値を作成し ます ： 

More > User Flatness > Do Calを押し ます。

信号発生器はユーザー平坦度校正を開始し、 

プロ グレ ス ・ バーを表示し ます。

振幅補正値がユーザー平坦度補正配列に 
自動的にロード されます。

ii. 保存された振幅補正値を表示し ます ： 

Configure Cal Arrayを押し ます。 

i. ユーザー平坦度表エデ ィ ターを開き、 行1の 
周波数値を強調表示させます ： 
More > User Flatness > Configure Cal Arrayを押し ます。

RF （無線周波数） 出力は、 表中でカーソルがあ る行の 
周波数値を変更し ます。 

ii. パワー ・ メ ーターによ り 測定された値を メ モし ます。

iii. デルタ値の符号を変更し ます （た と えば、 0 dBm基準値

（ステ ッ プ f） のデルタ値、 および、 iiからの測定値は- 0.34

であ り 、 +0.34の値に変更し ます。）

iv. 行1の補正値を強調表示させます。

v. 次の順に押し ます 
Select > ステ ッ プiiiで計算されたデルタ値を入力 > dB。

（例えば、 この例では+0.34を入力し ます）

信号発生器は、 入力された補正値に基づいて 
出力振幅を調整し ます。

vi. ステ ッ プiivを、 パワー ・ メ ーターの読み値が0 dBmにな

る まで繰 り 返し ます。

vii. 次の行の周波数値を強調表示させます。 

viii.後の行に対し て、 ステ ッ プii～viiを繰 り 返し ます。
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ユーザー平坦度補正配列の再読み取りと適用
次の例は、 ユーザー平坦度補正配列が作成され、 保存されている こ と を前提 と し ています。 まだであれば、
例：10個の補正値を使用する500 MHzから1 GHzの平坦度補正配列 （102ページ） を実行し て く ださい。

1. 信号発生器をプ リ セ ッ ト し ます。

2. 必要なユーザー平坦度補正フ ァ イルを再読み取 り し ます ：

a. AMPTD > More > User Flatness > Configure Cal Array > More > Preset List > Confirm Presetの順に押し    
ます。

b. Load/Storeを押し ます。

c. 目的のフ ァ イルを強調表示し ます。

d. ユーザー平坦度補正配列に、 選択されたフ ァ イルに含まれるデータ を投入し ます ： 
Load From Selected File > Confirm Load From Fileを押し ます。

ユーザー平坦度補正配列のタ イ ト ルにはUser Flatness:フ ァ イル名を表示し ます。

3. 配列内の補正データ を、RF（無線周波数）出力に適用し ます：Return > Flatness Off Onを押し てOnにし ます。
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内部チャンネル補正の使用（N5172B/82B専用）

注記 オプシ ョ ン653、 655、 656、 657を適用するいずれの機器でも、 内部校正ルーチン （工場校正） を実

行し て、 ベースバン ド と RF 振幅の両方、 および、 RF 周波数やパワー ・ レベル範囲全体にわた る位
相誤差の補正データ を収集し ます。 内部チャ ンネル補正は、 拡張工場校正を1回実行し た後でなけ

れば、 オンにでき ません。「拡張工場校正の実行」（108ページ）を参照し て く ださい。

内部チャ ンネル補正機能は、 システム振幅と位相応答を、 機器がサポー ト する 大帯域幅 （オプシ ョ ンによ
り ますが、 大160 MHz BW） にわたって平坦化し ます。 こ の性能改善は、 何れの任意の中心周波数または  

振幅レベルでも使用可能です。

補正フ ィ ルターの発生と適用は内部で実行されます。補正フ ィ ルター処理は、 リ アルタ イ ムで発生し、生デー
タに適用されます。

次の2つの補正タ イプがあ り ます ： 工場およびユーザー。 工場校正は、 正面パネルのRF （無線周波数） 出力

コネ ク ターの、 精密50オーム負荷への性能を 適化し ます。 ユーザー校正は、 その実行を、 新しい較正基準

平面まで拡張し、 高信号品質をユーザーのDUTに配信する こ と ができ ます。

また、 この機能は、 単体のDACから IQ振幅器まで、 IおよびQチャ ンネルの振幅と位相応答を平坦化 （および
一致） させる こ と によ って、 不要なベースバン ド ・ イ メ ージを 小化し ます。

この校正は、 前回の校正実行時の周囲温度から、 周囲温度が±5 °C以上変化した場合に実行する必要があ り ます。

こ の機能をオフにする と、 ボ ッ ク スはそれが常時あ る よ う に動作し ます。 この機能をオンにする と、 内部I/Q
パスがア ク テ ィ ブにな り 、 I/Q補正 適化パスがRF （無線周波数） 出力と な り 、 また、 周波数が1 kHz以上変 
更される と、 フ ァーム ウ ェアがチャ ンネル補正フ ィ ルターを計算し ます。 リ ス ト /掃引では、 波形掃引がア ク

テ ィ ブな場合、 または、 ベースバン ド がオンで機器が内部パスに 適化されている場合の何れかに、 指定さ
れた周波数を使用し て1回目の掃引をする前に、 計算が実行されます。 この計算は、 補正を 大キ ャ ッ シュ ・

ポイ ン ト （256） までキ ャ ッ シュ し ます。 リ ス ト /掃引では、 掃引は再度実行する前に一時停止し て、 キ ャ ッ

シュ を再補正し ます。

注意 任意周波数切替の場合には、 補正キ ャ ッ シュが一杯 （256の一意の周波数ポイ ン ト ） になる と、 新し

い周波数が選択される際に一番古い周波数補正は消去されます。 

I/Qタ イ ミ ング ・ スキ ュー、 I/Q遅延、 直角位相の角度調整、 または、 内部イ コ ラ イザー ・ フ ィ ルター
の調整が行われる と必ず、 すべてのキ ャ ッ シ ュは消去されます。

内部チャ ンネル補正のその他の特性 ：

• 内部チャ ンネル補正がオンの場合、 ベースバン ド がオンの間の任意周波数切替には、 周波数が指定され
た 初の回には、 大290 ｍs の追加時間がかか り ます （通常は 72 ms）。 周波数が選択された初回の後  
に、 その周波数に再度切 り 替える と、 1 msの追加時間が掛か り ます。

• 周波数掃引がア ク テ ィ ブになっている と、 初の一意の256の周波数の前に計算と キ ャ ッ シ ュ処理が発生

し、 それに追加されるすべての一意の周波数は任意周波数切替の特性にな り ます。

• I/Q Correction Optimized Path ソ フ ト キーがExt I/Qに設定されている と、 ベースバン ド補正のみが適    

用され、 周波数切替には影響はあ り ません。

• ア ク テ ィ ブな場合は、 内部チャ ンネル補正フ ィ ルターは、 ACP内部I/Qチャ ンネル 適化フ ィ ルターと イ

コ ラ イザー ・ フ ィ ルターで畳み込まれます。 ハ ミ ング窓が適用され、 その結果 と な る フ ィ ルターは 256
タ ッ プまで切 り 捨て られます。
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図5-18 内部チャンネル補正用のソフトキー

SCPIコマンド：
[:SOURce]:DM:INTernal:CHANnel:CORRection[:STATe] ON|OFF|1|0
[:SOURce]:DM:INTernal:CHANnel:CORRection[:STATe]?
:CALibration:BBG:CHANnel

:MEMory:LOAD:CHANnel <"filename">
:MEMory:STORe:CHANnel <"filename">

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

I/Q > More

内部ベースバンド発生器のRFおよび
ベースバンド振幅の適用、および、現
在のRF周波数における160 MHzの
ベースバンド帯域幅の位相補正のオン
とオフを切り替えます。
この機能がオンの場合、ベースバンド
がオンの間の任意周波数切替には、周
波数が指定された最初の回には、最大
3.3 ms（通常）から6.8 msの追加時間
がかかります。その後は、その周波数
への切り替えには、最大1.3 msの追加
時間がかかります。 
最も古い周波数が消去されるまでに、
最大1024までの周波数をキャッシュ
できます。周波数掃引がアクティブに
なっていると、最初の一意の1024の
周波数の前に計算とキャッシュ処理が
発生し、それに以上のすべての一意の
周波数は任意周波数切替の特性になり
ます。
I/Q補正最適化パスがExt I/Q出力に設
定されていると、ベースバンド補正の
みが適用され、周波数切替速度には影
響はありません。
この補正は、ACP内部I/Qチャンネル
最適化フィルターとイコライザー・
フィルターがアクティブであればこれ
らに畳み込まれます。その結果、フィ
ルターは256タップまで切り捨てられ
ます。
注記：拡張工場校正を、工場補正タイ
プをオンにできるようにするため、そ
の前に1回実行することが必要です。
108ページを参照してください。

DUTに追加補正を実行します。
開始および停止周波数を指定し、パ
ワー・メーターを設定し、校正を実
行します。

内部ベースバンド発生器のRFおよ
びベースバンド振幅の校正と適用、
および、ベースバンドの全帯域幅
にわたる位相補正を操作するメ
ニューを表示します。

工場またはユーザー I/Qチャンネ
ル補正適用のオンまたはオフを
切り替えます。 

工場は、RF（無線周波数）出力
コネクターの性能を最適化し 
ます。

ユーザーはDUTへの補正を拡張
します。

注記：拡張工場校正を、工場補
正タイプをオンにできるように
するため、その前に1回実行する
ことが必要です。拡張工場校
正の実行を参照してください。

工場校正を実行するには、
Utility > More > Service > I/Q 
Int Channel Correction 

Calibrationsを押します。

Factory Calibrationまたは
Enhanced Factory Calibration

のどちらかを選択します。信号
発生器のディスプレイ上の指示
に従ってください。
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内部チャンネル補正の設定

注記 オプシ ョ ン653、 655、 656、 657を適用するいずれの機器でも、 内部校正ルーチン （拡張工場校正）

を実行し て、 ベースバン ド と RF 振幅の両方、 および、 RF 周波数やパワー ・ レベル範囲全体にわた
る位相誤差の補正データ を収集し ます。 内部チャ ンネル補正は、 拡張工場校正を 1 回実行し た後で

なければ、 オンにでき ません。「拡張工場校正の実行」（108ページ）を参照し て く ださい。

以下は、 信号発生器の内部チャ ンネル補正を使用するための基本設定です。 図5-18を参照し て く ださい。

信号発生器で ：

1. 中心周波数を設定し ます ：

Freq > 3 > GHzを押し ます

2. I/Qを内部に設定 （デフ ォル ト ） し ます ：

I/Q > I/Q Source > Internalを押し ます

3. I/Qを押し てオンにし ます

4. 内部チャ ンネル補正を実行し ます ：

More > Int Channel Correction Off Onを押してオンにします

拡張工場校正の実行
B.01.10 よ り 前のフ ァーム ウ ェアを使用する機器では、 I/Q内部チャ ンネル補正 （工場補正タ イプ） をオンに
でき る よ う にする ために、 その前に拡張工場校正を一度実行する こ と が必要です。 必要に応じ て、 この校正
手順を、 新しい校正データ用にいつでも実行する こ と ができ ます。

注記 ご使用の機器によ って、 拡張工場校正は完了までに4時間かかる場合があ り ます。

信号発生器で ：

1. Utility > More > Service > I/Q Int Channel Correction Calibrations > Enhanced Factory Calibrationを    

押し ます。

2. 信号発生器のデ ィ スプレ イ上の指示に従って、 校正を完了させて く ださい。
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外部レベリングの使用（N5173B/83B専用）

注意 外部レベ リ ング ・ モード で操作する間は、 信号発生器と検出器の間のRF またはDC接続が故障する

と、 大信号発生器出力が発生する可能性があ り ます。 大出力は、 テス ト 中のパワーに弱い機器
に過大な負荷を与えるおそれがあ り ます。

Ext Detectorを選択すると、Atten Holdがオンになり、グレー表示（非アクティブ）に
なります。Internalを再度選択すると、ソフトキーはアクティブになりますが、減衰器
ホールドはオンのままです。必要であれば、手動でオフに設定します。

Ext Detectorを選択した場合は、Set Attenは出力パワー・レベルに影響しません。外部
検出器使用の間は、減衰器を使用して、負のdBmパワー・レベル使用時にALCパ
ワー・レベルを約0 dBmに維持します。113ページを参照してください。

このような設定は、信号
発生器の出力パワー振幅
を変更せず、結合器/スプ
リッターの出力で測定さ
れたパワー・レベルに綿
密に近接させるために、
正面パネル・ディスプレ
イの振幅値を変更できる
だけです。116ページを
参照してください。

このソフトキーは、Ext Derectorが選択されている時のみ機能します。 
そのゼロ基準点として、16 dBを使用します。

86ページページを参照してください。

メニューが開き、パワーが設定される方法を指定できます。パワー設定
は、さまざまなパラメーター用に最適化できます。
Optimize S/Nを選択して、結果として発生する信号の信号対ノイズ性能
を最大化します。
Optimize Harmonicsを選択して、結果として発生する信号の調和振幅を
最小化します。
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外部レベ リ ングでは、 ALC フ ィードバッ ク信号源を被試験デバイ ス (DUT)の近 く に移動して、 テス ト ・ セッ ト
ア ップのケーブルやコンポーネン ト に固有のパワーの不確かさのほとんどを考慮する こ とができ ます。 図 5-19
を参照し て く ださい。

図5-19 ALC回路

内部検出器は、 信号発生器背面パネルのALC INPUTコネ ク ターに、 検出器のパワー ・ レベルに基づいて負電 

圧を出力し ます。 結合器/パワー ・ スプ リ ッ ター入力のRFパワー ・ レベルが変更される と、 外部検出器は補
償負電圧を返し ます。 ALC回路はこの負電圧を、 信号のパワーを上昇および降下させる こ と によ り RF （無線

周波数） 出力パワーを レベル化する ために使用し、 それによ り 検出点 （外部検出器） で一定のパワー ・ レベ
ルを確実にし ます。 検出点は検出器が接続されたデバイ スの出力と は異な る位置にあ るので、 外部検出器に
よ り 補償されないパワー損失が多少存在し ます。 例えば、 結合器では、 結合ポー ト が外部検出器を駆動する
ために信号エネルギーの一部を消費し ます。 その上、 結合器は、 結合ポー ト と出力の間でい く らかの挿入損
失を蒙 り ます。 図5-21（112ページ）は、 Keysight の代表的なダ イオード検出器の、 入力パワー対出力電圧

の特性を示し ます。 こ のチャー ト を使用する と、 外部検出器の出力電圧を測定する こ と によ り 、 ダ イオード
検出器の入力でのレベ リ ング されたパワーを決定でき ます。 結合器の場合は、 レベ リ ング された出力パワー
を決定するには結合係数を加算する必要があ り ます。

外部検出器を使用する場合は、 信号発生器のパワー出力範囲がデータ ・ シー ト に記載された値と異な る可能
性があ り ます。 これは主に、 検出器の効率が原因です。 検出器、 結合器/パワー ・ スプ リ ッ ターが、 目的のパ
ワー /周波数範囲をカバーする よ う に指定されている こ と を必ず確認し て く ださい。 外部レベ リ ング使用時の

信号発生器の実際のパワー出力範囲を決定するには、「信号発生器の振幅範囲の決定」（114 ページ）を参照
し て く ださい。

外部検出器

パワー・

コンポーネント

DUT

RF

配線

出力

ALC INPUT

ALC変調器

ALC 内部検出器ドライバー

信号発生器

レベル処理された出力

（振幅、フィル
ター、減衰器、

（負出力）

または結合器

Opt 1E1出力減衰器（113ペー
ジを参照してください）。

など）

スプリッター
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 性能最適化   
外部レベリングの使用（N5173B/83B専用）
外部レベ リ ングを使用する場合、表示される振幅値は、外部検出器が接続されている結合器/パワー・ スプ リ ッ
ターの実際の出力 パワーと大幅に異なる可能性があ り ます （図5-20を参照して く ださい）。 これは、 結合器/ 
パワー ・ スプ リ ッ ター自体の信号特性 （挿入損失、 結合係数など） が信号発生器に と って不明なので、 正確
な振幅値を表示できないからです。 また、 信号発生器と外部検出器の間にあ る コ ンポーネン ト も、 結合器/パ
ワー・スプ リ ッ ターの出力パワーに影響する こ と があ り ます。このパワー表示値の不一致は、 Ext Leveling Amptd   
Offset ソ フ ト キー、 または、 Amptd Offset ソ フ ト キーを使用し て補正する こ と ができ ます。 この 2 つのソ フ ト  
キーの違いは、 Ext Leveling Amptd Offsetが外部レベ リ ングがオンの と きだけ機能する こ と です。 外部レベ リ ン   

グ ・ オフセ ッ ト 機能の使用法の詳細については、「信号発生器のディスプレイ振幅値の調整」（116ページ）を

参照し て く ださい。

図5-20 外部レベリング使用時のパワー値の差異

結合器の出力パワー測
定値

信号発生器で設定され
たパワー・レベル
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図5-21 代表的なダイオード検出器の25 ℃での応答
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 性能最適化   
外部レベリングの使用（N5173B/83B専用）
オプション1E1出力減衰器の動作と使用法
内部検出器を使用する場合、 オプシ ョ ン1E1出力減衰器によ って、 RF （無線周波数） 出力コネ ク ター部で信
号発生器のパワー ・ レベルを130 dBm まで下げる こ と が可能にな り ます。 このこ と は、 ALC検出回路の後 

に、 出力信号の減衰を付加する こ と によ り 実現されます。 出力パワーの値 （デ ィ スプレ イのAmplitude領域

に表示） は、 Set AttenおよびSet ALC Level値の結果によ り 得られます （109ページを参照）。 外部検出器を選択   
し た場合は、 検出回路のフ ィ ード バッ ク が出力減衰器の後に移動されているので、 出力減衰器は出力信号を
減衰し ません。 減衰器は出力信号の振幅に影響し ないために、 出力振幅は Set ALC Level ソ フ ト キーのみによ  
り 決定されます。

外部レベ リ ングを選択する と、信号発生器は減衰器のホール ド を有効化にし、出力範囲は標準オプシ ョ ン （減
衰器な し） の信号発生器の範囲と ほぼ一致し ます （データ ・ シー ト を参照し て く ださい）。 前述の通 り 、 実際
の出力パワーは、 外部検出器と結合器/パワー ・ スプ リ ッ ターの性能特性によ り 異なる可能性があ り ます。

注記 内部検出器を再度選択した場合は （Internal選択）、 信号発生器は減衰器のホールド をオフにし ません。

出力減衰器は出力パワーに影響し ませんが、 ALC回路を、 約0 dBmの中間パワー ・ ポイ ン ト に駆動する た

めには有効です。 これは内部レベ リ ング回路には 適なポイ ン ト であ り 、 通常は振幅平坦度の 適な結果が
得られます。 こ のこ と は、 5 dBm以下のパワー値で有効です。 例えば、 約20 dBmのパワー設定で中間パ

ワーを駆動するには、 25 dBの減衰を付加し ます。 こ のこ と によ り 、 ALC回路は5 dBm （20 + 25） に設定

されます。

注記 減衰が大き過ぎる と、 ALC回路の駆動が高 く な り 過ぎ、 信号発生器がレベ リ ングな しになる可能性

があ り ます。 パワー ・ レベルを上げた場合は減衰を減らすよ う にし て く ださい。

外部レベリングの設定

基本的なセットアップ・プロセス
• 単一周波数信号で作業する場合は、 ステ ッ プ1～5を実行し ます。

• 複数の周波数で作業する場合は ：

a. ステ ッ プ1～4を実行し ます。

b. ユーザー平坦度補正を実行し ます。「平坦度補正の使用」（97ページ）を参照し て く ださい。

• 掃引を使用し て作業する場合は ：

a. ステ ッ プ1～4を実行し ます。

b. 掃引をセ ッ ト ア ッ プし ます。「掃引出力の設定」（50ページ）を参照し て く ださい。

1. 機器をセ ッ ト ア ッ プし ます。「機器セットアップ」（114ページ）を参照し て く ださい。

2. 搬送信号を設定し ます。「搬送波の設定」（114ページ）を参照し て く ださい。

3. 外部レベ リ ングを選択し ます。「外部レベリングの選択」（114ページ）を参照し て く ださい。

4. 出力振幅範囲を決定し ます。「信号発生器の振幅範囲の決定」（114ページ）を参照し て く ださい。

5. 表示されるパワー値を設定し ます。「信号発生器のディスプレイ振幅値の調整」（116ページ）を参照し て

く ださい。
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機器セットアップ
機器を、 図5-22（114ページ）に示された よ う に設定し ます。 外部検出器 （検出器および結合器/パワー ・ ス
プ リ ッ ター） をでき る限 り DUTの近 く に配置し ます。

推奨機器
• Keysight 8474E負検出器

• Keysight 87301D方向性結合器

• 必要に応じ て、 ケーブルおよびアダプター

図5-22 方向性結合器を使用した、代表的な外部レベリング・セットアップ

搬送波の設定 

1. Presetを押し ます。

2. 搬送波周波数を設定し ます。

3. パワー ・ レベルを0 dBmに設定し ます。

• 信号発生器がオプシ ョ ン1E1および520を備えている場合は、 出力減衰器をゼロdBmに設定し ます ：

a. AMPTD > Atten/ALC Control > Atten Hold Off Onを押し てオンにし ます。

b. Set Atten > 0 > dBを押し ます。

c. Set ALC Level > 0 > d Bmを押し ます。

外部レベリングの選択
AMPTD > Leveling Control > Leveling Mode > Pwr Meter Contを押し ます。

信号発生器の振幅範囲の決定
大出力振幅は、 周波数に依存し ます。 そのため、 複数の周波数ポイ ン ト を使用し、 各周波数ポイ ン ト の

大出力振幅を知る こ と が必要であれば、 X- Seriesデータ ・ シー ト の 「振幅」 の節を参照し て く ださい。 その

後、 こ の手順を使用し て各バン ド の 大振幅を決定し ます。

レベル処理された信号

信号発生器 結合器増幅器

負検出器

RF（無線周波数）

ALC INPUT

出力
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外部レベ リ ング と オプシ ョ ン1E1を使用する場合は、 信号発生器のパワー範囲は、 標準オプシ ョ ン機器 （オ

プシ ョ ン1E1な し） のパワー範囲と ほぼ一致し ます。 しかし、 0 dBm未満の振幅値を使用する場合には、 オ
プシ ョ ン1E1は減衰器を使用し てALCを中間パワー ・ ポイ ン ト に駆動する こ と を可能にし ます。 ただし、 減

衰を付加する と レンジの上限は低下し ます。 詳細については「オプション1E1出力減衰器の動作と使用法」
（113ページ）を参照し て く ださい。

1. オプシ ョ ン1E1がイ ン ス ト ールされている場合は、 減衰器を所定のレベルに調整し ます。

注記 オプシ ョ ン1E1出力減衰器の値が高過ぎる場合 （約55 dB以上）、 RF （無線周波数） 出力をオン

にし た際にレベル処理な しの条件の原因と な り ます。

a. AMPTD > Atten/ALC Control > Atten Hold On > Set Attenの順に押し ます。

b. 減衰器の値を入力し ます。

2. RF （無線周波数） 出力をオンにし ます ： RF On/Offを押し てOnにし ます

3. AMPTDステ ッ プ増分値を1 dBに設定し ます。

• AMPTD > Incr Set > 1 > dB と押し ます。

4. 小振幅値を決定し ます。

a. 振幅を25 dBMに設定し ます。

b. 下矢印キーを使用し て振幅をUNLEVELイ ンジケーターが表示される まで下げます。

c. 上矢印キーを使用し て振幅をUNLEVELイ ンジケーターが消え る まで上げます。

UNLEVELイ ンジケーターが消え る時点で示された値が、 小振幅範囲の値です。

5. 大振幅値を決定し ます。

a. 振幅を、 信号発生器がレベル処理な しにな ら ない値に設定し ます。

b. 上矢印キーを使って、 レベ リ ングな しになるか、 上限に達し た と い う エラー ・ メ ッ セージがデ ィ スプ
レ イの下部に表示される まで、 振幅を上げます。

c. 振幅値を下げます。

• レベル処理な しのイ ンジケーターが表示された ら、指標が消え る まで振幅を下げます。イ ンジケー
ターが消えた時点の値が、 範囲の 大値です。

• 信号発生器のデ ィ スプレ イ下部に、 Error:501, Attenuator hold setting over range    
と表示された場合は、 示された値が範囲の 大値です。 

エラー ・ メ ッ セージを消すには、 下矢印キーを、 メ ッ セージが消え る まで押し ます。 このエラー ・
メ ッ セージは、 現在の減衰器のに関連する 大値を超えて振幅を大き く し よ う と し た場合に表示
されます。
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信号発生器のディスプレイ振幅値の調整
外部レベ リ ングを使用する場合は、信号発生器に表示される振幅値は、結合器/スプ リ ッ ターの出力での信号
のレベ リ ング されたパワーと は一致し ません。 こ の差を補正するために、 信号発生器に表示されるパワー値
が結合器/スプ リ ッ ターの出力での測定値にでき るだけ近 く なる よ う に設定する、 2つの方法があ り ます。 

1. 測定機器の接続と設定 ：

a. 結合器/スプ リ ッ ターの出力を、 パワー ・ メ ーターまたは信号アナラ イザーのどち らかに接続し ます。

b. パワー ・ メ ーター /信号アナラ イザーを、 信号のパワー ・ レベル測定用に設定し ます。

2. 信号発生器の表示振幅値の調整 ：

• Ext Leveling Amptd Offsetソ フ ト キーを使用する場合 ：

こ のソ フ ト キーは、 ゼロ基準と し て16 dBを使用し ます。 16 dBは内部検出器の結合係数です。

a. 信号発生器で、 AMPTD > Leveling Control > Ext Leveling Amptd Offsetを押し ます。

b. 信号発生器のディ スプレ イで搬送波振幅値を監視しながら、 RPG ノブ （デテン ト ・ ノブ） を使用し

て、 表示されている振幅値の整数部が測定値の整数部と一致する まで、 オフセッ ト 値を調整し ます。

各々のデテン ト 位置は、 値を1 dBずつ調整し ます。 

c. テンキーパッ ド を使用し て、 デ ィ スプレ イの振幅値に、 小数値の調整を必要に応じ て行います。

• Amptd Offsetソ フ ト キーを使用する場合 ：

a. 信号発生器で、 AMPTD > More > Amptd Offsetを押し ます。

b. 信号発生器に表示された振幅値と測定値の間の差を計算し ます。

c. テンキーパッ ド を使用し て、 こ の差をAmptd Offsetソ フ ト キー値と し て入力し ます。
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レベリングなし動作モードの使用
図5-23 Power SearchソフトキーとALC Offソフトキー

以下の場合のみ
使用可能

以下の場合のみ使用可能
Power Search Reference =

以下の場合のみ使用可能 
Power Search = Span 

Auto：出力周波数または振幅が変更されると、校
正ルーチンが必ず実行されます。

Span：Do Power Searchを押すと、選択された周
波数範囲に、出力検索校正ルーチンが1度実行され
ます。
補正値は保存され、信号発生器が校正済みの周波数
範囲に同調されると必ず使用されます。

各キーの詳細については、44ページで説明されているキー
のヘルプを使用してください。

RMS：値は、ファイル
のヘッダーから得られ
た値、または現在の
I/Qデータから計算さ
れた値と等価なDCバ
イアスです。
Fixed：0.5 Vrmsの固
定値を使用します
（Ext I/Qデータでも同
じ値が用いられます）。
Manual：ユーザがDCバ
イアス電圧値を指定す
ることを可能にします 
（0～1.414 Vrms）。
Modulated：実際の変
調信号のACバイアス
を使用します。

Manual

User：ユーザーが
信号発生器周波数
設定を使用するこ
とを可能にします。
Full：信号発生器
が出力検索の全周
波数レンジを選択
します。

I/Qがオンの場合の
み使用可能です。 

これらのソフト
キーは、ARB波
形がメモリー内
で再生された場
合のみアクティ
ブになります。

Manual：ユーザーは、開ループALCレベルを校正
するために、出力検索を明示的に実行することが
必要です。 

101ページを参照
してください 

許容セトリング誤差
を設定します。

I/Qがオンの場合の
み使用可能です。 

N5173B/83B専用

N5173B/83B専用

ALC = Off
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ALCオフ・モード
ALCをオフに切 り 替える と、 信号発生器の自動レベ リ ング回路が無効にな り ます。 ALCをオフにする と有利
になるのは、 変調がALCのパルス幅仕様を下回る超狭パルスで構成される場合、 外部I/Q信号をア ッ プ ・ コ ン

バージ ョ ンする場合、 または、 変調を構成する振幅変動やバース ト がきわめて低速なために、 自動レベ リ ン
グでは除去された り 歪んだ り する場合です。 内部ベースバン ド発生器を使用する場合は、 上記のタ イプの信
号に対し て、 ALCをオフにする よ り も、 ALCホール ド ・ マーカー機能を使用する こ と が 適な方法です。

注記 ALCをオフにする と、 正面パネルで要求された出力パワー ・ レベルを適切に設定するために、 出力

検索を実行させる こ と が必要です。 出力検索はデフ ォル ト では自動的に実行されますが、 この設定
はManualモード を使用する こ と によ り 、 一時的に変更でき ます。

出力検索モード

注記 出力検索モード は、 外部I/Q入力経由のバース ト 信号入力に対し ては使用でき ません。

MXG/EXGには、 3種類の出力検索モード （内部および外部I/Q変調用）、 および、 4種類の出力検索基準 （外
部I/Q変調専用） があ り ます。 図5-23（117ページ）を参照し て く ださい。

出力検索は、 ALCを一時的にア ク テ ィ ブにし、 現在のRF （無線周波数） 出力のパワーを校正し、 ALC回路を

切断するルーチンを実行し ます。

出力検索モード （外部および内部I/Q変調に適用）

• Auto -  出力検索は、 各々の周波数またはパワーが変更されるたび、 および、 AM、 バース ト 、 パルス ま

たはI/Q変調状態がそれぞれ変更されるたびに実行されます。

• Span -  Power SearchがSpanに設定されている場合、 Do Power Searchを押すと、 ユーザー定義周波数の範囲    

にわたって出力検索校正ルーチンが実行されます。 出力検索は保存され、 信号発生器がユーザー定義範
囲内に同調される と使用されます。 Spanソ フ ト キーを押し た後、 FullまたはUserを選択し ます。 Userを選
択する と、 開始および停止周波数を選択する こ と が必要です。

• Manual -  Power SearchがManualに設定されている場合、 Do Power Searchを押すと、 現在のRF周波数と振    

幅に対する出力検索校正ルーチンが実行されます。 こ のモード では、 RF周波数または振幅を変更し た場
合は、 も う 一度Do Power Searchを押すこ と が必要にな り ます。

出力検索基準 （内部I/Q変調のみに適用）

4つの出力検索基準が出力検索機能を制御し ます。 これらの4つの基準は、 RF信号がI/Q変調される間に使用さ

れる基準電圧を選択し ます。 （出力検索は次のアナログ変調には使用されません ： FM、 fMまたはパルス変調。）

注意 出力検索基準のRMS電圧が適正でない場合は、 出力パワーは不適正にな り ます。 図5-24、「単一波
形サンプル・ポイントに対する出力パワー誤差の計算」および図5-25、「波形のRMS電圧の計算」
を参照し て く ださい。

注記 適正な出力検索は、 出力検索基準の有効性次第です。
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• Fixed - 基準レベルは0.5 Vrmsです。 

こ の基準は内部、 外部I/Qおよびバース ト 信号に作用し ます。 これは機器のデフ ォル ト 設定です。 

• RMS -  波形ヘッ ダに配置されたユーザー規定の基準レベル0～1.414 Vrmsです。「波形の設定およびパ
ラメーターの保存」（155ページ）を参照し て く ださい。

こ の基準は、 内部I/Qおよびバース ト 信号に作用し ます。

• Manual -  ユーザー規定の基準レベル0～1.414 Vrmsです。 

こ の基準は内部、 外部I/Qおよびバース ト 信号に作用し ます。 

• Modulated -  I/Q変調信号を基準レベル と し て使用し ます。

この基準は、内部および外部I/Qに作用し ます。バース ト 信号またはVrmsが変化する信号には作用し ません。

図5-24 単一波形サンプル・ポイントに対する出力パワー誤差の計算

図5-25 波形のRMS電圧の計算

RMSおよびMANUAL基準は、 も強力な選択です。 ユーザーは基準レベルを規定し ます。 IQ信号はバース ト

信号 （レーダー） であって も、 または、 異なるRMSレベル （無線信号） があって も可能です。 RMS/MANUAL
基準レベルが設定される と、 出力検索は、 波形の現在のVrms値に依存せず実行されます。 

1.0 Vrmsを持つRMSおよびMANUAL基準は、 計算されたrms値1に相当し、 SINE_TEST_WFMを使用し て計 
算する こ と ができ ます。 

20 10 V1  V2  log=
こ こ で ：

V1は実際の波形RMS電圧

V2は入力されたRMS電圧

出力パワー誤差

注記 ： 入力されたRMS電圧値が実際のRMS電圧よ り 低い場合は、 出力パワーは所定の値よ り 高 く な り ま

す。 入力されたRMS電圧値が実際のRMS電圧よ り 高い場合は、 出力パワーは所定の値よ り 低 く な り ます。

信号発生器はRMS値を自動的に計算でき ます。 2つを超える連続
のI/Qデータ ・ ポイ ン ト がゼロの場合は、 信号発生器の計算はこ
れらのゼロ ・ ポイ ン ト を無視し ます。 また、 RMS計算は、 信号
発生器によ り 行われ、 時間がかかるため使用アプ リ ケーシ ョ ン
に適切でない可能性があるので、 ユーザーが波形フ ァ イル用の
測定済みRMS値を計算して入力してお く こ と をお薦めし ます。

波形のRMS値 =

SCPIコマン ド ：

[:SOURce]:RADio:ARB:HEADER:RMS 
<"file_name">,<val>|UNSPecified
[:SOURce]:RADio:ARB:HEADER:RMS?<"file_name">

波形のRMS電圧決定プロ グ ラ ムの例は、 本機器に付属する 『プロ グ ラ ミ ング ・ ガイ ド』 と ド キ ュ メ ンテーシ ョ ン
CDを参照し て く ださい。
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FIXED、 RMSおよびMANUAL基準は、 DACを使用し て基準電圧を印加するので、 I/Q信号が存在する こ と は
必要と し ません。

注記 MXG/EXG基準電圧は、公称値0.1 Vrms～1 Vrmsの間で作動する よ う に設計されていますが、1.414  
Vrmsまでのオーバーレンジが可能です。（RMSは、定数値が手動で読み込まれ、IおよびQの値に 「1」
が入力される と、1.414にオーバーレ ンジする こ と ができ ます。）「波形の設定およびパラメーターの
保存」（155ページ）も参照し て く ださい。

注意 適正な出力検索を可能にする 小基準レベルは、RF周波数、RF振幅および温度に依存し ます。MXG/EXG
出力検索は、1 GHzで、0 dBm用に0.1 Vrmsの基準レベルを使用する と、失敗する可能性があ り ます。

出力検索設定
出力検索ルーチンを実行させるには、 機器が次の条件を満たす必要があ り ます ：

• I/Q変調がオンになっている こ と。

• RF （無線周波数） 出力がオンになっている こ と。

• 自動レベ リ ング回路が無効 （オフ） であ る こ と。

• RFブラ ンキングがオンに設定されている こ と。 

この機能は出力検索の間のパワー・ スパイ ク を防止し ます （「RFブランキング・マーカー機能の使用」（172
ページ）を参照し て く ださい）。

• 内部Arb と外部I/Qの加算を使用する場合は、 4つすべてのパワー基準モード （Fixed、 RMS、 Manualおよ
びModulated） が使用でき ます。

• 外部IQ入力を使用する場合は、MANUAL基準モード を使用し、出力検索の実行時に外部I/Q信号が存在す

る こ と を確認し て く ださい。 外部I/Q信号が存在し ない場合は、 出力検索は失敗し ます。

例：自動出力検索
1. 信号発生器をプ リ セ ッ ト し ます。

2. 所定の周波数を設定し ます。

3. 所定の振幅を設定し ます。

4. RF （無線周波数） 出力をオンにし ます。

5. 信号発生器の自動機能を無効にし ます ： 

AMPTD > ALC Off Onを押し て、 Offを強調表示し ます

信号発生器のオー ト ・ レベ リ ング制御を無効にする こ と は、 重大な機器の変更であ る ため、 自動的に出
力検索が起動されます。

Autoに設定し た場合、 出力検索は、 重大な機器の設定変更が行われる と、 自動的に実行されます。 Do Power 
Search機能を使用すれば、 温度ド リ フ ト や外部入力の変化などを補正するためにいつパワー ・ サーチを実行

するかをユーザーが決定でき ます。
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出力オフセット、基準、乗数の使用

出力オフセットの設定
出力オフセ ッ ト を使用する と、 信号発生器は入力された値からオフセ ッ ト （正または負） された、 周波数ま
たは振幅を出力する こ と ができ ます。

RF （無線周波数） 出力 = 入力値  オフセ ッ ト 値

表示値 = 出力周波数 + オフセ ッ ト 値

オフセ ッ ト を設定するには ：

• 周波数 ： Freq > Freq Offset > オフセ ッ ト 値 > 周波数単位の順に押し ます。

• 振幅 ： Amptd > More > Amptd Offset > オフセ ッ ト 値 > dBの順に押し ます。

例

信号発生器を局所発振器(LO) と し て使用し ている場合は、 下の図に示された通 り 、 オフセ ッ ト を使って対象

の周波数を表示する こ と ができ ます。

パラ メ ーター 例#1 例#2 例#3 コ メ ン ト

入力 （表示） 値 ： 300 MHz 300 MHz 2 GHz 入力値は正の値であ る こ と が必要です。

オフセ ッ ト ： 50 MHz 50 MHz 1 GHz オフセ ッ ト 値は正または負のどち らにする こ と も でき ます。

出力周波数 ： 250 MHz 350 MHz 3 GHz 出力周波数または振幅が範囲外の場合は、 信号発生器から警告が

出されます。

オフセットがオンであることを示します
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出力基準の設定
出力基準を使用する と、 信号発生器は選択された基準値から入力値の分だけオフセ ッ ト （正または負） され
た周波数または振幅を出力する こ と ができ ます。

RF （無線周波数） 出力 = 基準値 + 入力値

基準を設定するには ：

1. 周波数または振幅を、 出力基準レベル とする値に設定し ます。

2. 周波数 ： Frequency > Freq Ref Setを押し ます 
周波数は0.00 Hz と表示されます。 これがRF （無線周波数） 出力周波数の 「ゼロ ・ レベル」 であ る こ と を 

示し ています。 
入力された周波数はすべて、 こ の基準周波数に相関し ている もの と解釈されます。

振幅 ： Amptd > More > Amptd Ref Setを押し ます 
振幅は 0.00 dB と表示されます。 これが RF （無線周波数） 出力振幅の 「ゼロ ・ レベル」 であ る こ と を示 

し ています。 
入力された振幅はすべて、 こ の基準振幅に相関し ている もの と解釈されます。

IF増幅器RF増幅器 ミキサー フィルター

信号発生器
（局所発振器）

出力周波数 = 1000 MHz

IF = 321 MHz

アンテナを 1321 MHzに同調

選択されたオフセ ッ ト

321 MHz

679 MHz

信号発生器のデ ィ スプレ イ

1321 MHz （アンテナ周波数）

321 MHz （IF出力）

IF出力
321 MHz

基準がオンであることを示します
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例

新たな周波数または振幅基準を設定するには、 周波数基準をオフにし て、 上述の手順に従います。

周波数乗数の設定
周波数乗数を使用する と、 信号発生器は出力値の倍数 （正または負） の周波数を表示する こ と ができ ます。 

表示値 = 乗数  出力周波数

出力周波数 = 表示値  乗数

周波数乗数を設定するには ：

1. Frequency > Freq Multiplier > 所定の乗数値 > xの順に押し ます。

2. 所定の周波数を設定し ます。 
出力周波数に乗数を掛けた値が表示されます。

例

パラ メ ーター 例#1 例#2 例#3 コ メ ン ト

基準 ： 50 MHz 50 MHz 2 GHz 基準値は正の値であ る こ と が必要です。

入力 （表示） 値 ： 2 MHz 2 MHz 1 GHz 入力値は正または負のどち らにする こ と も でき ます。

出力周波数 ： 52 MHz 48 MHz 1 GHz 出力周波数または振幅が範囲外であ る場合は、 信号発生器から警
告が出されます。

パラ メ ーター 例#1 例#2 例#3 コ メ ン ト

周波数乗数 ： 3 3 4 乗数は以下の範囲で設定でき ます ：

 +0.001 ～ +1000

 –1000 ～ –0.001

入力 （表示） 値 ： 600 MHz 600 MHz 8 GHz

出力周波数 ： 200 MHz 200 MHz 2 GHz 出力周波数が範囲外であ る場合は、 信号発生器から警告が出さ
れます。

周波数乗数がオンであることを示します
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信号発生器をシステムへの入力と し て使用し ている場合は、 下の図のよ う に逓倍器を使用し て、 信号発生器
にシステムの出力が表示される よ う に周波数乗数を設定する こ と ができ ます。

ミ キサの測定では、 周波数乗数と周波数オフセ ッ ト は、 頻繁に組み合わせて使用されます。 次のア ッ プコ ン
バーターの例では、乗数は1に設定され、オフセ ッ ト は3 GHzに設定されて、信号発生器はfRFを表示し ます。

信号発生器 逓倍器

出力 = 4 GHz
X2

入力 = 2 GHz 選択された 
乗数


信号発生器 
出力
2 GHz

入力/表示 
周波数
4 GHz

ミキサー

信号発生器
（局所発振器）

fLO = 800～ 600 MHz

fIF = 3000 MHz

選択された 
乗数 

1
1

信号発生器 
出力（fLO） 

800 MHz
600 MHz

fRF = 2200～ 2400 MHz

選択された 
オフセット 

3000 MHz
3000 MHz

入力/表示 
周波数（fRF） 

2200 MHz
2400 MHz
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周波数および位相基準ソフトキーの使用
MXG/EXGは、 ユーザ定義周波数または位相基準のどち らかを使用する よ う に設定でき ます。

図5-26 周波数基準および周波数オフセット用ソフトキー

フリー・ラン、ステップ持続時間、タイマー・トリガーの使用
Free Run （フ リ ー ・ ラ ン）、 Step Dwell （ステ ッ プ持続時間）、 Timer Trigger （タ イマー ・ ト リ ガー） を使用する   

と、 ステ ップ掃引または リ ス ト 掃引の任意のポイ ン ト で費やされる時間を調整でき ます。 使用可能な、 2つの
測定の組み合わせがあ り ます。

Free Run と Step Dwell time （図5-27（126ページ）を参照） 信号発生器は信号のセ ト リ ングを待ち、 次に   

ステ ッ プ持続時間を待って、 次の周波数ポイ ン ト にジ ャ ンプし ます。 さ らに、 掃引全体の完了までの時間も
異なる可能性があ り ます。 各々の周波数ポイ ン ト には、 必ず、 ステ ッ プ持続時間の 小値があ り ます。 それ
ぞれのポイ ン ト の 小ステ ッ プ持続時間は、 100 usの値に固定されます。 周波数ポイ ン ト 間の時間は、 セ ト  

リ ング時間と ステ ッ プ持続時間の合計です。 セ ト リ ング時間は、 周波数、 振幅、 バン ド公差、 その他の要因
によ り 異なる ために、 周波数ポイ ン ト 間の時間は変化する可能性があ り ます。 

Free Runの代わ り にTimer Trigger （図5-27（126ページ）を参照） 信号発生器は、 等間隔の ト リ ガーを発  

生させ、 各 ト リ ガーで次のポイ ン ト に移動し ます。 こ の方法には、 ポイ ン ト 間の時間が一定と な り 、 全体の
掃引時間が一定と なる メ リ ッ ト があ り ます。 ただし、 ト リ ガーが速すぎ る と、 信号に次のステ ッ プにジャ ン
プする までに十分なセ ト リ ング時間がない可能性があ り ます。

フリー・ラン、ステップ持続時間、タイマー・トリガー設定について
信号が、 各ポイ ン ト で 小指定時間でセ ト リ ングする必要があ り 、 ポイ ン ト 間の時間を一定にする こ と が重
要でない場合には、 Free Run と Step Dwell時間を使用し ます。

信号のポイ ン ト 間の時間が一定であ る こ と が必要で、 ただし、 各ポイ ン ト のそれぞれのセ ト リ ング時間が変
化し て も構わない場合には、 Timer Triggerを使用し ます。 掃引が速すぎる と、 信号発生器がセ ト リ ングでき 
な く なるため、 避けて く ださい。
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信号が指定された 少時間でセ ト リ ングする必要があ り 、 また、 ポイ ン ト 間の一定の時間が要求される場合
は、 Timer Triggerを、 ス イ ッチング時間 （900 usまたは5 ms、 オプシ ョ ンによ り 異な る） と測定を行 う た   

めに必要な 小セ ト リ ング時間の和に設定し て く ださ い。

測定に外部機器と の同期化が要求される場合には、 ハード ウ ェア ・ ト リ ガーの使用を検討し て く ださい。 

図5-27 フリー・ラン、ステップ持続時間、タイマ・トリガー用ソフトキー
Sweep  Configure Step 
Sweep  More 

セトリング後に追加の測定時間が必要な場合は、Step DwellとFree Runを使
用します。
信号が、各ポイントで最小指定時間でセトリングする必要があり、ポイント間
の時間を一定にすることが重要でない場合には、Step DwellとFree Run時間
を使用します。

Sweep  More 

信号のポイント間の時間が一定であるこ
とが必要で、ただし、各ポイントのそれ
ぞれのセトリング時間が変化しても構わ
ない場合には、Timer Triggerを使用し
ます。掃引が速すぎると、信号発生器が
セトリングできなくなるため、避けてく
ださい。 
信号が指定された最少時間でセトリング
する必要があり、また、ポイント間の一
定の時間が要求される場合は、Timer 
Triggerを、スイッチング時間（900 us
（オプションUNZ）または5 ms（標準））
と測定を行うために必要な最小セトリン
グ時間の和に設定してください。 
例：信号がセトリング状態を3 ms維持す
ることが必要であり、0.9 msでセトリン
グするオプションUNZを使用する場合に
は、タイム・トリガーを合計値の3.9 ms
に設定します。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

N5173B/83B専用
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USBキーボードの使用
USBキーボード を使用し て、 RF （無線周波数） 出力の状態や変調の状態を リ モー ト 制御し た り 、 メ モ リ ー ・

シーケン スや登録を選択し た り でき ます。 

登録の選択、 RF （無線周波数） 出力の状態や変調の状態は電源のオフ、 オンや リ セ ッ ト に影響されますが、
USBキーボード によ る制御状態やシーケン スの選択は影響されません。

注意 不揮発性 メ モ リ ーに永続的に保存されていないデータ、GPIB設定または現在のユーザーの機器状態

が消失する こ と を防ぐため、 信号発生器は、 必ず正面パネルの電源ボタ ン または適切なSCPIコマン
ド か ら電源オフ し て く だ さ い。 ラ ッ ク ・ システムに設置された信号発生器は、 機器の正面パネル ・
ス イ ッチではな く システム ・ ラ ッ ク電源ス イ ッチで電源オフ される と、 機器が適正に電源オフ され
なかったために、 Error- 310が表示されます。

USBキーボード制御をオフにすると、USBキーボード
は無効になります。Auto Recallソフトキーには影響し
ません。

各キーの詳細については、44ページで説明されているキーの
ヘルプを使用してください。

USBキーボード・キー
Delete、Enter
Insert
Home、上矢印
End、下矢印
Page Up、右矢印、+
Page Down、左矢印、–

信号発生器機能
RFオン/オフ
変調オン/オフ
次のシーケンス
前のシーケンス
次のステート・レジスタの再読取り
前のステート・レジスタの再読取り

すべてのシーケンスのすべての登録を削除。

注記：登録を削除した後は、回復できません。
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性能最適化 
USBキーボードの使用 
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
6 パルス変調の使用（オプションUNWまたは 320）
こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の

情報に習熟し て く ださ い。

• パルス特性 （131ページ）

• 基本的な手順 （133ページ）

• 例 （133ページ）

• Pulse Train（オプション320 – 必要：オプションUNW）（135ページ）
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パルス変調の使用（オプションUNWまたは320） 
 

図6-1 Pulseソフトキー

133ページ
133ページ

外部パルス入力からパル
ス同期出力までのレイテ
ンシ  5060 ns。
幅            周期
50 ns        50 ns
20 ns        50 ns

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

外部パルス信号に対する信号発生器
の応答方法を決定します。
Normal = ハイ・ステート
Invert = ロー・ステート

Low＝安定

TTL信号

14ページおよび17ページも
参照してください。 

各出力コネクターに
ルーティングする信
号を選択します。

BBGを備えたベク
トル機器で使用可
能です。

これらのソフトキーは、
Pulse–SourceがAdjustable 
Doubletに設定された場合の
み使用できます。

135ページ

注記：Pulse TrainをPulse 
Sourceとして選択した場
合は、Pulse Periodと
Pulse Widthは使用できま
せん。
130 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 パルス変調の使用（オプションUNWまたは320）   
パルス特性
パルス特性
注記 信号発生器のALCパルス幅仕様を下回る狭パルス、 または、 デューテ ィ ・ サイ クルが異常に長いレ

ベ リ ング ・ パルス を使用する場合は、 ALC をオフにする と有利な場合が多いです （118ページを参
照し て く ださい）。

Pulse Source タ イプ 周期a

aすべての遅延、幅および周期の分解能は10 nsです。

幅 と 遅延a ト リ ガー ・ イベン ト

を使用b ,

b内部発生パルスをトリガするには、背面パネルのパルス・コネクターの信号が20 ns以上ハイを維持することが必要です。

Square 50%のデューテ ィ ー ・ サイ クルの内部

フ リ ー ・ ラ ン ・ パルス列

ユーザー定義の
レー ト で決定され
ます。

 

Free Run 
（デフ ォル ト ）

内部フ リ ー ・ ラ ン ・ パルス列 ユーザー定義 ユーザー定義 

Triggered 内部パルス列  ユーザー定義 3

Adjustable 
Doublet

ト リ ガー ・ イベン ト ご と に2つの内部

パルス列。


ユーザー定義 ：

初のパルスは ト リ ガー信号の立ち
上 り エ ッ ジに関連し ます。

2番目のパルスは 初のパルスの立

ち上 り エ ッ ジに関連し ます。

図6-2（132ページ）を参照

3

Trigger 
Doublet

ト リ ガー ・ イベン ト ご と に2つの内部

パルス列。


初のパルスは ト リ ガー信号に従い
ます。

2番目のパルスはユーザー定義です。

図6-3（132ページ）を参照

3

Gated 内部ゲーテ ィ ッ ド ・ パルス列  ユーザー定義 3

External 背面パネルPulseコネ ク ターの外部パ

ルス信号
  

Pulse Train 内部パルス列
ユーザー定義

ユーザー定義 ：

図6-4（135ページ）を参照

3
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パルス変調の使用（オプションUNWまたは320） 
パルス特性 
 

図6-2 Adjustable Doublet

図6-3 Trigger Doublet

 

背面パネル入力は13ページに記述されています。

外部パルス入力

一番目のパルスの遅延は、外部トリガー信号
の立ち上がりエッジから測定されます。

遅延 幅

RF（無線
周波数）
出力

外部 
トリガー

2番目のパルスの遅延は、一番目のパルスの 
立ち上がりエッジから測定されます。

遅延 幅
パルス2パルス2

パルス1パルス1

2番目のパルスの遅延は、外部トリガー信号の
立ち上がりエッジから測定されます。

遅延 幅

RF（無線
周波数）
出力

外部 
トリガー

一番目のパルスは外部ト
リガー信号に従います。

パルス1 パルス1
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 パルス変調の使用（オプションUNWまたは320）   
基本的な手順
基本的な手順
1. 信号発生器をプ リ セ ッ ト し ます。

2. 搬送波(RF)周波数を設定し ます。

3. RF振幅を設定し ます。

4. 変調を設定し ます ：

a. パルス源を設定し ます ： Pulse > Pulse Source > 選択を押し ます

b. 選択し たパルス源のパラ メ ーターを設定し ます ：

5. 変調をオンにし ます ： Pulse Off Onソ フ ト キーをオンにし ます。

PULSEイ ンジケーターが点灯し、 変調がオンになった こ と が示されます。

6. 変調された信号を信号発生器から出力し ます ： 正面パネルのRF On Offキーを押し ます。

RF （無線周波数） 出力 LED が点灯し、 RF （無線周波数） 出力コネ ク ターから信号が送信されている こ と が

示されます。

「搬送信号の変調」（60ページ）も参照し て く ださい。

例
以下の例では、 工場設定のパルス源と遅延を使用し ます。

1. 信号発生器をプ リ セ ッ ト し ます。

2. 周波数を2 GHzに設定し ます。

3. 振幅を0 dBmに設定し ます。

Square Free Run
（デフ ォル ト ）

Triggered Adjustable Doublet Trigger Doublet Gated Pulse Traina

a オプション320が必要です。

External

パルス ・
レー ト

      

 パルス周期    パルス周期  

 パルス遅延 パルス遅延 パルス遅延 パルス遅延  パルス遅延 

 パルス幅 パルス幅 パルス幅 パルス幅 パルス幅  

   パルス2遅延    

   パルス2幅    

      パルス ・ オンb

b パルス・オンとパルス・オフで構成される、最大2047までのパルス・サイクル（要素）をユーザー定義できます。



      パルス ・ オフb 

出力 ： 100 s周期の24 sパルスによ って変調された2 GHz、 0 dBmの搬送波。
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パルス変調の使用（オプションUNWまたは320） 
例 
4. パルス周期を100 ì sに設定し ます ： Pulse > Pulse Period > 100 > usecを押し ます。

5. パルス幅を24 ì sに設定し ます ： Pulse > Pulse Width > 24 > usecを押し ます。

6. パルス変調と RF （無線周波数） 出力の両方をオンにし ます。 

PULSEイ ンジケーターが表示され、 RF （無線周波数） 出力LEDが点灯し ます。

変調が適切に作動し ていない可能性があ る場合、「RF（無線周波数）出力に変調がない」（383ページ）を参

照し て く ださい。 
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 パルス変調の使用（オプションUNWまたは320）   
Pulse Train（オプション320 – 必要：オプションUNW）   
Pulse Train（オプション320 – 必要：オプションUNW）
オプシ ョ ン 320Pulse Train 機能は、 大 2047 までの独立し たパルス ・ サイ クルの指定を可能にし、 各パル 

ス ・ サイ クルには 「オン ・ タ イ ム」 があって、 その間 RF （無線周波数） 出力を RF （無線周波数） 出力コネ
ク ターで測定可能であ り 、 また、 「オフ ・ タ イ ム」 の間には RF （無線周波数） 出力は減衰されます。 各パル

ス ・ サイ クルは、 他のX- Series信号発生器のパルス ・ モード と類似の機能ですが、 パルス ・ モード では 大

2つのみ （ダブレ ッ ト 使用） であ るのに対し て、 パルス列機能では 大2047サイ クルまで使用でき ます。 ま
た、 各パルスに繰返し カ ウ ン ト も使用でき ます。 これらの繰 り 返しは、 2047サイ クルの合計カ ウ ン ト に対し

てカ ウ ン ト されます。

機器は、 パルス列を.csv （カンマ区切 り 値） フ ァ イルまたは他のい く つかの共通ASCIIフ ォーマ ッ ト から イ ン
ポー ト する こ と ができ ます。 同様に、 ASCII/CSVフ ァ イルにエ ク スポー ト する こ と も でき ます。 エク スポー

ト では、 少数桁の区切 り 文字と列区切 り 記号を指定する こ と ができ ます。 イ ンポー ト では少数桁の区切 り 文
字が使用でき ますが （「,」 を使用可能）、列区切記号は自動判別されます。「Pulse Trainメニューのソフトキー」 
（135ページ）および「Pulse Trainメニューのソフトキーのディスプレイ」（137ページ）を参照し て く ださい。

図6-4 Pulse Trainメニューのソフトキー
Pulse > Pulse Source > More > Pulse Train 

Free-Runは、すべてのトリ
ガーを無視して、パルス列
を連続的に再生します。
トリガーでは、外部トリ
ガーがPULSE BNCコネク
ターに供給された場合、
Trigger Immediatelyソフト
キーが押された場合、もし
くは、Trigger SCPIコマンド
が送信された場合に、毎回
パルス列が実行されます
（Pulse Delayを待った後）。
ゲーティッドでは、PULSE 
BNCコネクターに外部トリ
ガーが供給される間（レベ
ル・トリガー）パルス列が
実行されます。GATEdトリ
ガーの状態は、再生の遷移
中またはアイドル状態にあ
る場合のみ検出されます。
すなわち、再生は開始され
たら、たとえGATEトリガー
が非アクティブ状態に変更
しても、必ず最後まで完了
します。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

ディスプレイ領域は、Pulse Trainが現在のパルス源であ
ることを示します。

トリガーは、即時にパルス
列を1回実行させます。

SCPIコマンド：

[:SOURce]:PULM:INTernal:TRAin:TRIGger FRUN|{TRIGgered}|GATEd
[:SOURce]:PULM:INTernal:TRAin:TRIGger:IMMediate 

『SCPI Command Reference』を参照してください。
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パルス変調の使用（オプションUNWまたは320） 
Pulse Train（オプション320 – 必要：オプションUNW） 
図6-5 Pulse Trainメニューのソフトキーの編集

Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train

137ページ

この列は、各パルス列サ
イクルの行を示します。
注記：サイクル（要素）
が繰り返される場合は、
パルス・サイクル行が繰
り返された回数分、行番
号が表示カウントでス
キップされます。
例：上に表示されたパル
ス列では、行2で、2 us
のオン・タイムと2 usの
オフ・タイムのパルス・
サイクルが2回繰り返さ
れています。ただし、そ
のパルス・サイクルでは
行2だけが表示されてい
ます（すなわち、行3は
表示されていません）。 

この列は、パルス
列の各パルス・サ
イクル（要素）の
オン・タイムを表
示します。

この列は、パルス
列の各パルス・サ
イクル（要素）の
オフ・タイムを表
示します。

この列は、パルス
列の各パルス・サ
イクル（要素）の
繰り返し回数を表
示します。

これらのソフトキーを使用し
て、パルス列のパルス・サイ
クル設定を変更し、使い易く
することができます。

SCPIコマンド：
[:SOURce]:PULM:INTernal:TRAin:LIST:PRESet
[:SOURce]:PULM:INTernal:TRAin:OFFTime <20ns - 42sec>
[:SOURce]:PULM:INTernal:TRAin:OFFTime?
[:SOURce]:PULM:INTernal:TRAin:OFFTime:POINts?
[:SOURce]:PULM:INTernal:TRAin:ONTime <20ns - 42sec>
[:SOURce]:PULM:INTernal:TRAin:ONTime?
[:SOURce]:PULM:INTernal:TRAin:ONTime:POINts?
[:SOURce]:PULM:INTernal:TRAin:REPetition <1-2047>
[:SOURce]:PULM:INTernal:TRAin:REPetition?
[:SOURce]:PULM:INTernal:TRAin:REPetition:POINts?

『SCPI Command Reference』を参照してください。

SPCIコマンド（続き）：
:MEMory:CATalog:PTRain? 
:MEMory:DELete:PTRain
:MEMory:EXPort[:ASCii]:PTRain <"filename">
:MEMory:EXPort[:ASCii]:SEParator:COLumn 
TAB|SEMicolon|{COMMa}|SPACe
:MEMory:EXPort[:ASCii]:SEParator:COLumn?
:MEMory:EXPort[:ASCii]:SEParator:DECimal {DOT}|COMMa
:MEMory:EXPort[:ASCii]:SEParator:DECimal?
:MEMory:IMPort[:ASCii]:PTRain <"filename">
:MEMory:IMPort[:ASCii]:SEParator:DECimal {DOT}|COMMa
:MEMory:IMPort[:ASCii]:SEParator:DECimal?
:MMEMory:LOAD:PTRain <"filename">
:MMEMory:STORe:PTRain <"filename">

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。

138ページ
136 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 パルス変調の使用（オプションUNWまたは320）   
Pulse Train（オプション320 – 必要：オプションUNW）   
図6-6 Pulse Trainメニューのソフトキーのディスプレイ

Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train > Display Pulse Train

これらのソフトキーを使用し
て、パルス列のさまざまな特
性の表示を最適化します。

このソフトキーは、タイ
ム・オフセットを、ディス
プレイの左側から、指定さ
れたものにシフトします。
増分と減分は、目視可能な
パルス列の1/20です。

この値は、Time Offset
ソフトキーを使用して調
整できます。

これらはディビジョン・マーカーで、
現在、現行の表示ビューで10.00 us/div
に設定されています。Zoomソフトキー
を使用して、time/div値を変更します。

これは最初のパル
ス・サイクル（行1）
です。このパルスの
オン・タイム部は、
2 usのオフセットの
ために表示されてい
ないことに注意して
ください。

5番目、6番目、7番
目のパルス・サイ
クル（要素）、また
は、行5、6、7。

上に表示されたパ
ルス列の最後のパ
ルス・サイクル
（要素）。8番目の
パルス・サイクル
または行番号8。

2番目、3番目
のパルス・サ
イクル（要
素）、または、
行2および3。

4番目のパルス・
サイクル（要素）
または行4。

各キーの詳細については、44ページで説明されているキー
のヘルプを使用してください。
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パルス変調の使用（オプションUNWまたは320） 
Pulse Train（オプション320 – 必要：オプションUNW） 
図6-7 Pulse Train：Import From Selected Fileソフトキー

Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train > More

66ページ

これらのソフトキーは、
個々のオン・タイムおよび
オフ・タイム要素、および、
繰返しサイクル・カウント
を削除します。

このファイル構造は、数値に小数点を使用するので、Import 
Decimal SeparatorをDotに設定することが必要です。

CSV/ASCIIファイルをインポート
する際に、小数点を「.」とする
か、「,」とするかを選択します。
この値は、プリセット/再読取お
よび電源オフ-オンの間も持続し
ます。

SCPIコマンド：
:MEMory:IMPort[:ASCii]:SEParato
r:DECimal DOT|COMMa
:MEMory:IMPort[:ASCii]:SEParato
r:DECimal?

ファイルのインポートを確認する
と、新しいファイルのパルス列値
が表示されます。

すべてのパルス・サイクル
行（要素）の削除を確認す
ることが必要です。

各キーの詳細については、44ページで説明されているキー
のヘルプを使用してください。

注記：列区切り記号は
機器により自動判別さ
れます。

139ページ

139ページ
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 パルス変調の使用（オプションUNWまたは320）   
Pulse Train（オプション320 – 必要：オプションUNW）   
図6-8 Pulse Train：Export to Fileソフトキー

Pulse > Pulse Source > More > Pulse Train > Edit Pulse Train > More

138ページ

テキスト領域エディター・
キーを使用して、BIN（2進
値）フォルダーにエクスポー
トするファイルの名前を変更
します。 

Export to Fileソフトキーのメ
ニューでCSV/ASCIIファイルを
BINARYディレクトリーに書き込
みます。ファイル名の一部とし
て、独自のエクステンダーを付け
ることができます。
例： 
MEM:EXP:PTR "myfile.csv".
SPCIコマンド：
:MEMory:EXPort[:ASCii]:PTRAin 
<"filename">

注記：ファイルは機器のBIN（2進値）フォルダーにFTP転送することができ、
または、USBスティックを使用してファイルを機器にダウンロードすること
もできます。67ページを参照してください。

各キーの詳細については、44ページで説明されているキーの
ヘルプを使用してください。

注記：PTRAIN.CSVと名付けられたファイルが既にあるので、新
しいファイル名は別のものとして、元のPTRAIN.CSVファイルが
上書きされることを防いでください。 

CSV/ASCIIファイルをエクスポー
トする際に、列区切をタブ、「;」、
「,」または「 」（空白）から選択し
ます。この値は、プリセット/再読
取および電源オフ-オンの間も持続
します。
SCPIコマンド： 
:MEMory:EXPort[:ASCii]:SEParato
r:COLumn 
TAB|SEMicolon|COMMa|SPACe
:MEMory:EXPort[:ASCii]:SEParato
r:COLumn?

CSV/ASCIIファイル
をエクスポートする
際に、小数点を「.」
とするか、「,」とす
るかを選択します。
この値は、プリセッ
ト/再読取および電源
オフ-オンの間も持続
します。
SCPIコマンド： 
:MEMory:EXPort[:AS
Cii]:SEParator:DECi
mal DOT|COMMa
:MEMory:EXPort[:AS
Cii]:SEParator:DECi
mal?
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パルス変調の使用（オプションUNWまたは320） 
Pulse Train（オプション320 – 必要：オプションUNW） 
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7 基本デジタル操作— BBGオプションが装着なし
こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の

情報に習熟し て く ださ い。

「デュアルARB波形にリアルタイム雑音の追加」（245ページ）も参照し て く ださ い。
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基本デジタル操作— BBGオプションが装着なし 
I/Q変調 
I/Q変調
以下の要因がエラー ・ ベク ト ル振幅の一因になっています ：

• 振幅、 位相における差異、 およびI と Qチャ ンネル間の遅延

• DCオフセ ッ ト

I/Q メ ニューでは、 IおよびQ信号における一部の差異を相殺するため、 または機能障害を追加するための調
整および校正を提供し ます。 追加情報については、 I/Q変調 （204ページ） を参照し て く ださい。

「搬送信号の変調」（60ページ）も参照し て く ださい。

図7-1 I/Qディスプレイおよびソフトキー

このパネルは外部I/Q信号ルー
ティングを表示しています。

このパネルではI/Q調整の現在のステータスと設定
を表示しています。グレーテキストはI/Q調整がオ
フであることを表示しています。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

I信号の位相に関連するQ信号の位相
をオフセットします。直角位相調整
キーは度を単位としています。この
調整は校正されていません。 

DCオフセッ
トを設定し 
ます

DC、ユーザー、フルIQ 校正タイプの間で切り替えます。 
DC：現在の信号発生器の設定で、単一の周波数について、I/Qオフ
セット、ゲインおよび直角位相エラーを校正します。 
この校正では、I/Qをオンにし、最適化されたパスをRF（無線周波数）
出力に設定し、発生源を内部ベースバンド発生器に設定するよう要求
されます。I/Q調整を除く、機器の設定の変更をDC校正後に行うとDC
校正が無効になり、信号発生器を提供されている工場校正データへ復
元する原因となります。 
ユーザー：ご自身が定義している周波数帯域における、すべての信号
発生器設定に関するI/Qオフセット、ゲイン、および直角位相エラーを
校正します。 
フル：信号発生器のフル周波数範囲における、すべての設定に関する
I/Qオフセット、ゲイン、および直角位相エラーを校正します。

選択された周波数範囲に
I/Q校正ルーティンを開始
します。（Calibration Type
ソフトキーを使用して周
波数範囲を選択します。）
Abort Calソフトキーまた
はLocal Cancel/(Esc)ハー
ドキーを押して校正を停
止できます。校正を停止
する場合、以前の校正
データが保存されます。
この校正は、前回の校正
実行時の周囲温度から、
周囲温度が±5°以上変化し
た場合に実行する必要が
あります。
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 基本デジタル操作— BBGオプションが装着なし    
I/Q変調
以下の表では調整用と し て一般に使用される ものを表示し ています。

正面パネル入力の設定
MXG/EXGは、 キ ャ リ ア変調のため、 正面パネルのI InputおよびQ Inputから外部よ り 提供されたアナロ グ  

のI と Q信号を受信し ます。

1. I および Q 信号を正面パネル ・ コ ネ ク ターに接続し ます。 電圧レベルについては、「正面パネルの概要」
（5ページ）を参照し ます。 

a. アナロ グI信号を信号発生器の正面パネルのI Inputに接続し ます。

b. アナロ グQ信号を信号発生器の正面パネルのQ Inputに接続し ます。

2. I/Q変調器をオンにし ます ： I/Q Off On を押し てOnに設定し ます。

3. RF （無線周波数） 出力を設定し ます ：

a. 搬送波周波数を設定し ます。

b. 搬送波振幅を設定し ます。

c. RF （無線周波数） 出力をオンにし ます。

4. 必要に応じ てI/Q信号 （142ページ） を調整し ます。

表 7-1 I/Q調節の使用

I/Q調節 効果 機能障害

オフセ ッ ト キ ャ リ ア ・ フ ィ ード スルー DCオフセ ッ ト

直角位相の角度

EVMエラー フ ェーズ ・ スキ ュー

I/Qイ メ ージ I/Qパス ・ デ ィ レ イ
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基本デジタル操作— BBGオプションが装着なし 
I/Q変調 
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8 基本的なデジタル操作 
（オプション653/655/656/657）

こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の
情報に習熟し て く ださ い。

こ の章で説明されている機能は、 オプシ ョ ン653や655(N5172B)またはオプシ ョ ン656や657(N5182B)を搭載

し たベク ト ル信号発生器のみで使用でき ます。

• 波形ファイルの基本 （146ページ）

• 波形セグメントの保存、読み込み、および再生 （148ページ）

• 波形シーケンス （151ページ）

• 波形の設定およびパラメーターの保存 （155ページ）

• 波形マーカーの使用 （161ページ）

• 波形のトリガー （178ページ）

• 波形のクリッピング （185ページ）

• 波形のスケーリング （194ページ）

• ベースバンド周波数補正の設定 （200ページ）

• I/Q変調 （204ページ）

• I/Q調整 （208ページ）

• I/Q校正 （210ページ）

• 等化フィルターの使用 （212ページ）

• デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用 （214ページ）

• FIR表エディターを使用したFIRフィルターの変更 （220ページ）

• リアルタイム変調フィルターの設定 （224ページ）

• 複数ベースバンド発生器の同期化 （225ページ）
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基本的なデジタル操作 （オプション653/655/656/657） 
波形ファイルの基本 
• オプション 012（位相干渉性に対する LO イン /アウト）の概要 （複数ベースバンド発生器の同期化）  
（232ページ）

• 波形ライセンス （237ページ）

以下も参照し て く ださい ： 

• デュアルARB波形にリアルタイム雑音の追加 （245ページ）

• リアルタイム位相雑音信号劣化 （312ページ）

• マルチトーンおよびツートーン波形（オプション430）（371ページ）

波形ファイルの基本
2つの種類の波形フ ァ イルがあ り ます ： 

• セグ メ ン ト は信号発生器にダウ ン ロードする波形フ ァ イルです。

波形フ ァ イルの作成およびダウンロードに関する情報は、『プログラ ミ ング ・ガイ ド』 を参照して く ださい。 

• シーケンスは信号発生器内で作成する フ ァ イルで、1つまたは複数の波形フ ァ イル （セグ メ ン ト 、他のシー

ケン ス、 またはその両方） へのポイ ン ターを含みます。 

シーケン スの作成に関する情報は、 151ページを参照し て く ださい。

信号発生器のメモリー
信号発生器には、 2つの種類の メ モ リ ーがあ り ます ：

• 揮発性 メ モ リ ー。ベースバン ド発生器(BBG) メ デ ィ アで、 こ こ の波形フ ァ イルを再生し た り 編集し た り し

ます。

• 不揮発性 メ モ リ ー。 内部(int)または外部(USB) メ デ ィ アで、 こ こに波形フ ァ イルが保存されます。

デュアルARBプレイヤー

注記 MXG/EXGのARB波形フ ァ イルのキ ャ ッ シュは、 128フ ァ イルまでに制限されています。 このため、

128 フ ァ イルのキ ャ ッ シュ制限に達する と、 追加フ ァ イルが揮発性波形 メ モ リ ー (BBG) にロード さ
れる ため波形切 り 替え速度が大幅に遅 く な り ます。

デュ アル ARB 波形プレ イヤーによ り 、 波形シーケン ス を作成するだけでな く 、 （外部または内部） 波形フ ァ

イルを再生、 名前変更、 削除、 保存、 およびロー ド する こ と ができ ます。 また、 デュ アルARB波形プレ イ
ヤーには、 マーカー （161ページ）、 ト リ ガー （178ページ）、 ク リ ッ ピング （185ページ）、 およびスケー リ ン

グ （194ページ） 機能も備えています。

こ の節のほ と んどの手順は、 Dual ARB メ ニューから始めます （下記の図を参照）。 
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 基本的なデジタル操作 （オプション653/655/656/657）    
波形ファイルの基本
図8-1 Dual ARBのソフトキー

245ページ

185ページ

194ページ

185ページ

148ページ

デュアルARBがオフのときにARBサンプル・ク
ロックを設定した場合、新しい設定は、デュアル
ARBプレイヤーがオンになったときに適用されま
す。この設定は、デュアルARBプレイヤーのオフ
およびオンを切り替えても保持されます。

52ページ

155ページ

178ページ

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

注記：これは、2つの
ARBメニューの2つ目
です。

151ページ

200ページ

194ページ

194ページ

203ページ

225ページ

これらのソフトキー
は、デュアルARBのArb 
Setupメニューのみで
利用可能です。

161ページ

オプション2xxを使用
する ベクトルモード
で利用可能です。

237ページ

225ページ
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基本的なデジタル操作 （オプション653/655/656/657） 
波形セグメントの保存、読み込み、および再生 
波形セグメントの保存、読み込み、および再生
注記 MXG/EXGのARB波形フ ァ イルのキ ャ ッ シュは、 128フ ァ イルまでに制限されています。 こ のため、

128フ ァ イルのキ ャ ッ シュ制限に達する と、 追加フ ァ イルが揮発性波形 メ モ リ ー (BBG)にロード さ
れる ため波形切 り 替え速度が大幅に遅 く な り ます。

こ の情報を使用する前に、 信号発生器のフ ァ  イル ・ メ  ニ ューに精通し てお く 必要があ り ます。 精通し

ておられない場合は、「ファイルによる操作」（62ページ）を参照し、 内容を よ く 理解し て く ださい。

以下も参照し て く ださい ：「波形シーケンス」（151ページ）。

信号発生器には、 不揮発性 （内蔵またはUSB）、 および揮発性(BBG) と い う 、 2つの種類の波形 メ デ ィ アがあ
り ます。 また、 BBG メ デ ィ アは、 「作業」 メ デ ィ ア と も呼ばれます。 波形フ ァ イルを再生、 編集、 またはシー

ケン スに含める よ う にする ために、 まず波形フ ァ イルをBBG メ デ ィ アにロードする必要があ るからです。

図8-2 波形セグメントのソフトキー

波形セグメントのBBGメディアへの読み込み
波形を再生、 編集、 シーケン スに含める よ う にするには、 まず波形をBBG メ デ ィ アに格納する必要があ り ま

す。 電源の循環または信号発生器の再起動を行 う と、 BBG メ デ ィ アのフ ァ イルは削除されます。

注記 装置の電源を入れる たびに、 次の2つの工場提供セグ メ ン ト が自動的にBBG メ デ ィ ア内に作成され

ます ： RAMP_TEST_WFMおよびSINE_TEST_WFM。

メ モ リ ーにロード可能な追加のサンプル波形が内部ス ト レージにあ り ます。www.keysight.comを参
照し、 「工場出荷時設定N5182B」 および 「波形」 で検索し て く ださい。

161ページ

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

注記：シーケンスが選択されているとき、このキー名
はShow Waveform Sequence Contentsに変更され
ます。

矢印キーやノブを使用して、
文字を強調表示します。

これらのキーは、デフォルト・メディアを示すように変更されます。 
デフォルト・メディアの選択に関する情報は、 73ページを参照してく
ださい。
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 基本的なデジタル操作 （オプション653/655/656/657）    
波形セグメントの保存、読み込み、および再生
1. Mode > Dual ARB > Select Waveform > Waveform Segmentsを押し ます。

2. Load Storeを押して、Loadを強調表示し、矢印キーを使用して、該当する波形セグ メ ン ト を強調表示し ます。

3. 現在選択し ている メ デ ィ アに こ のセグ メ ン ト のコ ピーがすでに存在し てお り 、 上書きする こ と を望まな
い場合は、 読み込みを行 う 前に波形セグ メ ン ト の名前を変更し ます （前の手順を参照し て く ださい）。

4. Load Segment From （現在選択し ている） Mediaを押し ます。

すべてのフ ァ イルを現在選択されている メ デ ィ アからBBG メ デ ィ アにロードするには、 Load All From （現  
在選択されている） Mediaを押し ます。 

波形セグメントの内蔵メディアまたはUSBメディアへの保存/名前変更
次の手順を使用して、BBG メ モ リ ーのフ ァ イルのコ ピーを現在選択されている メデ ィ アに保存し ます（73ペー
ジ）。 波形セグ メ ン ト をダウ ン ロード し ていない場合は、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照するか、 いずれ
かの工場提供セグ メ ン ト を使用し ます。 

1. Mode > Dual ARB > Select Waveform > Waveform Segmentsを押し ます。

2. Load Storeを押し て、 Storeを強調表示し ます。

3. 矢印キーを使用し て、 保存する波形セグ メ ン ト を強調表示し ます。

4. または、 セグ メ ン ト を名前変更し ます。

現在選択し ている メ デ ィ アに こ のセグ メ ン ト のコ ピーがすでに存在し てお り 、 上書きする こ と を望まな
い場合は、 保存を行 う 前に波形セグ メ ン ト の名前を変更し ます。

a. More > Rename Segment > Clear Textを押し ます。
b. 波形セグ メ ン ト の名前を入力し ます。
c. Enter > Moreを押し ます。

d. 名前変更された波形セグ メ ン ト を強調表示し ます。

5. Store Segment to （現在選択されている） Mediaを押し ます。

6. 保存するすべてのセグ メ ン ト に対し て、 ステップ3からステップ5の手順を繰 り 返し ます。

BBG メ デ ィ アからのすべてのセグ メ ン ト を現在選択されている メ デ ィ アに保存するには、 Store All to （現  
在選択されている） Mediaを押し ます。
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波形セグメントの保存、読み込み、および再生 
波形セグメントの再生
1. Mode > Dual ARB > Select Waveformを押し ます。

2. Segment on BBG Media列で、 再生し たい波形セグ メ ン ト を強調表示し ます。

3. Select Waveformを押し ます。

4. ARB Off OnをOnに設定し ます。

これで、 選択された波形セグ メ ン ト を再生し ます。 I/QおよびARB減衰器の両方がオンになっている と、

波形によ ってRF搬送波が変調されます。 

5. RF （無線周波数） 出力を設定し ます ： 

RF搬送波の周波数および振幅を設定し、 RF （無線周波） 出力をオンに切 り 替えます。

波形セグ メ ン ト が、 信号発生器のRF （無線周波数） 出力コネ ク ターで使用可能にな り ます。 

現在の波形選択

減衰器は、アクティブな波形（ARBオン）と一緒に表示されます
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波形シーケンス
波形シーケンス
図8-3 波形シーケンスのソフトキー

波形シーケン ス と は、1つまたは複数の波形セグ メ ン ト ま たは他の波形シーケン ス、 も し く はその両方への

ポイ ン ターを含むフ ァ イルのこ と です。 これによ り 、 信号発生器で複数の波形セグ メ ン ト 、 または他のシー
ケン ス、 も し く はその両方を再生でき る よ う にな り 、 別の波形を選択するためだけに波形の再生を停止する
必要がな く な り ます。

波形シーケン スが指定し ているセグ メ ン ト は、 シーケン ス を保存する と きに自動的に保存される こ と はあ り
ません。 個別のセグ メ ン ト を保存する必要があ り ます。 そのよ う にし ない と、 信号発生器をオフ または再起
動し た と きにそれらのセグ メ ン ト が失われます。 セグ メ ン ト が内部/外部 メ デ ィ アに格納されている場合、波

形シーケン ス を選択する前にBBG メ デ ィ アにそれら を ロードする必要があ り ます （148ページを参照）。 BBG
メ デ ィ アにセグ メ ン ト を ロード し ていない状態でシーケン スの再生を試みる場合、 信号発生器によ って次が
報告されます。 ERROR:629, File format invalid （フ ァ イル形式が無効です）。 これが発生し て、 セグ   

メ ン ト が内部/外部 メ デ ィ アに保存されていない場合、 シーケン ス を再生でき る よ う になる前に、 シーケン ス
が指定し ていたの と同じ フ ァ イル名を使用し てセグ メ ン ト を再作成する必要があ り ます。 

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

Mode > 
Dual ARB

シーケンス名

シーケンスのコンテンツ

174ページを参照して
ください 

このソフトキーを表示するには、波形シーケンスを選択します。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 151



基本的なデジタル操作 （オプション653/655/656/657） 
波形シーケンス 

            
シーケンスの作成
波形シーケン スには、 高1,024セグ メ ン ト を含める こ と ができ、 セグ メ ン ト および他のシーケン ス （ネス ト

されたシーケン ス） の両方を含める こ と ができ ます。 信号発生器を使用する と、 再生中にセグ メ ン ト やネス
ト されたシーケン スが繰 り 返す回数を設定する こ と ができ ます。 ただし、 セグ メ ン ト の繰 り 返し と ネス ト さ
れたシーケン スの繰 り 返しには相違があ り ます。各セグ メ ン ト は、 高65,535回繰 り 返すこ と ができ ますが、

セグ メ ン ト は、 繰 り 返し回数に関係な く 、 単一セグ メ ン ト と し てカ ウ ン ト されます。 それに対し、 ネス ト さ
れたシーケンの各繰 り 返しは、 追加のセグ メ ン ト と し てカ ウ ン ト されます。

ネス ト されたシーケン ス を繰 り 返すこ と が可能な 大数は、 ネス ト されたシーケン ス内のセグ メ ン ト 数およ
び許可されているセグ メ ン ト 数(1,024)の残存数に依存し ます。 例えば、 24つのセグ メ ン ト と 4つのセグ メ ン
ト を使用する ネス ト されたシーケン スが1つ含まれる シーケン スの場合、 ネス ト されたシーケン スの繰 り 返

し回数は250回に制限されます。

シーケン ス ご と の 大セグ メ ン ト 数は、 24 + (4×250) = 1,024 と な り ます

ネス ト されたシーケン スの繰 り 返し可能な 大数に関する制限要素があ り ますが、 ネス ト されたシーケン ス
内の各セグ メ ン ト は、 大65,535回まで繰 り 返すこ と ができ ます。

例
次の手順を使用して、 2つの異なるセグ メ ン ト のそれぞれを1回繰 り 返す波形シーケンスを作成し保存し ます。

前提 ： 波形セグ メ ン ト がBBG メ デ ィ ア （揮発性 メ モ リ ー） に格納されています。 波形セグ メ ン ト のBBG メ

デ ィ アへの読み込みに関する情報は、 148ページを参照し て く ださい。 

1. 初のセグ メ ン ト を選択し ます ：

a. Mode > Dual ARB > More > Waveform Sequences > Build New Waveform Sequence > Insert Waveformを押    

し ます。

b. 目的の波形セグ メ ン ト を強調表示し、 Insertを押し ます。

2. 2つ目のセグ メ ン ト を選択し ます ：

a. 次の目的の波形セグ メ ン ト を強調表示し、 Insertを押し ます。

b. Done Insertingを押し ます。

3. 波形シーケン スに名前を付け、 Seq.フ ァ イル ・ カ タ ロ グに保存し ます ：

a. More > Name and Storeを押し ます。

b. フ ァ イル名を入力し、 Enterを押し ます。

「シーケンスのコンテンツの表示」（153ページ）および「波形セグメントのマーカー・ポイントの設定」（168
ページ）も参照し て く ださい。

波形 
シーケンス

シーケンスA

シーケンスB

シーケンスAを
4回繰り返す

セグメント1

セグメント2

セグメント3

2つの 
セグメント

9つの 
セグメント

11つのセグメント

8つの 
セグメント
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シーケンスのコンテンツの表示
波形シーケン スのコ ンテンツを表示するには2つの方法があ り ます ：

Waveform Sequencesソフトキーを使用
1. Mode > Dual ARB > More > Waveform Sequencesを押し ます。

2. 目的のシーケン ス を強調表示し ます。

3. Show Waveform Sequence Contentsを押し ます。

Select Waveformソフトキーの使用
1. Mode > Dual ARB > Select Waveformを押し ます。

2. Sequence On列で、 目的の波形シーケン ス を強調表示し ます。

3. Show Waveform Sequence Contentsを押し ます

シーケンスの編集
波形シーケン ス を編集する と き、 次を行 う こ と ができ ます ：

• 各セグ メ ン ト またはネス ト されたシーケン スの再生回数の変更

• シーケン スからのセグ メ ン ト またはネス ト されたシーケン スの削除

• セグ メ ン ト またはネス ト されたシーケン ス をシーケン スに追加

• マーカーのオンおよびオフを切 り 替え （174ページで説明）

• 現在の波形シーケン スに加えた変更の保存または新しいシーケン ス と し て保存

変更を保存する前に、 シーケン ス編集 メ ニューを終了する と、 変更内容が失われます。

Seq.フ ァ イル ・ カ タ ロ グにシーケン ス を保存し ます。

注意 シーケン スで使用さ れる セグ メ ン ト を編集および再保存する場合、 シーケ ン スはそのヘ ッ ダーの
RMS値を自動的に更新し ません。 シーケン スのヘッ ダー情報を選択および更新する必要があ り ます

（155ページ）。

次の手順を使用し て2つの異な るセグ メ ン ト を持つシーケン ス を編集し て、 初のセグ メ ン ト が100回、 2つ

目のセグ メ ン ト が200回繰 り 返される よ う にし てから、 変更を保存し ます。

前提 ： 2つの異なるセグ メ ン ト を持つ波形シーケン スが作成および保存されています （152ページの以前の例

を参照）。

1. シーケン ス を選択し ます ： 
Mode > Dual ARB > More > Waveform Sequences > 目的のシーケ ン ス を強調表示する > Edit Selected Waveform    
Sequenceを押し ます。

2. 初のセグ メ ン ト を変更し て、 100回繰 り 返すよ う にし ます ： 
初のセグ メ ン ト のエン ト リ 内容を強調表示し、 Edit Repetitions > 100 > Enterを押し ます。

カーソルが次のエン ト リ に移動し ます。 
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3. 選択されたエン ト リ の繰 り 返し を200に変更し ます。 
Edit Repetitions > 200 > Enterを押し ます。

4. 前の手順で加え られた変更を保存し ます ： 
More > Name and Store > Enterを押し ます。

新しいシーケン ス と し て変更内容を保存する方法 ： 

a. More > Name and Store > Clear Textを押し ます。
b. フ ァ イル名を入力し ます （例えば、 SINE100+RAMP200）。

c. Enterを押し ます。

編集し たシーケン ス を新しい波形シーケン ス と し て保存し ます。 

シーケンスの再生
波形シーケン ス を作成し ていない場合、「シーケンスの作成」（152ページ）を参照し て く ださい。

注記 波形セグ メ ン ト を個別に再生する か、 波形シーケン スの一部 と し て再生する には、 セグ メ ン ト が
BBG メ デ ィ ア内に格納されている必要があ り ます。「波形セグメントのBBGメディアへの読み込み」
（148ページ）も参照し て く ださい。

1. 波形シーケン ス を選択し ます ：

a. Mode > Dual ARB > Select Waveformを押し ます。

b. 波形シーケン ス （こ の例ではSINE100+RAMP200） をSequence On列から強調表示し ます。

c. Select Waveformを押し ます。

デ ィ スプレ イに現在選択された波形が表示されます （例えば、 Selected 
Waveform:SEQ:SINE100+RAMP200）。

現在の波形選択

減衰器は、アクティブな波形（ARBオン）と一緒に表示されます
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2. 波形を生成し ます ： 
ARB Off Onを押し てOnに設定し ます。 

これで、 選択された波形シーケン ス を再生し ます。 波形シーケン スの生成中に、 I/QおよびARB減衰器の

両方がオンにな り 、 波形によ ってRF搬送波が変調されます。 

3. RF （無線周波数） 出力を設定し ます ： 

a. RF搬送波の周波数を設定し ます。
b. RF （無線周波数） 出力の振幅を設定し ます。

c. RF （無線周波数） 出力をオンにし ます。

波形シーケン スが、 信号発生器のRF （無線周波数） 出力コネ ク ターで使用可能にな り ます。 

波形の設定およびパラメーターの保存
こ の節は、 フ ァ イル ・ ヘッ ダーを編集および保存する方法を説明し ます。 波形フ ァ イル （I/Qデータ。 信号発
生器を波形セグ メ ン ト と し て取 り 扱 う ） のみをダウ ン ロードする と きは、信号発生器は、 フ ァ イル・ヘッ ダー
および波形フ ァ イル と同じ名前を持つマーカー・ フ ァ イルを自動的に生成し ます。元々、 フ ァ イル・ヘッ ダー
には保存されている信号発生器がな く 、 マーカー ・ フ ァ イルはすべてゼロで構成されます。 指定された波形
の場合、 信号発生器の設定およびパラ メ ーターをフ ァ イル ・ ヘッ ダーに、 マーカー設定をマーカー ・ フ ァ イ
ルに保存する こ と ができ ます （161ページ）。 保存された波形をBBG メ デ ィ アにロードする と き、 フ ァ イル ・
ヘッ ダーおよびマーカー ・ フ ァ イル設定が自動的に信号発生器に適用され、 デュ アルARBプレ イヤーが波形

フ ァ イルが再生される たびに同じ方法で設定される よ う にし ます。 

図8-4 ヘッダー・ユーティリティのソフトキー

波形シーケン ス を作成する と き （152ページで説明）、 信号発生器は、 個別の波形セグ メ ン ト ・ ヘッ ダーよ り
も優先される波形シーケン ス ・ ヘッ ダーを自動的に作成し ます。 波形シーケン スの再生中に、 すべての必須
オプシ ョ ンがイ ン ス ト ールされている こ と を確証する こ と を除いて、セグ メ ン ト ・ヘッ ダーが無視されます。
波形シーケン ス を保存する と、 そのフ ァ イル ・ ヘッ ダーも保存されます。 

フ ァ イル ・ ヘッ ダーに表示されている信号発生器設定の一部が ソ フ ト キー ・ ラベルの一部 と し て表示され、
他の部分は、 次の例に示すよ う に、 デュ アルARB要約デ ィ スプレ イに表示されます。

158ページ

Mode > Dual ARB > 
More > 
Header Utilities

各キーの詳細について
は、44ページで説明さ
れているキーのヘルプを
使用してください。
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表8-1 ファイル・ヘッダーの入力 

Description （32文字） 波形の機能などの、 ヘッ ダー用に入力された説明 （Edit Descriptionソ フ ト キーを使用した保存/編集、 図8-4
を参照） です。

Sample Rate 波形再生率です。 これは、 Arb Setup メ ニ ューで設定された、 ARBサンプ リ ング ・ ク ロ ッ ク ・ レー ト です

（「Dual ARBのソフトキー」（147ページ）に表示）。

Runtime Scaling ラ ン タ イ ム ・ ス ケー リ ング値は、 波形の再生中にラ ン タ イ ムで適用されます。 こ の設定は、 デュ アルARB
プレ イ ヤーで再生し ている フ ァ イルのみに対する変更を行 う こ と ができ ます （197ページを参照）。

RMS 変調器減衰設定 （147ページを参照） がAutoに設定されている と き、 こ の値はACPRを 適化する ために

I/Q変調器減衰設定を計算する ために使用されます。 値 ： 0～1.414213562。

Marker 1...4 Polarity マーカー極性は、 正または負にする こ と ができ ます （174ページで説明）。 

ALC Hold Routing ALC 保持機能を実装するマーカー （存在する場合） （163ページで説明）。 マーカー信号が低いと き、 現在の

レベルでALC を保持し ます。 信号発生器で生成されたすべての波形には、 初のサンプル ・ ポイ ン ト にマー

カーがあ り ます。 3つのルーテ ィ ング選択からの結果を参照するには、 サンプル範囲 （マーカー） ポイ ン ト を

選択する必要がある場合があ り ます（「波形セグメントのマーカー・ポイントの設定」（168ページ）を参照）。 

ARB要約、ファイル
ヘッダー設定

ソフトキー・ラベル、
ファイル・ヘッダー
設定

ソフトキー・ラベル、
ファイル・ヘッダー
設定

このメニューのすべての設定は、ファイル・ヘッダーに保
存することができます（表8-1（156ページ）に、ファ
イル・ヘッダーに保存されているすべての設定をリスト表
示します）

Runtime Scalingソ
フトキーは、Dual 
ARBメニューの下で
のみ使用可能です。

200ページを参照
してください 
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ヘッダー情報の表示および変更
次の例は、 工場提供波形フ ァ イルRAMP_TEST_WFMを使用し ます。

1. BBG メ デ ィ アから、 波形RAMP_TEST_WFMを選択し ます ： 

a. Mode > Dual ARB > Select Waveformを押し ます。

b. Segment On列で、 波形RAMP_TEST_WFMを強調表示し ます。

c. Select Waveformを押し ます。

2. Header Utilities メ ニューを開き ます ：

More > Header Utilitiesを押し ます。

図8-5に、工場提供波形RAMP_TEST_WFMのデフ ォル ト ・ フ ァ イル・ヘッ ダーを示し ます。Header Field 
列に、 フ ァ イル ・ ヘッ ダー ・ パラ メ ーターを リ ス ト 表示し ます。 Page Downキーを使用し てすべてを表示 

させる こ と ができ ます。

RF Blank Routing マーカー信号が低い と きの、 RF ブ ラ ンキング機能を実装する マーカー （存在する場合） （172ページで説

明）。 RFブラ ンキング も ALC保持を使用し ます。 RFブラ ン ク ・ ルーテ ィ ング機能を使用する と き、 同一の

マーカーに対するALC保持ルーテ ィ ングを選択する必要はあ り ません。 マーカー信号が高 く な る と、 RFブ

ラ ンキングが中断されます。 

Mod Attenuation I/Q変調器減衰設定です （図8-1（147ページ）に表示されるArb Setup メ ニ ューで設定し ます）。

BB Freq Offset ベースバン ド 周波数補正 （Hz単位） です （200ページを参照）。

AWGN:State リ アルタ イ ム雑音がオン(1)またはオフ(0)になっているかど う かを示す （245ページを参照）。

AWGN:C/N Ratio 搬送波対雑音比 （dB単位） です （250ページを参照）。

AWGN:Carrier BW 雑音電力を統合する帯域幅 （Hz単位） です （250ページを参照）。

AWGN:Noise BW 雑音の帯域幅 （Hz単位） です （250ページを参照）。

AWGN:Carrier RMS 搬送波帯域幅にわた る搬送波RMSです （250ページを参照）。

Phase Noise State 位相雑音がオン(1)またはオフ(0)になっているかど う かを示す （312ページを参照）。

Phase Noise F1 中間レベル周波数特性の開始周波数です （312ページを参照）。

Phase Noise F2 中間レベル周波数特性の終了周波数です （312ページを参照）。

Phase Noise Lmid 中間レベル周波数特性の振幅です （312ページを参照）。

Modulation Filter 選択された リ アルタ イ ム変調フ ィ ルターのタ イプです｡ （224ページを参照）。

Over–Range Protect DACオーバーレ ンジ保護がオン(1)またはオフ(0)になっているかど う かを示す （316ページを参照）。

Unique Waveform Id 0 = IDな し。 IDは割 り 当て られた ら、 変更する こ と はでき ません。

License Required 波形を再生する ためにラ イ セン スが必要かど う かを指定し ます。 以下も参照し て く だ さ い ： 「オプション
およびライセンスの表示」（40ページ）

Can be Read Out 波形がSCPIまたはFTPを介し て問い合わせる こ と が可能かど う かを指定し ます。

表8-1 ファイル・ヘッダーの入力（続ぎ）
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Saved Header Settings列に、 ほ と んどの設定がUnspecifiedである こ と が表示されます。 未指定と  
は、 特定のパラ メ ーターに対し て保存された設定がないこ と を意味し ます。

Current Inst.Settings列に、 現在の信号発生器の設定が表示されます。 この例では、 これらの設定を 

フ ァ イル ・ ヘッ ダーに保存し ます。 

注記 設定がフ ァ イル ・ ヘッ ダーで指定されていない場合、 信号発生器は、 波形を選択および再生する と
きに、 その設定の現在の値を使用し ます。

図8-5 ファイル・ヘッダーの例

3. Current Inst.Settings列の情報をフ ァ イル ・ ヘッ ダーに保存し ます ：

Save Setup To Headerを押し ます。

Saved Header Settings列およびCurrent Inst.Settings列には、 同じ値が表示される よ う にな   

り ます。 Saved Header Settings列には、 フ ァ イル ・ ヘッ ダーに保存されている設定が リ ス ト 表示さ  

れます。

4. 設定を編集し、 更新し ます

a. ARB Setup メ ニューに戻 り ます ： 
Return > More > ARB Setupを押し ます。

こ の メ ニューから、 フ ァ イル ・ ヘッ ダーに保存されている信号発生器の設定の一部にア ク セスする こ
と ができ ます。図8-1（147ページ）に、次の手順で使用されるARB Setupのソ フ ト キーを表示し ます。

波形ファイルの名前。

説明は、最大32文字まで可
能です。

Mode > Dual ARB > More > Header Utilities

デフォルトのヘッダー設定 現在の信号発生器の設定

保存されたヘッダー
設定エントリをデ
フォルト設定にリ
セットします

RMS波形電圧を計算するには： 
Calculateを押します
次いで、Header Field情報を参照します。
注記：波形の立ち上がり/立下がり時間が長いか、DCオフセットがあるか、雑音*
がすでに波形に追加されている場合（爆発信号）、精度を向上して最適な測定精
度を得るため、Edit RMSソフトキーおよびEdit AWGN RMS Overrideソフトキー
を使用することをお勧めします。 
*オプション403リアルタイムAWGNは、Header Field RMS値には影響しません。
ただし、信号発生器内にダウンロードおよび再生する前に波形に追加された雑音
は、Header Field RMS値には影響します。

メニューを開いて、AWGNを計
算するために使用するキャリ
アRMS値を手動で定義しま
す：ヘッダー・フィールドの
Carrier RMS値。 
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b. ARBサンプル ・ ク ロ ッ ク を5 MHzに設定し ます ： 
ARB Sample Clock > 5 > MHzを押し ます。

c. 波形ラ ン タ イ ム ・ ス ケー リ ングを60%に設定し ます ： 

Waveform Runtime Scaling > 60 > %を押し ます。

d. Header Utilities メ ニューに戻 り ます ： 
Return > More > Header Utilitiesを押し ます。

次の図に示されている よ う に、 Current Inst.Settings列に、 現在の信号発生器設定への変更が 

反映されますが、 保存されたヘッ ダー値は変更されません。

e. 現在の設定をフ ァ イル ・ ヘッ ダーに保存し ます ： 
Save Setup To Headerソ フ ト キーを押し ます。

Current Inst.Settings列からの設定がSaved Header Settings列に表示されます。 これで、   

新しい現在の装置設定がフ ァ イル ・ ヘッ ダーに保存されます。

波形フ ァ イルを選択し た後にいずれかの信号発生器の設定を変更し た場合、変更された設定がフ ァ イル・ヘッ
ダーの Current Inst.Settings列に表示され、 保存されたヘッ ダー設定の代わ り に使用されます。 保存 

されたヘッ ダー設定を再度適用するには、 再生用に波形を再度選択し ます。

波形を選択せずにヘッダーを表示または編集
157ページで説明されている よ う に、波形を選択した後に波形のヘッ ダー情報を表示および編集する こ と がで
き ます。 また、 波形を選択する こ と な く 波形ヘッ ダー情報を編集し た り 、 現在選択されているの と は別の波
形ヘッ ダー情報を編集し た り する こ と ができ ます。

1. フ ァ イル ・ ヘッ ダーのユーテ ィ リ テ ィ ・ メ ニューにア ク セス し ます ： 
Mode > Dual ARB > More > Header Utilities > More > Select Different Headerを押し ます。

信号発生器は、 後に選択された メ デ ィ アの波形フ ァ イルをアルフ ァベッ ト 順で表示し ます。 次の図
に、 BBG メ デ ィ ア内の工場提供波形の例を示し ます。

値は、2つの列で 
異なります
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2. 適切なカ タ ロ グが表示されていない場合、 それを選択し ます。 

3. 適切な波形フ ァ イルを強調表示し、 Select Headerを押し ます。

信号発生器は、 選択された波形フ ァ イルのフ ァ イル ・ ヘッ ダーを表示し ます。 

4. ヘッ ダーを編集するには、 Moreを押し、 ステップ4（158ページ）（ヘッダー情報の表示および変更節）
で説明されている手順を進めます。

アクティブ波形カタログ

アクティブ・メディア

タイプ：
WFM1 = 揮発性セグメント
NVWFM = 不揮発性セグメント
SEQ = シーケンス

アクティブ・カタログ

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

アクティブ・メディアのファ
イルを表示できるようにする
カタログです。
アクティブ・メディアの選択
に関する詳細は、64ページを
参照してください。

BBGメディアのファイル
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波形マーカーの使用
信号発生器には、 波形セグ メ ン ト の特定のポ イ ン ト をマークする ための、 4つの波形マーカーが用意されて

います。 信号発生器が有効なマーカーに遭遇する と、 補助信号がマーカー番号に該当する背面パネル ・ イベ
ン ト 出力に送信されます。

• イベン ト 1は、 EVENT 1 BNCコネク ター （17ページを参照） とAUXILIARY I/Oコネク ターのピン （18ページ   
を参照） の両方で使用可能です。

• イベン ト 2は、 TRIG 1およびTRIG 2コネ ク ター （14ページを参照） と AUXILIARY I/Oコネ ク ターのピン   

（18ページを参照） で使用可能です。

• イベン ト 3および4は、 AUXILIARY I/Oコネ ク ターのピン （18ページを参照） で使用可能です。

補助出力信号を使用し てその波形を使用する別の装置と同期させた り 、 ト リ ガー信号と し て使用し て波形の
指定されたポイ ン ト で装置を始動させる こ と ができ ます。

ALC ホール ド または RF ブラ ンキング （ALC ホール ド を含む） を起動するマーカーを構成する こ と も でき ま

す。 詳細については、「波形マーカーの使用」（161ページ）を参照し て く ださい。

波形に関連付け られているマーカー ・ フ ァ イルがない波形フ ァ イルをダウ ン ロードする と き、 信号発生器が
マーカー ・ ポイ ン ト な しでマーカー ・ フ ァ イルを作成し ます。 工場提供セグ メ ン ト （RAMP_TEST_WFMおよ

びSINE_TEST_WFM） の場合は、 初のサンプルに4つすべてのマーカーのマーカー ・ ポイ ン ト があ り ます。

次の手順は、 デュ アルARBプレ イヤーで作業し ている と きにマーカーを使用する方法を示し ています。 これ
らの手順では、マーカー・ ポイ ン ト と サンプル・ポイ ン ト と い う 2種類のポイ ン ト について も説明し ます。マー

カー ・ ポイ ン ト と は、 与え られたマーカーが波形に設定されているポイ ン ト です。 各マーカーに対し て1つま

たは複数のマーカー ・ ポイ ン ト を設定でき ます。 サンプル ・ ポイ ン ト と は、 波形を構成する多 く のポイ ン ト
の1つです。

波形マーカーを使用する3つの基本手順があ り ます。

波形セグメントからのマーカー・ポイントを消去 （167ページ）

波形セグメントのマーカー・ポイントの設定 （168ページ）

波形シーケンスのマーカーの制御 （174ページ）

また、 こ の節は、 次の情報を提供し ています。

• 波形マーカーの概念 （162ページ）

• マーカー・ユーティリティへのアクセス （166ページ）

• 波形セグメント・マーカーの表示 （167ページ）

• マーカー・パルスの表示 （171ページ）

• RFブランキング・マーカー機能の使用 （172ページ）

• マーカー極性の設定 （174ページ）
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波形マーカーの概念
信号発生器のデュ アルARBには、波形セグ メ ン ト で使用する4つの波形マーカーが用意されています。各マー
カー極性およびマーカー ・ ポイ ン ト を （単一のサンプル ・ ポイ ン ト またはサンプル ・ ポイ ン ト の範囲全体に）
設定する こ と ができ ます。 各マーカーは、 ALCホール ド、 またはRFブラ ンキング と ALCホール ド を実行する
こ と もでき ます。

マーカー信号応答
信号発生器は、 マーカー信号をベースバン ド発生器のIおよびQ信号に一致させます。 ただし、 振幅、 フ ィ ル
ターなど、 RF （無線周波数） 出力パス内のその他の設定は、 マーカー EVENT出力信号 と変調されたRF （無
線周波数） 出力の間に遅延を発生させる こ と があ り ます。 マーカー EVENT出力信号を使用する と き、 信号
の待ち時間を観察し （変調されたRFに関係するマーカー）、必要に応じ て、 マーカー ・ ポイ ン ト 位置を リ セ ッ
ト し て、 遅延 （208ページ）、 または両方を含める よ う にし ます。

マーカー・ファイルの作成
波形フ ァ イルに関連付け られているマーカー ・ フ ァ イルがない波形フ ァ イル （『プロ グ ラ ミ ング ・ ガ イ ド』 で
説明） をダウ ン ロードする と、 信号発生器は自動的にマーカー ・ フ ァ イルを作成させますが、 マーカー ・ ポ
イ ン ト は配置し ません。

マーカー・ポイントの編集要件
波形セグ メ ン ト のマーカー ・ ポイ ン ト を変更でき る よ う になる前に、 セグ メ ン ト がBBG メ デ ィ ア内に格納さ
れている必要があ り ます （「波形セグメントのBBGメディアへの読み込み」（148ページ）を参照）。

マーカー極性およびルーティング設定の保存
ユーザーが再構成し、信号発生器のプ リ セ ッ ト 、または電源の循環を行 う まで、マーカー極性およびルーテ ィ
ング設定が保持されます。波形フ ァ イルが再生される と きに波形が正しい設定を使用する よ う にするか、マー
カー極性またはルーテ ィ ングを設定し （RFブラ ンキングおよびALCホール ド）、 フ ァ イル ・ ヘッ ダーに情報
を保存し ます （155ページ）。 

注記 フ ァ イル ・ ヘッ ダーに保存されたマーカー ・ ルーテ ィ ング設定およびマーカー極性設定がない波形、
およびRFブラ ンキングを使用する際に、前に再生された波形を使用する場合は、RF BlankingをNone 
に設定し ている こ と を確認し て く ださ い。 これを怠る と、 RF （無線周波数） 出力が得られなかった
り 、 歪んだ波形になって し ま う こ と があ り ます。

マーカー 
ファイル
ビットN

マーカー
極性

マーカー N 
RF Blank Off On

マーカー N
マーカーが低い
ときにRFを削除

EVENTN

負

正

Set Marker
On Off

マーカー N 
ALC Hold Off On

マーカー N
マーカーが低い
ときにALCを
保持

信号発生器が有効なマーカーに遭遇すると（174ページで説明）、補助出力信号が生成
され、背面パネルに送信されます。 

イベント1は、EVENT 1 BNCコネクター（17ページを参照）とAUXILIARY I/Oコネク
ターのピン（18ページを参照）で使用可能です。

イベント2から4は、AUXILIARY I/Oコネクターのピン（18ページを参照）で使用可能
です。

RF Blank Only： 
ALC Holdを含みます
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ALC Holdマーカー機能

マーカー機能の設定 （ソ フ ト キー ・ ラベルのMarker Routing と し て説明） は、 マーカー ・ ポイ ン ト を設定する 
（168ページ） 前または後のいずれかに行 う こ と ができ ますが、 マーカー ・ ポイ ン ト を設定する前にマーカー

機能を設定する と、 RF （無線周波数） 出力で電源スパイ ク または電源の損失を も た らすこ と があ り ます。

ア イ ド リ ング期間、 バース ト ・ ラ ンプを組み込む波形信号があ る場合、 またはRFバンキングの使用によ る動
的な範囲の増加 （172ページ） を望まない場合は、 ALCホール ド機能自体を使用し ます。 

ALCホール ド ・ マーカー機能は、 マーカーで設定されたサンプル ・ ポイ ン ト の平均値でALC回路を保持し ま

す。 正と負のマーカー極性のために、 ALCは、 マーカー信号が高 く なった と きにRF （無線周波数） 出力信号

をサンプ リ ング し ます （搬送波＋変調信号） ：

注記 波形の出力振幅に影響する可能性があ るため、 100 ms以上ALCホール ド を使用し てはな り ません。 

よ り 長い時間間隔については、「出力検索モード」（118ページ）を参照し て く ださい。

注意 不正確なALCサンプ リ ングのために、 突然に不均衡な条件が形成され、 RF （無線周波数） 出力のスパ
イ ク を作成し て、 DUTまたは選択された装置を損傷し て し ま う 可能性があ り ます。 この状態を防ぐ

ために、 マーカを設定し て、 ALCが信号内で遭遇する高い電源レベルを考慮し た振幅でサンプ リ ン

グを行 う よ う にし ます。

正 ： 信号は、 オンのマーカー ・ ポ イ ン ト でサンプ リ ング されます。

負 ： 信号は、 オフのマーカー ・ ポ イ ン ト でサンプ リ ング されます。

正極
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平均の詳細

ALCは、 マーカー信号が高 く なった と きの波形のサンプ リ ング
を行い、 ALC回路を設定するサンプ リ ング された波形の平均を

使用し ます。

こ こ で、 ALCはオン ・ マーカー ・ ポイ ン ト （正極性） 中にサン
プ リ ング し ます。

マーカー マーカー

マーカーマーカー

正しい使用例

波形 ： 1022ポイ ン ト  

マーカー範囲 ： 95–97
マーカー極性 ： 正

こ の例は、 波形の振幅が も高い部分をサンプ リ ングする ための
マーカー ・ セ ッ ト を示し ています。 マーカーは波形の振幅が も
低い部分の十分前に設定されている こ と を確認し て く ださい。 こ
れは、 マーカー信号と波形信号間の応答の相違を考慮に入れてい
ます。

 
 

不均衡なパルス

不適切な使用例

波形 ： 1022ポイ ン ト  
マーカー範囲 ： 110–1022
マーカー極性 ： 正

この例は、 同じ波形の低い部分のサンプ リ ングを行い、 そのレ
ベルのALC振幅回路を設定するマーカー ・ セ ッ ト を示し ていま
す。 これは、 通常、 高振幅パルスに遭遇し た と きの信号発生器
に対し て不均衡な条件を も た らすこ と があ り ます。

マーカーマーカー
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サンプリング範囲は、信号の最初のポイン
トで始まります

負範囲を信号とオフ時間の間に設定

不適切な使用例

波形 ： 1022ポイ ン ト  
マーカー範囲 ： 110–1022
マーカー極性 ： 負

こ の図は、 負極マーカーがマーカー ・ オン ・ ポイ ン ト 時に低 く な
る こ と を示し ています。 マーカー信号は、 オフ ・ ポイ ン ト 時に高
く な り ます。 ALCは、 オフ ・ マーカー ・ ポイ ン ト 時に波形をサン

プ リ ング し ます。
マーカー・オン マーカー・オン

オン と オフ時間の両方のサンプ リ ングによ って、 よ り 高い信号
レベルに対応する振幅回路が不正確に設定されます。 パルスの
開始時に、 振幅が増加する こ と に注意し て く ださい。

マーカー

マーカー・オン
マーカーマーカー

オフ

オン

・オン
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マーカー・ユーティリティへのアクセス
Mode > Dual ARB > More > Marker Utilities

注記：これは、2つ目
のARBメニューです。

下記のディスプレイは、波形のIおよびQコン
ポーネント、および工場提供セグメントのマー
カー・ポイント・セットを表示しています。 ディスプレイに 

表示されている 
最初のサンプル・
ポイント

これらのソフトキー
は、マーカー・ディ 
スプレイに表示されて
いる波形サンプル・ 
ポイントの範囲を変更
します。

ソフトキーを毎回押す
たびに、ほぼ2つの因
数でサンプル範囲が変
更されます。最初のサンプ

ル・ポイント
の マーカー・
ポイント

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

これらのメニューの設定は、
ファイル・ヘッダーに保存でき
ます（155ページを参照）。

52ページ
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波形セグメント・マーカーの表示
マーカーは、 波形セグ メ ン ト に適用されます。 次の手順を使用し て、 セグ メ ン ト のマーカー ・ セ ッ ト を表示
し ます （こ の例は、 工場提供のセグ メ ン ト SINE_TEST_WFMを使用し ます）。

1. 2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Set Markersを押し ます。
2. 目的の波形セグ メ ン ト （こ の例では、 SINE_TEST_WFM） を強調表示し ます。

3. Display Waveform and Markers > Zoom in Maxを押し ます。 
大ズーム ・ イ ン範囲は、 28ポイ ン ト です。

Zoom機能を試し て、 マーカーを表示する方法を表示し ます。

デ ィ スプレ イには、 大460ポイ ン ト 表示可能です。 460ポイ ン ト を超えるサンプル ・ ポイ ン ト 範囲の表示さ

れた波形では、 マーカー位置が表示されないこ と があ り ます。

波形セグメントからのマーカー・ポイントを消去
マーカー ・ ポイ ン ト を設定し た と き、 既存のポイ ン ト を置き換え る こ と はあ り ません。 ただし、 既存のポイ
ン ト に追加されて設定されます。 マーカーが重複し ているため、 ポイ ン ト を設定する前に、 セグ メ ン ト を表
示し （167 ページ） 望まないポイ ン ト を削除し ます。 すべてのマーカーが消去される と、 イベン ト 出力信号

のレベルが0Vにな り ます。 セグ メ ン ト のマーカー ・ ポイ ン ト を消去するため、 セグ メ ン ト がBBG メ デ ィ ア内
に格納されている必要があ り ます （148ページ）。

すべてのマーカー・ポイントを消去
1. 2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Set Markersを押し ます。

2. 目的の波形セグ メ ン ト （こ の例では、 SINE_TEST_WFM） を強調表示し ます。

3. 目的のマーカー番号を強調表示し ます ： Marker 1 2 3 4を押し ます。

4. 選択し たマーカー番号の場合、 選択されたセグ メ ン ト ですべてのマーカー ・ ポイ ン ト を削除し ます ：

a. Set Marker Off Range of Pointsを押し ます。

初および 後のマーカー ・ ポ イ ン ト の ソ フ ト キーが波形の長さ に対応する こ と に注意し て く だ さ
い。 工場提供波形 （SINE_TEST_WFM） には、 200つのサンプルが含まれます。 すべてのセ ッ ト ・ マー

カー ・ ポイ ン ト を消去するには、 範囲は波形の長さ と等し く なっている必要があ り ます。

b. Apply To Waveform > Returnを押し ます。

5. 他のマーカーから削除し たい任意の残っているマーカー ・ ポイ ン ト に対し て、ステップ3以降を繰 り 返し

ます。

マーカー・ポイントの範囲の消去
次の例は、ポイ ン ト 1020全体にわた るマーカー・ ポイ ン ト (Marker 1)セ ッ ト と一緒に波形を使用し ます。 こ 
れによ り 、 影響を受けるマーカー ・ ポイ ン ト を表示しやす く な り ます。 同じプロセスは、 既存のポイ ン ト が
範囲全体に対し てまたは単一のポイ ン ト と し て設定されるかど う かを適用し ます （168ページ）。

1. 2つ目のARBメ ニューで （166ページ）、 Marker Utilities > Set Markersを押してから、Marker 1を選択し ます。

2. オフにし たい 初のサンプル ・ ポイ ン ト を設定し ます （こ の例では、 13） ： 
Set Marker Off Range Of Points > First Mkr Point > 13 > Enterを押し ます。
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3. 後のマーカー ・ ポイ ン ト を、 波形のポイ ン ト 数以下で、 かつステップ2 で設定された値 （この例では、
17） 以上になる範囲で設定し ます ： 

Last Mkr Point > 17 > Enter > Apply To Waveform > Returnを押し ます。

 
こ れに よ り 、 右に示すよ う に、 ステッ
プ2 と 3で設定された範囲内のア ク テ ィ

ブなマーカーのすべてのマーカー ・ ポ
イ ン ト がオフにな り ます。

マーカーを表示す る 方法については、
167ページで説明されています。

単一マーカー・ポイントの消去
「マーカー・ポイントの範囲の消去」（167ページ）で説明されている手順を使用し ますが、 初および 後
のマーカー ・ ポ イ ン ト 両方を消去し たいポ イ ン ト の値に設定し ます。 例えば、 ポ イ ン ト 5のマーカーを消去

し たい場合、 初と 後の両方の値を5に設定し ます。

波形セグメントのマーカー・ポイントの設定
セグ メ ン ト 上にマーカー ・ ポイ ン ト を設定するには、 セグ メ ン ト はBBG メ デ ィ ア内に格納されている必要が

あ り ます （148ページ）。

マーカー ・ ポイ ン ト を設定し た と き、 既存のポイ ン ト を置き換え る こ と はあ り ません。 ただし、 既存のポイ
ン ト に追加されて設定されます。 マーカーが重複し ているため、 セグ メ ン ト 内にマーカー ・ ポイ ン ト を設定
する前に、 セグ メ ン ト を表示し （167ページ） 望まないポイ ン ト を削除し ます （167ページ）。

ポイントの範囲全体にわたるマーカーの配置
1. 2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Set Markersを押し ます。

2. 目的の波形セグ メ ン ト を強調表示し ます。

3. 目的のマーカー数を選択し ます ： Marker 1 2 3 4を押し ます。

4. 初のサンプル ・ ポイ ン ト を範囲内で設定し ます （こ の例では、 10）。

Set Marker On Range Of Points > First Mkr Point > 10 > Enterを押し ます。

5. 後のマーカー ・ ポイ ン ト を、 波形のポイ ン ト 数以下で、 かつ 初のマーカー ・ ポイ ン ト （この例では、
20） 以上になる範囲で設定し ます ：

Last Mkr Point > 20 > Enterを押し ます。
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6. Apply To Waveform > Returnを押し ます。

これで、 波形マーカー ・ ポ イ ン ト の範囲が設定されます。 マーカー信号は、 次の図に示されている よ う に、
サンプル ・ ポイ ン ト 10で開始し、 サンプル ・ ポイ ン ト 20で終了し ます。

単一ポイントへのマーカーの配置
初のポイ ン ト 上

1. 2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Set Markersを押し ます。

2. 目的の波形セグ メ ン ト を強調表示し ます。

3. 目的のマーカー数を選択し ます ： 
Marker 1 2 3 4を押し ます。

4. Set Marker On First Pointを押し ます。

これによ り 、ステップ3で選択されたマーカー番号のセグ メ ン ト の 初のポイ ン ト にマーカーが設定され

ます。

任意のポイ ン ト 上

「ポイントの範囲全体にわたるマーカーの配置」（168ページ）で説明されている手順を使用し ますが、 初
および 後のマーカー ・ ポイ ン ト 両方を設定し たいポイ ン ト の値に設定し ます。 例えば、 ポイ ン ト 5 にマー

カーを設定し たい場合、 初と 後の両方の値を5に設定し ます。

繰り返し間隔マーカーの配置
次の例では、 ポイ ン ト の範囲全体にマーカーを設定し、 各マーカー間の間隔 （スキ ッ プするポイ ン ト 数） を
指定し ます。 マーカー設定を適用する前に間隔を設定する必要があ り ます。 スキ ッ プするポイ ン ト 数を以前
に設定し たポイ ン ト の範囲に適用する こ と はでき ません。

注記 スキ ッ プするポイ ン ト 数の値は、 ポイ ン ト の範囲のサイ ズに限定されます。

1. 任意の既存のマーカー ・ ポイ ン ト を削除し ます （162ページ）。

2. 2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Set Markersを押し ます。

3. 目的の波形セグ メ ン ト を強調表示し ます。 

4. 目的のマーカー数を選択し ます ： 
Marker 1 2 3 4を押し ます。

マーカーを表示する方法については、167ページで説明されています 
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5. 初のサンプル ・ ポイ ン ト を範囲内で設定し ます （こ の例では、 5） 
Set Marker On Range Of Points > First Mkr Point > 5 > Enterを押し ます。

6. 後のマーカー ・ ポイ ン ト を範囲内に設定し ます。 （ 後のマーカー ・ ポイ ン ト 値は、 常に波形のポイ ン
ト 数以下で、 かつ 初のマーカー ・ ポイ ン ト （こ の例では、 25） 以上であ る必要があ り ます） ： 

Last Mkr Point > 25 > Enterを押し ます。

7. スキ ッ プし たいサンプル ・ ポイ ン ト 数を入力し ます （こ の例では、 1） ： 

# Skipped Points > 1 > Enterを押し ます。

8. Apply To Waveform > Returnを押し ます。

これによ り 、 右に示すよ う に、 マーカーが
マーカー・ ポイ ン ト 範囲内で1ポイ ン ト おき

で （サンプル ・ ポイ ン ト が1つスキ ッ プされ
る） 配置されます。

マーカーを表示する方法については、 
167ページで説明されています。

ス キ ッ プ ・ ポ イ ン ト 機能は、 ク ロ ッ ク信号
をEVENT出力と し て作成する時などに使用
し ます。
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マーカー・パルスの表示
波形を再生する と き （154ページ）、 そのマーカー番号に対応する背面パネル ・ イベン ト ・ コネ ク ター /補助

I/Oピンにおける有効なマーカーのパルス を検出し設定し ます。 この例では、 少な く と も1つのマーカー ・ ポ

イ ン ト ・ セ ッ ト を持つ波形セグ メ ン ト によ って生成されたマーカー ・ パルス を表示する方法を実演し ていま
す （168ページ）。 プロセスは、 波形シーケン スの場合 と同じです。  

こ の例では、 工場提供セグ メ ン ト SINE_TEST_WFMをデュ アルARBプレ イヤーで使用し ています。 工場提供

セグ メ ン ト の場合は、 図示されている よ う に、 初のサンプル ・ ポイ ン ト に4つすべてのマーカーのマー
カー ・ ポイ ン ト があ り ます。

1. 初のARB メ ニューで （147ページ）、 Select Waveformを押し ます。

2. SINE_TEST_WFMセグ メ ン ト を強調表示し、 Select Waveformを押し ます。

3. ARB Off Onを押し てOnに設定し ます。

4. 信号発生器の背面パネルQ OUT出力をオシロ ス コープのチャ ンネル1入力に接続し ます。

5. 信号発生器の背面パネルEVENT 1出力をオシ ロ ス コープのチャ ンネル2入力に接続し ます。 

マーカー 1が存在する と き、 次の例に示されている よ う に、 Keysight MXG/EXGはEVENT 1から信号を  
出力し ます。

波形セグメントの 
最初のサンプル・ 
ポイント上のマー
カー・ポイント

マーカーを表示する方法については、167ページで説明されています

Q OUT

EVENT 1信号のマーカー・パルスです。
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RFブランキング・マーカー機能の使用
マーカー機能を （Marker Utilities メ ニューのソ フ ト キー ・ ラベルのMarker Routing と し て説明） マーカー ・ ポ  
イ ン ト の設定の前でも後でも設定でき ますが （168ページ）、 マーカー ・ ポイ ン ト を設定する前にマーカー機

能を設定する と RF （無線周波数） 出力を変更し て し ま う こ と があ り ます。 RF ブラ ンキングには、 ALC ホー

ル ド が含まれます （不均衡な電源については、163ページの注意の説明に留意し て く ださい）。信号発生器は、
マーカー信号が低下し た と きにRF （無線周波数） 出力を削除し ます。 この例は、 前の例の続き と なっていま

す （マーカー・パルスの表示）。

1. 工場提供セグ メ ン ト SINE_TEST_WFMを使用し て、ポイ ン ト 1180の全体にわたってMarker 1を設定し ま 
す （168ページ）。

2. Marker Routingソ フ ト キー ・ メ ニューから、 RF BlankingをMarker 1に割 り 当てます ： 
2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Marker Routing > Pulse/RF Blank > Marker 1を押    
し ます。
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マーカー極性 = 正
マーカー極性が正であるとき（デフォルト 
設定）、オフ・マーカー・ポイント時にRF
（無線周波数）出力を削除します。

200180ポイント1

マーカー

セグメント

RF信号

RF信号

200180ポイント1
マーカー

セグメント

マーカー極性 = 負
マーカー極性が負であるとき、オン・マー
カー・ポイント時にRF（無線周波数）出力を
削除します

3.3V

0V

3.3V

0V

RF信号

RF信号
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マーカー極性の設定
負のマーカー極性を設定する と マーカー信号が反転し ます。

1. 2つ目のARB メ ニューで （166ページ）、 Marker Utilities > Marker Polarityを押し ます。

2. 各マーカーについて、 必要に合わせてマーカー極性を設定し ます。

• デフ ォル ト のマーカー極性は正です。

• 各マーカー極性は、 個別に設定されます。

「マーカー極性およびルーティング設定の保存」（162ページ）も参照し て く ださい。

172ページに図示されている よ う に ：

正極 ： Onのマーカー ・ ポイ ン ト は、 高い値です(3.3V)。 

負極 ： Onのマーカー ・ ポイ ン ト は、 低い値です(0V)。

RFブラ ンキングは、 極性設定にかかわらず、 信号の低い部分で発生し ます。

波形シーケンスのマーカーの制御
波形セグ メ ン ト では、 有効なマーカー ・ ポイ ン ト は補助出力信号を生成し、 この信号はマーカー番号に対応
する リ アパネルEVENT出力 （「背面パネル概要（N5171B、N5172B、N5181B、N5182B）」（13ページ）で説

明） に送信されます。 波形シーケンスの場合、 セグ メ ン ト ご と にマーカーが有効化または無効化されます。 こ
れによ り 、 シーケンスの一部のセグ メ ン ト に対してマーカーを出力でき る よ う にな り ますが、 他のセグ メ ン ト
に対し ては出力されません。 シーケン スのマーカー設定を変更し た り 、 電源を循環させる まで、 シーケン ス
で編集された 後のセグ メ ン ト のマーカー設定がユーザーが構築し た次のシーケン スのすべてのセグ メ ン ト
に適用されます。 波形シーケン ス を構築に関する情報は、「シーケンスの作成」（152ページ）を参照し て く

ださい。
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図8-6 セグ メ ン ト・ マーカーの有効化/無効化用の波形シーケンス・メニュー

Mode > Dual ARB > 
More 

注記：これは、2つ目のARBメニューです。

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

波形シーケンスの作成中にマー
カーを有効化/無効化

シーケンスを編集して、
マーカーを有効化/無効化
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波形シーケンスのマーカーの有効化および無効化
波形シーケン ス内の波形セグ メ ン ト を選択し て、 各セグ メ ン ト のマーカーを個別に有効化または無効化し ま
す。 シーケン スの作成時またはシーケン スの作成および保存後にマーカーを有効化または無効化する こ と が
でき ます。 シーケン スがすでに保存されている場合、 何らかの変更を加えた後にシーケン ス を保存する必要
があ り ます。 マーカー ・ ポイ ン ト のないマーカーを有効化しても、 補助出力には影響はあ り ません。 セグ メ ン
ト のマーカー ・ ポイ ン ト を設定するには、「波形セグメントのマーカー・ポイントの設定」（168 ページ）を

参照し て く ださい。 こ の例は、 波形シーケン スが存在し ている こ と を前提と し ています。

1. シーケン スのすべての波形セグ メ ン ト がBBG メ デ ィ アに格納されている こ と を確認し て く ださい 
（148ページを参照）。

2. 2つ目のARB メ ニューから、 Waveform Sequencesを押し ます。

3. 目的の波形シーケン ス を強調表示し ます。

4. Edit Selected Waveform Sequence > Enable/Disable Markersを押し ます。

5. マーカーを切 り 替えます ： 

a. 初の波形セグ メ ン ト を強調表示し ます。

b. 必要に応じ て、 Toggle Marker 1、 Toggle Marker 2、 Toggle Marker 3、 およびToggle Marker 4を押し ます。

Mkr列の入力内容は （下記の図を参照）、 そのセグ メ ン ト に対し てマーカーが有効になっている こ と
を示し、列に入力内容がないこ と はそのセグ メ ン ト のすべてのマーカーが無効になっている こ と を意
味し ます。

c. 順に、 残っている各セグ メ ン ト を強調表示し、 ステップbを繰 り 返し ます。

6. Return > More > Name and Storeを押し ます。

7. テキス ト ・ エン ト リ ・ キーを使用し てシーケン スの名前を変更するか （149ページを参照）、 Enterを押し

て、 既存の名前を使用し てシーケン ス を保存し ます。

選択内容ご と にマーカーが有効化または無効化され、 変更内容がシーケン ス ・ フ ァ イルに保存されます。

次の図は、 工場提供波形セグ メ ン ト のいずれかを使用し て構築されたシーケン ス を表示し ます。 工場提供セ
グ メ ン ト の場合は、 初のサンプルに4つすべてのマーカーのマーカー ・ ポイ ン ト があ り ます。 この例では、

マーカー 1は 初のセグ メ ン ト に対し て有効化され、 マーカー 2は2つ目のセグ メ ン ト に対し て有効化され、
マーカー 3および4は、 3つ目のセグ メ ン ト に対し て有効化されます。

各セグ メ ン ト に対し て、 そのセグ メ ン ト に対し て有効化されているマーカーのみが背面パネル補助出力信号
を生成し ます。 この例では、 マーカー 1補助信号は、 残 り のセグ メ ン ト に対しては無効化されるため、 初の

セグ メ ン ト に対し てのみ表示されます。 マーカー 2補助信号は、 2つ目のセグ メ ン ト に対し てのみ表示され、
マーカー 3および4補助信号は、 3つ目のセグ メ ン ト に対し てのみ表示されます。

シーケンス・マーカー列

このエントリは、このセグメント
に対してマーカー 3および4が有効
化されていることを示します。
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EVENT出力信号を装置のトリガーとして使用
 
EVENT出力信号 （マーカー信号） の用

途の1つは、 測定装置の ト リ ガーです。

波形の開始時、波形の任意の単一ポイ ン
ト 、 または波形の複数のポ イ ン ト で装
置を開始する よ う にマーカーを設定す
る こ と ができ ます。 装置のEVENT信号

の使用を 適化する ため、 サンプル ・
レー ト を調整する必要も あ る場合があ
り ます。 サンプル ・ レー ト 設定の場所
は、 右の図に示されています。

EVENT出力信号は、 立ち上が り エ ッ ジ
および立ち下が り エッジで 高±4 nsの 

ジ ッ ターを提示でき ます。 こ のジ ッ ターは、 以下の2つの方法のいずれかで 小化する こ と ができ ます。 

方法1 ： 125 MHz/Nのサンプル ・ ク ロ ッ ク を使用し ます。 こ こ で、 Nは正の整数であ り 、 125 MHz/Nはデ ィ   
スプレ イに正確に表示する こ と が必要です。 
例 ： 125 MHz、 62.5 MHz、 31.25 MHz、 25 MHzなど。 

結果がデ ィ スプレ イに正確に表示する こ と ができない場合、 ジ ッ ターが存在する可能性があ り ます。 
例 ： N = 6にする と、 125 MHz/6 = 20.833 Mhz と なる ためジ ッ ターが存在し ます。 値は、 表示する と きに切    
り 捨て られます。

方法2 ： サンプル ・ ク ロ ッ クおよび波形の長さ を選択し、 8 nsの倍数でマーカーの間隔が空け られます。 例 ： 

初のポイ ン ト のマーカーを持つ200ポイ ン ト 波形および50 MHzのサンプル ・ ク ロ ッ クは、 マーカーを4 µs  
ご と に提供し ます。 4 µsは8 nsの倍数であ るため、 ジ ッ ターが 小化されます。

EVENT出力信号がジ ッ ターを示し、 装置の ト リ ガー と し て使用される と き、 波形がジ ッ ターを持つ波形と し

て誤って表示される こ と があ り ます。 こ の状態が発生する場合、 サンプル ・ レー ト をジ ッ ターを発生させな
い値に調整する こ と ができ ます （上記を参照）。 サンプル ・ レー ト を変更し て元の波形の完全性を保持するに
は、 サンプル値を再計算する必要も あ り ます。 次の図は、 マーカー信号ジ ッ ターおよびその波形への影響を
図示し ています。

サンプル・ 
レート 
設定

このメニューの設定は、
ファイル・ヘッダーに保存
できます（155ページを
参照）。

各キーの詳細については、44ページで説明されている
キーのヘルプを使用してください。

ジッターが消えた
（サンプル・レートを最適化し

波形にジッターがあるように見える
（ジッターを持つ EVENT信号を使用してトリガーしたため）

オシロスコープが波形をトリガー オシロスコープが EVENT信号をトリガー オシロスコープが EVENT信号をトリガー

EVENT出力信号にジッターが現れる
（サンプル・レートが最適でないため）

たため）
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波形のトリガー
図8-7 トリガーのソフトキー

ト リ ガーは、 信号発生器が変調信号を転送する タ イ ミ ングを制御する こ と で、 データ転送を制御し ます。 ト
リ ガー設定を構成し て、 データ転送が1度 （Singleモード）、 連続 （Continuousモード） で発生するか、 開始

および停止を繰 り 返す （Gated と Segment Advanceモード） よ う にする こ と ができ ます。

ト リ ガー信号は正状態および負状態の両方を含みます。 ト リ ガーに対してどちらかを使用する こ とができ ます。

ト リ ガー ・ モード を 初に選択する と き、 またはあ る ト リ ガー ・ モード から別のモード に変更する と き、 変
更信号が ト リ ガーされる までは、 RF （無線周波数） 出力時に搬送信号を失 う こ と があ り ます。 これは、 信号発

生器がIおよびQ信号を、 初の ト リ ガー ・ イベン ト 前に0 （ゼロ） ボル ト に設定するからです。 RF （無線周
波数） 出力時の搬送信号を保持するため、 初期のIおよびQ電圧をゼロ以外の値に設定し たデータ ・ パターン

を作成し ます。 

ARB を 初に ON に切 り 替えるか ト リ ガー ・ モード を選択する と き、 またはあ る ト リ ガー ・ モード から別の

モー ド に変更する と き、 RF （無線周波数） 出力時に数十 ミ リ 秒搬送信号を一時的に失 う こ と があ り ます。
ARBは、 IQ変調器に次の任意波形のア イ ド リ ングIQrms値を示し ます。 これによ り 、 ARBが ト リ ガーを待機

し ている間、 RF搬送波出力が正しい振幅レベルに保持されます。 ト リ ガーを受け取る と、 ARBが波形の再生
を開始するので、 変調RF搬送波に不要な過渡現象があ り ません。

波形 ト リ ガーの設定には2つの部分があ り ます ：

• タ イプは、 波形を再生する と きに波形の動作を決定し ます （トリガー・タイプ （179ページ） を参照）。

• 信号源は、 信号発生器が変調波形の再生を開始する ト リ ガーの受け取る方法を決定し ます （トリガー・
ソース （180ページ） を参照）。

Mode > Dual ARB

179ページ

180ページ

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。
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トリガー・タイプ
タ イプは、 ト リ ガー ・ モード、 つま り ト リ ガーされる と きの波形の再生方法を定義し ます。 

注記 下記の例では、 デュ アルARBモード を示し ていますが、 ト リ ガー機能は別の変調モード に類似し て

います。 使用可能な ト リ ガー ・ タ イプは、 選択された変調モード によ って異な り ます。

• Continuousモード は、 信号がオフになるか別の波形、 ト リ ガー ・ モード または応答を選択する まで、 波形
を繰 り 返し ます （Free Run、 Trigger & Run、 Reset & Run）。

• Singleモード は波形を一回再生し ます。 

注記 Single No Retrigger では、 この設定の待ち時間が可変であ るため、 Continuous Reset & Run モード を使    

用し ないで く ださい。

No Retrigger ： ト リ ガーを初期に受け取っていた場合は、 無視されます。 再生のギ ャ ッ プは ト リ ガー期間 

に依存し ます。 その時間が過ぎる と、 RFが期待された場所から再び開始し ます。

Buffered Trigger ： 初期の ト リ ガーによ り 、 波形は 後まで再生された後、 再び開始し ます。 RFは、 この初 

期 ト リ ガーに一致し ません。

Mode >
Dual ARB > 
Trigger Type

波形を即席にトリガーし再生します。波形の再生中に受け
取ったトリガーは無視されます。

トリガーを受け取ったときに波形を再生します。後続の
トリガーは無視されます。

トリガーを受け取ったときに波形を再生します。後続のト
リガーは波形の再生を再開します。

トリガー・ソースが作動なしの状態で
ある間は波形が停止し、作動状態中に
再生されます。

波形の再生中、受け
取った最初のトリガー
が無視されます。

波形の再生中、初期に
受け取ったトリガーは
現在の波形が完了する
まで待機し、その後再
度波形が再度再生され
ます。

波形の再生中に受け
取った初期のトリガー
が速やかに波形を再始
動します。

シーケンスのセグメントを1回再
生します。繰り返し設定は無視
されます。再生後、デュアル
ARBプレーヤは停止してトリ
ガーを待ち、トリガーを受信す
ると次のセグメントに進みます。
次のセグメントが最後まで再生
されます。 
 
セグメントの再生中にトリガー
を受け取った場合、セグメント
が最後まで再生されます。その
後、デュアルARBプレイヤーが
次のセグメントに進み、セグメン
トを最後まで再生します。

シーケンス中のセグメントは、波形が別のトリガーを受け取るまで、連続的に再生されます。 
 
セグメントの再生中にトリガーを受け取った場合、セグメントが最後まで再生されます。その後、
デュアルARBのプレイヤーが次のセグメントに進み、セグメントを連続して再生します。 

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。
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Restart on Trigger ： ARBは、 再起動し て再度 ト リ ガーされますが、 これが起きている間に再生にい く らか  
のギ ャ ッ プが存在し ます。 ARBは ト リ ガーを受け取ったたびに自動的に リ セ ッ ト し ます。

• Segment Advanceモードは、 ト リ ガーされた場合のみシーケンスのセグ メ ン ト を再生し ます。 ト リ ガー・ ソー 
スは、 セグ メ ン ト 間の再生を制御し ます （例：セグメント・アドバンス・トリガー （181 ページ） を参

照）。 後のセグ メ ン ト 中に ト リ ガーを受け取る と、 シーケン スの 初のセグ メ ン ト までループ再生され
ます。

• Gatedモード は、 ア ク テ ィ ブな ト リ ガー状態時に波形を ト リ ガーし てから、 外部的に適用されたゲー ト 信

号に対応し て波形再生の開始および停止を繰 り 返し ます。例：ゲーティッド・トリガー （182ページ） を
参照し て く ださい。

トリガー・ソース

外部トリガー極性
• Continuous、Single、およびSegment Advanceモード では、Ext Polarityソ フ ト キーを使用して外部 ト リ ガー  

極性を設定し ます。

• Gatedモード では、Active LowおよびActive Highソ フ ト キー （179ページ） が外部 ト リ ガー極性を決定し ます。 

Mode >
Dual ARB > 
Trigger Source

Patt Trig In BNCコネクター 
（17ページを参照）

Aux I/Oコネクター 
（18ページを参照）

Neg = トリガー信号が低状態の 
間に信号発生器が応答します。

Pos = トリガー信号が高状態の 
間に信号発生器が応答します。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

Ext DelayがOnなるまで、
キーは無効です。
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例：セグメント・アドバンス・トリガー
セグ メ ン ト ・ ア ド バン ス ・ ト リ ガーによ って、 波形シーケン ス中のセグ メ ン ト 再生を制御でき る よ う にし ま
す。 このタ イプの ト リ ガーは、 繰 り 返し値を無視し ます （153ページ）。 例えば、 セグ メ ン ト の繰 り 返し値が

50の場合、 セグ メ ン ト ・ ア ド バン ス ・ ト リ ガー ・ モード と し てSingleを選択する と、 セグ メ ン ト は1回のみ再
生されます。 次の例では、 2つのセグ メ ン ト を持つ波形シーケン ス を使用し ます。

波形シーケン ス を作成および保存し ていない場合、「シーケンスの作成」（152ページ）を参照し て く ださい。

1. 信号発生器をプ リ セ ッ ト し ます。

2. RF （無線周波数） 出力を設定し ます ：

• 所定の周波数を設定し ます。

• 所定の振幅を設定し ます。

• RF （無線周波数） 出力をオンにし ます。

3. 再生のために波形シーケン ス を選択し ます ：

a. Mode > Dual ARB > Select Waveformを押し ます。

b. Sequence On列で、 波形シーケン ス ・ フ ァ イルを強調表示し ます。

c. Select Waveformを押し ます。

4. ト リ ガーを次のよ う に設定し ます ：

• ト リ ガー ・ タ イプ ： 連続セグ メ ン ト ・ ア ド バン ス 
Trigger Type > Segment Advance > Continuousを押し ます。

• ト リ ガー ・ ソース ： Triggerハード キー 

Trigger Source > Trigger Keyを押し ます。

5. 波形シーケン ス を生成し ます ： 
ARB Off OnをOnが強調表示される まで押し ます。

6. （オプシ ョ ン） 波形を監視し ます ：

信号発生器のRF OUTPUTをオシ ロ ス コープの入力に接続し、オシ ロ ス コープを構成し て信号を表示でき 

る よ う にし ます。

7. 初の波形セグ メ ン ト を ト リ ガーし て、 連続再生を開始し ます ： 
Triggerハード キーを押し ます。

8. 2つ目のセグ メ ン ト を ト リ ガーし ます ： 
Triggerハード キーを押し ます。

Triggerハード キーを押すと、現在再生中のセグ メ ン ト が終了され、次のセグ メ ン ト の再生が開始されます。

シーケン スの 後のセグ メ ン ト を再生し ている場合、Triggerハード キーを押すと、 後のセグ メ ン ト の再
生が終了し た と きに波形シーケン スの 初のセグ メ ン ト の再生が開始されます。
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例：ゲーティッド・トリガー
ゲーテ ィ ッ ド ・ ト リ ガーを使用する と、 変調波形のオンおよびオフ状態が定義でき ます。

1. 次の図に示されている よ う に、関数発生器の出力を信号発生器の背面パネルのPAT TRIGLYCERIDES IN  
コ ネ ク ターに接続し ます。 こ の接続は、 すべての外部 ト リ ガー ・ メ ソ ッ ド に適用されます。 オプシ ョ ン
のオシ ロ ス コープ接続によ って、 ト リ ガー信号にRF （無線周波数） 出力があ る場合の影響を確認する こ

と ができ ます。

2. 信号発生器をプ リ セ ッ ト し ます。

3. RF （無線周波数） 出力を設定し ます ：

• 所定の周波数を設定し ます。

• 所定の振幅を設定し ます。

• RF （無線周波数） 出力をオンにし ます。

4. 再生用の波形を選択し ます （シーケン ス またはセグ メ ン ト ） ：

a. Mode > Dual ARB > Select Waveformを押し ます。

b. Segment OnまたはSequence On列で、 波形を強調表示し ます。

c. Select Waveformを押し ます。

5. ト リ ガーを次のよ う に設定し ます ：

• ト リ ガー ・ タ イプ ： ゲーテ ィ ッ ド 
Trigger Type > Gatedを押し ます。

• ア ク テ ィ ブ状態 ： 低 
Active Lowを押し ます。

• ト リ ガー ・ ソース ： 外部 
Trigger Source > Extを押し ます。

• 入力コネ ク ター ： 背面パネルPatt Trig In BNC
Ext Source > Patt Trig In 1を押し ます。
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6. 波形を生成し ます ： Return > ARB Off OnをOnが強調表示される まで押し ます。

7. 関数発生器上で、 外部ゲー ト ・ ト リ ガー用にTTL信号を構成し ます。

8. （オプシ ョ ン） 波形を監視し ます ：

信号発生器および外部 ト リ ガー信号の出力の両方を表示する ためにオシ ロ ス コープを構成し ます。 ゲー
ト がア ク テ ィ ブになっている間に （こ の例では低）、 出力の波形によ る変調を確認でき ます。

次の図は、 デ ィ スプレ イの例を示し ています。

変調波形 RF （無線

外部からのゲー ト 信号 
ゲー ト ・ ア ク テ ィ ブ = 低
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例：外部トリガー
次の例を使用し て、 PATT TRIG IN背面パネルのBNC コネ ク ターにおいて、 TTL状態が低から高への変更が  

発生し た後に、 変調RF信号100 ミ リ 秒出力する よ う に信号発生器を設定し ます。

1. 上記に示されている よ う に、 信号発生器を関数発生器に接続し ます。

2. RF （無線周波数） 出力を設定し ます ：

• 所定の周波数を設定し ます。
• 所定の振幅を設定し ます。
• RF （無線周波数） 出力をオンにし ます。

3. 再生用の波形を選択し ます （シーケン ス またはセグ メ ン ト ） ：

a. Mode > Dual ARB > Select Waveformを押し ます。

b. Segment OnまたはSequence On列で、 波形を強調表示し ます。
c. Select Waveformを押し ます。

4. 波形を生成し ます ： 
ARB Off OnをOnが強調表示される まで押し ます。

5. 次のよ う に波形 ト リ ガーを設定し ます。

a. ト リ ガー ・ タ イプ ： 単一 
Trigger Type > Single > No Retriggerを押し ます

b. ト リ ガー ・ ソース ： 外部 
Trigger Source > Extを押し ます

c. 入力コネ ク ター ： 背面パネルPatt Trig In BNC
Ext Source > Patt Trig In 1を押し ます。

d. 外部 ト リ ガー極性 ： 正 
Ext PolarityをPosが強調表示される まで押し ます

e. 外部遅延 ： 100 ms
More > Ext DelayをOnが強調表示される まで押し ます 

Ext Delay Time > 100 > msecを押し ます

6. 関数発生器を設定し ます ：

• 波形 ： 0.1 Hzの方形波

• 出力レベル ： 3.5V～5V
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波形のクリッピング
高出力ピーク のあ るデジ タル変調信号は、 相互変調歪みを も た らすこ と があ り 、 スペク ト ル再増殖が隣接周
波数バン ド の信号への干渉を も た らすこ と があ り ます。 ク リ ッ ピング関数を使用する と、 IおよびQデータ を

高ピーク の選択されたパーセンテージにク リ ッ ピングする こ と で 高出力ピーク を低減し て、 スペク ト ル
再増殖を低減する こ と ができ ます。

• 電源ピークの構築方法 （186ページ）

• ピークがスペクトル再増殖をもたらす方法 （188ページ）

• クリッピングがピーク対平均電力を減らす方法 （189ページ）

• 円形クリッピングの構成 （192ページ）

• 矩形クリッピングの構成 （193ページ）

図8-8 クリッピングのソフトキー

Mode > Dual ARB > More 

以下の場合のみ使用可能 
クリッピング・タイプ = 
|I|、|Q|

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。
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電源ピークの構築方法
ク リ ッ ピングが高出力ピーク を減少する方法を知るには、 信号を構成する と きに、 ピーク の構築方法を理解
する こ と は重要です。

複数のチャンネルの加算
I/Q波形は、 次の図に示されている よ う に、 複数のチャ ンネルを加算する こ と ができ ます。 い く つかの個別の

チャ ンネル波形において同時に同じ状態 （高または低） のビ ッ ト が発生し た場合、 加算された波形で異常な
高電力ピーク （正または負） が発生する こ と があ り ます。 

チャ ンネル波形のビ ッ ト の高および低状態がラ ンダムで、 一般的にキ ャ ンセル効果を も た らすこ と があ るた
め、 複数のチャ ンネル加算でまれに 高電力ピーク が発生する こ と があ り ます。
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波形のクリッピング
IおよびQ波形の組み合わせ

IおよびQ波形がI/Q振幅器を組み合わせてRF波形を作成する と き、 RFエンベロープの振幅が と な り 、

IおよびQの二乗は常に正値と な り ます。

次の図に示されている よ う に、 IおよびQ波形で同時に正であ る ピークおよび負であ る ピークは互いに相殺さ

れず、 組み合わせて よ り 大き なピーク を形成し ます。
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ピークがスペクトル再増殖をもたらす方法
波形では、 次の図に示されている よ う に、 まれに発生する高電力ピーク によ って、 波形のピーク対平均電力
比が上昇し ます。 

ト ランス ミ ッ ターの電力増幅器の利得が特定の平均電力を提供する よ う に設定されているため、 高ピークは電力
増幅器を飽和させる こ と ができ ます。 これが相互変調歪みを も た ら し、 スペク ト ル再増殖を生成し ます。 ス
ペク ト ル再増殖は、 周波数帯域であ り 、 搬送波の両側に形成され （サイ ド バン ド に類似）、 隣接周波数バン ド
に及びます （次の図を参照）。 ク リ ッ ピングは、 ピーク対平均電力比を減らすこ と でこの問題の解決策を提供
し ます。
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クリッピングがピーク対平均電力を減らす方法
波形を ク リ ッ ピングする こ と で、 ピーク対平均電力を減ら し、 その結果、 スペク ト ル再増殖を低減する こ と
ができ ます。 IおよびQデータ を 高ピーク の選択されたパーセンテージにク リ ッ ピングする こ と で、 波形の

電力ピーク を制限し ます。 信号発生器には、 2つのク リ ッ ピング方法があ り ます ：

• 円形ク リ ッ ピングは、 合成I/Qデータに適用されます （IおよびQデータは均一にク リ ッ プ されます）。

図 8-9 に図示されている よ う に、 ク リ ッ ピング･レベルはベク ト ルのすべての位相で一定であ り 、 ベク ト

ル表示で円と し て表示されます。

• 矩形ク リ ッ ピングは、 個別にIおよびQデータに適用されます。

図8-10（190ページ）に図示されている よ う に、 ク リ ッ ピング･レベルはIおよびQで異なってお り 、 ベク

ト ル表示では矩形と し て表示されます。

円形および矩形ク リ ッ ピングの両方において、 目的は、 スペク ト ル再増殖が低減し、 しかも信号の完全性が
損なわれないレベルまで波形を ク リ ッ ピングする こ と です。図8-11（191ページ）の2つの補完的な累積分布
プロ ッ ト は、 円形ク リ ッ ピングを波形に適用し た後に発生する ピーク対平均電力の低減を示し ています。

ク リ ッ ピング値が低 く なる と、 伝達される ピーク電力も低 く な り ます （よ り 多 く の信号がク リ ッ ピング され
ます）。 殆どの場合、 ピークは、 波形の残 り の部分に実質的に干渉する こ と な く ク リ ッ ピングする こ と ができ
ます。 多 く の場合、 コード化システムに固有のエラー補正が備え られているため、 本来な ら ク リ ッ ピング工
程で失われる可能性のあ るデータ も保持されます。 ただし、 過度な ク リ ッ ピングを行なった場合は、 失われ
たデータ を回復させる こ と はでき ません。 さ まざまな ク リ ッ ピング設定を試し て、 必要なデータ を保持し て
いる と きに、 スペク ト ル再増殖を低減させるパーセンテージを見つけます。

図8-9 円形クリッピング
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波形のクリッピング 
図8-10 矩形クリッピング
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波形のクリッピング
図8-11 ピーク対平均電力の低減
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円形クリッピングの構成
こ の例を使用し て、 円形ク リ ッ ピングを構成し、 波形のピーク対平均電力比への影響を観察し ます。 円形ク
リ ッ ピングは、 合成I/Qデータ を ク リ ッ ピング し ます （IおよびQデータは均一にク リ ッ ピング されます）。 円

形ク リ ッ ピングに関する詳細な情報は、「クリッピングがピーク対平均電力を減らす方法」（189 ページ）を
参照し て く ださい。

注意 ク リ ッ ピングは非可逆的で、 累積されます。 ク リ ッ ピングを適用する前に、 波形フ ァ イルのコ ピー
を保存し ます。

波形ファイルのコピー
1. 信号発生器のフ ァ イルを表示し ます ： File > Catalog Type > More > Volatile Segmentsを押し ます。

2. 波形RAMP_TEST_WFMを強調表示し ます。

3. Copy Fileを押し ます。

4. コ ピーに名前を付け （こ の例では、 名前はMY_TEST_CIRC）、 Enterを押し ます。

円形クリッピングのコピーされた波形ファイルへの適用
1. DUAL ARB Waveform Utilities メ ニューを開き ます ： Mode > Dual ARB > More > Waveform Utilitiesを押    

し ます。

2. フ ァ イルの リ ス ト で、 コ ピーされたフ ァ イルを強調表示し ます （こ の例では、 MY_TEST_CIRC）。

3. CCDFプロ ッ ト を作成し ます ： Plot CCDFを押し ます。 

4. 波形の曲線の形状お よ び位置を観察 し
ます （右側の例では暗い線）。

5. 円形ク リ ッ ピングを開始し ます ： 
Return > Clipping > Clipping Typeを
|I+jQ|が強調表示される まで押し ます。

6. 円形ク リ ッ ピングを80%に設定し ます： 
Clip |I+jQ| To > 80 > %を押し ます。

7. 80%のク リ ッ ピングをIおよびQデータに

適用し ます ： Apply to Waveformを押し ます。

8. CCDFプロ ッ ト を作成し ます （右側の例

を参照） ： Plot CCDFを押し ます。 

9. ク リ ッ ピ ン グ後に波形の曲線を観察 し
ます。 

以前のプ ロ ッ ト と 比べて ピー ク 対平均
電力の低減に注意し て く ださい。

クリッピング前の波形曲線の例

円形クリッピング後の波形曲線の例
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矩形クリッピングの構成
こ の例を使用し て、 矩形ク リ ッ ピングを構成し ます。 矩形ク リ ッ ピングは、 IおよびQデータ を個別にク リ ッ

ピング し ます。 矩形ク リ ッ ピングに関する詳細な情報は、「クリッピングがピーク対平均電力を減らす方法」
（189ページ）を参照し て く ださい。

注意 ク リ ッ ピングは非可逆的で、 累積されます。 ク リ ッ ピングを適用する前に、 波形フ ァ イルのコ ピー
を保存し ます。

波形ファイルのコピー
1. 信号発生器のフ ァ イルを表示し ます ： File > Catalog Type > More > Volatile Segmentsを押し ます。

2. 波形RAMP_TEST_WFMを強調表示し ます。

3. Copy Fileを押し ます。

4. コ ピーに名前を付け （こ の例では、 名前はMY_TEST_REC）、 Enterを押し ます。

矩形クリッピングのコピーされた波形ファイルへの適用
1. DUAL ARB Waveform Utilities メ ニューを開き ます ： Mode > Dual ARB > More > Waveform Utilitiesを押    

し ます。

2. フ ァ イルの リ ス ト で、 コ ピーされたフ ァ イルを強調表示し ます （この例では、 MY_TEST_REC）。

3. CCDFプロ ッ ト を作成し ます ： Plot CCDFを押し ます。 

4. 波形の曲線の形状お よ び位置を観察 し
ます （右側の例では暗い線）。

5. 矩形ク リ ッ ピングを開始し ます：Return > 
Clipping > Clipping Type を |I|,|Q| が強調   

表示される まで押し ます。

6. 80% の ク リ ッ ピングを I データに設定し
ます ： Clip |I| To > 80 > %を押し ます。

7. 40% のク リ ッ ピングを Qデータに設定し

ます ： Clip |Q| To > 40 > %を押し ます。

8. 矩形ク リ ッ ピングを波形に適用し ます ： Apply to Waveformを押し ます。

9. CCDFプロ ッ ト を作成し ます （右側の例
を参照） ： Plot CCDFを押し ます。 

10. ク リ ッ ピ ン グ後に波形の曲線を観察 し
ます。 

以前のプ ロ ッ ト と 比べて ピー ク 対平均
電力の低減に注意し て く ださ い。

クリッピング前の波形曲線の例

矩形クリッピング後の波形曲線の例
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波形のスケーリング
信号発生器は、 波形を再構成する と きに、 補間アルゴ リ ズム （I/Qデータポイ ン ト 間のサンプ リ ング） を使用

し ます。 一般的な波形の場合、 こ の補間によ ってオーバーシ ュー ト する こ と があ り 、 DAC オーバーレ ンジ ・

エラーが生成される可能性があ り ます。 こ の章では、 DACオーバーレ ンジ ・ エラーが発生する仕組みおよび
波形ス ケー リ ングを使用し て これらのエラーを除去する方法を説明し ます。

• DACオーバーレンジ・エラーが発生する仕組み （195ページ）

• スケーリングがDACオーバーレンジ・エラーを排除する仕組み （196ページ）

• MXG/EXG波形スケー リ ングについては、 197ページおよび198ページを参照し て く ださい ：

— 現在再生中の波形を ス ケー リ ングする ための波形ラ ン タ イ ム ・ スケー リ ング

— 現在再生中の波形またはBBG メデ ィ アの再生中でない波形フ ァ イルのいずれかを恒久的にスケー リ ン
グする ための波形ス ケー リ ング

図8-12 スケーリングのソフトキー

各キーの詳細については、44ページで説明
されているキーのヘルプを使用してください。

このメニューの設定は、ファ
イル・ヘッダーに保存できま
す（155ページを参照）。

波形ランタイム・スケーリングについては、
197ページを参照してください。

波形スケーリングについては、198ページを参照してください。
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DACオーバーレンジ・エラーが発生する仕組み

デジ タルIおよびQベースバン ド波形をアナ

ロ グ波形に変換する と き、 信号発生器は補

間 フ ィ ル タ ー を 使用 し ま す。 補間器の ク

ロ ッ ク レー ト は、 ベースバン ド ・ ク ロ ッ ク

のレー ト の4倍であ る ため、 右の図に示され

ている よ う に、補間器は受信ベースバン ド ・

サンプル間のサンプル ・ ポ イ ン ト を計算し

て、 波形を ス ムーズ化し ます。

DACの補間フ ィ ルターによ り 、 ベースバン

ド 波形がオーバーシ ュー ト し ます。 ベース

バン ド 波形に急速立ち上が り エ ッ ジがあ る

場合、 補間フ ィ ルターのオーバーシ ュー ト

が補間さ れたベースバン ド 波形のコ ンポー

ネン ト と な り ます。 こ の応答に よ って、 立

ち上が り エ ッ ジのピーク に リ ッ プルおよび

リ ンギング効果を も た ら し ます。 こ の リ ッ

プルが DAC 範囲の上限をオーバーシ ュー ト

する場合、 補間で誤ったサンプル ・ ポ イ ン

ト が計算さ れ、 リ ッ プルの正し い形を複製

でき な く な り ます （右の図を参照）。 結果と

し て、 信号発生器は DAC オーバーレ ンジ ・

エラーを報告し ます。
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スケーリングがDACオーバーレンジ・エラーを排除する仕組み

スケー リ ングは、 ピーク対平均電力比などの基本形

状および特性を保持し ながら、 ベースバン ド波形の

振幅を減少 さ せます。 補間フ ィ ル タ ーのオーバー

シュー ト に対し て適切な余裕を持たせる ために、 急

速立ち上が り ベースバン ド 波形を十分に ス ケー リ

ングする場合、 補間フ ィ ルターは リ ッ プル効果を含

むサンプル・ポ イ ン ト を計算し て、オーバーレ ンジ・

エラーを除去する こ と ができ ます （右の図を参照）。

スケー リ ングは波形の基本形状を保持し ますが、 過

剰な ス ケー リ ン グは波形の完全性を損な う 可能性

があ り ます。例えば、ビ ッ ト 解像度が低すぎ る場合、

波形が量子化雑音に よ って壊れる こ と があ り ます。

大限の精度を達成し、 動的な範囲を 適化するに

は、 DACオーバーレ ンジ ・ エラーを削除するのに必

要な分だけ波形を ス ケー リ ン グ し ます。 適な ス

ケー リ ングは波形の内容によ って異な り ます。
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波形ランタイム・スケーリングの設定
ラ ン タ イ ム ・ ス ケー リ ングは、 再生中に波形データ を スケー リ ング し ます。 これは保存されたデータに影響
し ません。 ラ ン タ イ ム ・ スケー リ ングをセグ メ ン ト またはスケー リ ングに適用し、 ARBがオンの場合でも オ

フの場合でも ス ケー リ ング値を設定でき ます。 こ の種類のス ケー リ ングは、 DACオーバーレ ンジ ・ エラーを
排除するのに適し ています。 ラ ン タ イ ム ・ スケー リ ング調整は、 累積的ではあ り ません。 スケー リ ング値は、
波形フ ァ イルの元の振幅には適用されます。 ラ ン タ イ ム ・ スケー リ ング設定を保存するには、 保存機能を使
用する方法 （70ページ） と設定をフ ァ イル ・ ヘッ ダーに保存する方法 （157ページ） の 2 つの方法があ り ま

す。 フ ァ イル ・ ヘッ ダーに保存する と、 値が波形フ ァ イル と一緒に保存されます。 保存機能を使用し て保存
を行 う と、 値が現在の装置設定と し て保存されます。

こ の例を使用し て、 現在選択された波形を ス ケー リ ングする方法を学びます。 

1. ス ケー リ ングを適用し たい波形を選択し ます ：

a. Mode > Dual ARB > Select Waveformを押し ます。

b. 目的の波形 （セグ メ ン ト またはシーケン ス） を強調表示し ます。
c. Select Waveformを押し ます。

2. 選択された波形を再生し ます ： ARB Off OnをOnが強調表示される まで押し ます。

3. 波形ラ ン タ イ ム ・ ス ケー リ ング値を設定し ます ： 

a. ARB Setup > Waveform Runtime Scalingを押し ます。 

b. ス ケー リ ング値を入力し ます。

信号発生器は、 新しいス ケー リ ング値を波形に自動的に適用し ます。 1つですべての波形に適切な信

号値はあ り ません。 大の動的範囲を達成するには、 DACオーバーレンジ ・ エラーを も た ら さ ない
大のス ケー リ ング値を使用し ます。 

c. Returnを押し ます。 
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波形スケーリングの設定
波形スケー リ ングは、 波形ラ ン タ イ ム ・ スケー リ ング と は異な り 、 永久的に波形データに影響し、 BBG メデ ィ

アに保存された波形セグ メ ン ト にのみ適用されます。 DAC フル ・ ス ケール (100%) のパーセンテージ と し て、

波形を上または下にス ケー リ ング し ます。 こ の方法を使用し て波形を スケー リ ングする場合、 波形ラ ン タ イ
ム ・ ス ケー リ ング値を変更し て こ のス ケー リ ングに適合させる必要も あ り ます。

ス ケー リ ングする と き、 信号発生器は永久的に波形フ ァ イルのサンプル値を修正し て、 適切なスケー リ ング
値に順応させます。 ス ケー リ ングを開始する と き、 信号発生器は次のア ク シ ョ ンを実行し ます ：

• 波形フ ァ イルの絶対ピーク ・ サンプル値の特定
• フル ・ ス ケールの現在のパーセンテージの決定
• 決定された絶対ピーク ・ サンプル ・ ス ケール値に対し て適切なスケール値比を計算
• 波形フ ァ イルの各サンプルを こ の比率で乗算

波形をスケー リ ングする と き、 部分データ、 損失データ、 またはこれらの両方のデータが作成される こ と があ
り ます。 部分データは、 スケー リ ング値を減少または増加させるたびにほ と んど毎回発生し、 量子化誤差の原
因になる こ と があ り ます。 量子化誤差は、 スケー リ ングを下げた と きによ り 顕著にな り ます。 これはノ イズ ・
フ ロアに近づいてし ま う ためです。 信号発生器が部分データ を切 り 捨てた り 、 スケー リ ング値が 2 の累乗の結

果を使用し て導出される と き、 データが失われます。 これは、 波形を半分にスケー リ ングする と （2の累乗 ：

21 = 2）、 各波形サンプルが1ビ ッ ト 失われる こ と を意味し ます。 波形データの変更は、 補正不能で、 波形の  
歪曲収差の原因になる こ と があ り ます。そのため、スケー リ ングを適用する前に、必ず元のフ ァ イルのコ ピー
を作成し てお く のが 善です。

次の例を使用 し て、 波形ス ケー リ ン グ を波形フ ァ イ ルに適用 し ます。 こ のプ ロ セ ス では工場提供の波形
RAMP_TEST_WFMを使用し ていますが、 どの波形フ ァ イルでも同様です。

波形ファイルのコピー
1. BBG メ デ ィ ア内の波形フ ァ イルを表示し ます ： File > Catalog Type > More > Volatile Segmentsを押し ます。

2. 波形RAMP_TEST_WFMを強調表示し ます。

3. Copy Fileを押し ます。

4. コ ピーに名前を付け （こ の例では、 MY_TEST_SCALと い う 名前を使用）、 Enterを押し ます。

ピーク・サンプル

フル・スケールの85%—プレスケーリング

フル・スケールの60%—ポスト・スケーリング

DACフル・スケール100%

スケーリングされたサンプル値 = スケーリング比プレスケリング・サンプル値

スケーリング比 = 適切なスケーリング値 / 現在のスケーリング値
                          = 60 / 85
                          = 0.70588

波形の各サンプルは、0.70588で乗算され、
ポスト・スケーリング波形振幅の60%になるようにされます。

元のランプ波形 スケーリングされたランプ波形

= サンプル
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波形のスケーリング
スケーリングのコピーされた波形ファイルへの適用

注意 こ のタ イプのス ケー リ ングは非可逆的です。スケー リ ング操作で失われたデータは復元でき ません。
ス ケー リ ングの前に波形フ ァ イルのコ ピーを保存し て く ださい。

1. DUAL ARB Waveform Utilities メ ニューを開き ます ： 

Mode > Dual ARB > More > Waveform Utilitiesを押し ます。

2. BBG メ デ ィ ア ・ セグ メ ン ト ・ フ ァ イルの リ ス ト で、 コ ピーし たフ ァ イル （この例では、 MY_TEST_SCAL）
を強調表示し ます。

3. ス ケー リ ング値を設定し て適用し ます （こ の例では、 70%のスケー リ ングが適用されます）。 

Scale Waveform Data > Scaling > 70 > % > Apply to Waveformを押し ます。
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ベースバンド周波数補正の設定
ベースバン ド周波数補正は、 信号発生器のベースバン ド発生器のオプシ ョ ンに応じ て、 BBG 100 MHz の信  

号帯域幅内で 大±50 MHzのベースバン ド周波数をシフ ト する値を指定し ます。 次の図は、 デュ アルARB再 
生機を使ってコ ン ト ロールにア ク セスする方法を示し ていますが､ARB Setup ソ フ ト キーによ る ア ク セス し た 

場合、 各ARBフ ォーマ ッ ト 内のBaseband Frequency Offsetソ フ ト キーの位置は、 デュ アルARB再生機の場合と  

同じです。

ベースバン ド周波数補正がゼロでなければ、 ハード ウ ェア回転器は、 ベースバン ド信号の位相シフ ト を蓄積
し ます。 こ の残留位相は、 補正値がゼロに戻された後も残 り ます。 こ の位相の蓄積を削除するには、 パーソ
ナ リ テ ィ を再起動するかBaseband Frequency Offset Phase Resetソ フ ト キーを選択し ます。 周波数オフセ ッ ト に    
よ り 位相がゼロであ る と きは、 こ のソ フ ト キーはいつでも グレー ・ ア ウ ト にな り ます。 さ らに、 信号に非ゼ
ロ残留位相があ る際に、 DACオーバーレ ンジ保護機能によ り 、 減少し た内部スケー リ ングが自動的に適用さ

れる よ う にな り ます。 こ の減少し たス ケー リ ングは、 周波数補正がゼロに戻され、 かつ位相が リ セ ッ ト され
る と削除されます。 

図8-13 Dual ARB PlayerのBaseband Frequency Offsetソフトキー

補正機能の一般的な使用法は次の とお り です。

• 任意のLOフ ィ ード スルー （搬送波周波数における搬送信号スプ リ アス） から搬送波を補正
• 外部IおよびQ入力でベースバン ド信号を加算し て、 マルチキ ャ リ ア信号を生成

• 信号発生器のI/Q信号をIF と し て使用

245ページ

ベースバンドに対して、
信号に入力されたベース
バンド周波数補正値を設
定します。

位相蓄積をクリアし、位
相ずれをゼロにします。
ベースバンド信号で突然
位相ずれが不連続になり
ます。

このメニューの設定は、ファ
イル・ヘッダーに保存できま
す（155ページを参照）。

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

245ページ

202ページ

226ページ

194ページ

226ページ
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ベースバンド周波数補正の設定
注記 ベースバン ド周波数補正を変更する と、DACオーバーレンジ状態が発生し、エラー628, Baseband 
Generator DAC over range （ベースバン ド発生器DACオーバーレンジ） が生成される場合があ り    

ます。 信号発生器は、 こ の発生を 小限にする自動スケー リ ング機能を内蔵し ています。 詳細につ
いては、「DACオーバーレンジ条件とスケーリング」（202ページ）を参照し て く ださい。

ベースバン ド 周波数補正値はフ ァ イル ・ ヘッ ダーのパラ メ ーター （155ページ） の一つです。 つま り 、 この
値を波形と と もに保存でき ます。保存された周波数補正値の波形を選択する と、信号発生器は、保存済みフ ァ
イルのヘッ ダー値と一致する よ う に電流値を変化させます。 電流波形に対し て保存されたベースバン ド周波
数補正値がない場合、 信号発生器は、 後に設定された周波数補正値を使用し ます。 

また、 Save機能 （70ページ） を使用し て、 こ の値を、 信号発生器のセ ッ ト ア ッ プの一部と し て保存でき ます。

Save機能で保存されたセ ッ ト ア ッ プを呼び出すと、 ベースバン ド周波数補正値は、 保存済みフ ァ イルのヘッ
ダ値に関係な く 、 現在の機器設定値にな り ます。

LO /キ ャ リ ア ・ フ ィ ード スルーから搬送波を補正するには、次の手順を使用し ます。 この例では、Dual ARB  
Player にあ る工場提供波形SINE_TEST_WFMを使用し ています。 こ の例の出力を表示するには、 信号発生器

のRF （無線周波数） 出力を スペク ト ル ・ アナラ イザーの入力に接続し ます。

1. 波形を選択し て再生し ます。

a. Mode > Dual ARB > Select Waveformを押し ます。
b. Segment On BBG Media列で、 SINE_TEST_WFMを選択し ます。

c. Select Waveformを押し ます。

2. 波形を生成し ます ： ARB Off Onを押し てOnに設定し ます。

3. 搬送信号を設定し ます。

a. 1 GHzの搬送信号を設定し ます。

b. 振幅を0 dBmに設定し ます。
c. RF （無線周波数） 出力をオンにし ます。

4. Mode > Dual Arb > ARB Setup > More > Baseband Frequency Offset > 20 MHzを押し ます。

以下の図に示すよ う に、 変調RF信号は、 こ こ で20 MHzだけ搬送周波数から補正されます。
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ベースバンド周波数補正の設定 
DACオーバーレンジ条件とスケーリング
（0 Hz以外の設定での） ベースバン ド周波数補正を使用する場合、 DAC オーバーレンジ条件を生成し、 これ 
によ り Keysight MXG/EXGがエラーを生成する こ と があ り ます。 周波数補正機能でこの条件を 小限に抑え 

る ために、 Keysight MXG/EXGは、 補正がゼロ以外の数字であれば、 I/Qデータ を1/2の平方根だけスケール 

ダウ ンする自動DACオーバーレ ンジ保護機能を備えています。 この機能によ り 、 必要以上にデータがスケー
リ ング される可能性があ る ため、通常は波形のダ イナ ミ ッ ク ・ レンジが低下し ます。 このこ と は、特に、GSM
などの定振幅信号を使用する場合に顕著にな り ます。

デュ アルARBプレーヤの場合は、 こ の自動オーバーレンジ機能をオフにする こ と ができ ます。オンにする と、
オフセ ッ ト が 0 Hz 以外の値になった場合のみデュ アル ARB 信号に対し てア ク テ ィ ブにな り ます。 デュ アル 

ARB DACオーバーレ ンジ保護機能のコ ン ト ロールは、 図8-14に示すキー ・ パスの通 り です。

ベースバンド周波数補正が 
0 Hzの変調搬送波

ベースバンド周波数補正が 
20 MHzの変調搬送波 変調RF信号

LO/キャリア・フィー

100 MHzのスパンに設定したスペクトル・アナライザー
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ベースバンド周波数補正の設定
図8-14 Dual ARB DAC Over–Range Protectionソフトキーの位置

デュ アルARBプレーヤでは、 過度のスケー リ ングを避ける ため、 あ るいは単に手動でスケー リ ングを実行す

る ために、 こ の機能をオフにし て、 Waveform Runtime Scalingソ フ ト キーを使ってDACオーバーレンジ状態を  
な く し ます。

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

デフォルト設定はオンです。Phase 
NoiseやAWGNがオンの場合（311
ページ参照）、またはベースバンド
周波数補正がゼロ以外の値に設定さ
れている場合のみ利用できます。
ベースバンド周波数補正機能を使用
しながら、手動でスケーリングをコ
ントロールする場合にはオフにしま
す。上記のWaveform Runtime 
Scalingソフトキーを使用してスケー
リングを手動で調整します。
Phase Noise、AWGNおよび
Frequency Offset機能を使って、
DACオーバーレンジ・エラーが発生
しないようにするために使用される
自動内部スケーリングを有効または
無効にします。この自動スケーリン
グは、（特に、一定振幅信号に対し
て）過剰であるため、必要以上のダ
イナミック・レンジを減少させるこ
とができます。
保護を無効にすると、自動スケーリ
ングは発生しないため、Runtime 
Scaling機能を使って、DACのオー
バーレンジを生じない最大スケーリ
ング値を調整しなければなりません。
オーバーレンジ保護は3つの機能での
み作動するため、保護がオンになっ
ている場合でも、3つの機能のうちの
1つがアクティブになるまで、この
キーはグレー表示となります。 

DACオーバーレンジ保護をオフにした場合
は、スケーリング値を小さくしてオーバーレ
ンジ状態を除去します（「波形ランタイ
ム・スケーリングの設定」（197ペー
ジ）を参照してください）。

226ページ
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I/Q変調 
I/Q変調
以下の要因がエラー ・ ベク ト ル振幅の一因になっています ：

• 振幅、 位相における差異、 およびI と Qチャ ンネル間の遅延

• DCオフセ ッ ト

I/Q メ ニューでは、 I/Q信号源と出力を選択する こ と ができ るだけでな く 、 I信号と Q信号の差を補償するため
の調整および校正も行います。

「搬送信号の変調」（60ページ）も参照し て く ださい。
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I/Q変調
図8-15 I/Qディスプレイおよびソフトキー

これらの選択は、 
I/Qルーティングと最
適化グラフィックで
反映されます。208ページ

このパネルは、I/Q信号のルー
ティングおよびI/Q補正の最適化
パスの現在の設定を表示します。

このパネルではI/Q調整の現在のステータスと設定
を表示しています。Page UpとPage Downキーを
使って、これらのパラメーターをスクロールしま
す。グレーは、非アクティブ（オフ）の調整を示
します。

内部で生成され、バーストした変調フォーマットでのみ使用されます。
RFバースト変調器を有効/無効にします。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

各パスには異なる最適値が必要です。 
パスを選択すると、そのパスで必要とさ
れるユニークな最適化の値を選択してい
ます。 
信号発生器は、選択した最適値を両方の
パスに適用します。選択しなったパスは
劣化します。

内部で生成されたQ信号を反転して、I成分がQ成分より90度遅れるよう
にします。

内部I/Qソースに対するRFおよび外部I/Q出力を修正および/または損なう
ために使用することのできる内部I/Q等化フィルターを開きます。

ACP（チャネル外性能）を犠牲にしてにEVM（チャネル内性能）の内部I/Qチャ
ンネルを最適化するか、EVMを犠牲にしてACPを最適化するかを選択します。
EVMは、広遷移帯域の80%ナイキスト・フィルター（100 MHz幅）です。等化
フィルターがアクティブであると、このフィルターはアクティブでなくなります。
ACPも、80%ナイキスト・フィルター（100 MHz幅）ですが、遷移帯域は非常に
狭いため、広帯域信号の画像が小さくなります。このフィルターは、アクティブ
な等化フィルターと内部チャンネル補正フィルター（オンの場合）で組み込ま
れ、その結果、中央部で256タップに切り捨てられます。
SCPIコマンド：
[:SOURce]:DM:INTernal:CHANnel:OPTimization EVM|ACP
[:SOURce]:DM:INTernal:CHANnel:OPTimization?

内部ベースバンド発生器のRFおよびベースバンド振幅の適用、および、現在のRF周波数における
160 MHｚのベースバンド帯域幅の位相補正のオンとオフを切り替えます。
この機能がオンの場合、ベースバンドがオンの間の任意周波数切替には、周波数が指定された最初
の回には、最大3.3 ms（通常）から6.8 msの追加時間がかかります。その後は、その周波数への切
り替えには、最大1.3 msの追加時間がかかります。
最も古い周波数が消去されるまでに、最大1024までの周波数をキャッシュできます。周波数掃引が
アクティブになっていると、最初の一意の1024の周波数の前に計算とキャッシュ処理が発生し、そ
れに以上のすべての一意の周波数は任意周波数切替の特性になります。
I/Q補正最適パスがExt I/Q出力に設定されると、ベースバンド補正のみ適用され、周波数切替え速度
には影響しません。
この補正は、ACP内部I/Qチャンネル最適化フィルターとイコライザー・フィルターがアクティブで
あればこれらに畳み込まれます。その結果、フィルターは256タップまで切り捨てられます。
SCPIコマンド：
[:SOURce]:DM:INTernal:CHANnel:CORRection[:STATe] ON|OFF|1|0
[:SOURce]:DM:INTernal:CHANnel:CORRection[:STATe]?

210ページ
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基本的なデジタル操作 （オプション653/655/656/657） 
I/Q変調 
背面パネルIおよびQ出力の利用

注記 背面パネルのIおよびQコネ ク ターは、 内部BBGを使用し ている間のみ信号出力し ます。

搬送波を変調する こ と に加えて、信号発生器はさ らに、内部で生成されたIおよびQ信号を背面パネルのIおよ

びQ コネ ク ターに送 り ます。 これらの出力信号はポス ト DACであ るため、 アナロ グ形式です。 これらの背面

パネルのIおよびQ信号を使って、 次を行 う こ と ができ ます。

• システムの ト ラ ン ス ミ ッ タ段を駆動する こ と
• I/Q変調器などの個々のアナロ グIおよびQコ ンポーネン ト をテス ト する こ と

• 別の信号発生器にIおよびQ信号を送る こ と

工場出荷時のデフ ォル ト 設定では、 内部で生成されたIおよびQ信号を I/Q変調器、 背面パネルのIおよびQ出

力コネ ク ターに送 り ます。 ただし、 背面パネルの信号を 適化 （校正係数を適用） するには、 外部I/Q出力パ

ス を選択する必要があ り ます。

波形を選択して再生
1. Mode > Dual ARB > Select Waveformを押し ます。

2. 目的の波形を強調表示し ます。
3. Select Waveform > ARB Off On to Onを押し ます。

信号パスを最適化
1. DUTまたは別の信号発生器のいずれかに、背面パネルのIおよびQコネク ターからのケーブルを接続し ます。

ARBをオンにする と、 信号発生器は、 IおよびQ信号を自動的に背面パネルのコネ ク ターに出力し ます。
別の信号発生器に対する IおよびQ入力と し て、 背面パネルのIおよびQ信号を使用でき ます。 MXG/EXG
は、 こ のために、 正面パネル ・ コネ ク ター、 I入力およびQ入力を備えています。

2. I/Q > I/Q Correction Optimized Path > Ext I/Q Outputを押し ます。

パス を 適化する と、 パス ・ イ ンジケーターが緑色に変わ り ます。

工場出荷時のデフォルト設定 - RF（無線周波数）出力パスが

背面パネル I/Qパスが最適化されました

最適化されました
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 基本的なデジタル操作 （オプション653/655/656/657）    
I/Q変調
正面パネル入力の設定
信号発生器は、 正面パネルI入力およびQ入力を通し て、 外部供給アナロ グIおよびQ信号を受け入れます。

外部信号を外部変調源と し て使用するか、 内部ベースバン ド発生器で外部信号を加算する こ と ができ ます。

1. IおよびQ信号を正面パネル ・ コネ ク ターに接続し ます。

a. アナロ グI信号を信号発生器の正面パネルのI Inputに接続し ます。

b. アナロ グQ信号を信号発生器の正面パネルのQ Inputに接続し ます。

2. 正面パネル入力信号を認識する よ う に信号発生器を設定し ます。 

• 搬送波を変調するには

I/Q > I/Q Source > Externalを押し ます。

• 加算し て搬送波を変調するには

I/Q > I/Q Source > Sumを押し ます。

BB GENパスの波形を選択し て再生するには、 150ページを参照し て く ださい。

内部BBG （BB GEN） だけが、IおよびQ信号を背面パネルのIおよびQ出力に送る こ と に注意し て く ださい。

3. 外部I信号およびQ信号のみ （加算な し） を使用し ている場合は、 I/Q変調器をオンにし ます。 
I/Q Off Onを押し てOnに設定し ます。

4. RF （無線周波数） 出力を設定し ます ：

a. 搬送波周波数を設定し ます。

b. 搬送波振幅を設定し ます。

c. RF （無線周波数） 出力をオンにし ます。

信号発生器ディスプレイ：両方のパスは、
I/Q Correction Optimized PathがExt I/Q Output（206ページ
参照）に設定されている場合に校正されます。

注記：最適化されたパスがRFに設定されている場
合、RF（無線周波数）出力パスのみ校正されます。

信号発生器ディスプレイ：両方のRFパスは、
I/Q Correction Optimized PathがRF Output（206ページ
参照）に設定されている場合に校正されます。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 207



基本的なデジタル操作 （オプション653/655/656/657） 
I/Q調整 
I/Q調整
I/Q調整を使って、 IQ信号を補正するか障害を追加し ます。

I/Q > I/Q Adjustments

波形が再生され
ている場合のみ
使用できます。

Q信号振幅を基準にしてI信号振幅を調整します。
これを内部障害として使用するか、外部IおよびQ
出力ケーブルにおけるパスの不規則性に起因して
発生する信号パス損失の差を補償します。

I信号の位相に関連するQ信号
の位相をオフセットします。
ベースバンド直角位相調整キー
は、度単位で校正されます。外
部入力直角位相調整は校正され
ません。 
このキーによって提供される機
能は、I/Q Skewキーが提供す
る機能と同じではありません。

Skewは通常、障害を作成するために、または
大きな帯域信号に対するエラー・ベクトルを減
少させるために、使用されます。
I信号とQ信号の間の相対的な時間遅延補正が
得られます。IおよびQ信号により移動する信号
パスが異なることで、大きな帯域幅の変調信号
における EVMエラーとして現れる時間遅延差
が生じます。 
ベースバンド生成中に I/Q信号で等しい反対時
間遅延（スキュー）を追加すると、時間遅延エ
ラーがなくなり、内部ベースバンド発生器で生
成される信号における遅延を補正します。 

トリガーおよびマーカーを基
準にして、I信号とQ信号両方
の絶対位相を変更します。 
正の値は遅延を追加し、負の
値は信号を進めます。この値
は、RFおよび外部出力信号 
（IおよびQ）上で変調された
ベースバンド信号の両方に影
響します。この設定は、一定
のエンベロープ変調で使用す
ることができず、外部Iおよび
Q入力に影響を与えません。

Offsetsは通常、キャリア・リークを低減するか、キャリア・リークをシミュレートする障害を作成するために使用されます。

Common Mode I/Q Offset Range
これにより、Common Mode I/Q Offsetの調整範囲をCoarse（デフォルト）からFine、またはその逆に変更します。Coarse範
囲は、デフォルトの値2.5 Vに対応します。Fine範囲は、100 mVの値に対応します。
Common Mode I/Q Offset
これにより、IおよびQ信号の両方のDC補正を同時に調整します。
Diff Mode I Offset
これにより、IおよびIバー出力信号のDC補正レベルを調整します。IおよびIバーは独立して調整することができません。
Diff Mode Q Offset
これにより、IおよびIバー出力信号のDC補正レベルを調整します。IおよびIバーは独立して調整することができません。

DC補正値は、ARBから再生されているRMS波
形電圧を基準にして校正されます。158ペー
ジを参照してください。

I/Q減衰器ソフトキーは、RF（無線周波数）出力および
外部I/Q出力へのI/Q信号に影響します。

I/Q最適化パスがExt I/Q Outputに設定され、デジタル変
調パーソナリティがオンになっていると、このソフト
キーはアクティブになります。この減衰は、各パーソナ
リティのArb SetupメニューにあるMod Attenuatorキー
を使っても調整できます。この調整は、I/Q Adjustments 

On/Offキーの影響を受けません。 

Autoモードが選択されると、信号発生器は、現在の条件
に対してI/Q減衰を自動的に最適化します。Manualモー
ドが選択されると、I/Q減衰がアクティブ機能になりま
す。入力した値でI/Q信号の減衰レベルを設定します。

SCPIコマンド（各パーソナリティのコマンドを参照）：
[:SOURce]:RADio:<personality>:IQ:MODulation:ATTen

この機能により、IおよびQの両方を回転して内部I/Qチャンネルの絶対位相の調
整を行い、RF搬送波の相対位相を調整することができます。オプション012で
は、これは、外部LOを使ったユニットのRF位相を調整する唯一の方法です。

注記：I/Q信号は、0以外のすべての
位相補正に対して0.7071だけ縮小さ
れます。I/Qの位相を調整しながら
ALCをオフにして一定パワーレベル
を維持することが望ましい場合は、
-360または+360を使用します。
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 基本的なデジタル操作 （オプション653/655/656/657）    
I/Q調整
I/Q調整、 I/Q遅延は、 障害を追加するためではあ り ません。 その機能は、 EVENT出力信号 （マーカ信号） と、
RF （無線周波数） 出力の間の待ち時間を補償する こ と です。

表8-2 I/Q調節の使用

I/Q調節 効果 機能障害

オフセ ッ ト キ ャ リ ア ・ フ ィ ード ス

ルー

DCオフセ ッ ト

直角位相の角度

EVMエラー フ ェーズ ・ スキ ュー

I/Qイ メ ージ I/Qパス ・ デ ィ レ イ

I/Qスキ ュー EVMエラー

高サンプル ・ レー ト 位相

スキ ューまたはI/Qパ

ス ・ デ ィ レ イ

I/Qゲイ ン ・ バラ ン ス I/Q振幅差 I/Qゲイ ン比

I/Q位相 I/Q位相回転 RF位相調整
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基本的なデジタル操作 （オプション653/655/656/657） 
I/Q校正 
I/Q校正
IおよびQ信号の補正のためにI/Q校正を使用し ます。 IおよびQ信号のどの側面を補正するかは、 信号が内部

または外部で生成されるかによ って変わ り ます。

I/Q校正を実行する と、 その校正データは、 工場供給の校正データ よ り も優先されます。 校正ルーチンは、 時

間経過や温度変化に起因し て低下する可能性のあ る性能を向上させます。I/Q校正は、前回の校正が実行され
た周囲温度から少な く と も±5 °C周囲温度が変化し た と きに実行する必要があ り ます。

• ユーザーのI/Q校正は永続的です （つま り 、 機器プ リ セ ッ ト をオスか出力を周期変動させて も メ モ リ ーか

らユーザー I/Q校正は削除されません）。

• 開始および停止の周波数が同じ値に設定される と、 校正はその周波数で正確に実行され、 データは境界
校正配列要素に保持されます。

補正 内部IおよびQ 外部IおよびQ

オフセ ッ ト X X

ゲイ ン ・ バラ ン ス X X

直角位相エラー X X
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 基本的なデジタル操作 （オプション653/655/656/657）    
I/Q校正
I/Q > I/Q校正

以下の場合のみ使用可能 
校正タイプ = ユーザー

DCは、現在の機器設定に対するI/Q性能を最適化し、通常
は、数秒で完了します。DC校正を実行した後に機器の設
定を変更すると、DC校正が無効になり、信号発生器が
ユーザー校正データ（ユーザー校正データがない場合は、
工場供給校正データ）に戻ります。
Userは、フル校正が不要な際に迅速な校正を行います。
校正の開始周波数と停止周波数を指定することで、校正を
制限することができます。 
校正を機器の全頻度範囲未満に制限すると、工場供給校正
データが残りの範囲で使用されます。開始および停止の周
波数が同じ値に設定されると、校正はその周波数で正確に
実行され、データは境界校正配列要素に保持されます。情
報は、プリセットまたはパワー・サイクルを通して保持さ
れます*。
Fullは、約1分かかり、機器の全頻度範囲にわたって測定
を実行します。 
情報は、プリセットまたはパワー・サイクルを通して保持
されます*。
*注意： 
不揮発性メモリーに永続的に保存されていないデータ、
GPIB設定または現在のユーザーの機器状態が消失するこ
とを防ぐため、信号発生器は、必ず正面パネルの電源ボタ
ンまたは適切なSCPIコマンドから電源オフしてください。
ラック・システムに設置された信号発生器は、機器の正面
パネル・スイッチではなくシステム・ラック電源スイッチ
で電源オフされると、機器が適正に電源オフされなかった
ために、Error-310が表示されます。

ユーザーが生成した校正
データを削除し、工場供給
校正データを復元します。

注記
DC校正では、以下の設定が必要です。
•I/Q：オン
• 最適化パス：RF（無線周波数）出力
• ソース：内部

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。
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基本的なデジタル操作 （オプション653/655/656/657） 
等化フィルターの使用 
等化フィルターの使用
等化FIRフ ァ イルは、 外部で作成し、 SCPI経由でア ッ プロード し、 続いてフ ァ イル ・ システムから選択でき

ます （「ファイルによる操作」（62ページ）を参照し て く ださい）。 FIRフ ァ イル係数のダウ ン ロード に関する

情報については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。 FIRフ ァ イル係数を使って手動で作業す
る こ と についての情報は、「FIR表エディターを使用したFIRフィルターの変更」（220ページ）を参照し て く だ

さい。

こ のフ ィ ルターは、 内部I/Q ソースのRFおよび外部I/Q出力の補正および/または劣化に使用する こ と ができ
ます。 こ のフ ィ ルターは （フ ィ ルターが選択される場合）、 ACP Internal I/Q Channel Optimizationフ ィ ル    

ターで畳み込まれ、 その結果が中央の256 タ ッ プに切 り 捨て られます。 等化フ ィ ルターは、 200 MHzで操作 

する ため、 等化フ ィ ルターが他のい く つかの率でサンプ リ ング されていれば、 すべての等化フ ィ ルターは、
選択の前に200 MHzで再サンプ リ ング されなければな り ません。

MXG/EXGは、 サンプル当た り 2つの入力 （I、 Q） と 2つの出力 （I、 Q） でプロ グ ラ ム可能なFIR フ ィ ルター

であ る等化フ ィ ルター （ComplexまたはReal） に対応し ます。 こ の256タ ッ プのフ ィ ルターには、 2つの動作
モード があ り ます。

注記 タ ッ プの 大数は、 等化フ ィ ルターの場合は256 （複合フ ィ ルターの場合は、 1 タ ッ プ当た り 2つの

係数があ り ます） です。 タ ッ プの 小数は2です。

等化フ ィルターは、 プ リ ディ ス ト ーシ ョ ン ・ フ ィルターまたは補正フ ィルターと呼ぶこ と もでき ます。

等化フ ィ ルターを、 オン またはオフにする こ と ができ ます。

フ ィ ルターの

種類

説明

Real IおよびQサンプルは、 単一組の実数によ って独立し てフ ィ ルタ リ ング されます。

Complex サンプルは、 複合 （I + jQ） と し て処理され、 時間領域で （I + jQ） と し て指定される フ ィ ルター係

数で組み込まれます。 
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 基本的なデジタル操作 （オプション653/655/656/657）    
等化フィルターの使用
図8-16 内部等化フィルター・ソフトキー

I/Q > More
各キーの詳細については、44ページ
で説明されているキーのヘルプを使
用してください。

SCPIコマンド：
等化フィルターの状態：[:SOURce]:DM:INTernal:EQUalization:FILTer:STATe { OFF } | 
ON [:SOURce]:DM:INTernal:EQUalization:FILTer:STATe? 
等化フィルターの選択：
[:SOURce]:DM:INTernal:EQUalization:FILTer:SELect "filename" 
[:SOURce]:DM:INTernal:EQUalization:FILTer:SELect? 
ファイル・システムに実際のフィルターを追加するには：
:MEMory:DATA:FIR "filename", [REAL,] osr, coeff1 [,coeff2 […, coeffN]] 
:MEMory:DATA:FIR?"filename" 
ファイル・システムに複合型フィルターを追加するには： 
:MEMory:DATA:FIR "filename", COMPlex, osr, hIRe0, hQIm0 [, hIRe1, hQIm1 […, 
hIReN, hQImN]] 
:MEMory:DATA:FIR?"filename"
ファイル・システムにI/Q記号データを追加するには： 
:MEMory:DATA “WFM1:filename", <blockdata>

215ページ

等化フィルターとして選択するには、FIRフィルターのファイル・カタログを開きます。等化
フィルターは、一般的に複合型であり、オーバーサンプリング率が1でなければなりません。
フィルターには、256を超えるタップをもっていてはなりません（複合フィルターの場合は
512係数）。等化フィルターは、200 MHzで操作するため、信号発生器に設置する前に、すべ
ての等化フィルターを200 MHzで再サンプリングなければなりません。

内部等化フィルターを有効にします。

SCPIコマンドの詳細については、『SCPI 
Command Reference』を参照してください。

205ページ

注記：
フィルターの係数を表示するには、FIRテーブル・エディター
を使用します。220ページを参照してください。
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デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用 
デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)
フィルターの使用
有限イ ンパルス応答(FIR)フ ィ ルターは、 単一搬送波I/Q波形を単にI/Qコ ン ス タ レーシ ョ ン ・ ポイ ン ト まで圧

縮し、 次にArb Customの変調フ ィ ルターと同様の遷移を定義するために使用でき ます （「カスタム変調によ 
る有限インパルス応答（FIR）フィルターの使用」（354ページ）を参照し て く ださい）。 デュ アルARB リ アル
タ イ ム変調の重要な違いは、波形データそのものではな く 、波形再生と してフ ィ ルターが適用される こ と です。 

図8-17 フィルター・メニュー
Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter >

このソフトキーは、選択されたフィルター 

タイプによって変わります。

フ ィ ルターにRoot Nyquist
またはNyquistが選択された 

場合のみ使用可能です

フィルターにGaussianが選択
された場合のみ使用可能です

220ページ

215ページ

各キーの詳細については、44ページで説明されているキーの
ヘルプを使用してください。

IS-95フィルター選
択メニューを開き
ます。

変調フィルターを有効または無効にします。このフィルターは通常、単にI/Q記号判定ポイントを含むARB波形に適用されます。変調フィル
ターは次に、記号判定ポイント間の遷移を有効に定義します。つまり、フィルターには2以上のオーバーサンプリング率がなければなりませ
ん。この機能がアクティブであると、サンプル・クロック率は、実際にはシンボル・レート
です。また、フィルターは実数である必要があります（224ページを参照してください）。

212ページ
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 基本的なデジタル操作 （オプション653/655/656/657）    
デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用
FIR表エディターを使用してユーザー定義FIRフィルターを作成
こ の手順では、 FIR Values表エデ ィ ターを使用し て、 オーバーサンプ リ ング率4の8シンボル ・ ウ ィ ン ド
ウ化同期関数フ ィ ルターを作成し て保存し ます。

表エディターへのアクセス
1. Presetを押し ます。

2. Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Select > Nyquistを押し ます。

3. Define User FIRを押し ます。 

4. More 1 of 2 > Delete All Rows > Confirm Delete of All Rowsを押し ます。 

これによ り 、 図8-18で示すよ う に、 表エデ ィ ターを初期化し ます。

図8-18 FIRフィルター表エディターを使用してユーザー定義FIRフィルターを作成
Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > 
Define User FIR > More 1 of 2 > Delete All Rows > Confirm Delete of 
All Rows

保存したファイルを選択し
て揮発性メモリーにロード
することのできるメニュー
を開きます。45ページを参
照してください。

221ページ

次の場合のみアクティブ
になります：
FIRフィルター係数表に、
2つ以上の値が表示され
ています。

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。

フィルターの虚数係数を
指定する列を追加しま
す。*（虚数係数はすべ
て、最初は0です。）
Convert to Complex Filter
ソフトキーが選択される
と、Convert to Real Filter
ソフトキーが使用可能に
なります。 
注意：Convert to Real 
Filterソフトキーを選択す
ると、虚数値列が削除さ
れ、虚数値がなくなり 
ます。

注記：
変調フィルターは実数であり、オーバーサンプリング率(OSR)が2以上である必要があります。
等化フィルターは通常複合型であり、オーバーサンプリング率(OSR)が1である必要があります。
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基本的なデジタル操作 （オプション653/655/656/657） 
デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用 
係数値の入力
1. Returnソ フ ト キーを押し て、 表エデ ィ ターの 初のページに移動し ます。 

2. カーソルを使用し て、 係数0のValueフ ィ ール ド を強調表示し ます。 

3. テンキーパッ ド を使用し て、表8-3から 初の値(0.000076)を タ イプし ます。 数字キーを押す と、 数字が
ア ク テ ィ ブ・エン ト リ ー領域に表示されます。（ ミ ス を し て もbackspace・ キーを使用し て訂正でき ます。）

4. ステ ッ プ1の表から、 すべての16の値が入力される まで、 係数値の入力を続けます。

表 8-3

係数 値 係数 値

0 0.000076 8 0.035667

1 0.001747 9 0.116753

2 0.005144 10 0.157348

3 0.004424 11 0.088484

4 0.007745 12 0.123414

5 0.029610 13 0.442748

6 0.043940 14 0.767329

7 0.025852 15 0.972149
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 基本的なデジタル操作 （オプション653/655/656/657）    
デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用
最初の16の係数の、Mirror Tableを使用するコピー

ウ ィ ン ド ウ化されたシン ク関数フ ィ ルターでは、 後半の計数は前半の係数と逆順で同一になっています。 信
号発生器は、 既存の係数値を逆順に自動コ ピーする、 鏡像表機能を備えています。

1. Mirror Table を押し ます。 図8-19（217ページ）で示すよ う に、 後の16個の係数 （16～31） は自動的に 

生成され、 これらの う ち 初の係数 （16番） は強調表示されます。 

図8-19

FIR表係数値は、工場出荷時の
デフォルト値である場合もあ
り、ユーザーにより入力された
値である場合もあります。

Goto Rowメニューを使用し
て移動し、FIR値係数表に
対する変更を行います。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。
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基本的なデジタル操作 （オプション653/655/656/657） 
デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用 
オーバーサンプリング率の設定

注記 変調フ ィ ルターは実数であ り 、 オーバーサンプ リ ング率 （OSR） が2以上です。

等化フ ィ ルターは通常複合型であ り 、 OSRが1であ る必要があ り ます （「等化フィルターの使用」
（212ページ）と「リアルタイム変調フィルターの設定」（224ページ）を参照し て く ださい）。 

オーバーサンプ リ ング率 （OSR） は符号ご と のフ ィ ルター係数の数値です。 指定でき る値の範囲は1～32で
す。 表エデ ィ ターで認められる タ ッ プの 大数は1024です。 

OSR、 係数の数、 およびシンボル数に対する実際の限界は、 FIRが使用する機能によ って変わ り ます。 表8-4
を参照し て く ださい。

変調フ ィ ルターの場合、 オーバーサンプ リ ング率が内部の 適に選択された もの と異な るのであれば、 フ ィ
ルターが自動で 適オーバーサンプ リ ング率に リ サンプ リ ング されます。

こ の例では、 所定のOSRは4であ り 、 こ の値はデフ ォル ト 値なので、 何ら ア ク シ ョ ンは必要あ り ません。

表 8-4

フ ィ ルター ・

タ イプ

オーバーサンプ リ ング率
(OSR)

タ ッ プ数

（ 大値）

シンボル/係数 

（ 大値）

等化a

aI/Qタイミング・スキュー、I/Q遅延、またはACP内部I/Qチャンネルの最適化機能がアクティブ
であれば、等化フィルターに対するタップの有効数は減ります。

1 256 - -

ARBカス タ ム

変調b

bフィルターは、より高いまたはより低いOSRにサンプリングされる場合があります。

2 - - 512/1024

デュ アルARB
リ アルタ イ ム

変調c

cフィルターは、シンボル・レートによって16以下のOSRに間引かれます。

2 - - 32/1024
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 基本的なデジタル操作 （オプション653/655/656/657）    
デュアルARBリアルタイム変調フィルターでの有限インパルス応答(FIR)フィルターの使用
フィルターのグラフ表現の表示
信号発生器には、 フ ィ ルターを時間と周波数次元の両方でグ ラ フ表示する機能があ り ます。

1. More 1 of 2 > Display Filter > Display FFT を押し ます （高速フー リ エ変換）。 

図8-20（219ページ）を参照し て く ださ い。

図8-20

2. Returnを押し ます。

3. Display Impulse Responseを押し ます。 

図8-21を参照し て く ださい。

図8-21

4. Return を押し て、 メ ニュー ・ キーに戻 り ます。

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。
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基本的なデジタル操作 （オプション653/655/656/657） 
FIR表エディターを使用したFIRフィルターの変更 
フィルターのメモリーへの保存
次のステ ッ プを使用し てフ ァ イルを保存し ます。

1. Load/Store > Store To Fileを押し ます。 FIRフ ァ イルのカ タ ロ グが、 メ モ リ ーの使用可能量と一緒に表示さ    
れます。

2. 波形セグメントの保存、読み込み、および再生 （148ページ） に記載する よ う に、 こ のフ ァ イルに

FIR_1と い う 名前をつけて保存し ます。

フ ァ イルFIR_1は リ ス ト される1番目の名前です。 （以前に他のFIRフ ァ イルを保存し ていた場合には、 追加さ

れる フ ァ イルの名前はFIR_1の下に リ ス ト されます。） フ ァ イル ・ タ イプはFIRで、 フ ァ イルのサイ ズは260バ

イ ト です。 メ モ リ ーの使用量も表示されます。 保存可能なフ ァ イル数は、 フ ァ イルの大き さ と使用済みの メ
モ リ ー量によ り ます。 図8-22を参照し て く ださい。

図8-22

メ モ リ ーは、 機器ステー ト ・ フ ァ イル と リ ス ト 掃引フ ァ イルによ り 共有されます。

これで、 こ のフ ィ ルターは変調フ ォーマ ッ ト のカス タマイ ズに使用でき、 または、 新しいフ ィ ルター設計の
基礎と し て も使用でき ます。 

FIR表エディターを使用したFIRフィルターの変更
信号発生器に保存されたFIR フ ィ ルターは、 FIR表エデ ィ ターを使用し て、 容易に変更する こ と ができ ます。
FIR表エデ ィ ターは、 不揮発性 メ モ リ ーに保存さ れたユーザー定義FIRフ ァ イルか ら の係数値、 ま たは、 デ

フ ォル ト のFIRフ ィ ルターの1つからの値と一緒にロードする こ と ができ ます。 次に値を変更し て新しいフ ァ

イル と し て保存でき ます。 

カタログは、ユーザーにより以前に保
存されたFIRファイルを表示します。

これらのキーは、内部スト
レージにあるDMODファイル
の表を管理します。

各キーの詳細については、44ページで説明されているキーのヘ
ルプを使用してください。
220 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 基本的なデジタル操作 （オプション653/655/656/657）    
FIR表エディターを使用したFIRフィルターの変更
デフォルト・ガウスFIRファイルの読み込み

図8-23 デフォルト・ガウスFIRファイルの読み込み

1. Presetを押し ます。

2. Mode > Dual ARB > Arb Setup > More > Real-Time Modulation Filter > Define User FIR > More > Load Default FIR > 
Gaussianを押し ます。

3. Filter BbT > 0.300 > Enterを押し ます。

4. Filter Symbols > 8 > Enterを押し ます。

5. Generateを押し ます。 

注記 変調中の実際のオーバーサンプ リ ング率は、 装置によ り 自動的に選択されます。 シンボル ・ レー ト 、
変調タ イプの符号ご と のビ ッ ト 数、 および、 符号数に応じ て、 4から16の間の値が、 選択されます。

6. Display Filter > Display Impulse Response （図8-24を参照） を押し ます。

Mode > Dual ARB > Arb Setup > More > Real-Time 
Modulation Filter

これらのソフトキーは、
フィルター用のウィンドウ
機能（アポディゼーション
機能）を選択します。

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。
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基本的なデジタル操作 （オプション653/655/656/657） 
FIR表エディターを使用したFIRフィルターの変更 
図8-24

7. Returnを押し ます。

係数の変更
1. 正面パネルの矢印キーを使用し て、 係数15を強調表示し ます。

2. 0 > Enterを押し ます。

3. Display Impulse Responseを押し ます。

図8-25

図8-25 を参照し て く ださい。 グ ラ フ ィ ッ ク ・ デ ィ スプレ イは、 便利な ト ラブルシ ューテ ィ ング ・ ツール

を提供する こ と ができ ます （こ の例では、 係数値が抜けている ため、 結果 と し て不適切なガウ ス応答 と
なった こ と を示し ています）。

4. Returnを押し ます。

5. 係数15を強調表示し ます。 

6. 1 > Enterを押し ます。 

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。
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 基本的なデジタル操作 （オプション653/655/656/657）    
FIR表エディターを使用したFIRフィルターの変更
フィルターのメモリーへの保存
大のフ ァ イル名長は23文字 （英数字と特殊文字） です。

1. Return > Return > Load/Store > Store To Fileを押し ます。 

2. フ ァ イルに、 NEWFIR2 と い う 名前を付けます。

3. Enterを押し ます。 

現在の FIR 表エデ ィ ターの内容は、 不揮発性 メ モ リ ー内のフ ァ イルに保存され、 カ タ ロ グ ・ フ ァ イルは新し
いフ ァ イルを表示する よ う に更新されます。 
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基本的なデジタル操作 （オプション653/655/656/657） 
リアルタイム変調フィルターの設定 
リアルタイム変調フィルターの設定
リ アルタ イ ム変調フ ィ ルターは、 単一搬送波I/Q波形を単にI/Qコ ン ス タ レーシ ョ ン ・ ポイ ン ト まで効果的に

圧縮し、 次にARBカス タ ム変調の変調フ ィ ルターと同様の遷移を コ ン ト ロールし ます。 重要な違いは、 フ ィ

ルターを波形データ自体では適用せず、波形の再生時に適用する こ と です。 リ アルタ イ ム変調フ ィ ルターは、
デュ アルARB波形でのみ使用でき ます。

リ アルタ イ ム変調フ ィ ルターがオンの場合、 サンプル ・ ク ロ ッ ク ・ レー ト がシンボル ・ レー ト と し て作用し
ます。 リ アルタ イ ムARB変調フ ィ ルター機能をオンにするには、 サンプル ・ ク ロ ッ ク ・ レー ト をサンプ リ ン
グ ・ レー ト の半分に設定する必要があ り ます。 サンプル ・ レー ト は、 オプシ ョ ン 65Xベースバン ド発生器に

よ り 決定されます。

注意 シンボル決定ポイ ン ト を定義する ための矩形I/QデータはARPフ ォーマ ッ ト のみ対応し ているため、
振幅と位相と し て指定する定包絡線変調には対応し ていません。 （定包絡線変調の例と し て、 MSK
と FSKがあ り ます。）

搬送波周波数は、 使用されるすべての周波数で同じにする必要があ り ます （つま り 、 単一の搬送波
アプ リ ケーシ ョ ンは、 ARB リ アルタ イ ム変調フ ィ ルターで動作し ます）。

図8-26 Dual ARB Playerのリアルタイム変調フィルター・ソフトキー

214ページ

このメニューの設定は、ファイ
ル・ヘッダーに保存できます
（155ページを参照）。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

Mode > Dual ARB > Arb 
Setup > More 

これらは、波形に適用できる利
用可能なリアルタイム変調フィ
ルターです。
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 基本的なデジタル操作 （オプション653/655/656/657）    
複数ベースバンド発生器の同期化
リ アルタ イ ム変調機能の一般的な使用法は次の とお り です。

• 単一搬送波の理想的な直交I/Qシンボル決定ポイ ン ト が既知で、 シンボル決定ポイ ン ト にオーバーサンプ
リ ング ・ フ ィ ルターが適用される場合。 

• よ り 大き な有効MXG/EXG メ モ リ ー ・ サイ ズが必要な場合。

• 低レー ト の波形があ り 、 OSRが高い方が、 波形が長 く な ら ないのでよい場合。

リ アルタ イ ム変調フ ィ ルター ・ セ ッ ト ア ッ プはフ ァ イル ・ ヘッ ダーのパラ メ ーター （155ページ） の一つで

す。 つま り 、 こ のセ ッ ト ア ッ プを波形と と もに保存でき ます。 保存された変調フ ィ ルター ・ セ ッ ト ア ッ プの
波形を選択する と、 信号発生器は、 保存済みフ ァ イルのヘッ ダー ・ セ ッ ト ア ッ プ と一致する よ う に電流セ ッ
ト ア ッ プを変化させます。 電流波形に対し て保存された変調フ ィ ルター ・ セ ッ ト ア ッ プがない場合、 信号発
生器は、 後に設定された変調フ ィ ルター ・ セ ッ ト ア ッ プを使用し ます。 

また、 Save機能 （70ページ） を使用し て、 こ の値を、 信号発生器のセ ッ ト ア ッ プの一部と し て保存でき ます。

Save機能で保存されたセ ッ ト ア ッ プを呼び出すと、 変調フ ィ ルター値は、 保存済みフ ァ イルのヘッ ダ値に関

係な く 、 現在の機器設定値にな り ます。

次のステ ッ プを使って、 揮発性 メ モ リ ーに読み込まれた電流波形に リ アルタ イ ム変調フ ィ ルターを適用し ま
す。 こ の例では、 Dual ARB Playerにあ る工場提供波形SINE_TEST_WFMを使用し ています。 この例の出力  

を表示するには、 信号発生器のRF （無線周波数） 出力を スペク ト ル ・ アナラ イザーの入力に接続し ます。

注記 次のセ ッ ト ア ッ プでは、 搬送波周波数から20 MHzだけ補正された変調RF信号を生成するために
「ベースバンド周波数補正の設定」（200ページ）でセ ッ ト ア ッ プを完了し た もの と仮定し ます。

1. 変調フ ィ ルターを設定し ます ：

Mode > Dual ARB > Arb setup > More > Real-Time Modulation Filter > Select > Root Nyquistを押し ます。

2. Filter Alpha > .4 > Enterを押し ます。

これで、 変調RF信号に対し て、 フ ィ ルター が0.400、 タ イプRoot Nyquistの リ アルタ イ ム変調フ ィ ル
ターが設定されま し た。

複数ベースバンド発生器の同期化
デュアルARBメ ニューで利用でき る この機能によ り 、 大16のKeysight MXG/EXGsのマス ター /ス レーブ ・ シ 
ステムが設定でき る ため、 ベースバン ド発生器(BBG)で波形の再生を同期でき ます。 システム ・ カ ウ ン ト に

は、マス ター と し て機能するKeysight MXG/EXGを1つ含みます （「機器セットアップ」（229ページ）を参照）。

オプシ ョ ン012のMXG/EXGによ り 、 2×2、 3×3、 または4×4のMIMO構成が位相干渉システムを作成する共通
の外部LO信号を共有でき ます。「オプション012（位相干渉性に対するLO イン/アウト）の概要 （複数ベー  
スバンド発生器の同期化）」（232ページ）とデータ ・ シー ト を参照し て く ださい。
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図8-27 複数ベースバンド発生器同期化（BBG同期化）のトリガー・ソフトキーとメニューの位置

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。

スレーブ機器ではグレー・アウ
トします。マスター機器ではア
クティブなままです。

227ページを参
照してください 

BBG同期では、現在の設定がFree RunまたはGatedであれば、トリ
ガー・タイプをTrigger and Runに自動的に変更します。必要に応じて、
BBG同期セットアップ・パラメーターを設定する前か後に、マスターま
たはスレーブのいずれか、またはその両方に対して別々に設定します。

Free RunとGatedは、BBG同期を使用している際は選択できません。

マスターのデフォルト設定。
必要に応じて、機器をマス
ターとして指定した後に、こ
れらの設定を変更します

スレーブのデフォルト設定。
これらの設定は、機器をス
レーブとして選択した後にア
クセスできません。

注記：BBG同期化機能により、以下に示すトリガー設定を自動的に構成します。このプロセスの設定競合エラーを回避するた
めに、227ページで示したBBG同期化パラメーターを設定する前に、トリガー設定を手動で構成してください。

148ページを参照
してください 

178ページを参照
してください 

Negは工場出荷時のデフォルト設定
です。スレーブ選択でPosに変更し
ます。必要に応じて、スレーブとし
て選択する前にPosに手動で変更し
ます。

注記：マスター /スレーブの選択時に以下
のトリガー設定が真であれば、設定競合エ
ラーが発生します。
マスター・ステーション
• Free RunまたはGatedトリガー・タイプ
スレーブ・ステーション
• Free RunまたはGatedトリガー・タイプ
• Ext Polarity Negトリガー・ソース
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図8-28 マルチBBG同期化正面パネル・ディスプレイ

各キーの詳細については、44ページで説明され
ているキーのヘルプを使用してください。

マスター・ディスプレイと使用可能なソフトキー

スレーブ・ディスプレイと使用可能なソフトキー

Off、Master、またはSlaveを選
択します。

システム内のすべての機器に対し
てベースバンド発生器を同期化し
ます。 

注記：スレーブ装置のListen for 
Syncを押した場合のみ押し、ス
レーブがステータスとして
「Waiting For Sync（同期待ち）」を
表示します。

マスターは、次のいずれかのメッセージを表
示します。
• Out of Sync（同期がずれています）
• In Sync（同期中です）

Sync Slavesを押した後に表示されます

マスター /スレーブのインジケー
タとセットアップ図。 

押した後、スレーブは、マスターに
よって開始される同期化信号を待ち
ます。

注記：マスター装置でSync 
Slavesを押す前に押します。

スレーブは、次のいずれかのメッセージを表示します。
• Out of Sync（同期がずれています）
• Waiting for Sync（同期待機中です）

Listen for Syncを押した後に表示します
• In Sync（同期中です）
マスターのSync Slavesを押した後に押します。

マスター /スレーブのインジケータとセッ
トアップ図。下部のスレーブ・インジ
ケータは、システムの最後のスレーブで
緑色になります。

Off、Master、またはSlaveを選
択します。

これは、プリセットと電源の再投
入の両方で持続する永続的な設定
です。

プリセットと電源の再投入の両方
で持続する永続的な設定です。

マスターでグレー・アウトし、ス
レーブでアクティブになります。

Mode > Dual ARB > Arb Setup > More > 
Multi-BBG Sync Setup
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マスター /スレーブ・システムの概要

システム遅延
マルチBBG同期化機能は、 マス ターと 後のス レーブ間の±8ナノ秒の特性値の範囲内に 大16個の信号発生器

の波形生成機能を同期させるためのシステムを提供し ます。 この少量の遅延 （±8 ns） は、 I/Q メ ニューにある 

I/Q Delay ソ フ ト キーを使って、 ピ コ秒までさ らに減らすこ と ができ ます。 遅延を減らすには、 システム内の各 
信号発生器のBBG信号配置を確認し て調整し ます。 遅延の調整の詳細については、「I/Q調整」（208ページ）
を参照し て く ださい。

遅延値には、 EVENT 1 と PAT TRIGコネ ク ター間の1 ns未満の伝搬遅延のケーブルに対する補償を含みます （機   
器セットアップを参照）。 推奨される ケーブルは、 Keysight BNCケーブル （部品番号10502A） です。 伝搬遅 

延の大き なケーブルを使用する と、 信号発生器が正常に同期できな く な る こ と があ り ます。

システム同期化
マス ター信号発生器がシステム内の各ス レーブを通って、 さ ら に各ス レーブまで伝搬する1回限 り のイベン
ト ・ パルス を送信し た後に同期化が行われます。 こ のイベン ト の前に、 各ス レーブは、 システム構成中に発
生する こ のイベン ト ・ パルス を待っている こ と を認識し なければな り ません （「セットアップの構成」（229
ページ）を参照）。 同期化パルス を適切に送信する ために、 各信号発生器の ト リ ガー ・ ソースおよびデュ アル
ARBプレーヤをオフにする必要があ り ます。

マス ター/ス レーブのセ ッ ト ア ッ プでは、ス レーブ と マス ターと し て選択された信号発生器間にフ ィ ード バッ
ク ・ システムが組み込まれていません。 同期化後、 マルチBBG同期設定 メ ニューに変更があ るか、 信号発生

器がシステムに追加されて も、 マス ターはセ ッ ト ア ッ プを自動的に再同期し ません。 これによ り 、 システム
内の信号発生器がそのステータ ス をIn Syncと し て誤って報告する こ と があ り ます。 

システムはまた、 他の信号を同期化パルス と し て誤って解釈する可能性があ り 、 こ の場合、 In Syncが誤っ 
たステータ ス と な り ます。 これらのタ イプの信号には、 連続 ト リ ガーまたはEVENT 1コネ ク ターに送られる 

ア ク テ ィ ブなマーカーが含まれます。 背面パネル ・ ケーブルが不適切に接続されているため、 偽のステータ
ス を作 り 出す可能性も あ り ます。

マルチBBG同期セ ッ ト ア ッ プ ・ メ ニューの1つまたはそれらすべてで変更を行った後、 信号発生器をシステ

ムに追加し た後、 または信号発生器の真のステータ スに疑問があ る場合は、 システム全体を再同期する必要
があ り ます。 波形フ ァ イル、 デュ アルARB状態、 サンプル ・ レー ト 、 スケー リ ング、 搬送波波周波数または
振幅と いったマルチBBG同期セ ッ ト ア ッ プ ・ メ ニュー以外のパラ メ ーター変更し て も、 システム同期化に影

響を及ぼし ません。 システムを再同期するには、「複数同期化設定の変更とマスター /スレーブ・システムの
再同期化」（231ページ）を参照し て く ださい。

システム・トリガー・セットアップ
マルチBBG同期化機能は、 各信号発生器の ト リ ガーの選択を制限し ます （226ページを参照）。 ス レーブ と

し て選択された信号発生器の場合、 ト リ ガー ・ タ イプ （制限付き） のみ変更でき ます。 ト リ ガー ・ ソースは
固定され、 背面パネルPAT TRIGコネ ク ターから ト リ ガーを受信する よ う に設定されます。 マス ターでは、 ト

リ ガー ・ タ イプ （制限付き） と ト リ ガー ・ ソースの両方を変更する こ と ができ ます。 ト リ ガー ・ ソースに
は、 波形を ト リ ガーする3つのオプシ ョ ンが用意されています ： 外部 ト リ ガー、 正面パネルのTriggerキー、

またはGPIB ト リ ガー。
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ト リ ガー設定は、 BBG同期化機能がサポー ト する もの以外であれば、 ト リ ガー設定を 226ページで示される
ものに機能で変更し ます。 こ の変更が行われる と、 Keysight MXG/EXGは、 変更を警告するために、 設定競 

合エラーを生成し ます。 エラーの発生を避け るために、 信号発生器をマス ターまたはス レーブ と し て選択す
る前に ト リ ガー設定を適切に行って く ださ い。

システム ・ ト リ ガーは、 マス ターによ って開始される同期化パルス と同様に伝搬し ます （システム同期化を
参照）。 そのため、 同期化パラ メ ーターの変更時にオフ されていなければ、 偽のIn Syncステータ ス を生じ 

る可能性があ り ます。

マルチBBG同期化機能をオフにする と、 信号発生器は、 ト リ ガー ・ パラ メ ーターを リ セ ッ ト し ません。 この
機能を無効にし た後に波形を再生するには、 ト リ ガー ・ タ イプをFree Runに設定するか、 波形再生を開始す 

る ための ト リ ガーを提供する必要があ り ます。

機器セットアップ

図8-29 複数ベースバンド同期化セットアップ

セットアップの構成

共通パラメーターの設定
すべての信号発生器で次の手順を実行し ます。

1. 搬送信号の周波数を設定し ます。

2. 搬送信号の出力レベルを設定し ます。

3. 適切な波形を選択し ます （148ページを参照）。

デュ アルARBをオンにし ないで く ださい。

セットアップでは、 
1から15までのスレー
ブがある可能性があ
ります。 

トリガー・キーを使用していない場合は、外部トリ
ガー・ソースを提供します。PAT TRIGコネクターの
詳細については、17ページを参照してください。

PAT TRIG

PAT TRIG

PAT TRIG

10 MHz OUT

REF IN

10 MHz OUT

REF IN

REF IN

10 MHz OUT

EVENT 1

EVENT 1

EVENT 1

RF（無線周波数）出力

RF（無線周波数）出力

RF（無線周波数）出力

RF（無線周波数）出力

注記：同期化遅延を最小限に抑えるために、背面パネル・デイジーチェーン接続のケーブル
として、Keysight BNCケーブル10502Aを推奨します（228ページを参照）。

PAT TRIG
またはGPIB
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4. ト リ ガ リ ングを除き、 マーカーやサンプル ・ ク ロ ッ ク などの適切な波形パラ メ ーターを設定し ます。

ベースバン ド 同期化機能は、 マス ター と ス レーブの両方に対する ト リ ガーの選択を制限し ます。 現在の
ト リ ガー設定がサポー ト されていないBBG同期化パラ メ ーターを含む場合、 Keysight MXG/EXGは設定 

競合エラーを生成し、 ト リ ガー設定を変更し ます。 設定競合エラーを避けるために、 マルチ BBG同期化

パラ メ ーターを設定する前に、 226ページで示す通 り 、 ト リ ガー ・ パラ メ ーターを手動で設定し ます。

5. RF （無線周波数） 出力をオンにし ます。

BBG同期化マスター・パラメーターの設定
1. Mode > Dual ARB > ARB Setup > More > Multi–BBG Sync Setup > Multi–Bbg Sync Type > Masterを押し ます。

2. Number of Slavesソ フ ト キーを使って、 ス レーブ数を設定し ます。

3. 必要に応じ て、 ト リ ガー ・ パラ メ ーターを変更し ます （226ページを参照）。

マス ター信号発生器によ り 、 ト リ ガー ・ タ イプ と ト リ ガー ・ ソース両方の修正が可能にな り ます。

a. デュ アルARB メ ニューに戻 り ます （226ページを参照）。

b. 必要な ト リ ガー ・ タ イプ と ソース を設定し ます。

c. Multi–BBG Sync Setup メ ニューに戻 り ます。

BBG同期化スレーブ・パラメーターの設定
1. Mode > Dual ARB > ARB Setup > More > Multi–BBG Sync Setup > Multi–BBG Sync Type > Slaveを押し ます。

2. Number of Slavesソ フ ト キーを使って、 ス レーブ数を設定し ます。

3. 信号発生器が占有する ス レーブ位置を設定し ます。

システムでは、 大15までのス レーブがあ る可能性があ り ます。

4. Listen for Sync ソ フ ト キーを押し、 Waiting for Syncがデ ィ スプレ イのStatusエ リ アで表示されてい    

る こ と を確認し ます。

5. 必要に応じ て、 異なる ト リ ガー ・ タ イプ ・ パラ メ ーターを選択し ます。

a. デュ アルARB メ ニューに戻 り ます （226ページを参照）。

b. 必要な ト リ ガー ・ タ イプを設定し ます。

c. Multi–BBG Sync Setup メ ニューに戻 り ます。

6. システム内の各ス レーブ信号発生器に対し て繰 り 返し ます。

システムの同期化
マス ターと ス レーブの信号発生器両方のパラ メ ーター設定し た後のみ、 この手順を実行し ます。 システムを
再同期する場合は、「複数同期化設定の変更とマスター /スレーブ・システムの再同期化」（231ページ）の手

順を使用し ます。
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1. マス ターで、 Sync Slavesソ フ ト キーを押し ます。

注記 マス ター /ス レーブ ・ システムの信号発生器はすべて、 マス ター /ス レーブ設定に変更を行った場合、
あ るいはス レーブ機器を追加し た場合、 ス レーブ機器のListen for Syncソ フ ト キーを押し た後にIn 
Syncが表示されて も、 再同期する必要があ り ます。

2. 正面パネル ・ デ ィ スプレ イで、 すべての信号発生器にStatusと し てIn Syncが表示されている こ と を

確認し て く ださい。

波形をトリガーして再生
1. すべてのKeysight信号発生器で、 Mode > Dual ARB > ARB Off Onを押し てOnにし ます。

2. マス ター信号発生器への ト リ ガー信号の送信を起動し ます。

複数同期化設定の変更とマスター /スレーブ・システムの再同期化
マス ター /スレーブ ・ パラ メーターに変更を行 う か、 信号発生器 （スレーブ ・ ユニッ ト ） がシステムに加えられ
る と、 システムは、 ディ スプレ イのStatus部でIn Syncが表示されていても、 再同期化する必要があ り ます。 

1. ト リ ガー ・ ソース をオフにし ます。 Triggerキーを使用し ていれば、 オフにする ものは何も あ り ません。

ト リ ガー ・ ソースがオンで、 連続的なパルス ・ ス ト リ ームを与える場合、 Listen for Syncソ フ ト キーを押し  

た後の状態と し て、 信号発生器がIn Syncと誤って表示する こ と があ り ます。 

2. 信号発生器それぞれで、 Mode > Dual ARB > ARB Off Onを押し てOffにし ます。

信号発生器が変更中にデュ アル ARB をオンにする場合、 チェーン内の別の信号発生器は、 Listen for Sync  
ソ フ ト キーを押し た後にIn Syncと誤って表示する こ と があ り ます。

3 信号発生器それぞれで、 ARB Setup > More > Multi–BBG Sync Setupを押し ます。

4. マルチBBG同期セ ッ ト ア ッ プ ・ メ ニューで変更し ます。

Out Of Syncがステータ ス ・ メ ッ セージ と し て表示されます。

5. ス レーブ信号発生器それぞれで、 Listen for Syncを押し ます。

6. ス レーブのStatusがすべてWaiting for Syncを表示し ている こ と を確認し ます。 In Syncがステー   

タ ス と し て表示されれば、 次の手順を実行し ます。

a. PATT TRIGからEVENT 1へのケーブルが背面パネルに正し く 接続されている こ と を確認し ます。

ケーブルが切断し ている と、 偽のIn Syncステータ ス を引き起こす可能性があ り ます。

b. ケーブルが接続されている場合は、 手順1 と 2を実行し ます。

c. Listen for Syncを押し、 Waiting for Syncがステータ ス と し て表示される こ と を確認し ます。

7. マス ター信号発生器で、 Sync Slavesを押し ます。

8. In Syncがすべてのマス ター /ス レーブ信号発生器でステータ ス と し て表示される こ と を確認し ます。

9. プロセス「波形をトリガーして再生」（231ページ）を実行し ます。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 231



基本的なデジタル操作 （オプション653/655/656/657） 
オプション012（位相干渉性に対するLO イン/アウト）の概要 （複数ベースバンド発生器の同期化） 
オプション012（位相干渉性に対するLO イン/アウト）の概要 
（複数ベースバンド発生器の同期化）
注記 こ の節では、 複数ベースバン ド発生器の同期化を読み、 理解し ている こ と を前提と し ています。 そ

う でない場合は、 続行する前に「複数ベースバンド発生器の同期化」（225ページ）を参照し て く だ
さい。

オプシ ョ ン012搭載のMXG/EXGによ り 、 2×2、 3×3、 または4×4のMIMO構成が位相干渉システムを作成する共通

の外部LO信号を共有でき ます （「複数ベースバンド発生器の同期化」（225ページ）も参照し て く ださい）。

MIMO 受信機は、 チャ ンネル状態の一部と し てのソース間の位相差を認識し、 それら を修正するため、 一般
的な STC/MIMO 受信機のテス ト で、 RF 位相干渉性は必要ないこ と があ り ます。 しかし、 RF 位相干渉性は、

ビーム形成システムの研究開発などの特定の用途のために望ま しいかも しれません。

MINOを使ったオプション012（位相干渉性に対するLO イン/アウト）の設定
Keysight BNCケーブル （部品番号10502A） は、 標準のマルチBBG同期化セ ッ ト ア ッ プで推奨される ケーブ 
ルであ り 、 オプシ ョ ン 012でも推奨されます （図8-29（229ページ）も参照し て く ださい）。 さ らに、 LO IN 
と LO OUTから スプ リ ッ タへの2x2、 3x3、 および4x4のMIMO接続では、 追加のケーブルが必要と な り ます 

（表8-5、 図8-30（234ページ）、 と図8-31（235ページ）を参照し て く ださい）。

注記 LO出力は、 使用し ない と きにはカバーをかける こ と をお勧めし ます。

LO In/Outジャ ンパー ・ ケーブルが外され、 機器がデュ アルARBモード の場合は、 この機器はレベ 

リ ングな しにな り 、 Unlevelエラー ・ メ ッ セージが表示されます。

すべてのテス ト 装置は、 正確な性能を確保するために、 12時間のウ ォームア ッ プ時間が必要です。

位相干渉性設定では、 以下が必要です。

• 推奨LO入力駆動レベルは0～6 dBmの範囲にあ る こ と。

注記 0～6 dBmのLO入力駆動レベルによ り 、 機器が全周波数にわたって、 0～55の全周囲温度範囲で動 

作する こ と が保証されます1。

• I/Q校正と セルフテス ト は、 LOイ ン/ア ウ ト ・ ジ ャ ンパー ・ ケーブルを所定位置にし て実行する必要があ
り ます。 I/Q 校正を実行する こ と ができ ない場合、 ベースバン ド補正は、 I/Q 補正を 小化する よ う に調

整でき ます。

• 位相干渉性機能は、 デュ アルARB変調モード にのみ適用されます。

• スプ リ ッ タ出力から機器入力までのすべてのケーブルは、 同じ長さ でなければな り ません。

1LO入力電力要件は、 温度によ って変わ り ます。 20～30度の周囲温度条件で<0 dBmの電力が得られます。 データ ・

シー ト を参照し て く だ さい。
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表8-5 オプション012（位相干渉性に対するLO イン/アウト）機器

MIMOの設定 パーツa

aすべてのMIMO構成で、スプリッタ出力からマスターおよびスレーブの機器の入力まで、同じ長さのSMAフレキシブ
ル・ケーブルを接続します。図8-30（234ページ） および 図8-31（235ページ）を参照してください。

ケーブル長 注記

2×2 該当な し

11636A

必要に応じ て

該当な し

SMAフ レキシブル ・ ケーブルは、 電源ス

プ リ ッ タ出力から マス ターと ス レーブ

MXG/EXG両方の背面パネルにあ るLO入

力まで接続されます。 図8-30（234ページ）
を参照し て く ださい。 

 

電力分配器、 18 GHzまでの直流。

www.keysight.comを参照し て く だ さい。

3×3 該当な し

 

PS3–20–451/
12S

必要に応じ て

 

該当な し

SMAフ レキシブル ・ ケーブルは、 電源ス

プ リ ッ タ出力から スレーブMXG/EXGの背

面パネルにあるLO入力まで接続されます。

図8-31（235ページ）を参照して く ださい。 

 

3–Way Pulser Microwave Corp.、3–Way 
Wilkinson分配器

4x4 該当な し

 

PS4–16–452/
10S

必要に応じ て

 

該当な し

SMAフ レキシブル ・ ケーブルは、 電源ス

プ リ ッ タ出力から スレーブMXG/EXGの背

面パネルにあるLO入力まで接続されます。

図8-31（235ページ）を参照して く ださい。 

 

4–Way Pulser Microwave Corp.、4–Way 
Wilkinson分配器

すべて 10502A 22.86 cm （9イ ンチ） 図8-30（234ページ）および図8-31（235ペー
ジ）を参照し て く だ さい。「複数ベースバン
ド発生器の同期化」（225ページ）も参照し て

く ださい。
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2x2 MIMO（位相干渉性に対するLO イン/アウト）設定 

2x2 MIMO （位相干渉性に対するLOイ ン/アウ ト ） のセ ッ ト ア ップについては、 マス ター MXG/EXGからのLO 
は、 電源スプ リ ッ タ を介し て実行でき、 マス ター と ス レーブの信号発生器の両方のLO入力と し て使用でき ま

す。 外部ソースは必要あ り ません。

2x2 MIMO設定に対する位相干渉性信号を生成するために、 マス ター MXG LO OUTは、 ス レーブLO INの電    
源スプ リ ッ タ を介し て接続されます。 LO OUTは、 直接接続された と きに十分な振幅のLO信号を供給し、 ス 

レーブMXG/EXGを駆動する ため、 RF （無線周波数） 出力信号に対し て位相干渉性を も た ら し ます。 この例

では、 位相干渉性2x2 MIMOソ リ ューシ ョ ンのために接続されたオプシ ョ ン012を備えた2つのMXG信号発生 
器を示し ます。 図8-30を参照し て く ださい。

図8-30 2x2 MIMO（位相干渉性に対するLO イン/アウト）機器セットアップ

3x3および4x4 MIMO（位相干渉性に対するLO イン/アウト）設定

3x3および4x4 MIMO （位相干渉性に対するLOイ ン/ア ウ ト ） セ ッ ト ア ッ プでは、 電源スプ リ ッ タ と追加機器 
で必要と される高LO電源を提供する ために、 追加のアナロ グ ・ ソースが必要です。

LO出力を4つ通路に分割する と、システムのN5172B/82BsのLO入力を駆動するのに生じ る損失が大きすぎま

す。 また、 N5172B/82BのLO出力への振幅調整はあ り ません。 MXG/EXGで3x3および4x4設定のための位相

干渉性信号を生成するには、 ベク ト ル MXG/EXG に十分な振幅の LO 入力信号を提供するために、 外部マス
ター LOが必要です （図8-31（235ページ）を参照し て く ださい）。 

注記 マス ター LOは、 Signal Studioソ フ ト ウ ェアのいずれによ って も コ ン ト ロールされませんが、 ユー 
ザーがマス ター信号発生器で Ｒ Ｆ 周波数設定によ って、 所定の周波数と振幅を手動で設定する必要
があ り ます。

注記 ： 

位相干渉性を 適化するには、 同じ長さのSMAフレキシブル ・ ケーブルを使用して、 双方向スプ リ ッ タ

の出力をオプシ ョ ン012搭載の信号発生器のLO INに接続する こ とが推奨されます （232ページを参照）。 

同期化遅延を 小限に抑えるために、 EVENT 1およびPAT TRIG BNCコネク ターの背面パネル ・ デイ
ジーチェーン接続のケーブルと して、 Keysight BNCケーブル10502Aを推奨し ます （232ページを参照）。
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図8-31 3x3および4x4 MIMO（位相干渉性に対するLO イン/アウト）機器セットアップ

注記 ： 

4方向スプ リ ッ タへの入力からオプシ ョ ン012搭載の機器のLO INおよびLO OUTまでの接続には、 SMA
フ レキシブル ・ ケーブルを推奨し ます （232ページを参照）。

位相干渉性を 適化するには、 同じ長さ のSMAフ レキシブル ・ ケーブルを使用し て、 4方向スプ リ ッ タ
の出力からオプシ ョ ン012搭載の機器のLO INに接続する こ と が推奨されます （232ページを参照）。
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リアルタイム・アプリケーション
Keysight Xシ リ ーズ信号発生器は、 信号生成のためのい く つかの リ アルタ イ ム ・ アプ リ ケーシ ョ ンへのア ク

セス を提供し ます。 

図8-32 リアルタイム・アプリケーション・ソフトキー

146ページ

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

371ページ

318ページ

318ページ

認可を受けたSignal Studioアプリケーションがここで表示
されます。

www.keysight.com/find/signalstudioを参照してください。

245ページ

312ページ

178ページ
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波形ライセンス
波形ラ イセンスによ り 、 自分で生成した波形を ラ イセンス許可し、 Signal Studioアプ リ ケーシ ョ ンからダウン 

ロード して信号発生器で無制限に再生でき ます。 ラ イセンス ・ オプシ ョ ン （221～229） によ り 、 大5波形のラ

イセンスを恒久的に取得でき ます。 （250～259） では、 ご自分で選択して 大50の波形のラ イセンスを恒久的に
取得でき ます （すなわち、 波形オプシ ョ ン22Xまたはオプシ ョ ン25xは、 永久固定波形ラ イセンスです）。 

オプシ ョ ン221～229またはオプシ ョ ン250～259でラ イセンスを取得した波形は、 別の波形と交換でき ません。

波形にラ イセンスが与えられる と、 そのラ イセンスは永続的であ り、 取り消しや交換はできません。 オプシ ョ ン
22xと 25xの波形ラ イセン スは、 信号発生器に固有です （すなわち、 信号発生器のシ リ アル番号に固有です）。

ラ イセン ス ・ オプシ ョ ン22xまたはオプシ ョ ン25x波形フ ァ イルが別の信号発生器に転送される と、 そのフ ァ

イルは、 再生でき る よ う になる前に、 他の信号発生器にあ る別個のオプシ ョ ン22xまたはオプシ ョ ン25xでラ
イセン ス を与え られなければな り ません。

オプシ ョ ン22xまたはオプシ ョ ン25xを回復するには、 N5182B- 2xx注文書に付属するN5182B- 2xxラ イセンス
証明書を参照し て く ださい。 波形フ ァ イルの展開およびダウ ン ロード に関する情報は、 『プロ グ ラ ミ ング ・ ガ
イ ド』 を参照し て く ださい。

波形ライセンスの概要
信号発生器に波形を構築し てダウ ン ロードするには、 N76xxB Signal Studioソ フ ト ウ ェアを使用し て く ださ  

い。 各オプシ ョ ン22xでは、 利用可能なス ロ ッ ト を5個提供し、 オプシ ョ ン25x ラ イセン スでは、 利用可能な

ス ロ ッ ト を50個提供し ますが、 こ こ でス ロ ッ ト あた り 48時間の ト ラ イ アル期間で波形を追加し て再生でき ま
す。 こ の間、 ご自分が満足する まで何回でも波形を交換でき ます。 試用期間が終了し た後、 ス ロ ッ ト の再生
が恒久的にロ ッ ク される まで、 ス ロ ッ ト 内の波形はも う 再生でき ません。 ただし、 ス ロ ッ ト を ロ ッ クする前
に、 ス ロ ッ ト 内の波形を、 選択し た別の波形と交換でき ます。

オプシ ョ ン22xまたはオプシ ョ ン25xで認められた数を超える追加波形のラ イセンスを取得するには、 まだお持

ちでない別のオプシ ョ ン22xまたはオプシ ョ ン25xを購入する必要があ り ます。 た と えば、 すでにオプシ ョ ン

250をお持ちであれば、 さ らに50ス ロ ッ ト を追加するには、 オプシ ョ ン251を購入し て く ださい。 オプシ ョ ン
250～259をすべて追加する と、 大500ス ロ ッ ト が提供されます。オプシ ョ ン221～229をすべて追加する と、

大 45 ス ロ ッ ト が提供されます。 （同じ信号発生器で同じオプシ ョ ンを再購入し て も、 追加波形ラ イセン ス
は取得でき ません。）

オプションN5182-22xまたはオプションN5182B-25Xのインストール 

ラ イセン ス ・ マネージ ャ またはUSB メ デ ィ アを使用し て、 信号発生器に、 波形ラ イセン ス （オプシ ョ ン 

N5182- 22xまたはオプシ ョ ンN5182B- 25x） を ロード し ます。 波形ラ イセン スの読み込みの詳細については、
注文書に同梱し ているN5182B- 2xxラ イセン ス証明書を参照し て く ださい。

信号発生器波形のライセンス許可
N76xxB Signal Studioソ フ ト ウ ェアのいずれかを使用し て、 波形を作成し、 信号発生器にダウ ン ロード し ま  

す。 アプ リ ケーシ ョ ンを使用し て支援が必要な場合は、 お使いのSignal Studioソ フ ト ウ ェアのヘルプを参照 

し て く ださい。

48時間の試用期間に波形を ラ イセン ス ・ ス ロ ッ ト に追加する際は、 242ページを参照し て く ださい。 試用期
間中、 波形が再生され、 任意の回数交換する こ と ができ ます。 試用時間が経過する と、 ス ロ ッ ト が恒久的な
再生機能に対し て ロ ッ ク される まで、 ス ロ ッ ト は、 も う 再生に使用する こ と はでき ません。
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波形ライセンス・ソフトキーの概要

図8-33 波形ライセンス・ソフトキー

各キーの詳細については、44ページで説明
されているキーのヘルプを使用してください。

Mode > Dual ARB > More 

注記：オプション2xxでライセンスを取得した波形を他の波形と交換することはできません。波形がライセ
ンス・スロットにロックされると、そのライセンスは永続的であり、取り消しや交換はできません。 

機器にインストールされたオプション2xxのライセンスがある場合のみこのソフトキーが使用できます。
このソフトキーを押すと、各スロットのライセンス状況と関連したファイル名が表示され、波形ライセンス
のメニュー選択にアクセスします。 

このソフトキーにより、最初に使
用可能なスロットで選択した波形
を追加できます。239ページを
参照してください。

関連するライセンス・コマンドについては、
『SCPI Command Reference』を参照してく
ださい。

このソフトキーにより、選択した
スロットで波形を交換できます。
240ページを参照してください。

このソフトキーは、選択したス
ロットから波形を消去します。

このソフトキーにより、スロット
に波形をロックできます。 
試用期間が終了した後、波形 
を再生できるように、波形を 
ロックしなければなりません。
240ページを参照してください。

このソフトキーにより、波形の
追加、交換、またはクリアをす
る特定のスロットを選択できま
す。また、正面パネルの矢印
キーを使用するか、スロットに
スクロールしてスロットを選択
できます。239ページを参照し
てください。

 
注記：波形ライセンスに最初にアクセスすると、すべてのスロットがAvailableと表
示されます。波形がスロットに追加された後のライセンス状態の説明については、
表8-6（241ページ）を参照してください。

240ページ
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図8-34 波形ライセンス・ソフトキー

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

Mode > Dual ARB > More > 
Waveform Licensing > Add 
Waveform to First Available Slot
または
Mode > Dual ARB > More > 
Waveform Licensing > Replace 
Waveform in Slot

波形が既にライセンス許可されている
か、ライセンスを必要としない場合、
ソフトキーはグレー表示されます。

このソフトキーは、Int 
StorageまたはUSB Mediaに保
存された波形セグメントのカタ
ログを表示します。

このソフトキーは、BBGメモ
リーに保存された波形のカタ
ログを表示します。

波形を選択するには、矢印
キーを使って波形を強調表
示し、次にAdd Waveform
を押します。 

注記：オプション2xxでライセンスを取得した波形を「交換」することはできません。ス
ロットがロックされると、ロックされたスロットの波形に対するライセンスは永続的であ
り、取り消しや交換はできません。

関連するライセンス・コマンドに
ついては、『SCPI Command 
Reference』を参照してください。追加または交換する波形は、BBGメモリー、内部メモリー、またはUSBデバイスから選択できます。
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図8-35 波形ライセンス・ソフトキー

各キーの詳細については、
44ページで説明されてい
るキーのヘルプを使用して
ください。

Mode > Dual ARB > More > 
Waveform Licensing > Goto Slot

正面パネルのテンキーパッドを使用して、特定のスロット番号に入力した後、このソフトキー
を押します。

最初のスロットに移動するには、このソフトキーを押します。

ステータスが利用可能であれば、最初のスロットに移動するのに、このソフトキーを押します。

最後のスロットに移動するには、このソフトキーを押します。スロットの数は、機器にインス
トールされたライセンス・オプションの数によって変わります。

Mode > Dual ARB > More > Waveform Licensing 
> Lock Waveform in Slot

波形が信号発生器の内部ストレージにない場合は、このソフトキーが表示されます。このソフ
トキーを押し、波形を内部ストレージに保存し、Confirm Locking Waveformソフトキーを起
動します。ステップ4（243ページ）を参照してください。 

Mode > Dual ARB > More > Waveform 
Licensing > More > More

このソフトキーを押して、ハ
イライト表示されたスロット
の波形を再生します。

名前に関係なく、このスロッ
トに追加されたメモリー内の
波形を見つけるには、このソ
フトキーを押します。検索結
果が戻らない場合は、元の波
形がメモリーから削除されて
おり、見つけることができま
せん。

このソフトキーを押して、永続的なライセンスのために波形をスロットにロックすることを確
認します。波形がは内部ストレージに保存されていない場合は、警告メッセージが表示されま
す。ステップ4（243ページ）を参照してください。 

関連するライセンス・コマンドについては、
『SCPI Command Reference』を参照してく
ださい。
240 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 基本的なデジタル操作 （オプション653/655/656/657）    
波形ライセンス
表8-6 波形ライセンス・スロットのステータス・メッセージ

ステータ ス列 意味 注記

Available ス ロ ッ ト に波形が追加された こ と が

あ り ません。

各オプシ ョ ン25xに対し て、 50ス

ロ ッ ト が 初に利用可能です。

各オプシ ョ ン22xに対し て、 5ス ロ ッ

ト が 初に利用可能です。

Locked MM/DD/YY ス ロ ッ ト がロ ッ ク され、 も う 変更で

き ません。

こ のス ロ ッ ト の波形は、 無制限の再

生のために、 こ の信号発生器にラ イ

セン ス許可されています。

Remaining Trial Time HH:MM このス ロ ッ ト は試用期間中です。 試

用期間は波形が追加された時点から

48時間継続し ます。

試用期間中、 こ のス ロ ッ ト の波形は、

再生、 ク リ ア、 または別の波形と 交

換でき ます。

Lock Required ス ロ ッ ト の試用期間が満了し ていま

すが、 ス ロ ッ ト がロ ッ ク されていま

せん。 

ス ロ ッ ト はク リ アするか、 別の波形

と交換でき ますが、 ス ロ ッ ト がロ ッ

ク される まで、 波形は再生でき ませ

ん。 試用期間が切れま し た。
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基本的なデジタル操作 （オプション653/655/656/657） 
波形ライセンス 
例：Signal Studio波形のライセンス許可

次の手順では、 ラ イセン ス ・ ス ロ ッ ト に波形フ ァ イルを追加し、 永続的な再生のためにス ロ ッ ト を ロ ッ ク し
ます。

1. Mode > Dual ARB > More > Waveform Utilities > Waveform Licensingを押し ます。

信号発生器は、以下のラベルが付けられたフ ァ イルのカタ ログを表示し ます。Catalog of BBG Segment   
Files in BBG Memory。

2. 矢印キーを使用し て、 ラ イセン ス取得する フ ァ イルを強調表示し て選択し ます。

3. Add Waveformを押し て、 初の使用可能なス ロ ッ ト に選択し た波形を追加し ます。

図8-36       波形の追加
Mode > Dual ARB > More > Waveform Licensing> 
Add Waveform to First Available Slot

239ページ

波形N7602B-WFM1のStatusエリ
アは空で、Add Waveformソフト
キーはアクティブであり、波形の
ライセンス取得が可能です。

選択した波形は、最初に
利用可能なスロットに追
加されます。スロットの
試用時間は、波形が追加
された直後に開始され 
ます。
48時間の試用期間中、波
形の再生と交換を何回す
ることもできます。
試用時間が経過すると、
スロットのライセンス・
ステータスがLock 
Requiredに変わり、その
後、スロットがロックさ
れるまで、波形をもう再
生することができません。
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 基本的なデジタル操作 （オプション653/655/656/657）    
波形ライセンス
4. 波形のラ イセン ス許可 ：

a. Lock Waveform in Slotを押し ます。

警告が表示されます。 *** Waveform Lock Warning!!!***.必要に応じ て、 Returnを押し て、 ラ   
イセン ス供与の必要な正しい波形を選択し た こ と を確認し ます。

図8-37 波形ロック警告

b. Confirm Locking Waveformを押し ます。

ス ロ ッ ト のラ イセン ス ・ ステータ スがLocked MM/DD/YYに変更されます。

c. 波形が前に内部ス ト レージにバッ ク ア ッ プされていない場合、 警告が表示されます。 
*** Waveform Backup Required!!!***.

d. Backup Waveform to Int Storageを押す前に、 USB メ デ ィ アまたはコ ンピ ュータでこの波形のバッ ク    

ア ップ・コ ピーを作成し ます。（信号発生器上で波形が失われた り 、削除された場合は、回復でき ません）。

図8-38 Backup Waveform To Int Storageソフトキー

注意 ラ イセンスを取得する波形のバッ クアップ・ コピーを作る こ とが重要です。信号発生器にバッ クアップ・
コピーを保存しないで く ださい。 波形のすべてのコピーが削除または失われる と、 波形を回復する こ と
も、 ラ イセンスを再割り当てする こ と もできな く な り ます。「ファイルによる操作」（62ページ）を参
照し て く ださい。

このソフトキーを押し、波形を内部スト
レージに保存し、Confirm Locking 
Waveformソフトキーを起動します。

Confirm Locking Waveformソフト
キーは、波形が内部ストレージに保存
されるまで無効のままです。
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波形ライセンスの警告メッセージ

図8-39
この標準的な警告は、波形
のロックが選択されるたび
に表示されます。この通知
は、利用可能な「ライセン
ス・スロット」のいずれか
1つがオプション2xxによっ
て使用されようとしている
ことを示します。
ファイルが機器の内部スト
レージから削除されたり、
失われたりした場合に備え
て、「常に」別の不揮発性
メモリーに波形のバック
アップ・コピーを作ってく
ださい。

この警告は、内部スト
レージまたはUSBメディ
アに保存されていない波
形をロックしようとする
際に表示されます（すな
わち、波形を不揮発性メ
モリーに保存しなければ、
ロックできません）。
Backup Waveform To Int 
Storageソフトキーを押し
ます。

この警告は、十分なメモ
リーがないか、内部スト
レージまたはUSBメディ
ア（不揮発性メモリー）
で他の問題があり、波形
を不揮発性メモリーに保
存できなかった場合に表
示されます。

この警告は、波形ファイ
ルがBBGまたは内部スト
レージで見つからなかっ
た場合に表示されます。
波形をロックする前に、
波形が機器内に存在する
ことを確認する必要があ
ります。
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ユーザー・ガイド
9 リアルタイム雑音の信号への付加
（オプション403）

こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の
情報に習熟し て く ださ い。

こ の機能は、 オプシ ョ ン431付きのKeysight X- Seriesベク ト ル信号発生器のみで使用可能です。 オプシ ョ ン 

431には、 オプシ ョ ン653または655 （N5172B）、 または、 オプシ ョ ン656または657 （N5182B） が必要です。

本章は、オプシ ョ ン403を備えたベク ト ル信号発生器のみで使用可能の付加白色ガウ ス雑音(AWGN)波形発生
器の例が含まれます。

• デュアルARB波形にリアルタイム雑音の追加 （245ページ）

• Real Time I/Q Baseband AWGNの使用 （251ページ）

デュアルARB波形にリアルタイム雑音の追加

注記 こ の節で、 波形に リ アルタ イ ム雑音(AWGN)を追加する こ と に特に関連し た手順は、 カス タ ム

ARB、 マルチ ト ーンおよびツー ト ーン変調の規格にも適用されます。

オプシ ョ ン 403 を備えたベク ト ル信号発生器は、 変調波形がデュ アルARB波形再生機で再生する と き、 付加
白色ガウ ス雑音 (AWGN) を リ アルタ イ ムで搬送波に適用する こ と ができ ます。 この機能は、 それぞれの arb
フ ォーマ ッ ト と、 ス タ ン ド ア ロ ン ・ メ ニューで使用でき ます。 （図9-7（251ページ）を参照し て く ださい）。
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リアルタイム雑音の信号への付加（オプション403） 
デュアルARB波形にリアルタイム雑音の追加 
図9-1 Real Time I/Q Baseband AWGNソフトキー

247ページを参照してください 

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。

ディスプレイにノイズの状態（オン
またはオフ）が示されます。

図9-6（250ページ） に、これら
の設定の詳細を示します。

これは、スタンドアロンのRealTime 
AWGNと、Modulation Modeメニュー
の2ページ目です（251ページを参照
してください）。

ARBリアル・ノイズAWGNの静
的なグラフィック表現（すなわ
ち、値が変化してもグラフィッ
クは更新されません）。

値の間の関係がARBリアルタイムAWGNの静的なグ
ラフィックに表示されます。
Total Noise Powerは、占有雑音帯域幅(NBW * 1.25)全
体のNoise Powerです。

247ページを参照してください

247ページを参照してください 

選択した搬送波対雑音比の、ノイズ
を積分する帯域幅。通常、Carrier 
Bandwidth (CBW)は搬送波の占有帯
域幅です。

Flat Noise Bandwidth (NBW)：実際
のフラット・ノイズ帯域幅(NBW)。
搬送波の帯域幅より少し広くなりま
す（一般的に1.6倍程度）。占有帯域
幅＝ 
(1.25 * Flat Noise Bandwidth)

248ページを参照してください

Carrier Bit Rateソフトキーは搬送波の
ビット・レートを設定します。（デフォル
トの搬送波ビット・レートは1 bps）

Carrier Bit Rateソフトキーは、Carrier to 
Noise Ratio FormatソフトキーがEb/Noに
設定されている場合のみ使用できます。
249ページも参照してください。
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 リアルタイム雑音の信号への付加（オプション403）   
デュアルARB波形にリアルタイム雑音の追加
図9-2 Real Time I/Q Baseband AWGN - Power Control Modeソフトキー
各キーの詳細については、 
44ページで説明されているキーの
ヘルプを使用してください。

Mode > Dual ARB > Arb Setup >
Real-Time AWGN Setup

パワー制御モードとしてTotalを
選択すると、全パワーとC/Nが
独立変数、搬送波パワーと全ノ
イズ・パワーが従属変数になり
ます。従属変数の搬送波パワー
と全ノイズ・パワーは、全パ
ワー、C/N、およびその他のノ
イズ設定により設定されます。
どれかのノイズ・パラメーター
を調整すると、全パワーとC/N
を最新の設定値を維持するよう
に、搬送波パワーと全ノイズ・
パワーが変更されます。

パワー制御モードとしてCarrier
を選択すると、搬送波パワーと
C/Nが独立変数、全パワーと全
ノイズ・パワーが従属変数にな
ります。従属変数の全パワーと
全ノイズ・パワーは、搬送波パ
ワー、C/N、およびその他のノ
イズ設定により設定されます。
どれかのノイズ・パラメーター
を調整すると、搬送波パワーと
C/Nを最新の設定値を維持する
ように、全パワーと全ノイズ・
パワーが変更されます。

パワー制御モードとしてTotal 
Noiseを選択すると、全ノイズ・
パワーとC/Nが独立変数、全パ
ワーと搬送波パワーが従属変数
になります。従属変数の全パ
ワーと搬送波パワーは、全ノイ
ズ・パワー、C/N、およびその他
のノイズ設定により設定されま
す。どれかのノイズ・パラメー
ターを調整すると、全ノイズ・
パワーとC/Nを最新の設定値を維
持するように、全パワーと搬送
波パワーが変更されます。

図9-6（250ページ） に、これら
の設定の詳細を示します。

248ページを参照
してください 
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リアルタイム雑音の信号への付加（オプション403） 
デュアルARB波形にリアルタイム雑音の追加 
図9-3 Real Time I/Q Baseband AWGN - Noise Muxメニュー・ソフトキー

リアルタイムI/QベースバンドAWGNのEb/No調整ソフトキー

こ の機能を使えば、 AWGNのC/NをEb/No （ビ ッ ト あた り のエネルギーを レシーバでの ノ イ ズ ・ パワー密度で

割った値、 すなわちビ ッ ト あた り の信号対雑音比） フ ォーマ ッ ト で設定でき ます。 これには、 搬送波のビ ッ
ト ・ レー ト がわかっている必要があ り ます。 図9-4、「Eb/No搬送波ビット式」を参照し て く ださい。

図9-4 Eb/No搬送波ビット式

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。

Mode > Dual ARB > Arb Setup >
Real-Time AWGN Setup > More

相加性雑音の診断制御を可能にし
ます。これにより、ノイズのみ、
搬送波のみ、またはノイズと搬送
波の和を、内部ベースバンド発生
器から出力できます。ALCがオフ
の場合は、この機能により、搬送
波またはノイズの寄与を、全パ
ワーと独立に直接測定できます。
自動変調減衰とRMSパワー・サー
チのRMSレベルの判定に関して
は、システムはノイズと搬送波の
両方が出力に存在するかのように
動作します。

図9-6（250ページ） に、これ
らの設定の詳細を示します。

Carrier Bit Rate
ソフトキーは、
Carrier to Noise
ソフトキーが
Eb/Noに設定され
ている場合のみ
使用できます。

C
N Bd
---------

Eb
N0
------

 dB 10 10
bitRate

carrierBandwidth
-----------------------------------------------------


 
 log+ 

 =
248 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 リアルタイム雑音の信号への付加（オプション403）   
デュアルARB波形にリアルタイム雑音の追加
図9-5 リアルタイムI/QベースバンドAWGN - Eb/N0調整ソフトキー

各キーの詳細については、 
44ページで説明されているキーの
ヘルプを使用してください。

Mode > Dual ARB > Arb Setup > Real-Time AWGN Setup

Carrier to Noise Ratio (C/N)また
はビットあたりのエネルギーを
レシーバでのノイズ・パワー密
度で割った値(Eb/No)のいずれか
を、搬送波帯域幅内の搬送波パ
ワーとノイズ・パワーの比を制
御する変数として選択します。
Eb/Noを選択した場合は、
AWGN Setupメニューの2ペー
ジ目に、Eb/No値を計算するた
めのCarrier Bit Rateソフトキー
が表示されます。

図9-6（250ページ） に、これら
の設定の詳細を示します。

C/Nを選択

Eb/Noを選択

ソフトキーが使用できるかどう
かは、Carrier to Noise Ratio 
Formatソフトキーの設定（C/N
またはEb/No)により異なります。 

Carrier Bit Rateソフトキーは搬送波の
ビット・レートを設定します。（デフォ
ルトの搬送波ビット・レートは1 bps）

Carrier Bit Rateソフトキーは、Carrier 
to Noise Ratio Formatソフトキーが
Eb/Noに設定されている場合のみ使用で
きます。

搬送波ビット・レートの式については、
44ページを参照してください。

Carrier to Noise Ratio FormatソフトキーをEb/No

に設定すると、Eb/Noが表示されます。

アクティブなソフト
キーは、Carrier to Noise 
Ratio Formatの選択
（C/NまたはEb/No)によ
り変化します。以下を
参照してください。

リアルタイムAWGNをオンにす 
るまでグレー表示。
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リアルタイム雑音の信号への付加（オプション403） 
デュアルARB波形にリアルタイム雑音の追加 
図9-6 搬送波対雑音比の成分

例
工場提供波形SINE_TEST_WFMを使って1 GHz、 –10 dBmの搬送波を変調し た後、 40 MHzの搬送波帯域幅   

で30 dBの搬送波対雑音比を持つ45 MHz帯域幅の信号を使って ノ イ ズを適用するには、以下の手順を使用し  

ます。

1. 信号発生器をプ リ セ ッ ト し て、 以下を設定し ます ：

• 周波数 ： 1 GHz
• 振幅 ： 10 dBm
• RF出力 ： オン

2. 工場提供波形SINE_TEST_WFMを選択し ます ：

a. Mode > Dual ARB > Select Waveformを押し ます。

b. SINE_TEST_WFMを強調表示し、 Select Waveformを押し ます。

3. デュ アルARB再生機をオンにし ます ： ARB Off Onを押し てOnを強調表示し ます。

4. ARBサンプル・ ク ロ ッ ク を50 MHzに設定し ます：ARB Setup > ARB Sample Clock > 50 > MHzを押し ます。

5. Real–Time AWGN Setupを押し、 以下を設定し ます ：

• 搬送波対雑音比 ： 30 dB
• Carrier Bandwidth ： 40 MHz
• Noise Bandwidth ： 45 MHz
• Real–time AWGN ： オン

信号発生器の表示パワー ・ レベル(–10 dBm)には ノ イ ズ ・ パワーが含まれます。

Carrier BW
    (CBW)

RMS 
（全搬送波パワー）

C

Carrier BW
     (CBW)

搬送波

ノイズ N

Noise BW 
(NBW)＝フ
ラットなノ
イズ帯域幅

搬送波は追加されたノイ
ズ・パワーのために大き
く見えます。

Carrier Bandwidth (CBW)は通常は搬送波の占有帯域幅
であり、Noise Bandwidthはフラットな雑音帯域幅
(NBW)です。
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Real Time I/Q Baseband AWGNの使用    
Real Time I/Q Baseband AWGNの使用

図9-7 Real Time I/Q Baseband AWGNソフトキー

10 MHz帯域幅の ノ イ ズを500 MHz、 –10 dBmの搬送波に適用するには、 以下の手順を使用し ます。

1. ノ イ ズを設定し ます ：

a. 信号発生器をプ リ セ ッ ト し ます。

b. Mode > More > Real-Time AWGNを押し ます

c. Bandwidth > 10 > MHzを押し ます。

2. ノ イ ズを発生し ます ：

Real-Time AWGN Off OnをOnが強調表示される まで押し ます。

発生中には、 AWGNとI/Qインジケーター
がア ク テ ィ ブにな り ます （右の図を参
照）。 RF搬送波の変調にAWGNを使用
でき る よ う にな り ます。

3. RF （無線周波数） 出力を設定し ます ：

• 周波数 ： 500 MHz

• 振幅 ： 10 dBm

• RF出力 ： オン

信号発生器のRF OUTPUTコネ ク ターでAWGNを持つ搬送波を使用でき る よ う にな り ます。

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 251



リアルタイム雑音の信号への付加（オプション403） 
Real Time I/Q Baseband AWGNの使用 
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X-Series信号発生器

ユーザー・ガイド
10 デジタル信号インターフェイス・モジュール
（オプション003/004）

本章は、 N5102Aベースバン ド ・ ス タジオ ・ デジタル信号イ ン ターフ ェ イ ス ・ モジュールの情報を提供し ます。

これらの機能は、 オプシ ョ ン003/004および653/655/656/657を備えたN5172B/82Bベク ト ル信号発生器のみ
で使用可能です。 次の リ ス ト は本章で取 り 上げられる ト ピ ッ ク を示し ます ：

• クロック・タイミング （253ページ）

• データ・タイプ （268ページ）

• クロック・ソースとテストされるデバイスの接続 （265ページ）

• 出力モードにおけるN5102A Moduleの操作 （269ページ）

• 入力モードにおけるN5102A Moduleの操作 （280ページ）

クロック・タイミング
こ の節では、 デジ タル ・ データのク ロ ッ ク が規定される方法を説明し ます。 ク ロ ッ ク ・ タ イ ミ ング情報と図
が、 さ まざまなポー ト 構成 （シ リ アル、 パラ レル、 または、 並列イ ン ター リ ーブ ・ ポー ト 構成） 用に提供さ
れます。 イ ン ターフ ェース ・ モジュール用のすべての設定は、信号発生器のユーザー ・ イ ン ターフ ェース(UI)
から可能です。

クロックおよびサンプル・レート
サンプル と はビ ッ ト のグループであ り 、 サンプルのサイ ズはWord Sizeソ フ ト キーを使用し て設定し ます。 ク 

ロ ッ ク と は、 サンプルのビ ッ ト がいつ有効にな るかを命令する （非遷移状態で） 信号です。 ク ロ ッ クおよび
サンプル ・ レー ト は、 第1レベルおよびdata setupソ フ ト キー ・ メ ニューで表示されます。 ク ロ ッ ク ・ レー ト  

と サンプル ・ レー ト は通常は同じです。 これらはシ リ アル ・ モード が選択された場合、 も し く は、 サンプル
に複数のク ロ ッ ク があ る場合には異な り ます。
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図10-1 パラレル・ポート構成用のデータ・セットアップ・メニュー

N5102A moduleの ク ロ ッ ク ・ レー ト は、 Clock Rateソ フ ト キーを使用し て設定され、 その範囲は、 1 kHzか

ら400 MHzまでです。 サンプル ・ レー ト は自動計算され、 範囲は1 kHzから200 MHzまでです。 こ のよ う な

範囲は、 ロ ジ ッ ク ・ タ イプ、 データ ・ パラ メ ーターおよびク ロ ッ ク配置によ っては、 これよ り 小さい場合が
あ り ます。

最大クロック・レート
N5102A moduleの 大ク ロ ッ ク ・ レー ト は、 ロ ジ ッ クおよび信号タ イプによ り 変わ り ます。 表10-1また 
表10-2は、 さ まざまな ロ ジ ッ クおよび信号タ イプ用の、 保証されたレー ト および 大ク ロ ッ ク ・ レー ト を示

し ます。 IF信号を使用する出力モード のLVDSは、保証されたレー ト と 大レー ト が同じであ る唯一のロ ジ ッ

ク ・ タ イプであ る こ と に注意し て く ださ い。

レベルは保証されたレベルのク ロ ッ ク ・ レー ト よ り 劣化し ますが、 使用は可能です。

表 10-1 保証されたパラレル出力レベル・クロック・レートおよび最大クロック・レート

ロ ジ ッ ク ・ タ イプ
保証されたレベル ・ ク ロ ッ ク ・ レー ト  大ク ロ ッ ク ・ レー ト （標準）

IQ信号タ イプ IF信号タ イプ1

1IF信号タイプはシリアル・ポート構成には使用できません。

IQ信号タ イプ IF信号タ イプ

LVTTLおよびCMOS 100 MHz 100 MHz 150 MHz 150 MHz

LVDS 200 MHz 400 MHz 400 MHz 400 MHz

表 10-2 保証されたパラレル入力レベル・クロック・レートおよび最大クロック・レート

ロ ジ ッ ク ・ タ イプ 保証されたレベル ・ ク ロ ッ ク ・ レー ト  大ク ロ ッ ク ・ レー ト （標準）

LVTTLおよびCMOS 100 MHz 150 MHz

LVDS 200 MHz 200 MHz

クロックおよびサンプル・レート最下位ビット 最上位ビット
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シリアル・ポート構成クロック・レート

シ リ アル ・ ポー ト 構成では、 ク ロ ッ ク ・ レー ト の下限はワード ・ サイ ズ （ワード ・ サイ ズ と サンプル ・ サイ
ズは同義です） によ り 決定されますが、 一方、 大ク ロ ッ ク ・ レー ト 制限は LVTTLおよびCMOS ロ ジ ッ ク ・

タ イプでは150 MHz、 LVDSロ ジ ッ ク ・ タ イプでは400 MHzの定数のま まです。 

サンプル ・ レー ト には逆も当てはま り ます。 1 kHzの下限サンプル （ワード） レー ト 値は変わ り ませんが、 サ 
ンプル ・ レー ト の上限は、 ワード ・ サイ ズによ り 変化し ます。 例えば、 LVTTL またはCMOS ロ ジ ッ ク ・ タ イ

プの5ビ ッ ト ・ サンプルでは、 シ リ アル ・ モード では次の値を使用でき ます ：

• 5 kHz～150 MHzまでのク ロ ッ ク ・ レー ト

• 1 kHz～30 MHzまでのサンプル ・ レー ト

シ リ アル ・ ク ロ ッ ク ・ レー ト に関し ては、 表10-3および表10-4を参照し て く ださい。 

パラレル、および、並列インターリーブ・ポート構成クロック・レート 

パラ レルおよび並列イ ン ター リ ーブ ・ ポー ト 構成には、 ク ロ ッ クおよびサンプル ・ レー ト に別の制限因子が
あ り ます ：

• ロ ジ ッ ク ・ タ イプ

• サンプル選択ご と のク ロ ッ ク

• IQおよびIFデジ タル信号タ イプ

表 10-3 出力シリアル・クロック・レート

ロ ジ ッ ク ・ タ イプ 小レー ト  大レー ト  

LVDS 1 x (ワード ・ サイ ズ) kHz 400 MHz

LVTTLおよびCMOS 1 x (ワード ・ サイ ズ) kHz 150 MHz

表 10-4 入力シリアル・クロック・レート

ロ ジ ッ ク ・ タ イプ データ ・ タ イプ 小レー ト  大レー ト  

LVDS サンプル 1 x (ワード ・ サイ ズ) 
kHz

400

FIR前サンプル 1 x (ワード ・ サイ ズ) 
kHz

何れか小さい方 ： 501 x (ワード ・ サイズ) MHz
または 
400 MHz

1最大サンプル・レートは、データ・レートがFIR前サンプルである場合は、選択されたフィルターによります。詳細につ
いては「入力モード」（268ページ）を参照してください。

LVTTLおよびCMOS 該当な し 1 x (ワード ・ サイ ズ) 
kHz

150 MHz
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サンプル当た り のク ロ ッ ク （ク ロ ッ ク /サンプル） はク ロ ッ ク ・ レー ト 対サンプル ・ レー ト の比率です。 IQ信
号タ イプでは、 サンプル当た り のク ロ ッ クの値が1よ り 大きい場合、 サンプル ・ レー ト はこの値で減少し ます。

IF信号または入力信号では、 サンプル当た り のク ロ ッ クは必ず1に設定されます。 出力モード ・ パラ レル、 お

よび、 並列イ ン ター リ ーブ ・ ポー ト 構成のク ロ ッ ク ・ レー ト に関し ては、 表10-5を参照し て く ださい。

入力モード では、 大ク ロ ッ ク ・ レー ト は次の因子によ り 制限されます ：

• サンプル ・ サイ ズ

• データ ・ タ イプ

入力モード ・ パラ レル、 および、 並列イ ン ター リ ーブ ・ ポー ト 構成のク ロ ッ ク ・ レー ト に関し ては、 表10-6
を参照し て く ださい。

クロック・ソース
N5102A module用ク ロ ッ ク信号は、 これ以降の節を通し た3つの方法の1つによ り 規定されます ：

• 内部 ： イ ン ターフ ェース ・ モジュールで内部的に発生 （外部基準が必要）

• 外部外部ク ロ ッ ク入力コネ ク ターを通し て外部で発生 

• デバイ ス デバイ ス ・ イ ン ターフ ェース ・ コネ ク ターを通し て外部で発生

ク ロ ッ ク ・ ソースは、信号発生器のN5102A moduleUIを使用し て選択し ます （図10-2を参照し て く ださい）。 

表 10-5 出力パラレル、および、並列インターリーブ・クロック・レート

ロ ジ ッ ク ・

タ イプ

信号タ イプ 小レー ト  大レー ト  

LVDS IQ 1 x (ク ロ ッ ク /サンプル) kHz 何れか小さい方 ： 100 x (ク ロ ッ ク /サンプル) MHz
または 
400 MHz

IF 4 kHz 400 MHz

その他 IQ 1 x (ク ロ ッ ク /サンプル) kHz 何れか小さい方 ： 100 x (ク ロ ッ ク /サンプル) MHz
または 
150 MHz

IF 4 kHz 150 MHz

表 10-6 入力パラレル、および、並列インターリーブ・クロック・レート

ロ ジ ッ ク ・ 

タ イプ

データ ・ タ イプ 小レー ト  大レー ト  

該当な し サンプル 1 kHz 200 MHz

FIR前サンプル 1 kHz 100 MHz
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図10-2 クロック・ソース選択

ク ロ ッ ク ・ ソース を選択する際には、 Clock Rateソ フ ト キーを使用して、 N5102A moduleにク ロ ッ ク信号周波  

数を入力する こ と が必要です。 内部ク ロ ッ ク ・ ソース ・ モード で、 このソ フ ト キーを使用し て内部ク ロ ッ ク ・
レー ト を設定し ます。デバイ スおよび外部ク ロ ッ ク ・ ソースには、このソ フ ト キーによ って適用された ク ロ ッ
ク信号を反映する こ と が必要です。 

ク ロ ッ ク ・ ソースが内部の場合は、 周波数基準を、 周波数基準コネ ク ターに適用する こ と が必要です。 適用
された こ の信号の周波数は、現在の設定が適用される信号の設定 と一致し ない限 り は、Reference Frequencyソ 

フ ト キーを使用し て指定する こ と が必要です。 

選択された ク ロ ッ ク ・ ソースは、 ク ロ ッ ク出力およびデバイ ス ・ イ ン ターフ ェース ・ コネ ク ターから イ ン ター
フ ェース ・ モジュール出力ク ロ ッ ク信号を供給し ます。

共通の周波数基準
デジ タル信号イ ン ターフ ェ イ ス ・ モジ ュールのク ロ ッ キング柔軟性によ り 、 テス ト するデバイ スのための任
意の ク ロ ッ ク ・ レー ト を設定する こ と が可能にな り ます。 一般的に、 信号発生器内の ク ロ ッ ク ・ レー ト は、
イ ン ターフ ェース ・ モジュールのク ロ ッ ク ・ レー ト と は異な り 、 このため、 イ ン ターフ ェース ・ モジュール
がレー ト の変換を実行し ます。 こ の変換の重要な役割 り は、 正確な ク ロ ッ ク ・ レー ト 情報を持ち、 情報の損
失を防ぐ こ と です。 モジュールは、 絶対的な精度ではな く 相対的な ク ロ ッ ク精度に依存し ますが、 このこ と
は、 テス ト 設定に関連するすべてのク ロ ッ ク ・ レー ト 用に、 単一の周波数基準を使用する こ と によ り 保証す
る こ と が必要です。 このこ と は、 さ まざまな方法で実現でき ますが （図10-3（258ページ）の5つの図を参照

し て く ださい）、 どのよ う な方法で実現する場合も、 信号発生器内部のク ロ ッ ク が、 テス ト されるデバイ スに
よ り 使用される ク ロ ッ ク と同じ基本周波数基準を持つこ と が必要です。

内部クロック・ソース 
選択：適用された基準信号の周
波数を設定します。

外部およびデバイス選択： 
適用されたクロック信号内
部選択のクロック・レート
と一致するように設定しま
す：内部クロック・レート
を選択します。
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信号発生器周波数基準接続
周波数基準が信号発生器に接続されている場合は、 背面パネルのREFに適用されます。

図10-3 N5102A Moduleクロック信号用周波数基準セットアップ図

注記：2つの信号発生器周波数基準入力の内、1つのみを使用します。

内部生成クロック

デバイス（DUT）供給クロック
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並列データ用クロック・タイミング
一部のコ ンポーネン ト は、 単一のサンプル周期の間に複数のク ロ ッ ク を必要と し ます。 （1つのサンプル周期

は1つのIおよびQサンプルから成 り ます。） 並列データ送信には、サンプルご と に1つ、2つまたは4つのク ロ ッ

ク を選択でき ます。 サンプルご と のク ロ ッ ク が1つよ り 多い場合は、 IおよびQサンプルは、 追加ク ロ ッ ク周
期に適合する ために一定に保たれます。 こ の こ と は、 サンプルご と の ク ロ ッ ク の選択に等しい因子によ り 、
ク ロ ッ ク ・ レー ト に相対するサンプル ・ レー ト を減算し ます。 た と えば、 4つが選択された場合、 サンプル ・
レー ト は4の因子によ り 減算されます （サンプル ・ レー ト 対ク ロ ッ ク ・ レー ト の比率） 図10-4は、 それぞれ

のサンプルご と のク ロ ッ ク選択のためのク ロ ッ ク ・ タ イ ミ ングを例示し ます。 入力モード では、 サンプルご
と のク ロ ッ ク の設定は、 必ず1つです。

注記：2つの信号発生器周波数基準入力の内、1つのみを使用します。

外部供給クロック
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図10-4 並列ポート構成用のクロック・サンプル・タイミング

1つのサンプル周期

Qサンプルワード

サンプルごとに 1つのクロック

1つのクロック

クロックおよびサンプル・レートは同じです

Iサンプルワード

クロック

当たり 4ビット 

当たり 4ビット 
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1つのサンプル周期

サンプル当たり 4つのクロック

4つのクロック

4の因子により低減されたサンプルレート

Iサンプルワード 

Qサンプルワード 

クロック

当たり 4ビット 

当たり 4ビット 

1つのサンプル周期

サンプル当たり 2つのクロック

2つのクロック

Iサンプルワード

Qサンプルワード

2の因子により低減されたサンプル・レート

クロック

当たり 4ビット

当たり 4ビット
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並列インターリーブ・テータ用クロック・タイミング
N5102A moduleは、デジ タルIおよびQサンプルを イ ン ター リ ーブする機能を備えています。 イ ン ター リ ーブ 

処理には次の2つの選択肢があ り ます ：

• IQ、 Iサンプルが先に送信される

• QI、 Qサンプルが先に送信される

並列イ ン ター リ ーブが選択された場合は、 すべてのサンプルはIデータ ラ イ ンで送信されます。 このこ と によ

り 、 サンプル周期の間に同じ数のサンプルが、 非イ ン ター リ ーブ ・ サンプルに比べて半分のデータ ・ ラ イ ン
によ り 、 効果的に送信されます。 （1つのサンプル周期は1つのIおよびQサンプルから成 り ます。） サンプルご
と のク ロ ッ クは、 依然と し て、 並列イ ン ター リ ーブ送信の有効なパラ メ ーターであ り 、 ク ロ ッ ク ・ レー ト に
相対するサンプル ・ レー ト の減算を生み出し ます。 サンプルご と の ク ロ ッ ク の選択 と は、 減算の比率です。
図10-5は、 並列IQ イ ン ター リ ーブ ・ ポー ト 構成の、 それぞれのサンプルご と のク ロ ッ ク の選択を、 4ビ ッ ト

のワード ・ サイ ズ と IおよびQサンプルに相対する ク ロ ッ ク ・ タ イ ミ ングを使用し て示し ています。 並列QIイ

ン ター リ ーブ ・ ポー ト 構成は、 単に、 I と Qのサンプル位置を入れ替え るだけです。 入力モード では、 サンプ
ルご と のク ロ ッ ク の設定は、 必ず1つです。

図10-5 並列IQインターリーブ・ポート構成用クロック・タイミング

Qサンプル 
ワード当たり 4ビット 

Iサンプル 
ワード当たり 4ビット 

1つのサンプル周期

サンプルごとに 1つのクロック

1つのクロック

Iサンプルは 1つのクロック遷移時に送信され、Qサンプルは別のクロック遷移時に

クロック

送信されます。サンプル・レートとクロック・レートは同じです。
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1つのサンプル周期

サンプル当たり 4つのクロック

4つのクロック

Iサンプルは最初の 2つのクロック周期に送信され、Qサンプルは 2番目の 2つのクロック周期に

クロック

Qサンプル 
ワード当たり 4ビット 

Iサンプルワード 
当たり 4ビット 

送信されます。サンプル・レートは 4の因子により減少します。

1つのサンプル周期

サンプル当たり 2つのクロック

2つのクロック

Iサンプルは 1つのクロック周期に送信され、Qサンプルは 2番目のクロック周期に 

クロック

Qサンプル 
ワード当たり 4ビット 

Iサンプルワード 
当たり 4ビット 

送信されます。サンプル・レートは 2の因子により減少します。
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シリアル・データ用クロック・タイミング
図10-6はシ リ アル ・ ポー ト 構成用のク ロ ッ ク ・ タ イ ミ ングを示し ます。 シ リ アル送信には、 ク ロ ッ ク によ

り 各ビ ッ ト の開始が示され、 各サンプルの開始部が記されたフ レーム ・ パルスが含まれる こ と に注意し て く
ださい。 シ リ アル送信ではク ロ ッ ク と ビ ッ ト ・ レー ト は同じですが、 サンプル ・ レー ト は、 Word Sizeソ フ
ト キーを使用し て入力されたワード ご と のビ ッ ト 数によ り 変化し ます。 ワード ご と のビ ッ ト 数は、 サンプル
ご と のビ ッ ト 数と同じです。

図10-6 シリアル・ポート構成用のクロック・タイミング

位相および歪み調整のためのクロック・タイミング
N5102A moduleは、データ と相対する ク ロ ッ ク位相および歪み調整を備え、データ有効部分を使用した ク ロ ッ 
ク の調整に使用でき ます。 位相には、 10～200 MHzのク ロ ッ ク ・ レー ト には90度の分解能 （0、 90、 180およ 

び270度の選択）、 10 MHz未満および200 MHzを超え る ク ロ ッ ク ・ レー ト には180度の分解能 （0および180度  

の選択） があ り ます。 

歪みは、 ±5 nsの 大範囲で、 大±127の離散ステ ッ プを使用し て、 ナ ノ秒単位で表示されます。 歪み範囲 

と離散ステ ッ プは、 両方と も、 ク ロ ッ ク ・ レー ト に依存し て変化し ます。 歪み範囲はク ロ ッ ク ・ レー ト が高
く なる と減少し、 ク ロ ッ ク ・ レー ト が低 く な る と増加し ます。 大歪み範囲がク ロ ッ ク ・ レー ト が約99 MHz 
の時点で到達し、 ク ロ ッ ク ・ レー ト が25 MHzにな る まで維持されます。 25 MHz未満の ク ロ ッ ク ・ レー ト で  

は、 歪み調整は使用でき ません。 

離散ステ ッ プは次の式を使用し て計算されます ：

大歪み範囲の到達する ために必要な離散ステ ッ プの数は、 低い周波数では減少し ます。 た と えば、 50 MHz 
のク ロ ッ ク ・ レー ト では、127ステ ッ プで±5 nsの 大歪み範囲を超え るため、離散ステ ッ プの実際の数は127 
よ り 少な く な り ます。 

図10-7は位相および歪み調整の例であ り 、 元のク ロ ッ ク と、 各調整を行った後のデータに相対する位相位置
を示し ています。 歪み調整が位相設定に付け加え られている こ と に注意し て く ださい。

クロック

ワード当たり 4ビット 

1つのサンプル

フレーム・

データ・ビット

マーカー

 1
256 Clock     Rate
---------------------------------------------------------

ク ロ ッ ク ・ レー ト
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図10-7 クロック位相および歪み調整

クロック・ソースとテストされるデバイスの接続
図10-3（258ページ）に示される通 り 、共通の周波数基準をシステム ・ コ ンポーネン ト （信号発生器、N5102A
module、 および、 試験中のデバイ ス） に供給する、 多数の方法があ り ます。図10-8は、 信号発生器が共通の

周波数基準を供給し、 N5102A moduleが ク ロ ッ ク をデバイ スに提供するセ ッ ト ア ッ プの例を示し ます。

注意 イ ン タ フ ェース ・ モジュールのデバイ ス ・ イ ン ターフ ェース ・ コネ ク ターは、 高速デジ タル ・ デー
タ を使用し て通信し ます。接続を行 う 際には、ESD警告に従って、破損の可能性を排除し て く ださい。

クロック歪みの調整
90度位相調整

クロック

位相が調整され

歪みが調整され

たクロック

たクロック

データ

位相および
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図10-8 信号発生器の10 MHz周波数基準を使用するセットアップの例

注記 デジ タル ・ バス ・ ケーブル とデジ タル ・ モジ ュールは、 フ ァーム ウ ェアを信号発生器にダウ ン ロー
ドする間は切 り 離すこ と が必要です。

1. 図10-3（258ページ）の5つのセ ッ ト ア ッ プ図を参照し、 ク ロ ッ ク ・ ソースに従って周波数基準ケーブル

を接続し て く ださい。

2. 外部ク ロ ッ ク ・ ソース を使用する場合は、 外部ク ロ ッ ク信号を、 イ ン タ フ ェース ・ モジ ュールの外部ク
ロ ッ ク入力コネ ク ターに接続し ます。

3. 用途に適合し た出力コネ ク ターを備えたブレ イ ク ア ウ ト ・ ボード を選択し ます。

注記 テス ト するデバイ スにデバイ ス ・ イ ン ターフ ェース組み合わせコネ ク ターが使用されている場合に
は、 デバイ ス ・ イ ン ターフ ェース接続と、 デバイ スのN5102Aモジュールへの接続に関する図10-8
を参照し て く ださい。 次に「出力モードにおける N5102A Moduleの操作」（269ページ）、 または、 

「入力モードにおけるN5102A Moduleの操作」（280ページ）に進んで く ださい。

信号発生器の 10 MHz出力

周波数基準コネクター

デバイス・インターフェース接続

テストされるデバイス
ブレイクアウト・ボード

デバイスとブレイクアウト・ボードの間の接続には 
ユーザー支給のリボン・ケーブルを使用します。

共通の周波数基準ケーブル

デバイスへのクロックは、リボン・ケーブルで接続
します。
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4. 図10-8を参照し て く ださい。 ブレ イ ク ア ウ ト ・ ボード を、 N5102A moduleのデバイ ス ・ イ ン ターフ ェー 
ス ・ コネ ク ターに接続し ます。

5. デバイ ス をブレ イ ク ア ウ ト ・ ボード に接続し ます。
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データ・タイプ
次のブロ ッ ク図は、 信号発生プロ セスの中のど こ で、 データが入力モー ド 用にイ ンジ ェ ク ト され、 または、
出力モード用にタ ッ プされるかを示し ます。

出力モード
リ アルタ イ ム変調フ ィ ルターのないARBフ ォーマ ッ ト を使用する場合は、 データ ・ タ イプは必ずサンプル と

な り 、 データ ・ サンプルにフ ィ ルターは適用されません。 サンプルは、 ARBサンプル ・ ク ロ ッ ク ・ レー ト で
デジ タル ・ モジュールに送信され、 リ サンプルされます。

リ アルタ イ ム ・ フ ォーマ ッ ト 、 または、 リ アルタ イ ム変調フ ィ ルターを使用するデュ アルARBには、 データ ・

タ イプにサンプルを選択する と、 フ ィ ルター処理されたサンプルをデジ タル ・ モジ ュールに、 モジ ュールの
ク ロ ッ ク ・ レー ト で送信し ます。 FIR 前サンプルを選択し、 フ ィ ルター処理がな く 潜在的に リ サンプ リ ング
された可能性があ るサンプルを、 モジュールのク ロ ッ ク ・ レー ト で、 モジ ュールに送信し ます。

入力モード
データ ・ タ イプがサンプルの場合は、デジ タル ・ モジ ュールを通し て届いたデータ ・ サンプルは、 フ ィ ルター
処理を迂回し たポイ ン ト でイ ンジェ ク ト されます。 

FIR前サンプルが選択された場合は、 データ ・ サンプルは、 フ ィ ルター処理の前にイ ンジェ ク ト されます。 

Filterソ フ ト キーを使用し て、 所定のフ ィ ルター処理パラ メ ーター設定を可能にする メ ニューにア ク セスでき
ます。 

データ 
FIR

DAC

RF

サンプル
サンプル

出力 

サンプル サンプル
FIR前

モー ド

フィルター I、Q
変調器

LO

入力 
モード

FIR前

信号発生器

発生器 I/Q

入力モード

出力モード

プリング
およびリサン
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出力モードにおけるN5102A Moduleの操作
こ の節は、 信号発生器の出力指示用UI を使用する、 N5102A のパラ メ ーター設定の方法が示し ています。 そ

れぞれの手順には、 実行する イ ン タ フ ェース ・ モジ ュール機能用のソ フ ト キー ・ メ ニュー構造を示す図が含
まれます。 

信号発生器ベースバンド・データの設定
デジ タル信号イ ン ターフ ェ イ ス ・ モジ ュールは、 ベースバン ド ・ ソースからデータ を受信し、 選択された ロ
ジ ッ ク ・ タ イプに関連するデジ タルIQまたはデジ タルIF信号を出力し ます。信号発生器はベースバン ド ・デー

タ を供給する ため、イ ン ターフ ェース ・モジ ュール操作の 初の手順は、 リ アルタ イ ムまたはARB変調フ ォー
マ ッ ト の 1つを使用し て信号発生器を設定する こ と 、 も し く は、 デュ アルARB再生機を使用し て保存済み

フ ァ イルを再生する こ とです。 信号発生器設定の詳細については、第8章、「基本的なデジタル操作 （オプショ 
ン653/655/656/657）」（145ページ）を参照し て く ださい。

1. 信号発生器をプ リ セ ッ ト し ます。

2. 変調フ ォーマ ッ ト （GSM、 カス タ ム、 など） を選択し、 所定のパラ メ ーターを設定し ます。

3. 変調フ ォーマ ッ ト をオンにし ます。

N5102A Moduleユーザー・インターフェースへのアクセス
図10-9は、 信号発生器の正面パネルにあ る、 補助機能キーを押すこ と によ り ア ク セスでき る補助 メ ニューを

示し ます。

図10-9 第1レベル・ソフトキー・メニュー

PXBまたは N5102A接続性の

デフォルトでは N5102Aが

Aux Fctn

ここを押して、N5102Aメニュー

どちらかを選択します。

選択されています。

にアクセスします。
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N5102Aイ ン ターフ ェース を押し て、 デジ タル信号イ ン ターフ ェース ・ モジュールの設定に使用されるUI
（図10-10に示される第1レベル ・ ソ フ ト キー ・ メ ニュー） にア ク セス し ます。 N5102A moduleが自体の内部 
ク ロ ッ ク信号をど こ で生成するかを設定を示す、 信号発生器のデ ィ スプレ イのグ ラ フ ィ ッ ク に注意し て く だ
さい。 こ のグ ラ フ ィ ッ クは、 現在のク ロ ッ ク ・ ソース選択を反映し て変化し ます。

図10-10 N5102Aインターフェース・メニュー

N5102Aモジュール・インターフェースがオンになるまでは、線はグレー表示になっています。

DUTに向かう内部クロック
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Logic TypeおよびPort Configurationの選択

図10-11 LogicおよびPort Configurationソフトキー・メニュー

1. 図10-11を参照し て く ださい。 Logic Typeソ フ ト キーを押し ます。

こ の メ ニューから、 ロ ジ ッ ク ・ タ イプを選択し ます。

注意 ロ ジ ッ ク ・ タ イプに変更によ り 、 試験中のデバイ スに送られる信号電圧レベルを増減でき ます。 デ
バイ スおよび/またはN5102A moduleの損傷を避け るため、 どち らにも取 り 扱 う 電圧変更に対する 
容量があ る こ と確認し ます。

2. テス ト するデバイ スに必要な ロ ジ ッ ク ・ タ イプを選択し ます。

ロ ジ ッ ク ・ タ イプに変更を加え る際には、 必ず注意 メ ッ セージが表示され、 確認を要求する ソ フ ト キー
選択が表示されます。

3. 図10-11を参照し て く ださい。 Port Configソ フ ト キーを押し ます。

こ の メ ニューで、 シ リ アル、 パラ レルまたは並列イ ン ター リ ーブ ・ データ送信から何れかを選択し ます。

注記 Data SetupおよびClock Setup ソ フ ト キー ・ メ ニュー内で、 い く つかのソ フ ト キーは現在の設定に  
関連し て機能し ます。 グレー表示された ソ フ ト キーは現在のセ ッ ト ア ッ プには使用でき ません。
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4. デバイ ス用ポー ト 構成を選択し ます。

出力指示の選択
Data Setup > Direction Input OutputでOutputを押し、 Returnを押し ます。 

注記 オプシ ョ ン と し て、 オプシ ョ ン003しかイ ン ス ト ールされていない場合は、 方向ソ フ ト キーは使用

できず、 モード は常に出力です。 オプシ ョ ン003 （出力モード） と オプシ ョ ン004 （入力モード） の
両方がイ ン ス ト ールされている場合、 デフ ォル ト の方向は出力です。 

データ・パラメーターの設定
こ の手順では、 Data Setup メ ニューを通し て解説し ます。 言葉の上から説明でき る名前が付いた ソ フ ト キー 

には、 原則と し て言及し ません。 例えば、 Word Sizeソ フ ト キーです。 

1. 図10-12を参照し て く ださい。 Data Setupソ フ ト キーを押し ます。

図10-12 Data Setupメニューの場所

こ の ソ フ ト キー ・ メ ニ ューか ら、 テス ト 中のデバイ スが受信するデータ を統制する さ ま ざまなパラ メ ー
ターにア ク セス し ます。 デ ィ スプレ イの状態領域は、 IおよびQの両方のために使用されたデータ ・ ラ イ ン

の数 と、 データに関連する ク ロ ッ ク位置を示し ます。 ポー ト 構成がパラ レルまたは並列イ ン ター リ ーブ
の場合は、 表示されるデータ ・ ラ イ ンの数は、 ワー ド （サンプル） サイ ズに相当し ます。 ポー ト 構成が
シ リ アルの場合は、 デ ィ スプレ イは、 それぞれ1つのみの I と Q のデータ ・ ラ イ ンが使用されている こ と
を、 サンプルの開始を示すフ レーム ・ マーカーと合わせて表示し ます。図10-13は、 Data Setup メ ニュー 

の構造を示し ます。

Data Setupメニューに
アクセスします
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図10-13 パラレル・ポート構成のData Setupソフトキー・メニュー

シリアル・ポート構成用

フレーム極性はシリアル・

には作動なし 

ARBフォーマットに

ワード・サイズ = 16ビット 
には作動なし

出力モードの間のみ 
使用可能

は作動なし

ポート構成用にアクティブです
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2. リ アルタ イ ム変調フォーマッ ト またはデュアルARB で変調フ ィ ルター機能が使用されている場合は、 Data
Typeソ フ ト キーを押し ます。 

こ の メ ニ ューで、 信号発生器か らの リ アルタ イ ム ・ ベースバン ド ・ データがフ ィ ルター処理されている
か （Samples） あ るいはフ ィ ルター処理されていないか （Pre-FIR Samples） を選択し ます。 選択は、 テス 

ト の要件次第です。 Samples を選択する と、 ア ク テ ィ ブ変調フ ォーマ ッ ト の通信規格に従ってFIR フ ィ ル
ター処理されたベースバン ド ・ サンプルが供給されます。 これはプ リ セ ッ ト 選択であ り 、 も よ く 使わ
れる ものです。 ただし、 テス ト される機器にすでにFIRフ ィ ルターが組み込まれている場合には、 Pre-FIR
Samplesを選択し て、 二重フ ィ ルター処理を回避し て く ださ い。

3. テス ト 用に適切なデータ ・ タ イプを選択し ます。

4. Numeric Formatソ フ ト キーを押し ます。

この メ ニューから、 2進値を表現する方法を選択し ます。 2の補数を選択する と、 正と負の両方のデータ値

が可能にな り ます。コ ンポーネン ト が負数を処理できない場合は、オフセ ッ ト 2進値の選択を使用し ます。

5. テス ト に必要な数値フ ォーマ ッ ト を選択し ます。

6. More (1 of 2)ソ フ ト キーを押し ます。

こ のソ フ ト キー ・ メ ニューから、 ビ ッ ト 順を選択し、 I と Q を入れ替え、 送信データの極性を選択し、 さ
らに、 データ消込、 ス ケー リ ング、 ゲイ ン、 オフセ ッ ト および IQ回転調整を可能にする メ ニューにア ク

セス し ます。

7. Data Negationソ フ ト キーを押し ます。

消込 （Nagation） は、 I とQの極性の変更 と は異な り ます。 サンプルに適用する と、 消込は、 2つの補数形
式で表現し、 それを負数 と 掛け合わせ、 サンプルを選択された数値フ ォーマ ッ ト に戻す変換を行 う こ と
によ り 、 対象のサンプルを変更し ます。 こ のこ と は、 I サンプル、 Q サンプル、 または、 両方に行 う こ と
ができ ます。 

消込使用の選択は、 テス ト されるデバイ ス と、 それがデータ を どのよ う に受信する こ と が必要であ るか
によ り 変わ り ます。

8 Gain, Offset & Scalingソ フ ト キーを押し ます。

こ の メ ニューのソ フ ト キーを次の機能に使用し ます ：

• Scalingソ フ ト キーを使用し て、 IおよびQの両方のサンプル値を削減

• I GainおよびQ Gainソ フ ト キーを使用し て、 サンプル値をI と Qそれぞれ単独で増加または減少

• I OffsetおよびQ Offsetソ フ ト キーを使用し て、 補償またはDCオフセ ッ ト を追加

• Rotationソ フ ト キーを使用し てデータ をIQ平面上で回転

9. 必要なス ケー リ ング、 ゲイ ン、 オフセ ッ ト または回転調整を行い、 デバイ ス を適切にテス ト し ます。

10. Return > Return と押し て、 第1レベル ・ ソ フ ト キー ・ メ ニューに戻 り ます
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クロック信号の設定
1. 図10-14を参照し て く ださい。 Clock Setupソ フ ト キーを押し ます。

図10-14 Clock Setupメニューの場所

このソ フ ト キー ・ メ ニューから、 N5102A module と信号発生器の間でク ロ ッ ク を同期させる、 すべての 
ク ロ ッ ク ・ パラ メ ーターを設定し ます。 ク ロ ッ ク信号の位相を、 データの有効部分の間を通し て ク ロ ッ
ク が発生する よ う に、 変更する こ と もでき ます。 図10-15は、 Clock Setup メ ニューを示し ます。

図10-15 パラレル・ポート構成用Clock Setupソフトキー・メニュー

Clock Setupメニュー 
にアクセスします

シリアル・ポート構成と IF信号タイプには作動なし

内部クロック・ソース選択時のみ作動

クロック・レートが 25 MHz以下の場合は作動なし

10 MHz未満および200 MHzを超える 
クロック・レートには作動なし
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デ ィ スプレ イ 上部のグ ラ フ ィ ッ ク は、 ク ロ ッ ク出力およびデバイ ス ・ イ ン ターフ ェース ・ コネ ク ター
部の出力ク ロ ッ ク信号を供給する、 現在の ク ロ ッ ク ・ ソース を表示し ます。 グ ラ フ ィ ッ クは、 こ の手順
で こ の後説明する ク ロ ッ ク ・ ソースの選択を反映し て変化し ます。 下部のグ ラ フ ィ ッ クは、 データ と 相
対する ク ロ ッ ク の位置を示し ます。 表示される ク ロ ッ ク信号は、 以下を反映し て変化し ます ：

• サンプル選択ご と のク ロ ッ ク

• ク ロ ッ ク位相の選択

• ク ロ ッ ク歪みの調整

• ク ロ ッ ク極性の選択

デバイ ス または外部ク ロ ッ ク が周波数に適合し ない場合は、 信号発生器に以下のエラー ・ メ ッ セージの
1つが表示されます ：

805 デジ タル ・ モジュール出力FIFOオーバーフ ロー ・ エラー。 現在の ク ロ ッ ク ・ レー ト

で処理でき る数よ り 多 く のサンプルが生成されま し た。 デジ タル ・ モジ ュール ・ ク
ロ ッ ク が適正にセ ッ ト ア ッ プされている こ と を確認し て く ださい。
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このエラーは、 出力FIFOが、 デジ タル ・ モジ ュールでオーバーフ ローし た場合にレ

ポー ト されます。 こ のエラーは、外部ク ロ ッ ク またはその基準が、適切にセ ッ ト ア ッ
プされていない場合、 または、 内部VCOがロ ッ ク されていない場合に発生し ます。

806 デジ タル ・ モジュール出力FIFOアンダーフ ロー ・ エラー。 現在の ク ロ ッ ク ・ レー ト

用に、 十分なサンプルが生成されていません。 デジ タル ・ モジ ュール ・ ク ロ ッ ク が
適正にセ ッ ト ア ッ プされている こ と を確認し て く ださい。

このエラーは、 出力FIFOが、 デジ タル ・ モジ ュールでアンダーフ ローし た場合にレ

ポー ト されます。 こ のエラーは、外部ク ロ ッ ク またはその基準が、適切にセ ッ ト ア ッ
プされていない場合、 または、 内部VCOがロ ッ ク されていない場合に発生し ます。

2. ポー ト 構成が、 IQ信号タ イプを使用する、パラ レルまたは並列イ ン ター リ ーブであれば、 Clocks Per Sample   
ソ フ ト キーを押し ます。

サンプルご と に複数のク ロ ッ ク が選択でき る こ と に注意し て く ださい。 一部の DAC は、 それぞれのサン

プルを複数回ク ロ ッ ク処理する機能を要求し ます。 サンプル値ご と の ク ロ ッ ク数が1よ り 大きい と、 レー
ト は、 選択されたサンプルご と の ク ロ ッ ク の数に等しい因子によ り 減算されます。 サンプル ・ レー ト は
第1レベルおよびData Setupソ フ ト キー ・ メ ニューに表示されます。

3. サンプルご と のク ロ ッ ク の値を、 テス ト に適合させる よ う に選択し ます。

4. Clock Sourceソ フ ト キーを押し ます。

この メ ニューから、 ク ロ ッ ク信号ソースを選択し ます。それぞれの選択で、信号発生器Clock Setupメ ニュー 
の ク ロ ッ ク ・ ルーテ ィ ング ・ デ ィ スプレ イは、 現在の ク ロ ッ ク ・ ソース を反映し て変化し ます。 こ の こ
と は、 グ ラ フ ィ ッ ク の変化と し て表示されます。

5. ク ロ ッ ク ・ ソース を選択し ます。

ExternalまたはDeviceが選択された場合

Clock Rateソ フ ト キーを押し、 外部で適用された ク ロ ッ ク信号のク ロ ッ ク ・ レー ト を入力し ます。 

注記 ク ロ ッ ク位相と ク ロ ッ ク歪みは、 ク ロ ッ ク ・ レー ト の設定が変更された らいつでも、 調整が必要に
なる場合があ り ます。「位相および歪み調整のためのクロック・タイミング」（264 ページ）を参照

し て く ださい。

Externalを選択する場合、 信号は外部ク ロ ッ ク ・ ソースによ り 供給され、 外部ク ロ ッ ク入力コネ ク ターに
適用されます。 Deviceを選択する場合、 ク ロ ッ ク信号は、 通常はテス ト されるデバイ スによ って、 デバイ

ス ・ イ ン ターフ ェース ・ コネ ク ターを通し て供給されます。

Internalが選択された場合

外部周波数基準を使用し て、 N5102A moduleは、 それ自体の内部ク ロ ッ ク信号を発生し ます。 基準周波 
数信号は、 デジ タル ・ モジュールの周波数基準コネ ク ターに適用される こ と が必要です。

a. Reference Frequencyソ フ ト キーを押し て、 外部で適用された周波数基準を入力し ます。
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b. Clock Rateソ フ ト キーを押し て、 適切な ク ロ ッ ク ・ レー ト を入力し ます。

表10-7は、 それぞれの ク ロ ッ ク ・ ソース選択に関連する、 設定と接続のク イ ッ ク ・ ビ ューを提供し ます。

6. Clock Phaseソ フ ト キーを押し ます。

表示された メ ニューから、 データに関連する ク ロ ッ ク位相を、 90 度の増分で調整する こ と ができ ます。 こ
の選択は、 データの有効部分でク ロ ッ クの位置決めの粗調整を可能にし ます。 180度の選択は、 負のク ロ ッ

ク極性の選択と同じにな り ます。

90度と270度の選択は、 ク ロ ッ ク ・ レー ト が10 MHz未満または200 MHzを超える場合には適用でき ません。  
ク ロ ッ ク ・ レー ト が10 MHz未満または200 MHzを超え る場合に、 90度または270度が選択される と、 位  

相はそれぞれ0度または180度に変更されます。 

注記 ク ロ ッ ク位相 と ク ロ ッ ク歪みは、 ク ロ ッ ク ・ レー ト の設定が変更さ れた ら いつで も、 調整が必要
にな る場合があ り ます。「位相および歪み調整のためのクロック・タイミング」（264ページ）を参
照し て く ださい。

7. 必要な位相調整を入力し ます。

8. Returnソ フ ト キーを押し て、 Clock Setup メ ニューに戻 り ます。

9. Clock Skewソ フ ト キーを押し ます。

こ のこ と によ り 、 ク ロ ッ ク の、 現在の位相位置に相対する微調整が可能にな り ます。 歪み （Skew） と は

時間値の増分を使用する位相の調整です。 こ の こ と は、 ク ロ ッ ク ・ レー ト が高いほど、 よ り 大きい歪み
調整機能を可能にし ます。 25 MHz未満のク ロ ッ ク ・ レー ト では、 ソ フ ト キーは無効にな り ます。

歪みは、 ク ロ ッ ク ・ レー ト に依存する範囲を持つ、 離散値があ り ます。 歪み設定の詳細については「位
相および歪み調整のためのクロック・タイミング」（264ページ）を参照し て く ださい。

10. データの有効な部分によ って ク ロ ッ ク を 適に位置決める、 歪み調整を入力し ます。

表 10-7 クロック・ソース設定とコネクター

ク ロ ッ ク ・ ソース ソ フ ト キー N5102A Module接続

Reference 
Frequency

Clock Rate1

1Internalの選択には、これにより内部クロック・レートが設定されます。ExternalおよびDeviceの選択
には、これにより、適用されるクロック信号のレートが、インターフェース・モジュールに通知さ
れます。

周波数基準 外部ク ロ ッ ク 
入力

デバイ ス ・ イ ン ター
フ ェース

External • •

Device • •

Internal2

2外部クロック入力コネクターに適用されるクロック信号があってはなりません。

• • •
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11. Clock Polarity Neg Posソ フ ト キーをNegに押し ます。

こ のこ と によ り ク ロ ッ ク信号は180度シフ ト され、 データは負のク ロ ッ ク遷移の間に開始されます。 これ
は、 位相調整で180度を選択し たの と同じ影響を与えます。

12. テス ト されるデバイ スに必要な ク ロ ッ ク極性選択を行います。

13. Returnハード キーを押し て、 第1レベル ・ ソ フ ト キー ・ メ ニューに戻 り ます。

ク ロ ッ ク ・ ソース選択は、 第1レベル ・ ソ フ ト キー ・ メ ニューのグ ラ フ ィ ッ ク にも反映されます。 例えば、

デバイ スが新しい ク ロ ッ ク ・ ソースであ る場合は、 グ ラ フ ィ ッ クは、 今、 周波数基準がDUTに接続され、
DUTにN5102A moduleにつながる新しい ク ロ ッ ク ・ ラ イ ンがあ る こ と を表示し ます。

デジタル・データの発生
N5102A Off Onソ フ ト キーを押し てオンにし ます。

これで、 デジ タル ・ データはN5102A moduleを経由し てデバイ スに転送されます。 グ リ ーンの表示ラ ンプが 
点滅するはずです。 こ のこ と は、 データ ・ ラ イ ンがア ク テ ィ ブであ る こ と を示し ます。 表示ラ ンプが点灯の
ま ま （点滅し ない） 場合は、 すべてのデータ ・ ラ イ ンは、 ア ク テ ィ ブではあ り ません。 表示ラ ンプは、 初
にN5102A moduleがオンになった際に （N5102A Off Onをオン） 点灯し、点灯または点滅の状態を継続し ます。   

表示ラ ンプは、 モジュールが電源から切 り 離される まで点灯または点滅を続けます。

イ ン ターフ ェース ・ モジュールは、 変調フ ォーマ ッ ト がア ク テ ィ ブな間のみオンにでき ます。 モージュール
がオンの間に変調フ ォーマ ッ ト をオフにする と、 モジ ュールもオフになってエラーがレポー ト されます。

注記 ベース バン ド ・ デー タ ・ パ ラ メ ー タ ーに変更を行 う 場合は、 初にデジ タ ル出力を無効に し て
（N5102A Off Onソ フ ト キーをオフ）、 使用するデバイ ス と N5102A moduleを、 パラ メ ーター変更の際   

に発生する可能性があ る信号変動に曝される こ と を回避する こ と を推奨し ます。
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入力モードにおけるN5102A Moduleの操作
こ の節では、 信号発生器の入力指示のUI を使用する、 N5102A のパラ メ ーター設定の方法を示し ます。 それ

ぞれの手順には、 実行する イ ン タ フ ェース ・ モジ ュール機能用のソ フ ト キー ・ メ ニュー構造を示す図が含ま
れます。

「クロック・ソースとテストされるデバイスの接続」（265 ページ）を参照し て、 テス ト ・ セ ッ ト ア ッ プを設

定し ます。

N5102A Moduleユーザー・インターフェースへのアクセス
図 10-16 は、 信号発生器の正面パネルにあ る、 補助機能キーを押すこ と によ り ア ク セスでき る補助 メ ニュー
を示し ます。

図10-16 第1レベル・ソフトキー・メニュー

N5102A moduleのすべてのパラ メ ーターは、 信号発生器のソ フ ト キーを使用し て設定し ます。

N5102Aイ ン ターフ ェース を押し て、 デジ タル信号イ ン ターフ ェース ・ モジュールの設定に使用されるUI
（図10-17に示される第1レベル ・ ソ フ ト キー ・ メ ニュー） にア ク セス し ます。 N5102A moduleが自体の内部 
ク ロ ッ ク信号をど こ で生成するかを設定を示す、 信号発生器のデ ィ スプレ イのグ ラ フ ィ ッ ク に注意し て く だ
さい。 こ のグ ラ フ ィ ッ クは、 現在のク ロ ッ ク ・ ソース選択を反映し て変化し ます。

PXBまたは N5102A接続性の

デフォルトでは N5102Aが選択

Aux Fctn

ここを押して、N5102Aメニュー
。

どちらかを選択します。

されています。

にアクセスします
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図10-17 N5102Aインターフェース・メニュー
DUTに向かう内部クロック

N5102Aモジュール・インターフェースがオンになるまでは、線はグレー表示になっています。
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入力指示の選択
オプシ ョ ン003 （出力モード） と オプシ ョ ン004 （入力モード） の両方がイ ン ス ト ールされている場合は、 入

力指示を選択する こ と が必要です。

Data Setup > Direction Input OutputでInputを押し、 Returnを押し ます。 

注記 オプシ ョ ン と し て、 オプシ ョ ン 004 しかイ ン ス ト ールされていない場合は、 指示ソ フ ト キーは使用
できず、 モード は常に入力です。 

Logic TypeおよびPort Configurationの選択

図10-18 LogicおよびPort Configurationソフトキー・メニュー

1. 図10-18を参照し て く ださい。 Logic Typeソ フ ト キーを押し ます。

こ の メ ニューから、 ロ ジ ッ ク ・ タ イプを選択し ます。

注意 ロ ジ ッ ク ・ タ イプを変更する こ と によ り 、 信号電圧レベルが増減する可能性があ り ます。 デバイ ス
および/またはN5102A moduleの損傷を避け るため、 どち らにも取 り 扱 う 電圧変更に対する容量が 

あ る こ と確認し ます。
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2. テス ト するデバイ スに必要な ロ ジ ッ ク ・ タ イプを選択し ます。

ロ ジ ッ ク ・ タ イプに変更を加え る際には、 必ず注意 メ ッ セージが表示され、 確認を問い合わせる ソ フ ト
キー選択が表示されます。

3. 図10-18を参照し て く ださい。 Port Configソ フ ト キーを押し ます。

こ の メ ニューで、 シ リ アル、 パラ レルまたは並列イ ン ター リ ーブ ・ データ送信から何れかを選択し ます。

注記 Data SetupおよびClock Setupソ フ ト キー ・ メ ニュー内で、 い く つかのソ フ ト キーは現在の設定に関  

連し て機能し ます。 グレー表示された ソ フ ト キーは現在のセ ッ ト ア ッ プには使用でき ません。 ヘル
プ ・ テキス ト を参照し て、 どのパラ メ ーターがソ フ ト キーを使用できない原因と なっているか判定
し ます。 信号発生器正面パネルのHelpハード キーを押し、 次に使用できないソ フ ト キーを押し ます。

4. テス ト するデバイ ス用のポー ト 構成を選択し ます。

クロック信号の設定
1. 図10-19を参照し て く ださい。 Clock Setupソ フ ト キーを押し ます。

図10-19 Clock Setupメニューの場所

このソ フ ト キー ・ メ ニューから、 N5102A module とデバイ スの間でデータ を同期させる、 すべてのク ロ ッ 

ク ・ パラ メ ーターを設定し ます。 こ の メ ニ ューか ら、 ク ロ ッ ク信号の位相を、 データの有効部分の間を
通し て ク ロ ッ ク が発生する よ う に変更でき ます。 図10-20は、 Clock Setup メ ニューを示し ます。

デバイ ス または外部ク ロ ッ ク が周波数に適合し ない場合は、 信号発生器に以下のエラー ・ メ ッ セージの1
つが表示されます ：

803 デジ タル ・ モジュール入力FIFOオーバーフ ロー ・ エラー。 現在の ク ロ ッ ク ・ レー ト
で処理でき る数よ り 多 く のサンプルが生成されま し た。 デジ タル ・ モジ ュール ・ ク
ロ ッ ク が適正にセ ッ ト ア ッ プされている こ と を確認し て く ださい。

こ のエ ラーは、 デジ タル ・ モジ ュール ・ ク ロ ッ ク ・ セ ッ ト ア ッ プ と、 サンプルがデ
ジ タル ・ モジ ュール

に入力し ている レー ト が同期し ない場合にレポー ト されます。

Clock Setupメニューに 
アクセスします
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入力された ク ロ ッ ク ・ レー ト が、 ク ロ ッ ク ・ セ ッ ト ア ッ プ ・ メ ニューで指定された

ク ロ ッ ク ・ レー ト と一致する こ と を確認し ます。

804 デジ タル ・ モジュール入力FIFOアンダーフ ロー ・ エラー。 現在の ク ロ ッ ク ・ レー ト
用に、 十分なサンプルが生成されていません。 デジ タル ・ モジ ュール ・ ク ロ ッ ク が
適正にセ ッ ト ア ッ プされている こ と を確認し て く ださい。

こ のエ ラーは、 デジ タル ・ モジ ュール ・ ク ロ ッ ク ・ セ ッ ト ア ッ プ と、 サンプルがデ
ジ タル ・ モジュール

に入力し ている レー ト が同期し ない場合にレポー ト されます。

入力された ク ロ ッ ク ・ レー ト が、 ク ロ ッ ク ・ セ ッ ト ア ッ プ ・ メ ニューで指定された

ク ロ ッ ク ・ レー ト と一致する こ と を確認し ます。

図10-20 パラレル・ポート構成用Clock Setupソフトキー・メニュー

入力モードには非アクティブ

内部クロック・ソース選択時のみ作動

クロック・レートが 25 MHz以下の場合は作動なし

10 MHz未満および200 MHzを超える 
クロック・レートには作動なし
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デ ィ スプレ イ 上部のグ ラ フ ィ ッ ク は、 ク ロ ッ ク出力およびデバイ ス ・ イ ン ターフ ェース ・ コネ ク ター
部の出力ク ロ ッ ク信号を供給する、 現在の ク ロ ッ ク ・ ソース を表示し ます。 グ ラ フ ィ ッ クは、 こ の手順
で こ の後説明する ク ロ ッ ク ・ ソースの選択を反映し て変化し ます。 下部のグ ラ フ ィ ッ クは、 データ と 相
対する ク ロ ッ ク のエ ッ ジを示し ます。 表示される ク ロ ッ ク信号は、 以下を反映し て変化し ます ：

• ク ロ ッ ク位相の選択

• ク ロ ッ ク歪みの調整

• ク ロ ッ ク極性の選択

2. Clock Sourceソ フ ト キーを押し ます。

この メ ニューから、ク ロ ッ ク信号ソースを選択し ます。それぞれの選択で、信号発生器Clock Setup メ ニュー 
の ク ロ ッ ク ・ ルーテ ィ ング ・ デ ィ スプレ イは、 現在の ク ロ ッ ク ・ ソース を反映し て変化し ます。 こ の こ
と は、 グ ラ フ ィ ッ ク の変化と し て表示されます。

3. ク ロ ッ ク ・ ソース を選択し ます。

ExternalまたはDeviceが選択された場合

Clock Rateソ フ ト キーを押し、 外部で適用された ク ロ ッ ク信号のク ロ ッ ク ・ レー ト を入力し ます。 

注記 ク ロ ッ ク位相と ク ロ ッ ク歪みは、 ク ロ ッ ク ・ レー ト の設定が変更された らいつでも、 調整が必要に
なる場合があ り ます。「位相および歪み調整のためのクロック・タイミング」（264 ページ）を参照

し て く ださい。

Externalを選択する場合、 信号は外部ク ロ ッ ク ・ ソースによ り 供給され、 外部ク ロ ッ ク入力コネク ターに適

用されます。 Device選択では、 ク ロ ッ ク信号は、 通常はテス ト されるデバイ スによ って、 デバイ ス ・ イ ン
ターフ ェース ・ コネ ク ターを通し て供給されます。

Internalが選択された場合

外部周波数基準を使用し て、 N5102A moduleは、 それ自体の内部ク ロ ッ ク信号を発生し ます。 基準周波 

数信号は、 デジ タル ・ モジュールの周波数基準コネ ク ターに適用される こ と が必要です。

a. Reference Frequencyソ フ ト キーを押し て、 外部で適用された周波数基準を入力し ます。

b. Clock Rateソ フ ト キーを押し て、 適切な ク ロ ッ ク ・ レー ト を入力し ます。

表10-8は、 それぞれの ク ロ ッ ク ・ ソース選択に関連する、 設定 と接続のク イ ッ ク ・ ビ ューを提供し ます。
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4. Clock Phaseソ フ ト キーを押し ます。

表示された メ ニューから、データに関連する ク ロ ッ ク位相を、90度の増分で変更する こ と ができ ます。 こ

の選択は、 データの有効部分でク ロ ッ クの位置決めの粗調整を可能にし ます。 180度の選択は、 負のク ロ ッ

ク極性の選択と同じにな り ます。

90度と270度の選択は、 ク ロ ッ ク ・ レー ト が10 MHz未満または200 MHzを超える場合には適用でき ません。  
ク ロ ッ ク ・ レー ト が10 MHz未満または200 MHzを超え る場合に、 90度または270度が選択される と、 位  

相はそれぞれ0度または180度に変更されます。 

注記 ク ロ ッ ク位相と ク ロ ッ ク歪みは、 ク ロ ッ ク ・ レー ト の設定が変更された らいつでも、 調整が必要に
な る場合があ り ます。「位相および歪み調整のためのクロック・タイミング」（264ページ）を参照

し て く ださい。

5. 必要な位相調整を入力し ます。

6. Returnソ フ ト キーを押し て、 Clock Setup メ ニューに戻 り ます。

7. Clock Skewソ フ ト キーを押し ます。

こ のこ と によ り 、 ク ロ ッ ク の、 現在の位相位置に相対する微調整が可能にな り ます。 歪み （Skew） と は
時間値の増分を使用する位相の調整です。 こ の こ と は、 ク ロ ッ ク ・ レー ト が高いほど、 よ り 大きい歪み
調整機能を可能にし ます。 25 MHz未満のク ロ ッ ク ・ レー ト では、 ソ フ ト キーは無効にな り ます。

歪みは、 ク ロ ッ ク ・ レー ト に依存する範囲を持つ、 離散値があ り ます。 歪み設定の詳細については「位
相および歪み調整のためのクロック・タイミング」（264ページ）を参照し て く ださい。

8. データの有効な部分によ って ク ロ ッ ク を 適に位置決める、 歪み調整を入力し ます。

表 10-8 クロック・ソース設定とコネクター

ク ロ ッ ク ・ ソース ソ フ ト キー N5102A Module接続

Reference 
Frequency

Clock Rate1

1Internalの選択には、これにより内部クロック・レートが設定されます。ExternalおよびDeviceの選択
には、これにより、適用されるクロック信号のレートが、インターフェース・モジュールに通知さ
れます。

周波数基準 外部ク ロ ッ ク 
入力

デバイ ス ・ イ ン ター
フ ェース

External • •

Device • •

Internal2

2Internalが使用さている場合には、外部クロック入力コネクターに適用されるクロック信号があって
はなりません。

• • •
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9. Clock Polarity Neg Posソ フ ト キーをNegに押し ます。

こ のこ と によ り ク ロ ッ ク信号は180度シフ ト され、 データは負のク ロ ッ ク遷移の間に開始されます。 これ

は、 位相調整で180度を選択し たの と同じ影響を与えます。

10. テス ト されるデバイ スに必要な ク ロ ッ ク極性選択を行います。

11. Returnハード キーを押し て、 第1レベル ・ ソ フ ト キー ・ メ ニューに戻 り ます。

ク ロ ッ ク ・ ソース選択は、 第1レベル ・ ソ フ ト キー ・ メ ニューのグ ラ フ ィ ッ ク にも反映されます。 例えば、

デバイ スが新しい ク ロ ッ ク ・ ソースであ る場合は、 今、 周波数基準が DUT に接続され、 DUT に N5102A
moduleにつながる新しい ク ロ ッ ク ・ ラ イ ンがあ る こ と が分か り ます。

データ・パラメーターの設定
こ の手順では、 Data Setup メ ニューを通し て解説し ます。 言葉の上から説明でき る名前が付いた ソ フ ト キー 

には、 原則と し て言及し ません。 例えば、 Word Sizeソ フ ト キーです。

1. 図10-21を参照し て く ださい。 Data Setupソ フ ト キーを押し ます。

図10-21 Data Setupメニューの場所

こ の ソ フ ト キー ・ メ ニ ューか ら、 信号発生器が受信するデータ を統制する さ ま ざまなパラ メ ーターにア
ク セス し ます。 デ ィ スプレ イの状態領域は、 IおよびQの両方のために使用されたデータ ・ ラ イ ンの数と、
データに関連する ク ロ ッ ク位置を示し ます。 図10-22は、 Data Setup メ ニューの構造を示し ます。

Data Setupメニューに 
アクセスします
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図10-22 パラレル・ポート構成のData Setupソフトキー・メニュー

シリアル・ポート構成用

フレーム極性はシリアル・

には作動なし 

N5102Aデジタル・モジュールが 
オンにされ、入力モードを 
使用している場合のみ有効です

データタイプがFIR前サンプル 
である場合のみに 
使用可能です

ポート構成用にアクティブです
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2. Data Typeソ フ ト キーを押し ます。 

こ の メ ニューで、 フ ィ ルター処理するデータ タ イプ （Samples） またはフ ィ ルター処理し ないデータ タ イ
プ （Pre-FIR Samples） のどち らかを選択し ます。 こ の選択はテス ト 要件と テス ト されるデバイ スによ り ま 

す。 ただし、 テス ト される機器にすでにFIRフ ィ ルターが組み込まれている場合には、 Pre-FIR Samplesを 

選択し て、 二重フ ィ ルター処理を回避し て く だ さ い。 詳細については「データ・タイプ」（268ページ）
を参照し て く ださい。

3. テス ト 要件に適切なデータ ・ タ イプを選択し ます。

4. Numeric Formatソ フ ト キーを押し ます。

この メ ニューから、 2進値を表現する方法を選択し ます。 2の補数を選択する と、 正と負の両方のデータ値

が可能にな り ます。コ ンポーネン ト が負数を処理できない場合は、オフセ ッ ト 2進値の選択を使用し ます。

5. テス ト に必要な数値フ ォーマ ッ ト を選択し ます。

6. More (1 of 2)ソ フ ト キーを押し ます。

このソ フ ト キー ・ メ ニューから、 ビ ッ ト 順を選択し、 I と Qを入れ替え、 データの極性を選択し、 さ らに、

データ消込、 ス ケー リ ング、 フ ィ ルタ リ ング ・ パラ メ ーターを可能にする メ ニューにア ク セス し ます。

7. Data Negationソ フ ト キーを押し ます。

消込 （Nagation） は、 I と Qの極性の変更 と は異な り ます。 サンプルに適用する と、 消込は、 2つの補数形
式で表現し、 それを負数 と 掛け合わせ、 サンプルを選択された数値フ ォーマ ッ ト に戻す変換を行 う こ と
によ り 、 対象のサンプルを変更し ます。 こ のこ と は、 I サンプル、 Q サンプル、 または、 両方に行 う こ と

ができ ます。 

消込使用の選択は、 テス ト する機器次第です。

8. I/Qスケー リ ング と フ ィ ルター ・ パラ メ ーターにア ク セスするには、 Return > N5102A Off Onを押し てオン    
にし ます。 こ の こ と によ り 、 信号発生器、 ベースバン ド 発生器の リ アルタ イ ム ・ カ ス タ ム ・ フ ォーマ ッ
ト が呼び出されます。 このこ と は、 データ ・ タ イプにFIR前サンプルが選択された場合に、 フ ィ ルター ・
パラ メ ーターを設定する ために必要にな り ます。 

9. Baseband Setupソ フ ト キーを押し ます。

こ のソ フ ト キー ・ メ ニューを使用し て、 I/Qスケー リ ングを調整し、 フ ィ ルター ・ パラ メ ーターにア ク セ

ス し ます。 選択さ れたデータ ・ タ イ プがサンプルであ る場合は、 Filter ソ フ ト キーはグ レー表示 （無効）
にな り ます。 ユーザー定義フ ィ ル タ リ ン グの詳細については、「デュアルARBリアルタイム変調フィル
ターでの有限インパルス応答(FIR)フィルターの使用」（214ページ）および「FIR表エディターを使用した
FIRフィルターの変更」（220ページ）を参照し て く ださい。
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デジタル・データ
N5102Aがオンになっていない場合には、 Return > Return > N5102A Off Onを押し てオンにし ます。

これで、 デジ タル ・ データはN5102A moduleを経由し て信号発生器に転送されます。 グ リ ーンの表示ラ ンプ 

が点滅するはずです。 こ のこ と は、 データ ・ ラ イ ンがア ク テ ィ ブであ る こ と を示し ます。 表示ラ ンプが点灯
のま ま （点滅し ない） 場合は、 すべてのデータ ・ ラ イ ンは、 ア ク テ ィ ブではあ り ません。 表示ラ ンプは、
初にN5102A moduleがオンになった際に （N5102A Off Onをオン） 点灯し、 点灯または点滅の状態を継続し ま   

す。 表示ラ ンプは、 モジュールが電源から切 り 離される まで点灯または点滅を続けます。

注記 ベースバン ド ・ データ ・ パラ メ ーターに変更を行 う 場合は、 初にデジ タル入力を無効にし て
（N5102A Off Onソ フ ト キーをオフ）、 デバイ ス と N5102A moduleを、 パラ メ ーター変更の際に発

生する可能性があ る信号変動に曝される こ と を回避する こ と を推奨し ます。
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X-Series信号発生器

ユーザー・ガイド   
11 BERT（オプションUN7）
ビ ッ ト ・ エラー ・ レー ト 試験(BERT)機能によ り ビ ッ ト ・ エラー ・ レー ト (BER)分析をデジタル通信機器で実
施でき ます。 これによ り 受信機と コ ンポーネン ト の、 感度と選択性を含む関数試験およびパラ メ ーター試験
が可能にな り ます。

こ の機能はX- Seriesベク ト ル信号発生器 （N5172BおよびN5182B） で利用可能です。 

以下のオプシ ョ ンが推奨されています ：

• オプシ ョ ン653または655(N5172B) - -  内部ベースバン ド発生器 

• オプシ ョ ン656または657(N5182B) - -  内部ベースバン ド発生器

• オプシ ョ ン431 - -  カス タ ム ・ デジ タル変調 

ビット・エラー・レート試験機–オプションUN7
ビ ッ ト ・ エラー ・ レー ト 試験(BERT)機能によ り ビ ッ ト ・ エラー ・ レー ト (BER)分析をデジタル通信機器で実
施でき ます。 これによ り 受信機と コ ンポーネン ト の、 感度と選択性を含む関数試験およびパラ メ ーター試験
が可能にな り ます。

ブロック図
BERの計測時、ユニ ッ ト ・アンダー試験(UUT)出力データに対応する ク ロ ッ ク信号をBER CLK INコネ ク ター  

に入力する必要があ り ます。 ク ロ ッ ク がUUTから利用でき ない場合、X- Seriesベースバン ド変調器からDATA
CLK OUT信号を使用し ます。 これらの接続については、 図11-16を参照し て く ださ い。
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図11-1

クロック・ゲート関数
ク ロ ッ ク ・ ゲー ト 関数を使用する場合、 BER CLK IN （背面パネルBB TRIG 1） コネ ク ターへのク ロ ッ ク信    

号はBER GATE INコネ ク ターへのク ロ ッ ク ・ ゲー ト 信号がオンの場合のみ有効です。

Clock Gate Off Onソ フ ト キーを押して ク ロ ッ ク ・ゲー ト 関数をオフまたはオンにし ます。Clock Gate Polarity Neg Pos    
ソ フ ト キーによ り 、 背面パネルの BER GATE IN コネ ク ターに提供される ク ロ ッ ク ・ ゲー ト 信号の入力極性  

を設定し ます。 Pos （正極） を選択し た場合、 ク ロ ッ ク信号は ク ロ ッ ク ・ ゲー ト 信号が高い場合に有効にな
り 、 Neg （負極） を選択し た場合、 ク ロ ッ ク信号はク ロ ッ ク ・ ゲー ト 信号が低い場合に有効にな り ます。

以下の図ではク ロ ッ ク ・ ゲー ト 信号の例を表示し ています。

図11-2
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• Clock Gate Off Onソ フ ト キーがOffに設定されている場合 ：

「A」 部および 「B」 部のク ロ ッ ク信号は有効であ り 、 ゲー ト 関数は必要ではあ り ません。 そのため、 ビ ッ
ト ・ エラー ・ レー ト はク ロ ッ ク と 「A」 部および 「B」 部におけるデータ信号を使用し て測定されます。

• Clock Gate Off On ソ フ ト キーがOnに設定され、 Clock Gate Polarity Neg Pos ソ フ ト キーがPosに設定されてい    

る場合 ：

「A」 部における ク ロ ッ ク信号は有効です。 そのため、 ビ ッ ト ・ エラー ・ レー ト はク ロ ッ クおよび 「A」 部
におけるデータ信号を使用し て測定されます。

• Clock Gate Off On ソ フ ト キーがOnに設定され、 Clock Gate Polarity Neg Pos ソ フ ト キーがNegに設定されてい    

る場合 ：

「B」 部におけ る ク ロ ッ ク信号は有効です。 そのため、 ビ ッ ト ・ エラー ・ レー ト 試験ではク ロ ッ クおよび
「B」 部におけるデータ信号を使用し て測定されます。

クロック/ゲート遅延関数
こ の機能によ り ユニ ッ ト ・ アンダー試験(UUT)およびパケ ッ ト ・ データ を通過する、 ク ロ ッ ク /ゲー ト 間のタ

イ ミ ング関係を復元する こ と ができ ます。

シフ ト された ク ロ ッ ク信号はAUX I/O背面パネル ・ コネ ク ターのピン17から放出されます。 ク ロ ッ ク遅延関 
数を使用する場合、ク ロ ッ ク遅延関数によ り BER CLK INコネ ク ターへのク ロ ッ ク信号が遅延し ます。ク ロ ッ  

ク ・ ゲー ト 関数を搭載するゲー ト 遅延関数を使用する場合、 ク ロ ッ ク信号はゲー ト 遅延関数によ り 遅延する
ゲー ト 信号によ り ゲー ト されます。

ク ロ ッ クおよびゲー ト 関数を使用する信号フ ローについては、 図11-3を参照し て く ださい。
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図11-3
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クロック遅延関数
こ の例では、 ク ロ ッ ク遅延関数はオフになっています。 図11-4はAUX I/Oによ るUN7の内部エラー ・ デ ィ テ 

ク ターの入力を表示し、 データがク ロ ッ ク から遅延し ている こ と を示し ます。

図11-4

CH1 ： BER TEST OUT （AUX I/Oコネ ク ターのピン17） 

CH2 ： BER MEAS END （AUX I/Oコネ ク ターのピン15）

こ の例では、 ク ロ ッ ク遅延関数はオンになっています。 ク ロ ッ ク の立ち上が り エ ッ ジが 200 ナ ノ秒遅延し て
お り 、 データの中心に調整されま し た。 図11-5はク ロ ッ ク遅延関数を使用し た結果を表示し ます。 

図11-5

CH1

CH2

CH1

CH2
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クロック・モードでのゲート遅延関数
こ の関数を使用するには、 ク ロ ッ クは連続波モード に設定されている必要があ り ます。 

こ の例では、 ク ロ ッ クはゲー ト 関数を遅延させるために使用されています。 内部エラー ・ デ ィ テ ク ターのク
ロ ッ クは2つのク ロ ッ ク で遅延されているゲー ト 信号によ り ゲー ト されています。図11-6は、CH0およびCH1
が、UN7の背面パネル入力コネ ク ターからのク ロ ッ クおよびデータの入力であ る こ と を表示し ています。CH2
はAUX I/Oコネ ク ターによ るゲー ト されている ク ロ ッ ク です。

図11-6

CH0 ： BER CLK IN （BB TRIG 1 と表示された背面パネルBNCコネ ク ター） 

CH1 ： BER GATE IN （BB TRIG 2 と表示された背面パネルBNCコネ ク ター） 
CH2 ： BER TEST OUT （AUX I/Oコネ ク ターのピン17）

CH1

CH2

CH0
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トリガー
こ の節ではオプシ ョ ンUN7用 ト リ ガー関数の動作原理を説明し ます。 ト リ ガー関数によ る信号フ ローについ

ては、 図11-7を参照し て く ださい。

図11-7
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こ の例では、 ト リ ガー ・ シーケン スは受信データ ク ロ ッ クおよびデータ ・ ビ ッ ト ・ シーケン スがあ る箇所で
あ り 、 ト リ ガーが有効で、 BERT測定が開始されます。 図11-8を参照し て く ださい。

図11-8
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こ の例では、 ト リ ガーを受信し た後に同期化が発生し ます。 

基準データは保存されているデータ ・ ビ ッ ト によ り 生成されます。 ト リ ガーを受信した後すぐに、 BERT測定

がデータ ・ ビ ッ ト を受け取った場合、 ト リ ガー遅延をオンに設定し、 ト リ ガー遅延カ ウ ン ト をデータ形式に
対応する値に設定し ます。 PN9については遅延を9に設定し ます。 図11-9を参照し て く ださい。

図11-9
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この例では、ト リ ガー・シーケンスは ト リ ガー遅延がサイ クル・カウン ト によ り アクテ ィブになっている箇所です。 

基準データは保存されているデータ ・ ビ ッ ト によ り 生成されます。 ト リ ガーを受信し た後すぐに、 BERT測

定がデータ ・ ビ ッ ト を受け取った場合、 ト リ ガー遅延をオンに設定し、 ト リ ガー遅延カ ウ ン ト をデータ形式
に対応する値に設定し ます。 PN9については遅延を9に設定し ます。 サイ クル ・ カ ウ ン ト は1超に設定されて

いる場合、 データ ・ ビ ッ ト の保存と遅延を発生させる必要はあ り ません。 図11-10および「反復測定」（301
ページ）を参照し て く ださい。

図11-10

データ処理

データ・レート
非フ レーム化またはフ レーム化PNシーケン スでのBERT分析では 大90 MHzのデータ・レー ト がサポー ト さ 
れています。 BERTアナラ イザーは連続PNシーケン スのみサポー ト し ている こ と に注意し て く ださい。

同期化
ト リ ガー ・ イベン ト の直後に、 初の受信ビ ッ ト ・ ス ト リ ームを使用し て BERT測定用DSP が同期化を確立

し よ う と し ます。 

Bit Delay Off On ソ フ ト キーが On に設定されている場合、 Delayed Bits によ り 特定される ビ ッ ト 数は無視されま    

す。 同期化が確立される まで、 Delayed Bitsによ り 延長されているエラーフ リ ー ・ ビ ッ ト 文字列を使用し て同 

期化の確認が繰 り 返されます。 

BERT Resync Off On ソ フ ト キーがOnに設定されている場合、 中間のBERT測定結果はBERT Resync Limitsによ り     
指定される値を超過する と、 BERT測定は自動的に再開されます。 
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特殊パターン無視関数
特殊パターン無視関数は、 ト ラ フ ィ ッ ク ・ チャ ンネルがユニーク ・ ワード の検出に失敗し た り 、 同期化を喪
失し た場合に ト ラ フ ィ ッ ク ・ チャ ンネル用の0または1が連続するデータ を発生させる無線に対する BERT分

析を実施する際に特に役立ちます。 160以上連続する受信データ ・ ビ ッ ト は1またが0であ る場合、 Spcl Pattern 
Ignore Off Onソ フ ト キーがOnに設定された後、連続する0または1はすべて無視されます。Spcl Pattern 0’s 1’sソ フ    
ト キーを使用し て、 無視されるデータ と し て0または1のいずれかを選択し ます。 以下の図では特殊パターン

無視関数の例を表示し ています。

図11-11 パターン無視関数例

無視されている160以上のビ ッ ト はPNシーケン ス内のいずれかに存在する可能性があ り ます。 信号発生器は
これらのビ ッ ト をエラーと して無視し ますが、それらはPNシーケンス ・ ビ ッ ト ・カウン ト 内でカウン ト されます。

合否判定
2 つの合否判定ア ップデー ト ・ モード があ り ます ： サイ クル ・ エン ド と フ ェ イル ・ ホールド です。 サイ クル ・
エン ド が選択された場合、 合否判定は各測定サイ クルの結果のため行われます。 フ ェ イル ・ ホール ド が選択
された場合、 BERT反復測定のループが1回行われる間に不具合が発生する と きは、 いつでも不合格判定が保

持されます。 フ ェ イル ・ ホールド ・ モードによ り、 測定サイ クル全体で少な く と も一度不具合が発生する と き
を判定でき ます。

反復測定
Cycle Countソ フ ト キーが1超に設定されている場合、各測定が開始される前に実施されている同期化は初回の 

み実施されます。 その後、 ク ロ ッ ク信号を追跡し続け、 受信データ用 PRBS 生成を続けます。 この機能によ
り BERT測定の総時間を減少でき ます。 また、 同期化が確立される と、 BERT測定結果が低下し て も同期化は

保持されます。 信号レベルを調整し、 特定の BERT 値を検索する こ と ができ ます。 ただし、 反復シーケン ス

で同期化が喪失する と、 新しいシーケン スが開始される まで同期化は復元されません。 以下の図では反復測
定の例を表示し ています。
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図11-12 反復測定例

信号定義試験
タ イ ミ ング ・ ダ イヤグ ラ ム図11-13、「信号定義試験」は、 ト リ ガー ・ イベン ト と BER MEAS ENDおよびBER  
TEST OUTコネ ク ターの出力信号の関係を表示し ています。

BER MEAS END信号が以下の ト リ ガー ・ イベン ト で高いま まであ る場合、 BERT測定が進行し てお り 、 その  

他の ト リ ガー・ イベン ト は無視されます。この状態はステータ ス ・レジス ターに保存され、ク エ リ ーでき ます。

図11-13 信号定義試験
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• T1は、 ト リ ガー ・ イベン ト から BER MEAS END信号の立ち上が り エ ッ ジまで計測されたフ ァーム ウ ェ  
アの操作時間です。

• T2は、 BER TEST OUT信号の立ち下が り エ ッ ジからBER MEAS END信号の立ち上が り エ ッ ジまで計測    

されたフ ァーム ウ ェアの操作時間です。

• T3 は、 BER MEAS END 信号の立ち下が り エ ッ ジから次の ト リ ガー ・ イベン ト まで計測された 低要件  
時間です。 T3は0秒超にする必要があ り ます。

Nth- 1試験結果用のBER TEST OUTのパルス出力はNth測定用BER MEAS END信号の立ち下が り エ ッ ジま    

でに終了し、 こ のエ ッ ジを使用し てNth試験結果のラ ッチを開始し ます。

BERT操作の点検 
以下の手順によ り 信号発生器によ る ビ ッ ト ・ エラー ・ レー ト 試験(BERT)機能の操作を検証し ます。 このテス
ト は日々の点検作業の一部と し て実行でき、またBERT測定の点検を確認し たい場合いつでも使用でき ます。 

注記 以下の手順では信号発生器の BERT 操作を確認し ますが、 仕様に照ら し たシステム性能を確保する

ものではあ り ません。
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図11-14 BERTソフトキー

PXB/BERTを選択してBERT
機能を有効にします。

305ページを参照
してください

305ページを参照
してください

305ページを参照
してください
304 Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド



 BERT（オプションUN7）   
BERT操作の点検
図11-15 BERT I/O Setupソフトキー

PXB/BERTを選択してBERT
機能を有効にします。

304ページを参
照してください
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 305



BERT（オプションUN7） 
BERT操作の点検 

 

  
図11-16内の強調表示されたBNCコネ ク ターは、 BERT機能モード での異なる信号に利用されます。 BERT固
有の設定はこ ち らに表示されています。 AUX I/O コネ ク ター設定は使用されている アプ リ ケーシ ョ ン / オプ 

シ ョ ンにカス タマイ ズが可能です。図11-16はBERT機能に使用される背面パネル ・ コネ ク ターと AUX I/Oコ 

ネ ク タ ーの設定を表示 し てい ます。 AUX I/O コ ネ ク タ ーについての詳細は、 背面パネル概要（N5171B、 
N5172B、N5181B、N5182B）（13ページ） を参照し て く ださい。

セルフテスト・モードを使用する測定設定
以下の手順によ り BERT測定セルフテス ト 用に信号発生器を設定し ます。 

1. 図11-16を参照し、 信号発生器の背面パネルに以下の接続を行います。 

• DATA OUT （Aux I/Oコネ ク ター ・ ピン15） からBER DATA IN （EVENT 1 と表示されたBNCコネ ク    

ター）。 

• DATA CLK OUT （Aux I/Oコネ ク ター ・ ピン17） からBER CLK IN （BB TRIG1 と表示されたBNCコ    
ネ ク ター）。 
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図11-16 BERT設定用背面パネル・コネクター

2 Presetハード キーを押し ます。 これによ り 信号発生器を定義前の状態に設定し ます。

3. Aux Fctnハード キーを押し ます。

4. Digital Bus Connectivity PXB/BERT N5102A to PXB/BERT> Confirm Changes > BERT > BERT Off On （Onにして） >    
BER Display > BER Display % Exp （%にし て） > Display Update Cycle End Cont （Contにし て） を押し ます。 

5. BERT > I/O Setup > AUX I/O Out > PN9 Outを押し ます。 

6. Return > Configure Trigger > BERT Trigger > Immediateを押し ます。 

7. Return > BERT > Onを押し ます。  

総ビ ッ ト は10000ビ ッ ト （デフ ォル ト 設定） までカ ウ ン ト され、 エラー ・ ビ ッ ト は0ビ ッ ト と し て読み込
まれます。 図11-17を参照し て く ださい。
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図11-17 セルフテスト・モード結果
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カスタム・デジタル変調を使用する測定例（オプション431が必要です）
以下の手順によ り カス タ ム ・ デジ タル変調を使用するBERT測定用に信号発生器を設定し ます。 

1. 図11-16を参照し、 信号発生器の背面パネルに以下の接続を行います。 

• DATA OUT （Aux I/Oコネ ク ター ・ ピン33） からBER DATA IN （EVENT 1 と表示されたBNCコネ ク    
ター）。 

• DATA CLK OUT （Aux I/Oコネ ク ター ・ ピン7） からBER CLK IN （BB TRIG1 と表示されたBNCコ    

ネ ク ター）。 

2. Presetハード キーを押し ます。 これによ り 信号発生器を定義前の状態に設定し ます。

3. Modeハード キーを押し ます。

4. Real-Time Custom > Modulation Setup > Modulation Type > QPSKを押し ます。 

5. Return > Return > Return > Data > PN Sequence > More > PN9を押し ます。

6. Return > More > More > Data/Clk/Sync Signal Polarity Setup > Data/Clk/Sync Rear Outputs Onを押し ます。

7. Aux Fctnハード キーを押し ます。

8. Digital Bus Connectivity PXB/BERT N5102A to N5102A > Confirm Changes > BERT > BERT Off On （Onにし て） > 
BER Display > BER Display % Exp （%にし て） > Display Update Cycle End Cont （Contにし て） を押し ます。 

以下の手順によ り BERT測定パラ メ ーターを設定し ます。 

9. Return > Configure BERT > Total Bits （100000にし て） > Enter > More > Special Pattern Ignore Off Onを押し て     

Offにし ます。

10. BERT Resync Off On （Offにし て） > Return > Pass/Fail Off On （Offにし て） を押し ます。

11. Return > I/O Setup > Gate Control > Gate Off Onを押し てOffにし ます。

12. Return > Polarity Setup > Clock Polarity Pos Neg （Negにして） > Data Polarity Pos Neg （Posにして） を押し ます。

13. Return > Return > Configure Trigger > Cycle Count 0 > Enterを押し ます。

14. Bit Delay Off On （Offにし て） > BERT Trigger （Trigger Keyにし て） を押し ます。

15. Triggerハード キーを押し ます。 図11-18では、 上記手順完了後の信号発生器の正面パネル ・ デ ィ スプレ イ
を表示し ています。 
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図11-18 カスタム・デジタル変調を使用する設定

BERT検証
1. BERT Triggerを押し てImmediateにし ます。

信号発生器デ ィ スプレ イの左下隅にあ る更新されているサイ クル ・ カ ウ ン ターに注意し て く ださい。 

2. DATA OUTからBER DATA INコネ ク ターに接続されている ケーブルを切断し ます。 

デ ィ スプレ イの左下隅にあ るNo Dataのイ ンジケーターおよびBER結果がおよそ50%であ る こ と に注意 

し て く だ さ い。 エ ラー ・ ビ ッ ト ・ カ ウ ン ターはエラー ・ ビ ッ ト のカ ウ ン ト を更新し ます。 接続を再確立
する と イ ンジケーターがオフにな り 、 エラー ・ ビ ッ ト ・ カ ウ ン ト が0ビ ッ ト 且つBERが0.00000000%に設

定されます。 

3. DATA CLK OUTからBER CLK INコネ ク ターに接続されている ケーブルを切断し ます。 

デ ィ スプレ イの左下隅にあ るNo Clockのイ ンジケーターに注意し て く ださい。ケーブルを再接続する際 
はイ ンジケーターがオフにな り ますが、 エラー ・ ビ ッ ト ・ カ ウ ン ト と BER %読み取 り 値は同期化の喪失 

を表示し ます。 

4 Returnを押し ます。 

BERT Off On ソ フ ト キーを Off または On にし ます。 前の正面パネル ・ デ ィ スプレ イに表示されている、 エ  

ラー ・ ビ ッ ト ・ カ ウ ン ター表示が0ビ ッ ト 且つBERが0.00000000%であ る新しいBER結果を参照でき る よ
う にな り ます。

検証手続によ り 想定された結果が得られた場合、 信号発生器の BERT 測定機能は適切に動作しています。 上記
手順によ り 想定外の結果が発生した場合、 Keysightサービ ス ・ セン ターまでお問い合わせ く ださい。 Keysight
サービ ス ・ セン ターの リ ス ト については、 『X- Series信号発生器入門ガイ ド』 を参照し て く ださい。
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12 リアルタイム位相雑音信号劣化
（オプション432）

こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の
情報に習熟し て く ださ い。

こ の機能は、 オプシ ョ ン431付きのKeysight X- Seriesベク ト ル信号発生器のみで使用可能です。 オプシ ョ ン 

431には、 オプシ ョ ン653または655 （N5172B）、 または、 オプシ ョ ン656または657 （N5182B） が必要です。

本章は、 位相雑音劣化オプシ ョ ン機能が置かれる ソ フ ト キーのマ ッ プ、 および、 この機能の使用法を記述し
ます。

• リアルタイム位相雑音信号劣化 （312ページ）

• Keysight X-Seriesの位相雑音形状および相加性位相雑音信号劣化 （313ページ）

• 位相雑音調整の理解 （315ページ）

• DACオーバーレンジ条件とスケーリング （316ページ）
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リアルタイム位相雑音信号劣化 
リアルタイム位相雑音信号劣化
この機能では、 2個の周波数ポイ ン ト と振幅値を制御する こ と によ り 、 信号発生器の位相雑音性能を低下させ

る こ と がで き ます。 信号発生器は、 信号発生器が通常発生する位相雑音に、 この位相雑音を付加し ます。 こ 

の機能は、 それぞれのarbフ ォーマ ッ ト と、 ス タ ン ド ア ロ ン ・ メ ニューで使用でき ます。 次の図では、 ス タ ン
ド ア ロ ン ・ メ ニュー とデュ アルARB再生機で各コ ン ト ロールにア ク セスする方法を示し ていますが、 それぞ

れのarbフ ォーマ ッ ト での位置と ソ フ ト キーは、 デュ アルARB再生機でも同じです。

図12-1 Stand–AloneおよびDual ARB Player Real–Time Phase Noiseソフトキー

フラットな中間周波数特性の 
終了周波数。

フラットな中間周波数特性の 
開始周波数。

各キーの詳細については、 
44ページで説明されているキーの 
ヘルプを使用してください。 

ディスプレイは、この機能がオ
フであっても更新されます。

これらの設定の詳細は、以下をご
覧ください：
「Keysight X-Seriesの位相雑
音形状および相加性位相雑
音信号劣化」（313ページ）。

フ ラ ッ ト な中間周波

このソフトキーは、す
べてのarbフォーマット
で使用できます。

フラットな中間周波数特性の振
幅。（Lmidとは、中間周波数特
性のレベル振幅を意味します。）

注記：位相雑音信号劣化は、信号発生器のベース位相雑音に 
追加されます。

スタンドアロン・メニュー
位相雑音を、波形を再生させ
ることなく、CW出力に追加す
るために使用します。
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 リアルタイム位相雑音信号劣化（オプション432）   
Keysight X-Seriesの位相雑音形状および相加性位相雑音信号劣化 
Keysight X-Seriesの位相雑音形状および相加性位相雑音信号劣化

フラットな中間周波数オフセット

50 dBc/Hz50 dBc/Hz

位相雑音信号劣化のない位相雑音プロット

Keysight X-Seriesベクトル信号発生器は、そ 
の位相雑音プロットで明確な形状をを示し
ます。中間周波数のオフセットは、約3 kHz 
オフセットから約 70 kHz オフセットまでの 
位相雑音振幅のレベリング（フラット化）に
よって特徴付けられます。

近傍と遠端のオフセットは、傾斜特性を示し
ます（中間周波数のオフセットの前後の 
領域）。

信号発生器は、 次の設定に基づいて、 中間周波数特性を移動する こ と、 および/または、 振幅を変化させる
こ と によ って位相雑音を劣化させます ：

中間周波数特性の開始周波数(f1)

中間周波数特性の終了周波数(f2)

f1 f2

中間周波数特性

50 dBc/Hz50 dBc/Hz

振幅 （Lmid）

このプロットは、変更前の位相雑音形状と、
それぞれの値が変更される位置を示します。
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Keysight X-Seriesの位相雑音形状および相加性位相雑音信号劣化 
フラットな中間周波数

f1
f2

オフセット特性（Lmid）

位相雑音信号劣化を加えた位相雑音プロット

50 dBc/Hz 50 dBc/Hz

フラットな中間周波数
オフセット特性（Lmid）

相加性位相
雑音なし

結果の位相
雑音プロット

オンにすると、この位相雑音が信号発生器
のベース位相雑音に追加されます。 
 
変更されるのは中間周波数特性だけであっ
ても、これらの変更は位相雑音形状全体に
影響します。近傍と遠端のオフセット特性
は、周波数オフセットのオクターブ当たり
約20 dBc/Hzの傾きで変化します。

左に示す結果の位相雑音プロットは、次の
設定によるものです：
f1 = 100 Hz

f2 = 1 kHz

振幅（Lmid） = –70 dBc

20 dBc/Hzの傾き

f f

70 

100 1 

劣化のために入力された周波数値は、 RF （無線周波数） 出力で観察し た場合に正確な値ではない こ と があ

り ます。 入力された値は、 信号発生器が実際の値を計算するために使用する指標と な り ます。 詳細について
は「位相雑音調整の理解」（315ページ）を参照し て く ださい。 

 
設定 （f1、 f2、 Lmid） の結果を見るには、 正面パネルのグ ラ フ （下図および312ページ） を使用する または、

測定機器で位相雑音プロ ッ ト を表示し ます （上の図はKeysight E4440A PSA＋オプシ ョ ン226によ る もの）。

50 dBc/Hz 50 dBc/Hz

信号発生器正面パネルのプロット：
f1 = 100 Hz

f2 = 1 kHz

Lmid = –70 dBc

f1の値は必ずf2以下に設定してください。
そうでない場合、f2はf1に適合する値に変
更されます。逆に、f2をf1より小さい値に
設定した場合、f1がf2に適合する値に変更
されます。
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位相雑音調整の理解
位相雑音調整の理解
信号発生器は、 Lmid （振幅）、 f1 （開始周波数）、 f2 （終了周波数） の 3 つの設定に基づいて、 位相雑音形状

を生成し ます。

Lmidの範囲はf2に連結し てお り 、 f2の値が増加する と、 Lmidの上限境界は減少し ます。 現在のLmidの設定
が新しい f2 の設定に対し て高過ぎ る場合、 信号発生器は Lmid の値を変更し、 使用者に変更を促すためのエ

ラーを生成し ます。 さ らに、 実際のLmidの値は入力された値から0.28 dBc/Hzずれる可能性があ り ます。

周波数設定 （f1 と f2） は、 信号発生器が RF OUTPUT に見られる実際の周波数オフセ ッ ト 値の計算に使用す 

る、 指標に過ぎません。 すなわち、 入力された開始周波数と終了周波数は近似値であ り 、 測定機器に表示さ
れる値に近 く て も、 そのものではない場合があ り  ます。 

f1およびf2パラ メ ータの効果は、 さ まざまな対数スケールに基づき ます。 こ のスケールは、 f2の値によ って

決ま り ます。 f2 の値が大きいほど ス ケールも大きいので、 こ の動作は周波数設定が高いほど観察しやす く な
り ます。 こ のこ と は、 f1 またはf2の値を変更し て も、 f1 またはf2の位置がほ と んどあ るいは全 く 変化し ない

場合に明確です。 これは、 図12-2に示すよ う に、 信号発生器の正面パネル位相雑音グ ラ フで簡単に見る こ と

ができ ます。 こ の作用によ り 、 f2周波数の値が大き く なるほど、 周波数調整は粗 く な り ます。

図12-2 f1およびf2の周波数設定作用

f1 と f2の値の効果を正確に判定するには、 正面パネルにグ ラ フを表示させるか、 測定を行 う こ と が必要にな

り ます。 正面パネルのグ ラ フは、 LXIイ ン タ フ ェース経由で リ モー ト 表示も でき ます。 LXIイ ン タ フ ェースの

詳細については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださ い。

正面パネル位相雑音グラフのf1および
f2ソフトキー設定。 

f1は、12.1 MHzが設定されるまで周波
数が変化しませんでした。すなわち、
周波数オフセットを変更するには1.6 
MHzの増加が必要でした。

f2は、40 MHzが設定されるまで周波数
が変化しませんでした。すなわち、周
波数オフセットを変更するには10 MHz
の増加が必要でした。

f1 - 最初の10.5 MHz
の設定

f1 - オフセット位置を移
動した12.1 MHzの設定

f2 - 最初の30 MHzの
設定

f2 - オフセット位置を
移動した40 MHzの設定

各キーの詳細については、 
44ページで説明されているキーの
ヘルプを使用してください。
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DACオーバーレンジ条件とスケーリング 
DACオーバーレンジ条件とスケーリング
位相雑音信号劣化を使用する と、 DACオーバーレ ンジ条件が発生し、 信号発生器がエラーを発生する原因と

なる場合があ り ます。 位相雑音信号劣化機能を使用中のこの条件を 小限 とするために、 Keysight X- Series 
信号発生器には、 I/Qデータ を スケール ・ ダウ ンする自動DACオーバーレンジ保護機能が内蔵されています。

こ の機能によ り 、 必要以上にデータがス ケー リ ング される可能性があ る ため、 通常は波形のダ イナ ミ ッ ク ・
レ ンジが低下し ます。 こ のこ と は、 特に、 GSMなどの定振幅信号を使用する場合に顕著にな り ます。

デュ アルARB再生機を使用する場合は、 自動オーバーレ ンジ保護をオフにでき ます （工場初期設定はオン）。
デュ アルARB DACオーバーレ ンジ保護機能のコ ン ト ロールは、 図12-3に示すキー ・ パスの通 り です。

図12-3 Dual ARB DAC Over–Range Protectionソフトキーの位置

デュ アルARB再生機では、過剰なス ケー リ ングを避ける ため、または単に手動でスケー リ ングを行 う ために、
オーバーレ ンジ保護をオフにし、 Waveform Runtime Scalingソ フ ト キーを使用し てDACオーバーレンジ条件を  

取 り 除き ます。

自動機能を無効にし た場合は、 DACオーバーレ ンジ条件を取 り 除 く ための別の選択肢には、 条件が修正され
る までf2、 Lmid、 またはその両方の値を減らす方法があ り ます。 

各キーの詳細については、 
44ページで説明されているキーの
ヘルプを使用してください。

DACオーバーレンジ保護をオフにした場合
は、スケーリング値を小さくしてオーバー 
レンジ状態を除去します（「波形ランタイ
ム・スケーリングの設定」（197ペー
ジ）を参照してください）。

デフォルト設定はオンです。 

オフにした場合は、位相雑音信号劣化オプ
ションを使用する際には、スケーリングを
手動で制御します。上に示すWaveform 
Runtime Scalingソフトキーを使用して、
スケーリングを手動で調整します。
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13 カスタム・デジタル変調（オプション431）
こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 第3章、「基本操作」（43ページ）を参照し て、 その章の

情報に習熟し て く ださ い。

この機能は、 オプシ ョ ン 431 付きの Keysight X- Series ベク ト ル信号発生器のみで使用可能です。 オプシ ョ ン 
431には、 オプシ ョ ン653または655 （N5172B）、 または、 オプシ ョ ン656または657 （N5182B） が必要です。

• カスタム変調 （318ページ）

• ビット・ファイルの作成と使用 （326ページ）

• カスタマイズされたバースト形状曲線の使用 （332ページ）

• 任意波形発生器の使用 （338ページ）

• カスタム変調による有限インパルス応答（FIR）フィルターの使用 （354ページ）

• FIR表エディターを使用したFIRフィルターの変更 （360ページ）

• 差分符号化 （363ページ）
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カスタム変調 
カスタム変調
カス タ ム変調の作成には、 信号発生器は次の 2つの操作モード を提供し ます ： ARB カ ス タ ム変調モード、 お

よび、 リ アルタ イ ム ・ カス タ ム変調モード。 ARBカス タ ム変調モード には、 NADCまたはGSMなどの内蔵変

調フ ォーマ ッ ト 、 および、 信号の作成に使用可能な BPSK や 16QAM などの定義済み変調タ イプがあ り ます。
また、 デジ タル ・ フ ォーマ ッ ト の属性を変更する柔軟性も提供し ます。 リ アルタ イ ム ・ カ ス タ ム変調モード
は、 内蔵のPNシーケン ス またはカ ス タ ム ・ ユーザー ・ フ ァ イル、 また、 多様な変調タ イプおよびGaussianや
Nyquistなどのさ まざまな内蔵フ ィ ルターを使用し て、 カ ス タ ム ・データ フ ォーマ ッ ト を作成するために使用

でき ます。 

どち らの操作モード も、 既存のデジ タル ・ フ ォーマ ッ ト の修正、 デジ タル変調された信号の定義または作成、
および、 信号障害を追加する ために、 通信規格をフ レキシブルにシ ミ ュ レーシ ョ ンする、 デジ タル変調され
た複雑な信号の作成に使用し ます。

ARBカスタム変調モード波形発生器
信号発生器のARBカス タ ム変調モード は、 ア ウ ト チャネル ・ テス ト ・ アプ リ ケーシ ョ ン用に設計されていま
す。 こ のモード は、 ラ ンダムな通信 ト ラ フ ィ ッ ク をシ ミ ュ レーシ ョ ンするデータ ・ フ ォーマ ッ ト の生成に使
用され、 コ ンポーネン ト ・ テス ト 用の刺激と して使用されます。 ARBカス タ ム変調モード の他の機能には、 以

下が挙げられます ： 

• 信号またはマルチキ ャ リ ア信号の構成。 大100までのキ ャ リ アを構成でき ます。 

• 信号発生器の正面パネル ・ イ ン ターフ ェース を使用する波形フ ァ イルの作成。

波形フ ァ イルは、 ラ ンダム ・ データ と し て作成される と、 コ ンポーネン ト ・ テス ト 用の刺激と し て使用でき、
隣接チャ ンネル電力 （ACP） などのデバイ ス性能を測定でき ます。 AUTOGEN_WAVEFORMフ ァ イルは、ARB
カス タ ム変調をオンにする と自動的に作成され、 名前を変更し て信号発生器の不揮発性 メ モ リ ーに保存する
こ と ができ ます。 こ のフ ァ イルは、 後ほど揮発性 メ モ リ ーにロード し、 デュ アルARB波形再生機を使用し て
再生する こ と ができ ます。 

詳細は、「波形ファイルの基本」（146ページ）および「掃引信号」（4ページ）を参照し て く ださい。

リアルタイム・カスタム変調波形発生器
リ アルタ イ ム ・ モード は、 カス タ ムFIRフ ィ ルターを合わせたユーザー定義変調タ イプ、 および、 シンボル ・
レー ト を使用し て、単チャ ンネル通信をシ ミ ュ レーシ ョ ン し ます。データは、外部ソースからPRAM メ モ リ ー

にダウ ン ロードする こ と ができ、 または、 外部入力を使用し て リ アルタ イ ム ・ データ と し て供給する こ と が
でき ます。 リ アルタ イ ム I/Qベースバン ド ・ モード は、 PN9 またはFIX4などの定義済みデータ ・ フ ォーマ ッ

ト を生成する こ と も でき ます。 こ のモー ド で生成された連続データ ・ ス ト リ ームは、 レシーバー ・ ビ ッ ト ・
エラー解析に使用でき ます。 こ のモード はシングル ・ キ ャ リ アに制限されます。 リ アルタ イ ム ・ カ ス タ ム変
調モード は ：

• ARB波形発生器モード よ り 多 く のデータ と変調タ イプを使用でき ます

• カス タ ムI/Q集合フ ォーマ ッ ト をサポー ト し ます

• ビ ッ ト ・ エラー ・ レー ト ・ テス ト （BERT） 用の連続PNシーケン ス を生成する機能があ り ます

• 信号パラ メ ーターが変更されて も、 波形生成時間を必要と し ません。
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カスタム変調
図13-1 ARB Custom Modulationソフトキー

320ページ

200ページ

146ページ

351ページ

このソフトキーは、選択された
変調モードにより変化します。

マルチキャリアがオンの場合
のみ使用可能。

マルチキャリアがオフの場合
のみ使用可能。

351ページ

現在のARBカスタム変調設定を
有効にします。

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。

178ページ

147ページ

371ページ

323ページ

236ページ
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カスタム変調 
図13-2 Quick Setupソフトキー

321ページ

354ページ

344ページ

Mode > ARB Custom Modulation > Single Carrier Setup

322ページ

このソフトキー・ラベルは、現在選択
されている変調基準を示します。

必要に応じて、
Symbol Rateソフト
キーを押し、テンキー
パッドを使用して値を
変更します。 
デフォルト（当初）の
シンボル・レート最大
範囲値は、Quick 
Setupソフトキーを使
用して選択された変調
基準によります。

これらの定義済み変調基準から1つが選
択された場合は、セットアップ（フィ
ルター、シンボル・レートおよび変調
タイプ）のコンポーネントのデフォル
ト値が自動的に指定されます。

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。

Default：このソフトキーにより、次の
デフォルト設定を選択できます：
Modulation Type = QPSK、 
Symbol Rate = 1 Msps、 
Filter = Root Nyquist、および 
Filter Alpha = 0.5
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 カスタム・デジタル変調（オプション431）   
カスタム変調
図13-3 Mod Typeソフトキー

354ページ

320ページ

322ページ

Mode > ARB Custom Modulation > Single Carrier Setup

340ページ

振幅シフト・キーイング（ASK）
用の変調度を設定します。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

これらのシンボ
ル・マップは、 
グレイ符号ビッ
ト・マッピング 
を使用します。

これらのシンボル・
マップは、VSAソ
フトウェアのシン
ボル・マップと整
合します。
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カスタム変調 
図13-4 カスタム変調フォーマットとアプリケーション

図13-5 Store Custom Dig Mod Stateソフトキー

カタログは、以前保存されたデジタル変
調（DMOD）ファイルを表示します。

343ページ

Mode > ARB Custom Modulation > Single Carrier Setup > Store Custom Dig Mod State

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。
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 カスタム・デジタル変調（オプション431）   
カスタム変調
図13-6 Real-Time Custom Modulationソフトキー

146ページ

各キーの詳細については、44ページで説明されているキーの 
ヘルプを使用してください。

371ページ
324ページ

メニューが開き、そこか
らバースト形状パラメー
ターを設定できます。

236ページ

318ページ

現在のカスタム・リアルタ
イム変調を有効にします。

363ページ

245ページ

312ページ

178ページ

200ページ
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カスタム・デジタル変調（オプション431） 
カスタム変調 
図13-7 Modulation Setupソフトキー

325ページ

354ページ

Mode > Real-Time Custom Modulation > Modulation Setup

327ページ

このソフトキー・ラベルは、
現在選択されている変調基準
を示します。

必要に応じて、
Symbol Rateソフト
キーを押し、テンキー
パッドを使用して値を
変更します。 
デフォルト（当初）の
シンボル・レート最大
範囲値は、Quick 
Setupソフトキーを使
用して選択された変調
基準によります。

これらの定義済み変調基準から1つが選択さ
れた場合は、セットアップ（フィルター、
シンボル・レートおよび変調タイプ）のコン
ポーネントのデフォルト値が自動的に指定
されます。

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。
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 カスタム・デジタル変調（オプション431）   
カスタム変調
図13-8 Modulation Typeソフトキー

354ページ

324ページ

Mode > Real-Time Custom Modulation 
> Modulation Setup

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。

326ページ

これらのシンボル・
マップは、グレイ符号
ビット・マッピングを
使用します。

これらのシンボル・
マップは、VSAソ
フトウェアのシン
ボル・マップと整
合します。

345ページ

346ページ
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ビット・ファイルの作成と使用 
ビット・ファイルの作成と使用
こ の手順では、 Bit File Editorを使用し て、 リ アルタ イ ムI/Qベースバン ド が発生させる変調内で、 デー  

タ転送用のユーザー定義フ ァ イルを作成、 編集、 保存する方法を説明し ます。 この例では、 ユーザー ・ フ ァ
イルはカス タ ム ・ デジ タル通信フ ォーマ ッ ト 内で定義されています。

ユーザー ・ フ ァ イル （ユーザー定義データ ・ フ ァ イル） は、 リ モー ト ・ コ ンピ ューターで作成し て信号発生
器に移動させ、 その後変調に使用する こ と ができ、 も し く は、 信号発生器のBit File Editorを使用し て  

作成変更する こ と ができ ます。

こ のよ う なユーザー・ フ ァ イルは、その後、ア ク テ ィ ブなフ ォーマ ッ ト のプロ ト コルに従った連続する フ レー
ムな しデータ ・ ス ト リ ーム と し て転送データ とする こ と、 カス タ ムARB変調用データ、 または、 リ アルタ イ

ム ・ フ ォーマ ッ ト と し て転送する こ と ができ ます。 ユーザー ・ フ ァ イルは、 デュ アルARB波形発生器によ り
発生された信号には使用でき ません。

注記 リ モー ト ・ コ ンピ ューター上のユーザー定義データ ・ フ ァ イル作成に関する情報は、 『Keysight信号

発生器プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださ い。
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 カスタム・デジタル変調（オプション431）   
ビット・ファイルの作成と使用
図13-9 Data Selectionソフトキー

ユーザー・ファイルの作成

表エディターへのアクセス
1. Presetを押し ます。

2. Mode > Real-Time Custom Modulation > Modulation Setup > Data > User File > Create Fileの順に押し ます。

これでBit File Editorが開き ます。 Bit File Editorには次の3つの列があ り ます ： Offset、 Binary Data
および16進データ、 また、 カーソルの位置 （Position） と フ ァ イルの名前 （Name） は次の図に示された通

り です。

Mode > Real-Time Custom Modulation > 
Modulation Setup

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。

このキーを押して、Pシーケンス
の番号から選択し、反転するかど
うかを選択します。

このキーを押して、1 sまたは0 sの
データ・パターンを選択します。

このキーを押して、ビット・パ
ターンとして使用するファイルを
作成、選択または編集します。

このキーを押して、パターンRAM（PRAM）ファイル
を選択します。 
PRAMファイルは、バイト・フォーマットの2進値ア
レイです。それぞれのバイトはデータ・ビット
（LSB/ビット0）、バースト・ビット（ビット2）およ
びイベント1出力ビット（ビット6）から構成されま
す。PRAM内部フォーマットは、それぞれのPRAMバ
イト用の4バイトから構成されます。
PRAMファイルは、固定データを持つカスタム・フ
レーミング構造の指定用に便利です。
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カスタム・デジタル変調（オプション431） 
ビット・ファイルの作成と使用 
図13-10 ビット・ファイル・ディスプレイ

注記 新しいフ ァ イルを作成する と、 デフ ォル ト 名はUNTITLEDまたはUNTITLED1のよ う に番号を取って
表示されます。 これによ り 、 以前のフ ァ イルが上書き される こ と を防止し ます。

ビット値の入力
ビ ッ ト ・ データは、 1 ビ ッ ト ・ フォーマッ ト で表エディ ターに入力されます。 バイナ リ ・ データの現在の16進

値は16進データ列に表示され、 カーソル位置 （16進数表示） は位置イ ンジケーターに表示されます。

1. 次の図を参照し て く ださい。

2. 示された32ビ ッ ト 値を入力し ます。

オフセット
（16進数）

ビット・
データ

カーソル位置インジ
ケーター（16進数）

16進数データ ファイル名インジ
ケーター
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 カスタム・デジタル変調（オプション431）   
ビット・ファイルの作成と使用
図13-11 ビット値の入力

ユーザー・ファイルの名前変更と保存
こ の例では、 ユーザー ・ フ ァ イルを保存する方法を学びます。 ユーザー ・ フ ァ イルがまだ作成されていない
場合は、 前節、「ユーザー・ファイルの作成」（327ページ）のステ ッ プを完了させて く ださい。

1. More (1 of 2) > Rename > Editing Keys > Clear Textの順に押し ます。

2. フ ァ イル名 （例えば、 USER1） を、 アルフ ァベッ ト ・ キー と テンキーパッ ド を使用し て入力し ます。

3. Enterを押し ます。

これで、ユーザー・フ ァ イルは名前が変更され、Bitメ モ リ ー・カ タ ロ グにUSER1の名前で保存されま し た。

これらのビット値を
入力します

カーソル位置インジ
ケーター

16進数データ
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 329
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ユーザー・ファイルの再読取
この例では、 ユーザー定義データ ・ フ ァ イルを メ モ リ ー ・ カタ ログから再読取する方法を学びます。 ユーザー
定義データ ・ フ ァ イルがまだ作成および保存されていない場合は、 前節、「ユーザー・ファイルの作成」（327
ページ）および「ユーザー・ファイルの名前変更と保存」（329ページ）のステ ッ プを完了させて く ださい。

1. Presetを押し ます。

2. Mode > Real-Time Custom Modulation > Modulation Setup > Data > User Fileの順に押し ます。

3. フ ァ イルUSER1を強調表示させます。

4. Edit Fileを押し ます。

Bit File Editorがフ ァ イルUSER1を開き ます。

既存のユーザー・ファイルの変更
こ の例では、 既存のユーザー定義データ ・ フ ァ イルを変更する方法を学びます。 ユーザー定義データ ・ フ ァ
イルがまだ作成、 保存および再読取されていない場合は、 前節、「ユーザー・ファイルの作成」（327ページ）、
「ユーザー・ファイルの名前変更と保存」（329ページ）および「ユーザー・ファイルの再読取」（330ページ）
のステ ッ プを完了させて く ださい。

ビット値の移動
1. Return > Goto > 4 > C > Enterの順に押し ます。

こ のこ と によ り 、 次の図で示された通 り 、 カーソルは表のビ ッ ト 位置4Cに移動し ます。

図13-12 ビット値の移動

カーソルが新しい位置に 
移動します

位置インジケーターが
変化します
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 カスタム・デジタル変調（オプション431）   
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ビット値の反転
1. 1011を押し ます。

こ のこ と によ り 、 4Cから4Fの位置にあ る ビ ッ ト 値が反転し ます。 この行の16進数データが、 次の図に示
される よ う に、 76DB6DB6に変更された こ と に注意し て く ださい。

図13-13 ビット値の反転

ビット・エラーをユーザー・ファイルに適用 

この例では、 既存のユーザー定義データ ・ フ ァ イルに、 ビ ッ ト ・ エラーを適用する方法を学びます。 ユーザー定義
データ ・ ファ イルがまだ作成および保存されていない場合は、 前節、「ユーザー・ファイルの作成」（327ページ）
および「ユーザー・ファイルの名前変更と保存」（329ページ）のステ ッ プを完了させて く ださい。

1. Apply Bit Errorsを押し ます。

2. Bit Errors > 5 > Enterの順に押し ます。

3. Apply Bit Errorsを押し ます。

両方のBit Errorsソ フ ト キーの値が リ ン ク された値に変更された こ と に注意し て く ださい。

ビット4Cから4Fまでが反
転されました

16進数データが変更されま
した
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カスタマイズされたバースト形状曲線の使用 
カスタマイズされたバースト形状曲線の使用
上昇時間曲線と下降時間曲線の形状を、 立ち上が り 形状曲線および立ち下が り 曲線形状エデ ィ ターを使用し
て調整する こ と ができ ます。 それぞれのエデ ィ ターには、 大256個の等間隔時間の値を入力し て、 曲線の

形状を定義する こ と ができ ます。 値は リ サンプ リ ング され、 すべてのサンプル ・ ポイ ン ト を通過する三次ス
プラ イ ンが生成されます。

立ち上が り 形状曲線および立ち下が り 曲線形状表エデ ィ ターは、 カ ス タ ム ・ リ アルタ イ ムI/Qベースバン ド

発生器波形に使用でき ます。

バースト形状の理解
それぞれのフ ォーマ ッ ト のデフ ォル ト ・ バース ト 形状は、 選択されたフ ォーマ ッ ト の規格に従って生成され
ます。 ただし、 バース ト 形状の次の特性は変更でき ます ：

上昇時間 符号またはビ ッ ト で指定された時間帯で、 その間にバース ト は 小
値の70 dB(0) から フル ・ パワー (1)まで上昇し ます。

下降時間 符号またはビ ッ ト で指定された時間帯で、その間にバース ト はフル・
パワー (1)から 小値の70 dB(0)まで下降し ます。

上昇遅延 符号またはビ ッ ト で指定された、 バース ト 上昇の開始が遅延する時
間帯です。 上昇遅延は負の値にも正の値にも でき ます。 ゼロ以外の
遅延の値を入力する と、 フル ・ パワー ・ ポイ ン ト は、 初の有効な
符号の開始よ り 早 く または遅 く な り ます。

下降遅延 符号またはビ ッ ト で指定された、 バース ト 下降の開始が遅延する時
間帯です。 下降遅延は負の値にも正の値にも でき ます。 ゼロ以外の
遅延の値を入力する と、 フル ・ パワー ・ ポイ ン ト は、 後の有効な
符号の終了よ り 早 く または遅 く な り ます。

ユーザー定義バース ト 形状 大256個のユーザー入力値で、指定された上昇時間または下降時間
の曲線の形状を定義し ます。 値は0 （パワーな し） と 1 （フルパワー）

の間で変化させる こ と ができ、 線形スケール と な り ます。 指定され
る と、 値は必要に応じ て リ サンプ リ ング され、 すべてのサンプル ・
ポイ ン ト を通過する三次スプラ イ ンが生成されます。

0

1

パ
ワ

ー 上昇 
遅延

上昇 
時間

下降 
時間

下降 
遅延

時間 

ユーザー
定義値

ユーザー
定義値
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カスタマイズされたバースト形状曲線の使用
バース ト 形状の 大上昇および下降時間値は、 次の因子によ る影響を受けます ：

• シンボル ・ レー ト

• 変調タ イプ

上昇および下降の遅延が 0 に等しければ、 バース ト 形状は、 大バース ト 形状パワーに、 タ イ ム ス ロ ッ ト 内

の 初の有効な符号の開始点と、 後の有効な符号の終了点で同期し よ う と し ます。 次の図は上昇遅延が0、
下降遅延が+1ビ ッ ト のEDGEフ レームのバース ト 信号を解説し ます。

信号発生器のフ ァーム ウ ェ アは、 変調用に選択された設定に基づいた、 適なバース ト 形状を計算し ます。
バース ト 形状は、 データ部分を変調に整列させる こ と によ り 、 さ ら に 適化する こ と ができ ます。 例えば、
新しい変調方式を設計する場合は、 次のよ う にし ます ：

• 所定のスペク ト ルを設定する ために、 変調と フ ィ ルタ リ ングを調整し ます。

• バース ト 昇降遅延と、 タ イ ム ス ロ ッ ト の下降時間を調整し ます。

バース ト をオンにする際に、 エラー ・ ベク ト ル振幅 （EVM） または隣接チャ ンネル電力 （ACP） の上昇が見つ

かった ら、 バース ト 形状を調整し て ト ラブルシ ューテ ィ ングの一助とする こ と ができ ます。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 333



カスタム・デジタル変調（オプション431） 
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図13-14 Burst Shapeソフトキー

ユーザー定義バースト形状曲線の作成
こ の手順を使用し て、 立ち上が り 形状曲線サンプル値を入力し、 立ち下が り 曲線形状値と し てそれら を鏡像
描写し て、 対称バース ト 曲線を作成する方法を学びます。

こ の節は、 次の作業の実行方法を説明し ます ：

• 「表エディターへのアクセス」（334ページ）

• 「サンプル値の入力」（335ページ）

表エディターへのアクセス
1. Presetを押し ます。

2. Mode > Real-Time Custom Modulation > Burst Shapeの順に押し ます。

3. More > Define User Burst Shape > More (1 of 2) > Delete All Rows > Confirm Delete Of All Rowsの順に押し ます。

Mode > Real-Time Custom 
Modulation 

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。
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サンプル値の入力
次の表のサンプル値を使用し ます。

1. サンプル1の値 （1.000000） を強調表示し ます。

2. .4 > Enterを押し ます。

3. .6 > Enterを押し ます。

4. 上記の表から、 サンプル3から6までの残 り の値を入力し ます。

5. Return > Edit Fall Shape > Load Mirror Image of Rise Shape > Confirm Load Mirror Image Of Rise Shapeの順に押
し ます。

こ のこ と によ り 、 図13-15（335ページ）に示す通 り 、 立ち下が り 曲線形状値は立ち上が り 曲線形状値の

鏡像に変更されます。

図13-15 立ち上がり曲線形状の鏡像

立ち上が り 曲線形状エデ ィ ター

サンプル 値 サンプル 値

0  4 

1   

2   

3 
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バースト形状の表示
Display Burst Shapeを押し ます。

こ のこ と によ り 、 図13-16に示される通 り 、 波形上昇下降の特性がグ ラ フで表示されます。

図13-16 バースト形状

バース ト をデフ ォル ト の条件に戻すには、 次のキーを押し ます ：

Return > Return > Return > Confirm Exit From Table Without Saving > Restore Default Burst Shape。

ユーザー定義バースト形状曲線の保存
1. Define User Burst Shape > More (1 of 2) > Load/Store > Store To Fileの順に押し ます。

SHAPEフ ァ イルのカ タ ロ グからの、 ア ク テ ィ ブ ・ エン ト リ 領域を占める フ ァ イル名がすでにあ る場合は、
次のキーを押し ます ：

Editing Keys > Clear Text

2. フ ァ イル名 （例えば、 NEWBURST） を、 アルフ ァベッ ト ・ キーと テンキーパッ ド を使用し て入力し ます。

大のフ ァ イル名長は23文字 （英数字と特殊文字） です。

3. Enterを押し ます。

現状の立ち上が り 曲線形状および立ち下が り 曲線形状表エデ ィ ターの内容が、 SHAPEフ ァ イルのカ タ ロ グに
保存されます。 これで、 こ のバース ト 形状は、 変調のカ ス タマイ ズ、 または、 新しいバース ト 形状設計の基
準と し て使用する こ と ができ ます。
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ユーザー定義バースト形状曲線の再読取
ユーザー定義バース ト 形状フ ァ イルが メ モ リ ーに保存された ら、リ アルタ イ ムI/Qベースバン ド に生成された

デジ タル変調と合わせて使用する ために、 再読取する こ と ができ ます。

こ の例では、 メ モ リ ーに保存されたユーザー定義バース ト 形状フ ァ イルが必要です。 ユーザー定義バース ト
形状フ ァ イルがまだ作成および保存さ れていない場合は、 前節、「ユーザー定義バースト形状曲線の作成」
（334ページ）および「ユーザー定義バースト形状曲線の保存」（336ページ）のステ ッ プを完了させて く ださい。

1. Presetを押し ます。

2. Mode > Real-Time Custom Modulation > Burst Shape > Burst Shape Type > User Fileの順に押し ます。

3. 所定のバース ト 形状フ ァ イル （例えば、 NEWBURST） を強調表示させます。

4. Select Fileを押し ます。

これで、 選択されたバース ト 形状フ ァ イルは、 現在の リ アルタ イ ムI/Qベースバン ド ・ デジ タル変調状態
に適用されます。
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任意波形発生器の使用
こ の節では、 コ ンポーネン ト 設計のテス ト 用カス タ ム ・ デジ タル変調を含む、 デュ アル任意 （ARB） 波形

フ ァ イルを作成する方法を説明し ます。 

図13-17 波形にカスタム変調を追加

定義済みカスタム・デジタル変調の使用
こ の節は、 次の作業の実行方法を説明し ます ：

• 定義済みEDGEセットアップの選択 （338ページ）

• 波形の生成 （338ページ）

• RF（無線周波数）出力の設定 （339ページ）

定義済みEDGEセットアップの選択
1. Presetを押し ます。

2. ARB Custom Modulation メ ニュー （338ページ） で、 Single Carrier Setup > Quick Setup > EDGEの順に押    

し ます。

波形の生成
Digital Modulation Off Onを押し ます。

こ のこ と によ り 、 ステ ッ プで選択された定義済みEDGE状態を伴 う 波形が発生し ます。 デ ィ スプレ イはDig 
Mod Setup:EDGEに変わ り ます。 波形発生の間に、 DIGMODおよびI/Qイ ンジケーターが表示され、 定義済

みデジ タル変調状態は揮発性 メ モ リ ー （BBG） に保存されます。 これで、 波形はRFキ ャ リ アを変調し ます。

354ページ

322ページ

このソフトキー・ラベルは更新され、 
現在の変調タイプを反映します。

Mode > ARB Custom Modulation > Single Carrier Setup

321ページ

344ページ

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。
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RF（無線周波数）出力の設定
1. RF （無線周波数） 出力周波数を891 MHzに設定し ます。 

2. 出力振幅を5 dBmに設定し ます。 

3. RF On/Offを押し ます。

これで、 定義済みEDGE信号が、 信号発生器のRF （無線周波数） 出力コネ ク ターで使用可能にな り ます。
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カスタム・デジタル変調状態の作成
こ の手順では、 カス タマイ ズ された変調タ イプ、 シンボル ・ レー ト 、 および、 フ ィ ルタ リ ングを使用する、
シングルキ ャ リ アNADCデジ タル変調のセ ッ ト ア ッ プ方法を学びます。

図13-18 デジタル変調フィルターの設定

このソフトキー・ラベルは更新され、現在
の変調基準を反映します。

Mode > ARB Custom Modulation > Single Carrier Setup

344ページ

このソフト
キーはフィル
ター帯域幅パ
ラメーター、
アルファを設
定します。こ
のデフォルト
のアルファ値
は、変調基準
（354ページ
を参照）およ
び選択された
変調タイプ
（321ページ
を参照）によ
り変化します。

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。

このソフトキーは
フィルター形状を
設定します。

341ページ

メニューを開き、IS-95フィ
ルターを選択します。
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図13-19 デジタル変調タイプの変更

こ の節は、 次の作業の実行方法を説明し ます ：

• デジタル変調セットアップの選択 （341ページ）

• RF（無線周波数）出力の設定 （339ページ）

• フィルターの選択 （342ページ）

• RF（無線周波数）出力の設定 （339ページ）

デジタル変調セットアップの選択
1. Presetを押し ます。

2. ARB Custom Modulation メ ニュー （340ページ） で、 Single Carrier Setup > Quick Setup > NADCの順に押

し ます。

変調タイプとシンボル・レートの変更
1. ARB Custom Modulation メ ニュー （340ページ） で、 Single Carrier Setup > Modulation Type > Select > 

PSK > QPSK and OQPSK > QPSKの順に押し ます。

2. Return > Symbol Rate > 56 > kspsの順に押し ます。

注記：これは
PSKメニューの
2ページ目です。

注記：これはQPSK
メニューの2ページ
目です。

Mode > ARB Custom Modulation > Single Carrier Setup > 
Modulation Type > Select

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。

これらのソフト
キーは、現在の
変調タイプに選
択および適用が
可能な既存の
ユーザー I/Qま
たはユーザー
FSKファイルを
選択するために、
メニューを開き
ます。
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フィルターの選択
1. Setup Mod メ ニュー （340ページ） で、 Filter > Select > Nyquistの順に押し ます。

2. Return > Return と押し ます。

波形の生成
Digital Modulation Off Onを押し ます。

こ のこ と によ り 、 前節で作成された、 カス タ ム、 シングルキ ャ リ ア NADC、 デジ タル変調状態を使用する波

形が発生し ます。 デ ィ スプレ イは Dig Mod Setup:NADC (Modified) に変わ り ます。 波形発生の間に、   
DIGMODおよびI/Qイ ンジケーターが表示され、 カ ス タ ム ・ シングルキ ャ リ ア ・ デジ タル変調状態は揮発性 メ

モ リ ーに保存されます。 これで、 波形はRFキ ャ リ アを変調し ます。

このカス タ ム ・ シングルキ ャ リ ア NADCデジ タル変調状態を不揮発性 メ モ リ ー ・ カ タ ロ グに保存する方法の

説明は、 カスタム・デジタル変調状態の保存 （342ページ） を参照し て く ださい。 

RF（無線周波数）出力の設定
1. RF （無線周波数） 出力周波数を835 MHzに設定し ます。 

2. 出力振幅を0 dBmに設定し ます。 

3. RF On/Offを押し ます。

これで、 ユーザー定義NADC信号が、 RF （無線周波数） 出力コネ ク ターで使用可能にな り ます。

カスタム・デジタル変調状態の保存
こ の手順を使用し て、 カス タ ム ・ デジ タル変調状態と カ ス タ ム ・ マルチキ ャ リ ア ・ デジ タル変調状態を不揮
発性 メ モ リ ーに保存する方法を学びます。

カス タ ム、 シングルキ ャ リ ア、 デジ タル変調状態がまだ作成されていない場合は、 前節、 カスタム・デジタ
ル変調状態の作成 （340ページ） のステ ッ プを完了させて く ださい。
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図13-20 カスタム・デジタル変調状態の保存

1. Digital Modulation Off Onが 初のソ フ ト キーと なっている、 ト ップレベルARB Custom Modulationメ ニュー    
に戻 り ます。

2. ARB Custom Modulation メ ニュー （343ページ） で、Single Carrier Setup > Store Custom Dig Mod State > Store     
To Fileの順に押し ます。

DMODフ ァ イルのカ タ ロ グからの、 ア ク テ ィ ブ ・ エン ト リ 領域を占める フ ァ イル名がすでにあ る場合は、
次のキーを押し ます ： Clear Text

3. フ ァ イル名 （例えば、 NADCQPSK） を、 アルフ ァベッ ト ・ キーと テンキーパッ ド を使用し て、 大 23 文

字の長さ で入力し ます。

4. Enterを押し ます。

これで、 ユーザー定義、 シングルキ ャ リ ア、 デジ タル変調状態は不揮発性 メ モ リ ーに保存されます。

注記 RF （無線周波数） 出力振幅、 周波数および操作状態設定は、 ユーザー定義、 デジ タル変調状態フ ァ

イルの一部と し ては保存されません。

カタログは、ユーザーにより以前に保存
されたDMODファイルを表示します。

Mode > ARB Custom Modulation > Single 
Carrier Setup

45ページ

これらのキーは、内部スト
レージにあるDMODファイル
の表を管理します。

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。
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カスタム・デジタル変調状態の再読取
こ の手順を使用し て、信号不揮発性 メ モ リ ーから、カ ス タ ム・デジ タル変調状態を再読取する方法を学びます。

ユーザー定義、 デジ タル変調状態がまだ作成および保存されていない場合は、 前節、 カスタム・デジタル変
調状態の作成 （340ページ） および カスタム・デジタル変調状態の保存 （342ページ） のステ ッ プを完了さ  
せ、 信号発生器をプ リ セ ッ ト し て、 保存されたユーザー定義デジタル変調波形を揮発性ARB メ モ リ ーから ク

リ ア し て く ださい。

図13-21 カスタム・デジタル変調状態の再読取

1. Quick Setup メ ニューで、 Custom Digital Mod Stateを押し ます。

2. 所定のフ ァ イル （例えば、 NADCQPSK） を強調表示させます。

3. Select File > Returnを押し ます。

4. Digital Modulation Off Onをオンが強調表示される まで押し ます。

装置は、 カス タ ム、 デジ タル変調波形を揮発性 メ モ リ ーに再生成し ます。 波形発生後、 カ ス タ ム、 デジ タル
変調波形は、 RF （無線周波数） 出力で変調するために使用する こ と ができ ます。

RF （無線周波数） 出力を設定する方法の説明は、 RF（無線周波数）出力の設定 （339ページ） を参照し て く

ださい。

Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup

強調表示されたファイ
ルを装置メモリーに
ロードする。

これらのキーは、内部スト
レージにあるDMODファイル
の表を管理します。

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。
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変調の定義
一意の変調を、 2つのツール、 FSK表エデ ィ ター、 または、 I/Q表エデ ィ ターを使用し て作成する こ と ができ

ます。 これらの表は、 データ を特定の絶対変調状態にマ ッ ピング し ます。 状態間の遷移をマ ッ ピングするた
めに、 差分表エデ ィ ターが用意されています。

FSK表エディターを使用する、非対称FSK変調の作成

FSK表エデ ィ ターを使用し て、 大16レベルまでのカス タマイ ズ された非対称FSK変調を作成し、 次にカ ス

タ ム FSK変調を変調基準の 1つに適用する こ と ができ ます。 この機能の例には、 FLEXTMページ ャーの隣接
チャ ンネル選択度テス ト 用妨害信号の作成が挙げられます。 これを行 う には、 図13-22 に示された FSK表エ

デ ィ ターで、 4レベルのFSK変調を4.8 kHz と 1.6 kHzで作成し ます。 次に、 こ の信号をPN15データ転送の変  

調に使用し ます。 FLEXTMプロ ト コルで、 4レベルFSKのそれぞれのレベルは、 2ビ ッ ト ・ シーケン ス を表し
ます。

連続4レベルFSK信号の作成

こ の手順を使用し て、 FLEXTMページ ャーの隣接チャ ンネル ・ テス ト 用の4レベルFSK信号を作成し ます。

1. 信号発生器のPresetを押し ます。

2. Mode > Real- Time Custom Modulation > Modulation Setup > Modulation Type > Define User FSK

の順に押し ます。 

3. 図13-22に示された周波数偏差をFSK表エデ ィ ターに入力し ます。

4. フ ァ イルを4FSK と し て保存し ます。 Load/Store > Store To File > 4FSK > Enterの順に押し ます。

5. フ ァ イルを ロードする。 Load from Selected File > Confirm Load From Fileを押し ます。

6. Custom Modulationをオンにし ます。Return > Return > Return > Real- Time Custom Onを押し ます。

7. 周波数を隣接チャ ンネル用の所定の搬送波周波数に設定し ます。

8. 所定の振幅を設定し ます。

9. RF Onを押し ます。干渉物の振幅は、テス ト 中のデバイ スの性能測定のために調整する こ と ができ ます。 
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図13-22 FSK表エディター

I/Q表エディターを使用するI/Q値のマッピング

ほ と んどのデ ィ ジ タル無線システムでは、 キ ャ リ アの周波数は固定されているので、 考慮が必要なのは位相
と振幅のみです。 符号の位相と振幅は、 I/Q平面の離散点と し て表わすこ と ができ ます。 I/QのIは 「同位相」、
Qは 「直角位相」 を表し ます。 

Mode > Real- Time Custom Modulation > Modulation Setup > Modulation Type > Define User FSK

各キーの詳細については、44ページで説明さ
れているキーのヘルプを使用してください。
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図13-23 I/Q信号空間ダイヤグラム

キ ャ リ アをI/Q平面上でい く つかの規定位置の1つに変調する こ と によ り 、 エン コード された情報を転送す

る こ と ができ ます。 それぞれの位置または状態は、 レシーバーでデコード が可能な特定のビ ッ ト ・ パターン
を表し ます。 I/Q平面上のそれぞれの符号決定点における状態のマ ッ ピングは、 信号空間ダ イヤグ ラ ム と呼

ばれます。 信号空間ダ イヤグ ラ ムを、 図13-24に示されたI/Q表エデ ィ ターにマ ッ ピングする こ と によ って、

一意の信号を作成する こ と ができ ます。 表エデ ィ ターにはデ ィ スプレ イ機能も あ り 、 予想されるI/Q集合を
ク イ ッ ク目視チェ ッ クする こ と を可能にし ます。 

図13-24 I/Q表エディター

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。

Mode > Real-Time Custom Modulation > Modulation Setup > Modulation Type > Define User I/Q
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こ のI/Qマ ッ ピングのフ レキシビ リ テ ィ ーを活用し て、 一意の変調方式を作成する こ と ができ ます。 例えば、
STAR QAM と呼ばれる円形の信号空間配置を簡単に実行し て保存し、 後で、 リ アルタ イ ム I/Qベースバン ド 

発生器を使用し て再読取でき ます。 図13-25は、 STAR QAMに16の状態または符号があ る こ と を示し ていま 

す。 4つのデータ ・ ビ ッ ト はそれぞれの符号を定義し ます。 し たがって、 こ の図と表は同等です。

STAR QAM変調方式の作成
1. 信号発生器のPresetを押し ます。

2. Mode > Real- Time Custom Modulation > Modulation Setup > Modulation Type > Define User IQ

の順に押し ます。 

3. 図13-25に示されたI とQの値を、テンキーパッ ド と矢印キーを使用し て入力し ます。 IQマ ッ プのデ ィ スプ 
レ イ を押し、 入力を確認し て、 入力 ミ スがあれば調整し ます。

4. Return > Store To File > Clear Textを押し ます。

5. Custom Modulationをオンにし ます。Return > Return > Return > Real- Time Custom Onを押し ます。

6. フ ァ イルにSTAR と名前を付けて、 Enterを押し ます。

7. フ ァ イルを ロードする。 STARを強調表示させ、 Load from Selected File > Confirm Load From Fileを    

押し ます。

8. Custom Modulationをオンにし ます。Return > Return > Return > Return > Real- Time Custom Onの    
順に押し ます。

9. 周波数と振幅を所定の値に設定し ます。

10. RF Onを押し ます。 

図13-25 STAR QAMダイアグラムと表
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 カスタム・デジタル変調（オプション431）   
任意波形発生器の使用
図13-26は、 X- Seriesのセ ッ ト ア ッ プおよびI/Qデ ィ スプレ イ を示し ます。

図13-26 カスタム変調とI/Qディスプレイ

変調作図上のヒント
• マ ッ プはI と Qの結合のために、 16の合計信号レベルに制限されます。 表右側の読取値は、 使用されたI と

Qのレベル数を追跡し ます。レベルはIまたはQの値です。図13-27は、2つの異なる方法で構築された8PSK
信号を示し ます。図13-27中の ８ PSK信号は、 左側で使用可能な16のI/Q値の内5つを使用し、 右側で使用
可能な16のI/Q値の内4つを使用し ます。

• こ の例の通 り 、 リ アルタ イ ムI/Qベースバン ド発生器は対称256QAM集合をサポー ト し ますが、 非対称に

は16よ り 多 く のI/Q値が必要なため、 非対称256QAM集合はサポー ト し ません。

• レベルは、 I/Q平面で等間隔あ るいは対称にな る必要はあ り ません。 例えば、 図13-28に示された16QAM
変調はどち ら も可能です。
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任意波形発生器の使用 
図13-27 2種類の方法で構築された8PSK信号

図13-28 平坦および平坦でないレベルの16QAM I/Qマップ
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 カスタム・デジタル変調（オプション431）   
任意波形発生器の使用
カスタム・マルチキャリア・デジタル変調状態の作成
こ の手順では、 カス タ ム、 3 キ ャ リ ア EDGE、 デジ タル変調状態の作成によ る、 定義済み、 マルチキ ャ リ ア、
デジ タル変調セ ッ ト ア ッ プをカス タマイ ズする方法を学びます。

こ の節は、 次の作業の実行方法を説明し ます ：

• マルチキャリア・デジタル変調セットアップの作成 （352ページ）

• 搬送波周波数オフセットの変更 （352ページ）

• キャリア・パワーの変更 （352ページ）

• 波形の生成 （352ページ）

• RF（無線周波数）出力の設定 （352ページ）

図13-29 マルチキャリア・デジタル変調セットアップの作成

Mode > ARB Custom Modulation

Multicarrier Setup表の値または
Multicarrierメニューの値（すな
わち、キャリア・セットアップ、
キャリアの数、周波数間隔また
はキャリアの位相）に変更が行
われるとアクティブになります。

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。
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マルチキャリア・デジタル変調セットアップの作成
1. Presetを押し ます。

2. Mode > ARB Custom Modulation > Multicarrier Off Onの順に押し、 Multicarrier Off OnをOnにし ます。

3. Multicarrier Setup > Select Carrier and Initialize Table > Carrier Setup > EDGE > Doneの順に押し ます。

搬送波周波数オフセットの変更
1. 2行目の、 キ ャ リ ア用周波数オフセ ッ ト 値 （500.000 kHz） を強調表示させます。

2. –625 > kHz と押し ます。

キャリア・パワーの変更
1. 2行目の、 キ ャ リ ア用パワー値 （0.00 dB） を強調表示させます。

2. –10 > dB と押し ます。

次の表に示す通 り 、 これで、 周波数オフセ ッ ト –625 kHzのキ ャ リ ア と –10.00 dBmのパワー ・ レベルを  
使用する カス タ ム2キ ャ リ アEDGE波形が得られます。

波形の生成
Return > Digital Modulation Off Onを押し ます。

こ の こ と によ り 、 前節で作成された、 カ ス タ ム、 マルチキ ャ リ ア、 EDGE、 デジ タル変調状態を使用する波

形が発生し ます。 デ ィ スプレ イはDig Mod Setup: Multicarrier (Modified)に変わ り ます。 波形発    
生の間に、 DIGMODおよびI/Qイ ンジケーターが表示され、 新しいカ ス タ ム、 マルチキ ャ リ ア、 EDGE状態は

揮発性 メ モ リ ーに保存されます。 これで、 波形はRFキ ャ リ アを変調し ます。

こ の、 カス タ ム、 マルチキ ャ リ アEDGE状態を不揮発性 メ モ リ ーに保存する方法の説明は、「カスタム・マル
チキャリア・デジタル変調状態の保存」（353ページ）を参照し て く ださい。 

RF（無線周波数）出力の設定
1. RF （無線周波数） 出力周波数を890.01 MHzに設定し ます。 

2. 出力振幅を–10 dBmに設定し ます。 

3. RF On/Offを押し ます。

これで、 カス タ ム ・ マルチキ ャ リ アEDGE信号が、 RF （無線周波数） 出力コネ ク ターで使用可能にな り ます。

デジタル変調が既にオンであれば、
マルチキャリアを適用を押して変更
を適用し、更新された値に基づいて
新しいカスタム・マルチキャリア・
デジタル変調波形を発生させます。

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。
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 カスタム・デジタル変調（オプション431）   
任意波形発生器の使用
カスタム・マルチキャリア・デジタル変調状態の保存
こ の手順を使用し て、 不揮発性 メ モ リ ーに、 カ ス タ ム、 マルチキ ャ リ ア、 デジ タル変調状態を保存する方法
を学びます。

カ ス タ ム、 マルチキ ャ リ ア、 デジ タル変調状態がまだ作成されていない場合は、 前節、「カスタム・マルチ
キャリア・デジタル変調状態の作成」（351ページ）のステ ッ プを完了させて く ださい。

図13-30 カスタム・マルチキャリア・ソフトキーの保存

1. Digital Modulation Off Onが 初のソ フ ト キー と なっている、ト ッ プレベルDigital Modulation メ ニューに戻    

り ます。

2. Multicarrier Setup > More > Load/Store > Store To Fileの順に押し ます。

Catalog of MDMOD Filesからの、 ア ク テ ィ ブ ・ エン ト リ ー領域を占める フ ァ イル名がすでにあ る場   
合は、 次のキーを押し ます ： Clear Text

3. フ ァ イル名 （例えば、 EDGEM1） を、 アルフ ァベッ ト ・ キーと テンキーパッ ド を使用し て、 大23文字の

長さ で入力し ます。

4. Enterを押し ます。

これで、 ユーザー定義、 マルチキ ャ リ ア、 デジ タル変調状態は不揮発性 メ モ リ ーに保存されます。

注記 RF （無線周波数） 出力振幅、 周波数および操作状態設定は、 ユーザー定義、 デジ タル変調状態フ ァ

イルの一部と し ては保存されません。

アクティブなマルチキャリア・デジタル変調状態に変更を適用
Multicarrier Setup表エディ ターで変更を行 う 間に、デジタル変調フ ォーマッ ト が使用中（Digital Modulation  
Off Onをオンに設定） であれば、 更新された波形が発生する前に、 変更を適用する こ と が必要です。

Multicarrier Setup表エデ ィ ターで、 Apply Multicarrierを押し て変更を適用し、 更新された値に基づいて  
新しいカス タ ム ・ マルチキ ャ リ ア ・ デジ タル変調波形を発生し ます。

45ページ

Fixed：すべてのキャリアは0の位
相に設定されます。
Random：すべてのキャリアはラン
ダム位相値に設定されます。

各キーの詳細については、44ページ
で説明されているキーのヘルプを使用
してください。
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カスタム変調による有限インパルス応答（FIR）フィルターの使用 
カスタム変調による有限インパルス応答（FIR）フィルターの使用
有限イ ンパルス応答フ ィ ルターは、 発生し た波形の符号決定点の間の遷移を純化し ます。 

図13-31 Filterメニュー
Mode > ARB Custom Modulation > Single Carrier Setup > Filter

このことにより、現在のFIR
フィルターが、現在の変調タ
イプ用の工場デフォルトフィ
ルター設定を置き換えます。

このソフトキーは、選択されたフィルター

タイプによって変わります。

フィルターにRoot NyquistまたはNyquistが選択された
場合のみ使用可能です

フィルターにGaussianが選択
された場合のみ使用可能です

360ページDual ARB Modulationのみに適
用されます。145ページを参
照してください。

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。

IS-95フィルター 
選択メニューが開
きます。

356ページ
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 カスタム・デジタル変調（オプション431）   
カスタム変調による有限インパルス応答（FIR）フィルターの使用
FIRフィルターの理解
FIR フ ィ ルターは、 IおよびQ変調器への入力の帯域幅を制限し ます。 い く つかの異なる タ イプのFIR フ ィ ル
ターがあ り ます。NADC、PDC、PHSおよびTETRA規格は、送信機と受信機の両方のRoot Nyquistフ ィ ルター 

を規定し ます。結合された応答は、 Nyquistフ ィ ルター と同等です。 Nyquistフ ィ ルターには、データ ・ ク ロ ッ

ク ・ レー ト で リ ンギングする イ ンパルス応答があ り 、 このため、 イ ンパルス応答の中央にある所定の1点を除
く すべての符号決定点に、 ヌルが現れます。 それぞれの符号は、 すべての不要な決定点でゼロ応答を も た ら
し、 符号間干渉 （ISI） をな く せる可能性があ り ます。 Nyquist タ イプのフ ィ ルター用に定義されたアルフ ァ
区間 （） は、 フ ィ ルター応答がゼロの周波数カ ッ ト オフ点を識別し ます。 アルフ ァ区間が0に近いほど、 フ ィ

ルターのロールオフは急勾配にな り ます。 アルフ ァはシステムの占有周波数帯幅の直接測定を規定し、 次の
よ う に計算されます ：

占有周波数帯幅 = シンボル ・ レー ト  × （1 + ）

NADCおよびTETRA規格は、 0.35のアルフ ァ値を指定し ています。 PDCおよびPHS規格は0.50のアルフ ァ値
を指定し ています。 これらの規格それぞれに対し て、 Keysight X- Series信号発生器は、 デフ ォル ト の変調前 

フ ィ ルターと し て、 指定されたアルフ ァ値のRoot Nyquist フ ィ ルターを備えています。 図13-32は、 い く つ 
かのアルフ ァ値のNyquistイ ンパルス応答を示し ます。

片振幅点が、常にハーフシンボル ・ レー ト であ る こ と に注意し て く ださい。すべての情報がハーフシンボル ・
レー ト 帯域幅に含まれている ため、 アルフ ァ値は追加占有周波数帯幅の尺度にな り ます。

も う 1つのタ イプのFIRフ ィ ルターは、 GSMおよびDECT規格に規定されている、 Gaussianフ ィ ルターです。
Gaussian フ ィルターには、 通常はNyquistフ ィルターよ り多く の符号間干渉があ り ますが、 IおよびQのNyquist
フ ィ ルター処理が不可能なMSKのよ う な定振幅モード では、 隣接チャ ンネル電力性能がよ り 高いです。 帯域

幅ビ ッ ト 時間 （BbT） 積 （と同等） は、 GSM規格では0.30、 DECT規格では0.50 と定義されています。 これ
らの規格それぞれに対し て、 Keysight X- Series信号発生器は、 デフ ォル ト の変調前フ ィ ルターと し て、 指定 

された帯域幅ビ ッ ト 時間 （BbT） 積のGaussianフ ィ ルターを備えています。

図13-32 ナイキスト・フィルター・インパルス応答
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カスタム変調による有限インパルス応答（FIR）フィルターの使用 

          

    
フィルターとアルファ（a）または帯域幅ビット時間（BbT）積の選択

個別のシステム ・ デザイ ン要件によ り 、 フ ィ ルター、 または、 フ ィ ルター またはBbTの変更が必要と なる
場合があ り ます。 アルフ ァ値は0～1、 BbTは0.1～1に調整する こ と ができ ます。

フ ィ ルター ・ アルフ ァ を変更するには ：

1. 装置をプ リ セ ッ ト し ます。

2. Mode > Real- Time Custom Modulation > Modulation Setup > Filter > Select Nyquist > Filter Alpha     
の順に押し ます。

3. 0から1の間で、 新しい値を入力し ます。 Enterを押し ます。

4. デフ ォル ト のフ ィ ルター値を復元するには、 Restore Default Filterを押し ます。

注記 フ ィ ルター Bb ｔ を変更するには、 Mode > Real- Time Custom Modulation > Modulation Setup >    
Filter > Select Gaussian > Filter Bbtの順に押し ます。

0.1から1の間で、 新しい値を入力し ます。

FIR表エディターを使用してユーザー定義FIRフィルターを作成
こ の手順では、 FIR Values表エデ ィ ターを使用し て、 8符号、 オーバーサンプ リ ング率4のウ ィ ン ド ウ化され 
た同期関数フ ィ ルターを作成し、 保存し ます。

表エディターへのアクセス
1. Presetを押し ます。

2. Mode > ARB Custom Modulation > Single Carrier Setup > Filter > Select > Nyquistの順に押し ます。

3. Filter > Define User FIRを押し ます。 

4. More 2 of 2 > Delete All Rows > Confirm Delete of All Rowsの順に押し ます。 

こ のこ と によ り 、 図13-33に示す通 り 、 表エデ ィ ターが初期化されます。
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 カスタム・デジタル変調（オプション431）   
カスタム変調による有限インパルス応答（FIR）フィルターの使用
図13-33 FIRフィルター表エディターを使用してユーザー定義FIRフィルターを作成

係数値の入力
1. Returnソ フ ト キーを押し て、 表エデ ィ ターの1ページ目を開き ます。 

2. カーソルを使用し て、 係数0のValueフ ィ ール ド を強調表示させます。 

3. テンキーパッ ド を使用し て、表13-1から1番目の値 （- 0.000076） を タ イプし ます。 テンキーを押すと、 数
字がアクテ ィ ブ ・ エン ト リ ー領域に表示されます。 （ ミ スをしてもbackspaceキーを使用して訂正でき ます。）

4. ステ ッ プ1の表から、 すべての16の値が入力される まで、 係数値の入力を続けます。

表13-1  

係数 値 係数 値

0 0.000076 8 0.035667

1 0.001747 9 0.116753

2 0.005144 10 0.157348

3 0.004424 11 0.088484

4 0.007745 12 0.123414

Mode > ARB Custom Modulation> Single Carrier Setup > Filter > Define 
User FIR > More > Delete All Rows > Confirm Delete of All Rows

メニューが開き、揮発性 
メモリーに保存されたファ
イルを、選択してロードす
ることが可能になります。
45ページを参照してくだ 
さい。

215ページ

各キーの詳細については、44ページで説明されているキーのヘル
プを使用してください。

注記：
変調フィルターは通常は実数で、2より大きいオーバーサンプリング率（OSR）になっています。
イコライザー・フィルターは通常は複素数で、1のオーバーサンプリング率（OSR）になっています
（Dual ARBのみ）。

次の場合のみアクティブに
なります：
FIRフィルター係数表に、
2つ以上の値が表示されて
います。
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最初の16の係数の、Mirror Tableを使用するコピー

ウ ィ ン ド ウ化されたシン ク関数フ ィ ルターでは、 後半の計数は前半の係数と逆順で同一になっています。 信
号発生器は、 既存の係数値を逆順に自動コ ピーする、 鏡像表機能を備えています。

1. Mirror Tableを押し ます。 図13-34（358ページ）で示すよ う に、 後の16個の係数 （16～31） は自動的に 

生成され、 これらの う ち 初の係数 （16番） は強調表示されます。 

図13-34

オーバーサンプリング率の設定

注記 変調フ ィ ルターは実数で、 2よ り 大きいオーバーサンプ リ ング率 （OSR） であ る こ と が必要です。

オーバーサンプ リ ング率 （OSR） は符号ご と のフ ィ ルター係数の数値です。 使用可能な数値範囲は 1 から 32
です。表エデ ィ ターで許容される、符号 と オーバーサンプ リ ング率の 大の組み合わせは1024です。 ただし、

実際には装置ハード ウ ェアは32個の符号、 4 と 16の間のオーバーサンプ リ ング率、 512個の係数に制限されて

います。 そのため、 32個を超える符号または512個を超え る係数を入力する と、 装置はフ ィ ルターを使用す
る こ と ができ ません。 オーバーサンプ リ ング率が、 内部で 適に選択された もの と異な る場合には、 フ ィ ル
ターは自動的に リ サンプ リ ング され、 適なオーバーサンプ リ ング率にな り ます。

こ の例では、 所定のOSRは4であ り 、 こ の値はデフ ォル ト 値なので、 何ら ア ク シ ョ ンは必要あ り ません。

5 0.029610 13 0.442748

6 0.043940 14 0.767329

7 0.025852 15 0.972149

表13-1 （続き）

係数 値 係数 値

FIR表係数値は、工場出荷時
のデフォルト値である場合
もあり、ユーザーにより入
力された値である場合もあ
ります。

Goto Rowメニューを使用
して移動し、FIR値係数表
に対する変更を行います。各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。
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フィルターのグラフ形式を表示
信号発生器には、 フ ィ ルターを時間と周波数次元の両方でグ ラ フ表示する機能があ り ます。

1. More > Display Filter > Display FFT （高速フー リ エ変換） と押し ます。 

図13-35（359ページ）を参照し て く ださ い。

図13-35

2. Returnを押し ます。

3. Display Impulse Responseを押し ます。 

図13-36を参照し て く ださい。

図13-36

4. Returnを押し て、 メ ニューキーに戻 り ます。

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。

各キーの詳細については、 
44ページで説明されている
キーのヘルプを使用してく 
ださい。
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カスタム・デジタル変調（オプション431） 
FIR表エディターを使用したFIRフィルターの変更 
フィルターのメモリーへの保存
次のステ ッ プを使用し てフ ァ イルを保存し ます。

1. Load/Store > Store To Fileを押し ます。 FIRフ ァ イルのカ タ ロ グが、 メ モ リ ーの使用可能量と一緒に表示さ    
れます。

2. 波形セグメントの保存、読み込み、および再生 （148ページ） で説明される通 り 、 こ のフ ァ イルにFIR_1
と名前を付けて保存し ます。

フ ァ イルFIR_1は リ ス ト される1番目の名前です。 （以前に他のFIRフ ァ イルを保存し ていた場合には、 追加さ

れる フ ァ イルの名前はFIR_1の下に リ ス ト されます。） フ ァ イル ・ タ イプはFIRで、 フ ァ イルのサイ ズは260バ

イ ト です。 メ モ リ ーの使用量も表示されます。 保存可能なフ ァ イル数は、 フ ァ イルの大き さ と使用済みの メ
モ リ ー量によ り ます。 図13-37を参照し て く ださい。

図13-37

メ モ リ ーは、 機器ステー ト ・ フ ァ イル と リ ス ト 掃引フ ァ イルによ り 共有されます。

これで、 こ のフ ィ ルターは変調フ ォーマ ッ ト のカス タマイ ズに使用でき、 または、 新しいフ ィ ルター設計の
基礎と し て も使用でき ます。 

FIR表エディターを使用したFIRフィルターの変更
信号発生器に保存されたFIR フ ィ ルターは、 FIR表エデ ィ ターを使用し て、 容易に変更する こ と ができ ます。
FIR表エデ ィ ターは、不揮発性 メ モ リ ーに保存されたユーザー定義FIRフ ァ イルからの係数値、 または、デフ ォ

ル ト のFIRフ ィ ルターの1つからの値と一緒にロードする こ と ができ ます。 次に値を変更し て新しいフ ァ イル
と し て保存でき ます。 

カタログは、ユーザーにより以前に保
存されたFIRファイルを表示します。

これらのキーは、内部ストレージにあ
るDMODファイルの表を管理します。

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。
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 カスタム・デジタル変調（オプション431）   
FIR表エディターを使用したFIRフィルターの変更
デフォルト・ガウスFIRファイルの読み込み

図13-38 デフォルト・ガウスFIRファイルの読み込み

1. Presetを押し ます。

2. Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup > NADCの順に押し ます。

3. Filter > Define User FIR > More 1 of 2 > Load Default FIR > Gaussianの順に押し ます。

4. Filter BbT > 0.300 > Enter と押し ます。

Mode > ARB Custom Modulation > 
Single Carrier Setup

これらのソ フ ト
キーは、 フ ィ ル
ター用のウ ィ ン
ド ウ機能 （アポ
デ ィ ゼーシ ョ ン
機能） を選択し
ます。

各キーの詳細については、44ページで説明されているキーのヘルプ
を使用してください。
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カスタム・デジタル変調（オプション431） 
FIR表エディターを使用したFIRフィルターの変更 
5. Filter Symbols > 8 > Enter と押し ます。

6. Generateを押し ます。 

注記 変調中の実際のオーバーサンプ リ ング率は、 装置によ り 自動的に選択されます。 シンボル ・ レー ト 、
変調タ イプの符号ご と のビ ッ ト 数、 および、 符号数に応じ て、 4から16の間の値が、 選択されます。

7. Display Filter > Display Impulse Responseを押し ます （図13-39を参照し て く ださい）。

図13-39 Impulse Responseディスプレイ

8. Returnを押し ます。

係数の変更
1. 正面パネルの矢印キーを使用し て、 係数15を強調表示し ます。

2. 0 > Enter と押し ます。

3. Display Impulse Responseを押し ます。

図13-40 Impulse Responseディスプレイおよび変更された係数

各キーの詳細については、44ペー
ジで説明されているキーのヘルプを
使用してください。

各キーの詳細については、 
44ページで説明されているキー
のヘルプを使用してください。
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 カスタム・デジタル変調（オプション431）   
差分符号化
図13-40（362ページ）を参照して く ださい。 グラ フ ィ ッ ク ・ ディ スプレ イは、 便利な ト ラブルシューテ ィ ン
グ ・ ツールを提供する こ と ができ ます （こ の例では、 係数値が抜けている ため、 結果 と し て不適切なガ
ウ ス応答と なった こ と を示し ています）。

4. Returnを押し ます。

5. 係数15を強調表示し ます。 

6. 1 > Enter と押し ます。 

フィルターのメモリーへの保存
大のフ ァ イル名長は23文字 （英数字と特殊文字） です。

1. Return > Load/Store > Store To Fileを押し ます。 

2. フ ァ イルに、 NEWFIR2 と い う 名前を付けます。

3. Enterを押し ます。 

現在の FIR 表エデ ィ ターの内容は、 不揮発性 メ モ リ ー内のフ ァ イルに保存され、 カ タ ロ グ ・ フ ァ イルは新し

いフ ァ イルを表示する よ う に更新されます。 

差分符号化
差分符号化はディ ジタル符号化テクニッ クで、 それによって、 2進値は特定の信号状態ではな く信号変化によ り

表示されます。 差分符号化を使用する と、 何れのユーザー定義I/QまたはFSK変調のバイナ リ ・ データ も、 
Differential State Mapに定義された符号表を使用する変調処理の間に、 符号化される こ と が可能にな り ます。

た と えば、信号発生器のデフ ォル ト 4QAM I/Q変調で考えてみま し ょ う 。デフ ォル ト の4QAMテンプレー ト に基 

づ く ユーザー定義変調では、 I/Q Values表エディ ターには、 2つの固有値1.000000と1.000000。 を使用し て 

I/Q平面にマ ッ ピング された4つの符号 （00、 01、 10、 11） を表すデータが含まれます。 次の図は、 表エデ ィ
ター中の4QAM変調を示し ています。
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カスタム・デジタル変調（オプション431） 
差分符号化 
次の図は、 4QAM変調I/Q状態マ ッ プを示し ています。

差分符号化は、 符号表中の状態間の相対オフセ ッ ト を使用し て、 ユーザー定義変調方式を符号化し ます。 
Differential State Map表エデ ィ ターは、符号表オフセ ッ ト 値の導入に使用され、その値は次に関連デー  

タ値に基づ く I/Q 状態マ ッ プを通し て遷移を発生させます。 データ値が変調される場合は必ず、 Differential
State Mapに保存されたオフセ ッ ト 値がデータ符号化のために使用され、符号表オフセ ッ ト 値によ って定義さ 

れた方向と距離にあ る I/Q状態マ ッ プを通し て遷移する こ と によ って符号化されます。

下の図に示される よ う に、 +1の値を入力する と、 I/Q State Mapを通し た1- 状態前方遷移を発生させます。 

注記 次の I/Q State Map の図は、 特定の符号表オフセ ッ ト 値を使用し て起こ り 得る、 すべての状態遷移  
を示し ています。 実際の状態から状態への遷移は、 変調が開始される状態によ り ます。

例と し て、 次のデータ/符号表オフセ ッ ト 値を考えてみます。

表13-2  

データ オフセ ッ ト 値

00000000 +1

00000001 - 1

1 番目の符号

固有値：+1, +1
データ  = 00000000

2 番目の符号

固有値：-1, +1
データ  = 00000001

4 番目の符号

固有値：+1, -1
データ  = 00000011

3 番目の符号

固有値：-1, -1
データ  = 00000010

12

3 4
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 カスタム・デジタル変調（オプション431）   
差分符号化
NOTE 符号ご と のビ ッ ト 数は、 次の式を使用し て表現する こ と ができ ます。 この方程式は天井関数であ る
ため、 xの値に分数が含まれる と、 xは整数に切 り 上げられます。 

こ こ で、 x = 符号ご と のビ ッ ト 、 また、 y = 差分状態の数。

00000010 +2

00000011 0

表13-2 （続き）

データ オフセ ッ ト 値
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カスタム・デジタル変調（オプション431） 
差分符号化 
これらの符号表オフセ ッ ト は、 以下に示す遷移の1つに帰着し ます。

ユーザー定義デフ ォル ト 4QAM I/Qマ ッ プに適用する場合、 1番目の符号 （データ00） から開始し、 デー

タ ・ ス ト リ ーム （2ビ ッ ト 符号によ る） 0011100001のための差分符号化遷移は、 次の図に表示された通 り と
な り ます。 

データ値 00000001 

1 つの状態が後方に遷移
符号表オフセ ッ ト -1 使用

データ値 00000010 

2 つの状態が前方に遷移
符号表オフセ ッ ト +2 使用

データ値 00000011 

遷移な し
符号表オフセ ッ ト 0 使用

データ値 00000000 

1 つの状態が前方に遷移
符号表オフセ ッ ト +1 使用
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 カスタム・デジタル変調（オプション431）   
差分符号化

            
前の図で見られる通 り 、 1番目と 4番目の符号は、 同じ値 （00） を持ち、 同じ状態遷移 （前方1状態） を生成
し ます。 差分符号化では、 符号値は場所を定義し ません。 I/Q状態マ ッ プを通し て、 遷移の方向と距離を定

義し ます。

差分符号化の使用
信号発生器のDifferential State Map表エデ ィ ターは、 ユーザー定義I/Qおよびユーザー定義FSK変調  

に関連する差分状態マ ッ プの変更を可能にし ます。 こ の手順では、 ユーザー定義 I/Q 変調を作成し、 次に設

定、 ア ク テ ィ ブ化および差分符号化のユーザー定義変調への適用を行います。 詳細については「差分符号化」
（363ページ）を参照し て く ださい。

ユーザー定義I/Q変調の設定
1. Presetを押し ます。

2. 使用する フ ォーマ ッ ト ・ タ イプに必要な、 以下のキーの押す順番に従います。

カスタムARBフォーマット用

Mode > ARB Custom Modulation > Single Carrier Setup > Modulation Type > Select > More 1 of 2 > Define User I/Q >     
More > Load Default I/Q Map > QAM > 4QAMの順に押し ます。

または次の別の順番を使用し ます ：

Mode > ARB Custom Modulation > Single Carrier Setup > Quick Setup (所定のフ ォーマ ッ ト ) > Modulation Type > 
Select > More > Define User I/Q > More 1 of 2 > Load Default I/Q Map > QAM > 4QAMの順に押し ます。

データ値 符号表オフセ ッ ト
00
01
10
11

+1
-1
+2
+0

データ  = 0011100001

{{

{ {

{

5 番目の符号1 番目の符号
3 番目の符号

4 番目の符号2 番目の符号

1番目  

2番目 

3番目 
5番目 4番目 
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カスタム・デジタル変調（オプション431） 
差分符号化 
こ のこ と によ り 、 デフ ォル ト の4QAM I/Q変調が読み込まれ、 I/Q表エデ ィ ターに表示されます。

デフォル ト の4QAM I/Q変調には、 2つの固有値 （1.000000 および - 1.000000） を使用してI/Q平面にマッ ピン   
グ された4つの符号 （00、 01、 10、 11） を表すデータが含まれます。 これらの4つの符号は、 変調処理の間に、

データのそれぞれの符号に関連する符号表オフセ ッ ト 値によ り 横行されます。図13-41を参照し て く ださい。

図13-41

Differential State Map表エディターへのアクセス

Configure Differential Encodingを押し ます。 

こ のこ と によ り 、 以下の通 り 、 Differential State Map表エデ ィ ターが開き ます。 この時点で、 1番目  
の符号 （00000000） 用のデータ と オフセ ッ ト 値受入れのために準備 さ れたカー ソ ルが見え ます。 こ れで、

ユーザー定義デフ ォル ト の 4QAM I/Q 変調用のカ ス タ ム差分符号化を作成する準備ができ ま し た。 図 13-42 
（368ページ）を参照し て く ださい。

図13-42

データ 符号表オフセット値入力領域
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 カスタム・デジタル変調（オプション431）   
差分符号化

 

Differential State Mapの編集
1. 1 > Enterを押し ます。

こ のこ と によ り 、 1の符号表オフセ ッ ト が追加され、 1番目の符号が符号化されます。 符号は、 0のデータ
値が変調される と、 状態マ ッ プで1の値分前方に回転し ます。

2. +/– > 1 > Enterの順に押し ます。 

こ のこ と によ り 、 - 1の符号表オフセ ッ ト が追加され、 2番目の符号が符号化されます。 符号は、 1のデー

タ値が変調される と、 状態マ ッ プで1の値分後方に回転し ます。

注記 こ の時点で、 変調には符号ご と に1ビ ッ ト があ り ます。 初の2つのデータ値 （00000000 と  
00000001） には、 後のビ ッ ト （それぞれ0および １ ） のみが有意です。 

3. 2 > Enter と押し ます。

こ のこ と によ り 、 2の符号表オフセ ッ ト が追加され、 3番目の符号が符号化されます。 符号は、 10のデー

タ値が変調される と、 状態マ ッ プで2の値分前方に回転し ます。

4. 0 > Enter と押し ます。

こ のこ と によ り 、 0の符号表オフセ ッ ト が追加され、 4番目の符号が符号化されます。 符号は、 11のデー
タ値が変調されて も、 状態マ ッ プで回転し ません。

注記 こ の時点で、 変調には符号ご と に2ビ ッ ト があ り ます。 データ値00000000、 00000001、 00000010、

00000011には、 符号値はそれぞれ00、 01、 10、 11にな り ます。

カスタム差分符号化の適用
Return > Differential Encoding Off Onを押し ます。 

こ のこ と によ り 、 カス タ ム差分符号化がユーザー定義変調に適用されます。 

注記 信号発生器デ ィ スプレ イの Differential State Map の と な り に (UNSTORED) が表示されるの    

で注意し て く ださい。 Differential state mapは、 マ ッ プが作られる基と なったユーザー定義変調に  

関連し ます。 

カス タ ム差分状態マ ッ プを保存するために、 その設計の基と なったユーザー定義変調を保存する こ
と が必要です。 これを行わなわず、 I/Q またはFSK表エデ ィ ターを終了させる際に Confirm Exit From  
Table Without Savingソ フ ト キーを押すと、 符号表オフセ ッ ト 値は除去されます。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 369



カスタム・デジタル変調（オプション431） 
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
14 マルチトーンおよびツートーン波形
（オプション430）

こ の情報を使用する前に、 信号発生器の基本操作に十分習熟し ている こ と が必要です。 出力水準 と周波数の
設定などの機能を まだ十分に操作できない場合は、 基本操作 （43ページ） を参照し て、 その章の情報に習熟
し て く ださい。

こ の機能は、 オプシ ョ ン430付きのKeysight X- Seriesベク ト ル信号発生器のみで使用可能です。 オプシ ョ ン 

430にはオプシ ョ ン653または656が必要です。

カスタム・ツートーン波形の作成
Two-Toneメ ニューを使用し て、 ユーザー定義ツー ト ーン波形を定義し、 変更する こ と ができ ます。 ツー

ト ーン波形は、 デュ アル任意波形発生器によ り 発生し ます。

ツートーン変調の使用 （372ページ） 節は、 次の作業の実行方法を説明し ます ：

• ツートーン波形の作成 （373ページ）

• ツートーン波形の表示 （373ページ）

• キャリア・フィードスルーの最小化 （374ページ）

• ツートーン波形のアライメント変更 （376ページ）

カスタム・マルチトーン波形の作成
Multitone Setup表エデ ィ ターを使用し て、 ユーザー定義マルチ ト ーン波形の定義、 変更および保存する 

こ と ができ ます。 マルチ ト ーン波形は、 デュ アル任意波形発生器によ り 発生し ます。

マルチトーン変調の使用 （377ページ） は、 次の作業の実行方法を説明し ます ：

• Multitone Setup表エディターの初期化 （377ページ）

• 信号音電力と信号音位相の設定 （378ページ）

• トーンの削除 （378ページ）

• 波形の生成 （378ページ）

• RF（無線周波数）出力の設定 （379ページ）
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マルチトーンおよびツートーン波形（オプション430） 
ツートーン変調の使用 
ツートーン変調の使用
本章のこれ以降の節で、 オプシ ョ ン430付きのKeysight X- Seriesベク ト ル信号発生器のみで使用可能なツー
ト ーン ・ モード を説明し ます ：

• ツートーン波形の作成 （373ページ）

• ツートーン波形の表示 （373ページ）

• キャリア・フィードスルーの最小化 （374ページ）

• ツートーン波形のアライメント変更 （376ページ）

以下も参照し て く ださい ： 波形の設定およびパラメーターの保存 （155ページ）

注記 ツー ト ーン波形の特性、 および、 ツー ト ーンの規格に関する詳細は、 http://www.keysight.comを開

き、 試験および測定で 「AN 1410」 を検索し て、 webサイ ト から アプ リ ケーシ ョ ン ・ ノ ー ト 1410を 
ダウ ン ロード し て く ださい。

Two–Tone Modulationソフトキー
Freq SeparationソフトキーまたはAlignmentソフト
キーに変更を行うと、アクティブになります。 Two Toneをオンにするとアクティブ

になります。

Two–Toneを有効にするとアクティブになります。
ソフトキーの使用法については、 
147ページを参照してください。

245ページ

各キーの詳細については、44ページで説明されているキーのヘルプを使用してください。

377ページ

312ページ

参照147ページを参照してください。（ツートーンのArb 
Setupは、Dual Arb Setupに似ています。）

例外： 
> Waveform Runtime Scalingソフトキーはありません 
> Multi–BBG Sync Setupソフトキーはありません 
> DAC Over–Range Protectionソフトキーはありません
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ツートーン波形の作成
こ の手順は、 基本の、 セン ターの、 ツー ト ーン波形を作成する方法を説明し ます。

1. 信号発生器をプ リ セ ッ ト し ます。

2. 信号発生器のRF （無線周波数） 出力周波数を6 GHzに設定し ます。

3. 信号発生器のRF （無線周波数） 出力振幅を–10 dBmに設定し ます。

4. Mode > More > Two–Tone > Freq Separation > 10 > MHzの順に押し ます。

5. Two Tone Off Onを押し てオンにし ます。

6. RF （無線周波数） 出力をオンにし ます。

これで、 ツー ト ーン信号が、 信号発生器のRF （無線周波数） 出力コネ ク ターで使用可能にな り ます。図14-1
（373ページ）は、すべてのステ ッ プ完了後、信号発生器デ ィ スプレ イがどのよ う に表示されるかを示し ます。

T-TONEおよびI/Qイ ンジケーターが表示され、 RF ON、 MOD ONがオンであ り 、 信号のパラ メ ーター設定が  
信号発生器デ ィ スプレ イの状態領域に表示されている こ と確認し て く ださい。

図14-1

ツートーン波形の表示
こ の手順は、 スペク ト ル ・ アナラ イザーを設定し てツー ト ーン波形と そのIMD積を表示させる方法を説明し
ます。 実際に押すキーは、 ご使用のスペク ト ル ・ アナラ イザーのモデルによ って異な り ます。

1. スペク ト ル ・ アナラ イザーをプ リ セッ ト し ます。

2. 搬送波周波数を6 GHzに設定し ます。

3. 周波数スパンを60 MHzに設定し ます。

4. 10 dBスケール用の振幅を、 –10 dBm基準を使用して設定し ます。 

5. 分解能帯域幅を、 IMD積が見える よ う 、 ノ イズ ・ フ ロアを十分に低減する よ う に調整し ます。 この例では、

9.1 kHzに設定されま した。

6. ピーク ・ ディ テ ク ターをオンにし ます。

Mode > Two–Tone

各キーの詳細
については、
44ページで
説明されてい
るキーのヘル
プを使用して
ください。
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 373



マルチトーンおよびツートーン波形（オプション430） 
ツートーン変調の使用 
7. 減衰を4 dBに設定し、スペク ト ル・アナラ イザーの入力 ミ キサーがオーバード ラ イブする こ と を防ぎます。 

これで、 図14-2（374ページ）に示された もの と類似し た、 6 GHz の中心搬送波周波数を持つツー ト ーン波 

形が見えるはずです。 また、IMD積が10 MHzの間隔で発生し た ト ーンの上下に、キ ャ リ ア ・ フ ィ ード スルー・ 

スパイ クが中心周波数に、 中心搬送波周波数の上下の10 MHz間隔のキ ャ リ ア ・ フ ィ ード スルー歪み成分と一 
緒に見えます。

図14-2

キャリア・フィードスルーの最小化
こ の手順は、 キ ャ リ ア ・ フ ィ ード スルーを 小化し、 ト ーン と、 その相互変調歪み成分と の間の出力差を測
定する方法を説明し ます。 この手順を開始する前に、 機器に、 I/Q校正が直近に実施されている こ と が重要で

す。 I/Q校正の実施手順 （「I/Q校正」（210ページ）を参照し て く ださ い。）

こ の手順は、 前の手順の実施を前提と し ています。

1. スペク ト ル ・ アナラ イザーで、 約100～200 msの掃引レー ト 用に分解能帯域幅を設定し ます。 このこ と 
によ り 、 キ ャ リ ア ・ フ ィ ー ド スルー ・ スパイ ク を、 調整を行 う 際に、 動的に表示させる こ と が可能にな
り ます。

2. 信号発生器で、 I/Q > I/Q Adjustments > I/Q Adjustments Off Onを押し てオンにし ます。

3. Internal Baseband Adjustments > I Offset を押し、 スペク ト ル ・ アナラ イザーでキ ャ リ ア ・ フ ィ ード スルー     
を監視し ながら、 ロータ リ ー・ ノ ブを回し ます。Iオフセ ッ ト を適切な方向に変更する こ と によ り 、 フ ィ ー

ド スルー ・ レベルが低減されます。 レベルをでき る限 り 低 く 調整し て く ださい。

 

ツートーン
チャンネル

キャリア・フィード
スルー歪み

搬送波フィー
ドスルー

各キーの詳細については、44ページで説明されているキーの
ヘルプを使用してください。

相互変調歪み
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 マルチトーンおよびツートーン波形（オプション430）   
ツートーン変調の使用
4. Qオフセットを押し、 ロータ リ ー ・ ノ ブを回し て、 キ ャ リ ア ・ フ ィ ード スルーのレベルを更に低減し て く
ださい。

5. 可能な限 り 低いキ ャ リ ア ・ フ ィ ード スルー ・ レベルに達する まで、 3 と 4のステ ッ プを繰 り 返し ます。

6. スペク ト ル ・ アナラ イザーで、 分解能帯域幅を以前の設定に戻し ます。

7. 波形平均化をオンにし ます。

8. マーカーを作成し、 2つの ト ーンの内1つのピーク に配置し ます。

9. デルタ マーカーを作成し、 隣接する相互変調積のピーク に配置し ます。 マーク が付け られた ト ーンか ら
10 MHzの間隔と なるはずです。

10. ト ーン と歪み成分の間の出力差を測定し ます。 

これで、 図14-3（375ページ）に示された もの と類似のデ ィ スプレ イが見え るはずです。 適化されたツー

ト ーン信号は、 これで、 テス ト 中のデバイ スによ り 発生するIMD積の測定に使用でき ます。 

キ ャ リ ア ・ フ ィ ード スルーは、 時間と温度によ り 変化する こ と に注意し て く ださい。 このため、 信号の 適
化を維持する ため、 IおよびQのオフセ ッ ト を定期的に調整する こ と が必要です。

図14-3

 

主マーカー

デルタ・

最小化された
キャリア・
フィード

各キーの詳細について
は、44ページで説明
されているキーのヘル
プを使用してください。

スルー

マーカー
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ツートーン波形のアライメント変更
こ の手順は、 ツー ト ーン波形を、 中心搬送波周波数に相関し て、 左または右に整列させる方法を説明し ます。
ト ーンの内1つの周波数は搬送波周波数と同じであ る ため、 こ のア ラ イ メ ン ト は通常は何れのキ ャ リ ア ・ 

フ ィ ード スルーも非表示にし ます。但し、左または右のア ラ イ メ ン ト に起因する イ メ ージ周波数干渉が、ツー
ト ーン信号の軽微な歪みの原因と なる場合があ り ます。 こ の手順は、 前の手順の実施を前提と し ています。

1. 信号発生器で、 Mode > Two Tone > Alignment Left Cent Rightを押し て、 左に設定し ます。

2. Apply Settingsを押し て、 波形を再発生させます。

注記 ツー ト ーン発生器が稼働中 （Two Tone Off Onをオンに設定） に設定に変更を行った場合は、 更新され   

た波形を発生させる前に、 Apply Settings ソ フ ト キーを押し て変更を適用させる こ と が必要です。 変 

更を適用する と、 ベース ラ イ ン発生器は、 新しい設定を使用し てツー ト ーン波形を作成し、 ARB メ
モ リ ーの中の既存の波形を置き換えます。

3. スペク ト ル ・ アナラ イザーで、 波形平均化を一時的にオフにし て、 ビ ューを よ り 速 く リ フ レ ッ シ ュ し ま
す。 これで、 図14-4に示された もの と類似し た、 左側に整列されたツー ト ーン波形が見え るはずです。

図14-4

搬送波
周波数

搬送波周波数に
整列された

相互変調歪み

ツートーン・
チャンネル

上側トーン

各キーの詳細については、44ページで説明されているキー
のヘルプを使用してください。
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 マルチトーンおよびツートーン波形（オプション430）   
マルチトーン変調の使用
マルチトーン変調の使用

Multitone Modulationソフトキー

Multitone Setup表エディターの初期化
1. Presetを押し ます。

2. Mode > Multitoneを押し ます。

3. Initialize Table > Number of Tones > 5 > Enterの順に押し ます。

4. Freq Spacing > 20 > kHzの順に押し ます。

378ページ

377ページ

このソフトキーは、現在のマルチトーン波形に表エディター
で変更が加えられるとアクティブになります。このような変
更を適用するために、ソフトキーを押すことが必要です。

379ページ

379ページ

マルチトーンが有効
化の場合にアクティ
ブになります。
ソフトキーの使用 
法については、 
参照146ページを参
照してください。

146ページ
参照147ページを参照してください。
（マルチトーンのARB SetupはDual Arb Setupに似ています。）

例外： 
> Waveform Runtime Scalingソフトキーはありません 
> Multi–BBG Sync Setupソフトキーはありません 
> DAC Over–Range Protectionソフトキーはありません各キーの詳細については、44ページで説明されているキーの

ヘルプを使用してください。
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図14-5  

5. Doneを押し ます。

これで、 20 kHzの間隔で離された5つの ト ーンによ る、 マルチ ト ーン ・ セ ッ ト ア ッ プができ ま し た。 中心の 

ト ーンが搬送波周波数に配置され、 一方、 他の4つの ト ーンは中心の ト ーンから 20 kHzの増分で間隔が取ら 
れています。

信号音電力と信号音位相の設定
1. 2行目の、 ト ーン用Power列の値 （0 dB） を強調表示させます。

2. Edit Table > Edit Item > –4.5 > dBを押し ます。

3. 2行目の、 ト ーン用Phase列の値 （0） を強調表示させます。

4. Edit Item > 123 > degを押し ます。

トーンの削除
1. 4行目の、 ト ーン用State列の値 （オン） を強調表示させます。

2. Toggle Stateを押し ます。

波形の生成
Return > Multitone Off Onをオンが強調表示される まで押し ます。

こ のこ と によ り 、 マルチ ト ーン波形が、 前節で定義されたパラ メ ーターを使用し て発生し ます。 発生の間に、
M-TONEおよびI/Qイ ンジケーターがア ク テ ィ ブにな り 、マルチ ト ーン波形は揮発性ARB メ モ リ ーに保存され

ます。 これで、 波形はRFキ ャ リ アを変調し ます。

マルチトーンの位相値に
影響を与えるRandom 
Seedソフトキーは、次の
例では使用されていませ
ん。参考のみとして示さ
れています。各キーの詳細については、44ページで説明されているキーの

ヘルプを使用してください。
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 マルチトーンおよびツートーン波形（オプション430）   
マルチトーン変調の使用
RF（無線周波数）出力の設定
1. RF （無線周波数） 出力周波数を100 MHzに設定し ます。

2. 出力振幅を0 dBmに設定し ます。 

3. RF On/Offを押し ます。

これで、 マルチ ト ーン波形が、 信号発生器のRF （無線周波数） 出力コネ ク ターで使用可能にな り ます。

変更をアクティブなマルチトーン信号に適用
Multitone Setup表エデ ィ ターで変更を行 う 間に、 マルチ ト ーン発生器が使用中 （Multitone Off On をオン   
に設定） であれば、 更新された波形が発生する前に、 変更を適用する こ と が必要です。

Multitone Setup表エディ ターから、次のキーを押して変更を適用し、更新された値に基づいてマルチ ト ーン 

波形を発生させます ： Apply Multitone。

マルチトーン波形の保存
こ の例では、 マルチ ト ーン波形を保存する方法を学びます。 マルチ ト ーン波形がまだ作成されていない場合
は、 前節、 カスタム・マルチトーン波形の作成 （371ページ） のステ ッ プを完了させて く ださい。

1. Load/Store > Store To Fileを押し ます。

MTONEフ ァ イルのカ タ ロ グからの、 ア ク テ ィ ブ ・ エン ト リ 領域を占める フ ァ イル名がすでにあ る場合は、
次のキーを押し ます （45ページを参照） ：

Edit Keys > Clear Text

フ ァ イル名 （例えば、 5TONE） を、 アルフ ァベッ ト キー と テンキーパッ ド を使用し て、 大23文字の長

さ で入力し ます （45ページを参照）。

2. Enterを押し ます。

これで、 マルチ ト ーン波形はCatalog of MTONE Filesに保存されます。

注記 RF （無線周波数） 出力振幅、 周波数および操作状態設定は、 マルチ ト ーン波形フ ァ イルの一部と し

ては保存されません。 同様に、 マルチ ト ーン設定は機器ス テー ト の一部 と し ては保存されません。
こ のため、 ほ と んどのケースで、 機器状態と マルチ ト ーン設定の両方を、 後から設定のすべてを復
元でき る よ う に保存する こ と が必要です。
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マルチトーン波形の再読取
こ の手順を使用し て、信号発生器の メ モ リ ー・カ タ ロ グから、マルチ ト ーン波形を再読取する方法を学びます。

マルチ ト ーン波形がまだ作成および保存さ れていない場合は、 前節、 カスタム・マルチトーン波形の作成
（371ページ） およびマルチトーン波形の保存 （379ページ） のステ ッ プを完了させ、 信号発生器をプ リ セ ッ

ト し て、 保存されたマルチ ト ーン波形を揮発性ARB メ モ リ ーから ク リ ア し て く ださい。

1. Mode > Multitoneを押し ます。

2. Load/Storeを押し ます。

3. 所定のフ ァ イル （例えば、 5TONE） を強調表示させます。

4. Load From Selected File > Confirm Load From Fileを押し ます。

5. Multitone Off Onをオンが強調表示される まで押し ます。

フ ァーム ウ ェアは、 マルチ ト ーン波形をARB メ モ リ ーに生成し ます。 波形発生後、 マルチ ト ーン波形は、 RF
（無線周波数） 出力で変調する ために使用する こ と ができ ます。

RF （無線周波数） 出力を設定する方法の説明は、 RF（無線周波数）出力の設定 （379ページ） を参照し て く
ださい。
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
15 トラブルシューティング
ディスプレイ （383ページ）

信号発生器のロックアップ （383ページ）

RF（無線周波数）出力 （383ページ）

RF（無線周波数）出力がない

電源のシャットダウン
RF（無線周波数）出力に変調がない

RF（無線周波数）出力パワーが低過ぎる

歪み
スペクトル・アナライザーと一緒に使用中の信号損失
ミキサーと一緒に使用中の信号損失
掃引 （386ページ）

掃引をオフにできない
掃引がハングしたように見える
不適切なリスト掃引持続時間
再読取登録にリスト掃引情報がない
リストまたはステップ掃引で振幅が変化しない
内部メディア・データ・ストレージ （386ページ）

機器ステートを保存したが、レジスターが空か、間違った状態が含まれている
USBメディア・データ・ストレージ （387ページ）

機器がUSBメディア接続を認識するが、ファイルを表示しない

プリセット （387ページ）

信号発生器が応答しない
Presetを押すとユーザー・プリセットを実行する

エラー・メッセージ （388ページ）
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トラブルシューティング 
 

正面パネルのテスト （389ページ）

セルフ・テストの概要 （390ページ）

ライセンス （392ページ）

Keysight Technologiesへの問合せ方法 （392ページ）

信号発生器をKeysightに返送
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 トラブルシューティング   
ディスプレイ
デ ィ スプレ イ

デ ィ スプレ イが暗すぎて読めない

輝度が 小値に設定されている可能性があ り ます。「ディスプレイの設定」（28ページ）の図を使用し て
brightnessソ フ ト キーを探し、 値を調整し てデ ィ スプレ イが見え る よ う にし ます。

USB メ デ ィ ア使用時にデ ィ スプレ イが真っ暗になる

機器がUSB メ デ ィ アを使用し始めた と きに メ デ ィ アを取 り 外すと、 画面が真っ暗にな る こ と があ り ます。 機

器の電源をオフ- オン し て く ださ い。

信号発生器のロ ッ ク ア ッ プ

信号発生器が リ モー ト ・ モード （デ ィ スプレ イに R イ ンジケーターが表示されます） でないこ と を確認し ま
す。 リ モー ト ・ モード  を終了し、 正面パネルを ロ ッ ク解除するには、 Local Cancel/(Esc)を押し ます。

信号発生器が、 正面パネル操作を防止する ローカル ・ ロ ッ ク ア ウ ト になっていないこ と を確認し ます。 ロー
カル ・ ロ ッ ク ア ウ ト については、 『プロ グ ラ ミ ング ・ ガイ ド』 を参照し て く ださい。

信号発生器のデ ィ スプレ イにプロ グレ ス ・ バーが表示される場合は、 操作が進行中です。

信号発生器をプ リ セ ッ ト し ます。

信号発生器の電源をオフ- オン し て く ださ い。

RF （無線周波数） 出力

RF （無線周波数） 出力がない

RF ON/OFF LED （5ページを参照し て く ださい） をチェ ッ ク し ます。 オフの場合は、 RF On/Offを押し て出   

力をオンにし ます。

振幅が信号発生器のレンジ内に設定されている こ と を確認し ます。

機器が波形を再生中の場合は、マーカー極性と ルーテ ィ ング設定が正しいこ と を確認し ます （「マーカー極性
およびルーティング設定の保存」（162ページ）を参照し て く ださい）。

電源のシ ャ ッ ト ダウ ン

電源が作動し ない場合は、 修理または交換が必要です。 機器の整備をご自身でできない場合は、 修理のため
信号発生器をKeysightサービ ス・セン ター宛てお送 り く ださい（「Keysight Technologiesへの問合せ方法」（392 
ページ）を参照し て く ださい）。

RF （無線周波数） 出力に変調がない

Mod On/Off LED と <modulation> Off On ソ フ ト キーをチェ ッ ク し、両方がオンになっている こ と を確認し     

ます。「搬送信号の変調」（60ページ）も参照し て く ださい。

ベク ト ル信号発生器でのデジ タル変調の場合は、 内部I/Q変調器がオンであ る こ と を確認し ます （I/Qイ ンジ

ケーターが表示されます）。

外部変調源を使用する場合は、 外部ソースがオンで、 信号発生器の規定制限内で動作し ている こ と を確認し
ます。

RF （無線周波数） 出力パワーが低過ぎ る

デ ィ スプレ イのAMPLITUDE領域にOFFSイ ンジケーターが表示されている場合は、オフセ ッ ト を解除し ます。
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Amptd > More 1 of 2 > Amptd Offset > 0 > dBの順に押し ます。「出力オフセットの設定」（121ページ）も参照    
し て く ださい。

ディ スプレ イのAMPLITUDE領域にREFイ ンジケーターが表示されている場合は、 基準モード をオフにし ます。

Amptd > More > Amptd Ref Off OnをOffが強調表示される まで押し ます。

出力パワーを所定のレベルに リ セ ッ ト し ます。

「出力基準の設定」（122ページ）も参照し て く ださい。

信号発生器を外部 ミ キサーと一緒に使用し ている場合は、 385ページを参照し て く ださい。

信号発生器を スペク ト ル ・ アナラ イザーと一緒に使用し ている場合は、 384ページを参照し て く ださい。

パルス変調がオンの場合は、 ALCをオフにし、 パルス幅が仕様内であ る こ と をチェ ッ ク し ます。

歪み

波形シーケン スのセグ メ ン ト を編集し て再保存し た場合は、 シーケン スはヘッ ダーに保存されたRMS値を自
動的に更新し ません。 そのため、 出力信号に歪みが生じ ます。 シーケン スのヘッ ダー情報を表示し、 RMS値

を再計算し ます （155ページを参照し て く ださい）。

スペク ト ル ・ アナラ イザーと一緒に使用中の信号損失

信号発生器の損傷や性能低下を避ける ために、 RF入力の逆電力レベルが 大33 dBm(2 W) を超えないよ う   

にし て く ださい。 www.keysight.comの 『信号発生器の故障を防ぐための ヒ ン ト 』 も参照し て く ださい。

信号発生器をプ リ セレ ク シ ョ ンのないスペク ト ル ・ アナラ イザーと一緒に使用する場合は、 逆電力の影響に
よ り RF （無線周波数） 出力に問題が生じ る可能性があ り ます。 レべ リ ングな し動作モード （117ページで説

明し ます） を使用し て く ださい。

周波数によ っては、 スペク ト ル ・ アナラ イザーのLOフ ィ ード スルーがRF入力ポー ト で+5 dBmに達する場合 
があ り ます。 LOフ ィ ード スルー と RF搬送波の周波数差がALC帯域幅よ り 小さい と、 LOの逆電力が信号発生

器のRF （無線周波数） 出力を振幅変調する可能性があ り ます。 不要なAMの周波数は、 スペク ト ル ・ アナラ
イザーのLOフ ィ ード スルーと信号発生器のRF搬送波の周波数差に一致し ます。

逆電力の問題は、 いずれかのレベ リ ングな し動作モード を使用する と解決でき ます。 

以下を参照し て く ださい ：

「ALCオフ・モード」（118ページ）

および

「出力検索モード」（118ページ）
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ミ キサーと一緒に使用中の信号損失

信号発生器の損傷や性能低下を避け るために、 RF入力の逆電力レベルが 大33 dBm(2 W) を超えないよ う   
にし て く ださい。 www.keysight.comの 『信号発生器の故障を防ぐための ヒ ン ト 』 も参照し て く ださい。

ミ キサーと の低振幅結合動作中の信号発生器RF （無線周波数） 出力の信号損失を修正するには、 減衰を追加

し、 RF （無線周波数） 出力の振幅を増加し ます。

右の図に、 信号発生器が低振幅
信号を ミ キサーに供給する際の
設定を示し ます。

内部レべ リ ングされた信号発生器
の RF （無線周波数） 出力 （およ
びALCレベル） は8 dBmです。 

ミ キサは +10 dBm の LO で駆動 
され、 LO- RF ア イ ソ レーシ ョ ン

は15 dBです。 結果の5 dBmの  

LO フ ィ ード スルーが、 信号発生
器の RF （無線周波数） 出力コネ

ク ターに入 り 、 内部検出器に届
き ます。

周波数によっては、 このLOフ ィー

ド スルー ・ エネルギーのほ と ん
どが検出器に入 り ます。 検出器
は周波数に関係な く 全入力パワーに応答するので、 この過剰エネルギーによ り ALCがRF （無線周波数） 出力

を減少させます。 こ の例では、 検出器の逆電力が実際にALC レベルよ り 大き く 、 その結果RF （無線周波数）
出力で信号損失が起こ り ます。

右に示す解決策は同様の構成で
すが、 信号発生器のRF （無線周
波数） 出力 と ミ キサーの入力 と
の間に 10 dB減衰器を接続し て 

います。 信号発生器のALC レベ
ルは、+2 dBmまで増加し、10 dB  
減衰器 を 通 っ て 伝送 し、 ミ キ
サー入力で要求された 8 dBm 
の振幅 を実現し ます。 

元の構成と比較し て、 ALC レベ

ルは 10 dB高 く な り ますが、 減 
衰器がLOフ ィ ード スルー （およ

び信号発生器のRF （無線周波 
数） 出力） を10 dBだけ減少させ 

ます。減衰構成を使用する と、検
出器には +2 dBm の必要な信号 
と、 15 dBmの不要なLOフ ィ ード スルーが曝されます。 必要エネルギーと不要エネルギー間のこ の17 dBの  

差によ り 、 信号発生器のRF （無線周波数） 出力レベルに 大0.1 dBのシフ ト が生じ ます。

ミキサー

LO 

ALCレベル 
= 8 dBm

RFレベ
ル制御

信号発生器
出力制御

検出器
が8 
dBmの 
ALCレ
ベルを
測定

検出器
が5 
dBmの 
逆電力
を測定

LOフィードス
ルー = 5 dBm

RF（無線周波数）
出力= 8 dBm

LOレベル 
=  dBm

IF 

ALCへの逆電力の影響

ミキサー

LO 

ALCレベル/RF
（無線周波数）
出力= 2 dBm

RFレベ
ル制御

信号発生器
出力制御

検出器
が2 
dBmの 
ALCレ
ベルを
測定

検出器
が15 
dBmの 
逆電力
を測定

LOフィー
ドスルー 
= 5 dBm

RF（無線周
波数）出力 
= 8 dBm

LOレベル 
=  dBm

IF 

逆電力の解決策

10 dB
減衰器
Keysight EXGおよびMXG X-Series信号発生器ユーザー・ガイド 385



トラブルシューティング 
掃引 
掃引

掃引をオフにでき ない

Sweep > Sweep > Offを押し ます。

掃引がハング し た よ う に見える

掃引の現在の状態は、 プロ グレ ス ・ バーに陰影表示の長方形と し て示されます （「掃引出力の設定」（50ペー
ジ）を参照し て く ださい）。 掃引がハング し た よ う に見え る場合は、 以下をチェ ッ ク し ます ：

以下のキー ・ シーケン スのいずれかで掃引をオンにし ます ：

Sweep > Sweep > Freq
Sweep > Sweep > Amptd
Sweep > Sweep > Waveform （ベク ト ル機器のみ）

掃引がシングル ・ モード の場合は、 Single Sweepソ フ ト キーを押し ます。 

掃引 ト リ ガー （Sweep Triggerソ フ ト キーによ って示されます） がFree Runに設定されていない場合は、 Free  
Runに設定し、 掃引 ト リ ガーが発生し ないために掃引がブロ ッ ク されているかど う かを判定し ます。

ポイ ン ト ・ ト リ ガー （Point Triggerソ フ ト キーによ って示されます） がFree Runに設定されていない場合は、  
Free Runに設定し、 ポイン ト ・ ト リ ガーが発生しないために掃引がブロ ッ ク されているかど う かを判定し ます。

待ち時間を1秒に設定し、 持続時間の設定値が長すぎるか短すぎて表示でき ないのかど う かを判定し ます。

ステ ッ プ掃引または リ ス ト 掃引に2個以上のポイ ン ト が設定されている こ と を確認し ます。

不適切な リ ス ト 掃引持続時間

Sweep > More > Configure List Sweepを押し ます。

リ ス ト 掃引の持続値が正確であ る こ と をチェ ッ ク し ます。

持続値が不適切な場合は、 値を編集し ます。 
持続値が正しい場合は、 次の手順に進みます。

Moreを押し、 Dwell Type List Stepソ フ ト キーが リ ス ト に設定されている こ と を確認し ます。

Stepが選択されている場合は、 信号発生器が、 リ ス ト 掃引ではな く ステ ッ プ掃引用に設定された持続時間を

使用し て リ ス ト ・ ポイ ン ト を掃引し ます。

「掃引出力の設定」（50ページ）も参照し て く ださい。

再読取登録に リ ス ト 掃引情報がない

リ ス ト 掃引情報は、 機器ステー ト ・ レジス ターに機器ステー ト の一部と し て保存されません。 現在の リ ス ト
掃引だけが信号発生器で使用可能です。 リ ス ト 掃引データは、 機器カ タ ロ グに保存でき ます （「保存済みファ
イルの読込み（再読取）」（67ページ）を参照し て く ださい）。

リ ス ト またはステ ッ プ掃引で振幅が変化し ない

掃引タ イプが振幅 （Amptd） に設定されている こ と を確認し ます。 掃引タ イプを周波数 （Freq） または波形
に設定し た場合は、 振幅が変化し ません。

内部 メ デ ィ ア ・ データ ・ ス ト レージ

機器ステー ト を保存し たが、 レジス ターが空か、 間違った状態が含まれている
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使用する予定だったレジス ター番号が空か、 間違った機器ステー ト が含まれている場合は、 レジス ター 99を
再読取し ます。 99よ り も大き なレジス ター番号を選択し た場合は、 信号発生器が機器ステー ト を レジス ター

99に自動的に保存し ます。

「機器ステート・ファイルでの操作」（69ページ）も参照し て く ださい。

USB メ デ ィ ア ・ データ ・ ス ト レージ

機器がUSB メ デ ィ ア接続を認識するが、 フ ァ イルを表示し ない

USB メ デ ィ アが他の機器またはコ ンピ ューターで機能する場合は、 単に信号発生器と互換性がない可能性が
あ り ます。 別のUSB メ デ ィ アを試し て く ださい。 互換性のあ るUSB メ デ ィ アの詳細については、

http://www.keysight.com/find/mxgを参照し て く ださい。 

プ リ セ ッ ト

信号発生器が応答し ない

信号発生器がプ リ セ ッ ト に応答し ない場合は、機器が リ モー ト ・モード であ る可能性があ り 、そのためにキー
パッ ド がロ ッ ク されています。 

リ モー ト ・ モード を終了し、 プ リ セ ッ ト ・ キーを ロ ッ ク解除するには、 Local Cancel/(Esc)を押し ます。

Presetを押す と ユーザー ・ プ リ セ ッ ト を実行する

こ の動作は、 後方互換性のあ る SCPI コマン ド を使用する と発生し ます。 信号発生器を通常使用に戻すには、

コマン ド:SYST:PRESet:TYPE NORMを送信し ます。 

SCPIコマン ド については、 『SCPI Command Reference』 を参照し て く ださい。
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エラー・メッセージ 
エラー ・ メ ッ セージ

エラー ・ メ ッ セージのタ イプ

イベン ト が複数タ イプのエラーを生成する こ と はあ り ません。例えば、問合せエラーを生成する イベン ト は、
デバイ ス固有の実行エラーまたはコマン ド ・ エラーを生成し ません。

問合せエラー （–499～–400） は、 機器の出力待ち行列制御が、 IEEE 488.2第6章に記述された メ ッ セージ交 

換プロ ト コルに関する問題を検出し た こ と を示し ます。 こ のク ラ スのエラーは、 イベン ト ・ ステータ ス ・ レ
ジス ターの問合せエラー ・ ビ ッ ト （ビ ッ ト 2） をセ ッ ト し ます （IEEE 488.2、 セク シ ョ ン11.5.1）。 このよ う な 

エラーは、IEEE 488.2、6.5に記述されている メ ッ セージ交換プロ ト コル・エラーに対応し ます。 こ の場合は：

出力待ち行列に存在するデータ または処理待ち中のデータがない と きに、データ を読み出そ う と し ています。
または、

出力待ち行列のデータが失われま し た。

デバイ ス固有エラー （–399～–300、 201～703、 800～810） は、 おそ ら く ハード ウ ェアまたはフ ァーム ウ ェ

アの異常な状態によ り 、 デバイ ス操作が正し く 完了し なかった こ と を示し ます。 これらのコード は、 セルフ
テス ト 応答エラーにも使用されます。 こ のク ラ スのエラーは、 イベン ト ・ ステータ ス ・ レジス ターの機器別
エラー ・ ビ ッ ト （ビ ッ ト 3） をセ ッ  ト し ます （IEEE 488.2、 セ ク シ ョ ン11.5.1）。

正のエラーの<error_message>文字列は、 SCPIでは定義されていません。 正のエラーは、 機器が、 GPIBシス

テム内、機器のフ ァーム ウ ェ アまたはハード ウ ェ ア内、ブロ ッ ク ・データの転送中、あ るいは校正中にエラー
を検出し た こ と を示し ます。

実行エラー （–299～–200） は、 機器の実行制御ブロ ッ ク によ ってエラーが検出された こ と を示し ます。 この

ク ラ スのエラーは、 イベン ト ・ ステータ ス ・ レジス ターの実行エラー ・ ビ ッ ト （ビ ッ ト 4） をセ ッ ト し ます 
（IEEE 488.2、 セ ク シ ョ ン11.5.1）。 この場合は ：

ヘッ ダーに続 く <PROGRAM DATA>要素が、 デバイ スによ って有効な入力の範囲外と評価されたか、 デバイ 

スの機能に適合し ていません。 または

有効なプロ グ ラ ム ・ メ ッ セージが、 何らかのデバイ ス状態のために正し く 実行でき ませんでし た。

実行エラーは、 丸めや数式評価操作が完了し た後に報告されます。 例えば、 数値データ要素の丸めは、 実行
エラーと し て報告されません。

コマン ド ・ エラー （–199～–100） は、 機器のパーサーがIEEE 488.2構文エラーを検出し た こ と を示し ます。 

こ のク ラ スのエラーは、 イベン ト ・ ステータ ス ・ レジス ターのコマン ド ・ エラー ・ ビ ッ ト （ビ ッ ト 5） をセ ッ

ト し ます （IEEE 488.2、 セ ク シ ョ ン11.5.1）。 この場合は ：

IEEE 488.2構文エラーがパーサーによ って検出されています （IEEE 488.2規格に違反し た制御－デバイ ス ・  
メ ッ セージを受信し ま し た。 考え られる違反には、 デバイ ス ・ リ ッ ス ン形式に違反するデータ要素や、 デバ
イ スが受け入れる こ と ができ ないタ イプのデータ要素が含まれます）。 または、

認証不能なヘッ ダーを受信し ま し た。 これには、 不適切なデバイ ス固有ヘッ ダーや、 誤っているか実装され
ていないIEEE 488.2共通コマン ド が含まれます。

エラー ・ メ ッ セージ ・ フ ァ イルエラー ・ メ ッ セージの完全な リ ス ト は、 機器に付属の CDROM に収録されて

います。 エラー ・ メ ッ セージ ・ フ ァ イルには通常、 エラーの意味を さ らに明確にするため、 各エラーと共に
説明が含まれています。 エラー ・ メ ッ セージは数字で リ ス ト されています。 同じエラー番号に対し て複数の
メ ッ セージを リ ス ト する場合は、 メ ッ セージはアルフ ァベッ ト 順にな り ます。
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正面パネルのテスト
正面パネルのテス ト

すべてのディスプレイ・ピクセルを選択した色に設
定します。 
通常動作に戻すには、任意のキーを押します。

Blink RF On/Off、Mod on/OffおよびMore LEDs

正しい操作：
Full CCW = –10
Full CW = 10

キーボード・マップを表示します。 
キーを押すと、マップにキーの位置が示されます。

各キーの詳細については、 
44ページで説明されているキーの
ヘルプを使用してください。
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トラブルシューティング 
セルフ・テストの概要 
セルフ ・ テス ト の概要

セルフ ・ テス ト は、 信号発生器のさ まざまな機能をチェ ッ クする一連の内部テス ト です。 セルフ ・ テス ト は、
リ モー ト Webイ ン タ フ ェース経由でも実行でき ます。 Web- Enabled MXGの詳細については、 『プロ グ ラ ミ ン 
グ ・ ガ イ ド』 を参照し て く ださい。
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 トラブルシューティング   
セルフ・テストの概要
各キーの詳細については、 
44ページで説明されているキーの
ヘルプを使用してください。

診断セルフ・テストを自動的
に実行します。 

Self Test Summaryには現在のス
テータスが表示されます。

Test Editorディスプレイでテーブ
ルを開き、ユーザーが特定のテス
トを選択して詳細を表示できるよ
うにします。

Utility > Instrument Info

強調表示されたテストの
詳細情報を表示します。
44ページを参照してく
ださい
強調表示された操作を実
行します。

選択された操作をすべて
実行します。

強調表示された操作を選
択または選択解除します。

すべての操作を選択また
は選択解除します。

エラーが発生するまで、
選択されたテストのルー
プを実行します。

Go Toメニューを開きま
す。セルフ・テスト・メ
ニューに移動キーを追加
します。
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トラブルシューティング 
ライセンス 
ラ イセン ス

タ イ ムベースのラ イセン スが動作し な く なった

機器の時間または日付が進められたために、 タ イ ムベースのラ イセン スの有効期限が終了し た可能性があ り
ます。

機器の時間または日付が約25時間以上過去に戻されたために、 機器がタ イ ムベースのラ イセン ス を無視し て

いる可能性があ り ます。

時間と日付を設定する際の詳細と注意については、 30ページを参照し て く ださい。

タ イ ムベースのラ イセン ス を ロード でき ない

機器の時間または日付が約25時間以上過去に戻されたために、 機器がタ イ ムベースのラ イセン ス を無視し て
いる可能性があ り ます。

時間と日付を設定する際の詳細と注意については、 30ページを参照し て く ださい。

Keysight Technologiesへの問合せ方法

• テス ト と測定へのサポー ト 、 および 寄 り のKeysightオフ ィ スに関する情報 ： 

http://www.keysight.com/find/assist

ア ク セサ リ または ド キ ュ メ ンテーシ ョ ン ： http://www.keysight.com/find/X- Series_SG

新しいフ ァーム ウ ェア ・ リ リ ース ： http://www.keysight.com/find/upgradeassistant.

イ ン ターネ ッ ト にア ク セスでき ない場合は、 フ ィ ール ド ・ エンジニアにお問い合わせ く ださい。

文書や電話で信号発生器について説明する際には、 信号発生器のモデル番号と シ リ アル番号をお知らせ く だ
さい。 こ の情報を使用し て、 Keysight の営業担当者は、 お使いのユニ ッ ト が保証期間内にあ るかど う かを判

断する こ と ができ ます。

信号発生器をKeysightに返送

信号発生器を修理のためKeysight Technologiesに返送するには、 以下の手順に従って く ださい。

信号発生器の問題に関し て、 でき るだけ多 く の情報を収集し て く ださ い。 

イ ン ターネ ッ ト （http://www.keysight.com/find/assist） に掲載されている 寄 り の地域の電話番号にご連絡

く ださい。 イ ン ターネ ッ ト にア ク セスでき ない場合は、 Keysight のフ ィ ール ド ・ エンジニアにお問い合わせ

く ださい。 

信号発生器と その状態に関する情報をお伝えいただいた後で、 修理のための信号発生器の返送先についての
情報をお知らせし ます。

信号発生器を送る際には、 可能であれば、 元の工場出荷時の梱包材料を使用するか、 同様の梱包材料を使用
し て信号発生器を適切に保護し て く ださ い。
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Keysight Technologies 

X-Series信号発生器

ユーザー・ガイド   
16 セキュア環境での作業
機器をセキ ュ ア環境で使用 し てい る 場合は、 米国国防省ま たは類似の他の機関か ら 出版 さ れたセキ ュ リ
テ ィ ー規格に準拠する、 メ モ リ ーの消去またはサニタ イゼーシ ョ ンの詳細な方法が必要になる可能性があ り
ます。

Series B MXGおよびEXG機器では、 この情報はPDF ド キ ュ メ ン ト 『揮発性 メ モ リ ーのセキ ュ リ テ ィ ー機能  
と ド キ ュ メ ン ト 』 に記載されています。 この ド キ ュ メ ン ト は、 ド キ ュ メ ンテーシ ョ ンCDには含まれていませ
ん。 但し、 後述の通 り のKeysightのWebサイ ト から ダウ ン ロードする こ と ができ ます。

ド キ ュ メ ン ト には次の ト ピ ッ ク が含まれます ：

• セキ ュ リ テ ィ ー用語と定義

• 機器に使用する メ モ リ ーのタ イプ

• メ モ リ ーの消去と サニタ イゼーシ ョ ン （(Erase All、 Erase and Sanitize All機能） 

• 継続状態情報のク リ ア

• セキ ュ ア ・ デ ィ スプレ イ機能の使用 （後の「セキュア・ディスプレイの使用」（394ページ）にも文書化

されています）

• 故障機器の機密解除

セキュリティー機能ドキュメントを入手する方法
ステ ッ プ ア ク シ ョ ン

1 次のURLを ク リ ッ ク し、 閲覧し ます ：

http://www.keysight.com/find/security

2 ド キ ュ メ ン ト を検索し てダウ ン ロードする ために、 モデル番号 「N5182B」、 「N5181B」、 「N5172B」 また

は 「N5171B」 を選択し、 「送信」 を ク リ ッ ク し ます。

3 画面の説明に従って、 PDFフ ァ イルをダウ ン ロード し ます。
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セキュア環境での作業 
セキュア・ディスプレイの使用 

    
セキュア・ディスプレイの使用
こ の機能は、 許可のない人員が機器のデ ィ スプレ イ を読み取った り 、 現在の設定を正面パネルから不正に変
更する こ と を防止し ます。 セキ ュ ア ・ デ ィ スプレ イが有効な間は、 デ ィ スプレ イは下の図16-1に示されたア

ド バイ ス ・ メ ッ セージを除いては空白と な り ます。 正面パネルのすべてのキーは無効にな り ます。

セキュア ・ ディ スプレ イ を設定するには次の順に押し ます ： Utility > Display > More > Activate Secure Display >     
Confirm Secure Display。

セキ ュ ア ・ デ ィ スプレ イが有効になった後、 デ ィ スプレ イ と 正面パネルのキーを再度使用可能にするには、
電源をオフにし て、 も う 一度オンにする こ と が必要です。

図16-1 セキュア・ディスプレイが有効になった信号発生器の画面
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用語集

A

ARB 任意波形発生器

AWG 任意波形発生器。 付加白色ガウ ス雑音

B

BBG メ デ ィ ア ベースバン ド発生器 メ デ ィ ア。 波形フ ァ イルが再生または編集される揮発性 メ モ リ ー

BNCコネ ク ター Bayonet Neill- Concelmanコネ ク ター。 同軸ケーブルの終端に使用されるRFコネ ク ターの

一種 

C

CCW 反時計回 り

C/N 搬送波対雑音比

CW 連続波時計回 り

D

DHCP 動的ホス ト 構成プロ ト コル

E

EVM エラー ・ ベク ト ル振幅。 規定された瞬間におけ る、 理想的な基準信号 と測定された信号の間のベク ト

ル振幅の差。

G

Gaussianフ ィ ルター Gaussianフ ィ ルターには、 ゼロ符号間干渉 （ISI） があ り ません。 無線システム設計者
は、 システム中にどれだけのISIを許容するかを決定し、 それを雑音や干渉と結合する こ と が必要です。 

Gaussianフ ィ ルターは、 時間と周波数の両方の定義域でガウ ス型であ り 、 Root Nyquistフ ィ ルターのよ う リ ン 
ギングはし ません。 時間定義域におけ る こ のフ ィ ルターの効果は比較的短 く 、 各々の符号は先行する符号と
後続の符号のみと有意に作用し ます （またはISIの原因と な り ます）。 このこ と は、 符号の特定の配列が相互作

用する傾向を低減させ、 それによ って、 増幅器の設定を容易にし、 よ り 効率的にし ます。

GPIB 汎用イ ン ターフ ェース ・ バス。 試験機器によ く 使われる8ビ ッ ト 並列バス。
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I

IF 中間周波数

IP イ ン ターネ ッ ト ・ プロ ト コル。 イーサーネ ッ ト ・ ネ ッ ト ワーク で広 く 使用される、 TCP/IPプロ ト コル ・
ス イー ト 用のネ ッ ト ワーク層。

L

LAN ローカル ・ エ リ ア ・ ネ ッ ト ワーク

LO 局所発振器

LXI LAN eXtension for Instrumentation。 イーサーネ ッ ト 技術に基づ く 計装機器プラ ッ ト フ ォームで、 小
規模から中規模システムのモジュール性、 柔軟性および性能を実現する よ う に設計されています。
http://www.lxistandard.orgも参照し て く ださい

N

Nyquistフ ィ ルター コサイ ン ・ フ ィルターと も呼ばれます。 これらのフ ィルターには、 インパルス応答がシン

ボル ・ レー ト 時に リ ンギングする特性があ り ます。 隣接する符号は、 応答が、 中央 （所定値） を除 く すべて
のシンボル時間でゼロに等しいため、 シンボル時間でも相互に干渉し ません。

R

Root Nyquistフ ィ ルター ルー ト ・ コサイ ン ・ フ ィ ルター と も呼ばれます。 これら のフ ィ ルターには、 イ ン

パルス応答がシンボル ・ レー ト 時に リ ンギングする特性があ り ます。 隣接する符号は、 応答が、 中央 （所定
値） を除 く すべてのシンボル時間でゼロに等しいため、シンボル時間でも相互に干渉し ません。Root Nyquist 
フ ィルターは、 信号を不鮮明にする こ と な く 、 シンボル時間と合わせて厳密にフ ィ ルター処理し ます。 このこ
とは、 ISI に起因するエラーなしで、 情報を送信するために重要です。 ISI はシンボル （決定） 時間を除 く すべ
ての時間に存在する こ と に注意し て く ださ い。 これらのフ ィ ルターの2つの間を転送する と、 Nyquistフ ィ ル

ターの転送機能にな り ます。 一方は送信機内、 他方は受信機内にな り 、 システムには全体と し て ISI フ ィ ル
ターのゼロ ISI特性があ り ます。

RMS 二乗平均平方根。 時変信号の有効値 （規定された抵抗器を通し て相当する熱量を生成する ために必要

な直流電圧に相当）。 正弦波では、 RMS = 0.707 x ピーク値。 

T

TCP 伝送制御プロ ト コル。 イーサーネッ ト やインターネッ ト で使用される、 も一般的な ト ラ ンスポー ト 層。

U

USB ユニバーサル ・ シ リ アル ・ バス。 http://www.usb.orgも参照し て く ださい
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あ

ア ク テ ィ ブ ・ エン ト リ ー 現在選択されてお り 、 そのため編集可能なエン ト リ ーまたはパラ メ ーター

き

揮発性 電源をオフ、 オン時に残存し ない性質 （BBG メ デ ィ アに保存されたフ ァ イル、 など）。

く

矩形フ ィ ルター 理想的な ローパス ・ フ ィ ルターと も呼ばれます。 これらのフ ィ ルターには、 非常に急勾配の
カ ッ ト オフ特性があ り ます。 通過帯域は、 信号のシンボル ・ レー ト と等し く 設定されています。 有限数の係
数によ り 、 フ ィ ルターには定義済み長さ があ り 、本当に 「理想的」 ではあ り ません。結果と し て得られる カ ッ
ト オフ帯域での リ ッ プルは、 ハ ミ ング窓によ り 、 効果的に 小化されます。 このフ ィ ルターは、 適化され
たACPを達成する ために推奨し ます。 こ のフ ィ ルターには32以上のシンボル長を推奨し ます。

け

継続性 プ リ セ ッ ト 、 ユーザー ・ プ リ セ ッ ト および電源のオフ、 オンによ る影響を受けない性質。

し

持続時間 ステ ッ プ掃引 （52ページを参照） で信号がセ ト リ ングする時間。 掃引が次のポイ ン ト に移動する前
に測定を行 う こ と ができ ます。

そ

ソ フ ト キー 装置のデ ィ スプレ イに配置されたボタ ンで、そのデ ィ スプレ イ上で横に表示された機能を実行す
る もの。

た

ター ミ ネーター 入力を完了させる単位表示 （Hzまたは ｄ Bm、 など）。 た と えば、 100 Hzの入力では、 Hzが 
ター ミ ネーターです。

タ イプNコネ ク ター 同軸ケーブルの接合に使用するねじ付きRFコネ ク ター

な

内部 メ デ ィ ア 内部 メ デ ィ ア。 波形フ ァ イルが保存される、 不揮発性信号発生器 メ モ リ ー。
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は

ハード キー 装置上のラベル付きボタ ン。

ふ

フ ィ ルター係数BbT フ ィ ルターの帯域幅時間 （BbT）。 Gaussian フ ィ ルターのみに有効です （アルフ ァに類
似）。 BbTはGSM規格では0.3、 DECT規格では0.5 と定義されています。

フ ィ ルター係数アルフ ァ  フ ィルターのアルフ ァ係数。 Root NyquistおよびNyquistフ ィルターのみに有効です。

不揮発性 電源をオフ、 オン し て も消去されない性質 （USB メ デ ィ アに保存されたフ ァ イル、 など）。

へ

変調基準 セルラー標準フ ォーマ ッ ト （すなわち、 NADC、 PDC、 PHS、 など） を参照し て く ださい。

変調タ イプ さ まざまなI/Q集合タ イプ （すなわち、 PSK、 MSK、 FSK、 C4FM、 など） を参照し て く ださい。

変調フ ォーマ ッ ト  カス タ ム変調、 ツー ト ーン またはマルチ ト ーン。

変調モード  デュ アルARB、 カ ス タ ム変調、 ツー ト ーン またはマルチ ト ーン。

ほ

ポイ ン ト ト ゥ ポイ ン ト 時間 ステ ッ プ掃引 （52ページ参照） における、 持続時間、 処理時間、 ス イ ッチング時

間および設定時間の和。

ゆ

ユーザー FIR ユーザー定義された係数値のセ ッ ト を選択し ます。 FIR 値表の各行には、 1 つの係数値が含ま
れます。 リ ス ト された係数値の数は、 選択されたオーバーサンプル率の倍数であ る こ と が必要です。 それぞ
れの係数は、 IおよびQ成分に適用されます。
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記号
M

DCオフセット、削除 79
インジケーター 10
ソフトキー 75, 79
ハードキー 75

# pointsソフトキー 53
# Skipped Pointsソフトキー 166

数字
10 MHz OUTコネクター 15, 25, 26
100Base-T LANケーブル 33
128QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
1410、アプリケーション・ノート 372
16-Lvl FSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
16QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
2-Lvl FSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
256QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
2の補数の説明 274, 289
32QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
4-Lvl FSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
430、オプション
ツートーン 372
ツートーン・モード 372
マルチトーン・モード 377

4QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
628、エラー 200
64QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
651/652/654、オプション
説明 4
ツートーン・モード 372
マルチトーン・モード 377

8-Lvl FSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
8557D GPIB専用ソフトキー 37, 35
8648A/B/C/D GPIB専用ソフトキー 35, 37
8656B、8657A/B GPIB専用ソフトキー 35, 37

A
ACP 318
Activate Secure Displayソフトキー 28
Active Highソフトキー 179
Active Lowソフトキー 179
AC電源コンセント 13, 23
Adjust Phaseソフトキー 47, 49
Adjustable doubletソフトキー 130
Advanced Settingsソフトキー 33
Aeroflexソフトキー 35, 37
ALC

OFFインジケーター 10
オフ・モード 118
設定 49

ソフトキー 47, 49, 166
ホールド 162, 163

Allソフトキー 63
AM
インジケーター 10
外部ソース 79
広帯域 80
ソフトキー 75
ハードキー 75

amplitude
ハードキー 47, 49

AMPTDハードキー 47, 49
APCO 25 w/C4FMソフトキー 320, 324
APCO 25 w/CQPSKソフトキー 320, 324
Apply To Waveformソフトキー 166
ARB 318
ソフトキー 146, 177, 246, 247, 248, 312
定義 395
波形クリッピング 185
プレイヤー、デュアル 146

Arb Segmentソフトキー 68
Arb Sequenceソフトキー 68
Arbカスタム

FIR表エディター 360
FIRフィルター 354

ARBセットアップ
ソフトキー 224

ARMEDインジケーター 10
ASK Depthソフトキー 321, 325, 327, 328, 329, 330, 331, 334
ASKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
ATTEN HOLDインジケーター 10
Atten/ALC Controlソフトキー 47, 49
Auto-IPソフトキー 33
AUTOGEN_WAVEFORMファイル 318
Automatically Use USB Media If Presentソフトキー 63
Autoソフトキー
（DHCP/Auto-IP） 33
Auto 94, 117
Recall 127

AUX I/Oコネクター 18
Auxiliary Software Optionsソフトキー 40
AWGN
インジケーター 10
ソフトキー 251
定義 395
デュアルARB再生機 245
付加 245

AWGNソフトキー 246, 247, 248, 249

B
backspaceハードキー 45
Bandwidthソフトキー 251
BB GEN 207
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BBG

Memory to USBソフトキー 68
Memoryソフトキー 68
Segmentsソフトキー 63, 155
メディア 146, 148
メディア（定義） 395
ルーティング 207

BBG同期化 225
機器セットアップ 229
再同期化 231
システム 228
システム遅延 228
セットアップの構成 229
トリガー・セットアップ 228

BbT 398
Binaryソフトキー 63
Bk Spハードキー 45
Bluetoothソフトキー 320, 321, 324, 325, 327, 328, 329, 330,        
331, 334
BNC 395
Bright Colorソフトキー 28
Brightnessソフトキー 28
Buffered Trigソフトキー 179
Build New Waveform Sequenceソフトキー 151, 175
Burst Envelopeソフトキー 205
Busソフトキー 51

C
C/N 395
C4FMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
Calculateソフトキー 155
Calibration Typeソフトキー 210
Cancelハードキー 7
carrier
ソフトキー 246, 247, 248, 249

Carrier Bandwidthソフトキー 246, 247, 248, 249
Carrier to Noiseソフトキー 246, 247
Carrier+Noiseソフトキー 246, 248, 249
Carrierソフトキー 246, 247, 248, 249
Catalog Typeソフトキー 63, 64, 68, 155
ccw 395
CDPDソフトキー 320, 321, 324, 325, 327, 328, 329, 330, 331,         
334
Channel Bandソフトキー 47, 49
Channel Numberソフトキー 47, 49
Clearソフトキー

Text 45
エラー待ち行列 74
ヘッダー 155

Config Typeソフトキー 33

Configureソフトキー
Cal Array 98
List Sweep 51, 55
Step Array 98
Step Sweep 51, 53

Confirm Load From Fileソフトキー 67
Connection Monitoringソフトキー 33
Connection Typeソフトキー

USB 101
VXI-11 101
ソケット 101

Continuousソフトキー 179
Contrastソフトキー 28
Copy & ソフトキー
シーケンスの再生 67
波形の再生 67
ユーザ平坦度の選択 67
ユーザ平坦度補正の選択 67

Copyソフトキー
USBへのファイル 68
機器へのファイル 63, 68
全ファイル 68
ファイル 63

Create Directoryソフトキー 63, 68
custom

multicarrier TDMA waveforms
creating 351

Custom ARBソフトキー 236, 319, 323
cw 395
CW（変調なし）ソフトキー 55
CWモード
説明 4

D
DACオーバーレンジ・エラー 195, 200
DACオーバーレンジ保護
位相雑音 316
ベースバンド周波数補正 202

Dark Colorソフトキー 28
DCFM/DCfM Calソフトキー 77
DCオフセット 143
DCオフセット、削除 79
DECTソフトキー 320, 324
Default Gatewayソフトキー 33
Defaultソフトキー 320, 324
Deleteソフトキー

All Regs in Seq 69
All Segments On Int Media 148
All Segments On USB Media 148
All Sequences 69, 127
All Waveformsソフトキー 175
File or Directory 63, 65, 68, 73
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Seq Reg 69, 127
行 55
項目 55
すべての波形 151
全シーケンスファイル 63
選択された波形 151, 175
波形シーケンス 175
ファイル 63

DETHTRインジケーター 11
Deviceソフトキー 47, 49
DHCP 33, 395
DHCPソフトキー 33
differential state map、符号ごとのビット 365
DIGBUSインジケーター 11
display

tests 389
ソフトキー 27, 45

Displayed Caseソフトキー 45
Displayソフトキー

Case 45
Waveform And Markers 166
ディスプレイ 27

DNS Server Overrideソフトキー 33
DNS Serverソフトキー 33
Domain Nameソフトキー 33
doublet

adjustable 132
trigger 132
ソフトキー 130

dual ARB
ソフトキー 246, 247, 248, 249, 312

Dwell Typeソフトキー 55
Dynamic DNS Namingソフトキー 33
Dynamic Hostname Servicesソフトキー 33

E
E4428C、E4438Cソフトキー 35, 37
E442xB、E443xBソフトキー 35, 37
E8241A、E8244A、E8251A、E8254Aソフトキー 35, 37
E8247C、E8257C、E8267Cソフトキー 35, 37
E8257D、E8267Dソフトキー 35, 37
EDGE
カスタム・デジタル変調、定義済み 338

EDGEソフトキー 320, 324
Editing Keysソフトキー 45
Editing Modeソフトキー 45
Editソフトキー

RMS 155
繰り返し 175
説明 155
選択された波形シーケンス 151, 175
ノイズRMSの無効化 155

Enable/Disable Markersソフトキー 151, 175

Enter Directoryソフトキー 67
Erase All 393
Erase and Sanitize All 393
Errorハードキー 74
ERRインジケーター 11
Escハードキー 7
EVENT
コネクター、AUX I/O 18
コネクター、BNC 17, 161
出力 161
出力ジッター 177

EVENT出力のジッター 177
EVM 395
EVMエラー 143
Execute Calソフトキー 210
EXT CLOCKコネクター 17
EXT REFインジケーター 10, 11
Extソフトキー

Ext 51
Pulse 130
ソース 180
遅延 180
遅延時間 180

F
Fileハードキー 63, 72
First Mkr Pointソフトキー 166
First Sample Pointソフトキー 166
FIR表エディター

Arbカスタム 360
アクセス 215, 356
オーバーサンプリング率、設定 218, 358
計数、値入力 357
係数、値の入力 216
係数、コピー 217, 358
係数、変更 222, 362
デュアルARB 215, 220
ファイル、読み込み 221, 361
フィルター
作成 215, 355, 356
変更 220, 360
保存 220, 223, 360, 363

FIRフィルター
Arbカスタム 354
Hamming 221, 361
Hann 221, 361
Kaiser 221, 361
アポディゼーション設定 221, 361
ウィンドウ設定 221, 361
作成 215, 355, 356
使用 214, 354
変更 220, 360
保存 220, 360
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FIR前サンプルの選択 274, 289
Fixedソフトキー 94, 117
Flatnessソフトキー 98
FM

DCオフセット、削除 79
インジケーター 11
外部ソース 79
ソフトキー 75
ハードキー 75

Free Runソフトキー 51, 125, 179
Free-Runソフトキー 130
Freq Devソフトキー 321, 325, 327, 328, 329, 330, 331, 334
frequency
ソフトキー 47, 49
ハードキー 8, 9, 47, 49

Freqソフトキー 98
FREQハードキー 47, 49
FSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
FTP Serverソフトキー 34

G
Gatedソフトキー 130, 179
Go To Default Pathソフトキー 63, 65, 73
Goto Rowソフトキー 55, 63
GPIB
コネクター 15, 25
セットアップ 32
ソフトキー

Address 32
Setup 32
定義 395

GSMソフトキー 320, 324

H
Helpハードキー 7, 44
Hostnameソフトキー 33
HP 3300A、エミュレーション 127

I
I OUTコネクター 16
I/O Configソフトキー 27
I/Q
最適化 206
正面パネル入力、使用 143, 207
信号、整列 162
信号パス、最適化 206
ソフトキー 142, 205–211, 213
調整 143, 208
内部等化フィルターのソフトキーの場所 213
背面パネル出力 16
背面パネル出力、使用 206
波形、クリッピング 185
変調 142, 204

IF 396
Import Waveformソフトキー 175
Incr Setハードキー 9
Insertソフトキー
行 55
項目 55
挿入 151
波形 151
波形シーケンスのコンテンツ 151

Install Assemblyソフトキー 41
Install licensesソフトキー 67
instrument
ソフトキー

Info 27
オプション 40
調整 27

Int Phase Polarityソフトキー 205
Internal Baseband Adjustmentsソフトキー 208
Internal Storage to USBソフトキー 68
Internal/USB Storage Selectionソフトキー 63
IP

Addressソフトキー 33
アドレス、設定 33
自動 33
定義 396

IQ
クロック・レート 255

IQマップ、QAM変調 364
Iコネクター 9
I補正ソフトキー 208

K
keys

test 389
See also specific key

Keysight MXG
動作モード 4

Keysightセールスおよびサービス・オフィス 392

L
l 98
LAN

Services Setupソフトキー 32
Setupソフトキー 32
コネクター 15, 25
セットアップ 33
定義 396

Last Mkr Pointソフトキー 166
Lastソフトキー 29
LED 9
正面パネル 9
変調 61
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LEDs
blink test 389

LF（低周波）出力 81
周波数 82
振幅 82, 83
スイープ正弦
開始周波数 83
停止周波数 83
設定例 82, 83
説明 81
ソース
関数発生器 83
内部変調モニター 82
波形 76, 81, 83

LFO
LF（低周波）出力を参照してください

Listソフトキー 63
LO 396
Load From Selected Fileソフトキー 66, 67
Load Listソフトキー 67
Load/Storeソフトキー 55, 66, 67
Loadソフトキー

All From Int Media 148
All From USB Media 148
Cal Array From Step Array 98
From Selected File 66, 67
Segment From Int Media 148
Segment From USB Media 148
Store 148
掃引リスト 67
ロード/保存 55, 66, 67

Localハードキー 7
LXI 396
Lインジケーター 11

M
Manualソフトキー 94, 117

Config Settings 33
Manual 33
ポイント 51
モード 51

mirror table、係数のコピー 358
Mod On/Off、オプションUNT 75
Mod On/Offハードキー 8, 60, 61
Mod Typeソフトキー 321, 325, 327, 328, 329, 330, 331, 334
Modeハードキー 147, 246, 247, 248, 251, 312
Modulatedソフトキー 94, 117
Modulator Attenソフトキー 251
Monochromeソフトキー 28
MSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334

multicarrier setup
APCO 25 w/C4FM 351
APCO 25 w/CQPSK 351
Bluetooth 351
CDPD 351
DECT 351
Default 351
EDGE 351
GSM 351
NADC 351
PDC 351
PHS 351
PWT 351
TETRA 351

multicarrier setup softkeys 351
multicarrier TDMA waveforms

creating 351
multicarrier, Default softkey. See quick setup, Default     
softkey, settings
Multitoneソフトキー 377
MULTインジケーター 11

N
N5102A
位相および歪みクロック・タイミング 264
インターリーブ・クロック・タイミング 262
共通の周波数基準 257
クロック・ソース
説明 256
クロック・タイミング 259, 253
クロック・レート 253
クロック設定 275, 283
クロックとデバイスへの接続 265
周波数基準コネクター 258
出力指示 272
出力モード 268, 269
シリアル・クロック・タイミング 264
データ・タイプ 268
データ・パラメーター、設定 272, 287
データ発生 279
デジタル・データ 290
デジタル信号インターフェイス・モジュール 253
入力指示 282
入力モード 268, 280
ベースバンド・データ 269
ユーザー・インターフェース 269
ユーザー・インタフェース・モジュール 280
ロジック・タイプ 271
ロジック・タイプ、ポート構成 282

NADCソフトキー 320, 324
Name And Storeソフトキー 175
 403
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Next REGソフトキー 127
Next SEQソフトキー 127
No actionソフトキー 67
No Retriggerソフトキー 179
Noise Bandwidthソフトキー 246
Noise Muxソフトキー 248, 249
Noiseソフトキー 246, 248, 249

O
odeハードキー 249
OFFSインジケーター 11
Options Infoソフトキー 40
Output Blankingソフトキー 47, 49
Output Muxソフトキー 246

P
Page Upハードキー 6
PATT TRIG INコネクター 17
Patt Trig Inソフトキー 180
PDCソフトキー 320, 324
phase noise
ソフトキー 312

Phase Ref Setソフトキー 47, 49
PHSソフトキー 320, 324
pixel test 389
Plot CDDFソフトキー 194
PM Config

Calibrate Sensor 101
Zero Sensor 101

PM Configソフトキー
PM VXI-11デバイス名 101
接続タイプ 101
パワー・メーター IPアドレス 101
パワー・メーター IPポート 101

Point Triggerソフトキー 51
power
ソフトキー 27, 29, 94, 117

Power Control Modeソフトキー 247
Power Search Referenceソフトキー 94, 117
Powerソフトキー

On/Preset 27
Search 94, 117
オン 29

preset
ハードキーの場所 7

Presetソフトキー
Language 29
List 55, 98
Preset 29

Prev REGソフトキー 127
Prev SEQソフトキー 127

Proceed With Reconfigurationソフトキー 33, 34
PSKソフトキー 321, 325, 327, 328, 329, 330, 331, 334
pulse
インジケーター 11

Pulse/RF Blankソフトキー 166
Pulseソフトキー 52, 130
Pulseハードキー 130
PWTソフトキー 320, 324
PXBのLVDS互換性 3

Q
QAMソフトキー 321, 325, 327, 328, 329, 330, 331, 334
QAM変調IQマップ 364
Quadrature Angle Adjustmentソフトキー 208
Quick Setupソフトキー 320, 324
Qコネクター 9
Q補正ソフトキー 208

R
real-time

AWGN
ソフトキー 246, 247, 248

I/Q Baseband AWGNソフトキー 251
phase noise
ソフトキー 312

AWGN
ソフトキー 249

Recallキー
Reg 127
機器ステート 63, 67
ステート 67
ハードキー 127

Recallハードキー 69
REF INコネクター 15, 25
Ref Oscillator Ext Bandwidthキー 48
Ref Oscillator Ext Freqキー 48
Ref Oscillator Sourceソフトキー 47, 49
REFインジケーター 11
Remote Languageソフトキー 32, 35, 37
Remove Assemblyソフトキー 41
Rename Fileソフトキー 63
Rename Segmentソフトキー 148
Reset & Runソフトキー 179
Restart on Trigソフトキー 179
Restoreソフトキー

LAN Settings to Default Values 33
System Settings to Default Values 29

Returnハードキー 9
Reverse Power Protectionソフトキー 29
Revert to Default Cal Settingsソフトキー 210
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RF
（無線周波数）出力
トラブルシューティング 383
出力
コネクター 8
設定 48
レベリング、外部 109–116
ハードキー 8
ブランキング
設定、保存 162
マーカー機能 172

RF During Power Searchソフトキー 94, 117
RF Outputソフトキー 205, 206
RFC NETBIOS Namingソフトキー 33
RMS 396
RMSソフトキー 94, 117
Rohde & Schwarzソフトキー 35, 37
Route Connectorsソフトキー 51, 130
Route Toソフトキー 52, 130
RPG test 389
Rインジケーター 11

S
SAVE Seq Regソフトキー 69
Save Setup To Headerソフトキー 155
Saveハードキー 69
Scale Waveform Dataソフトキー 194
SCPI
参照内容 xv
ソフトキー 35, 37
有効化 34

Screen Saverソフトキー 28
Securityソフトキー 63
Segment Advanceソフトキー 179
Select Seqソフトキー 127
Selectソフトキー

Reg 69
Seq 69
カラー・パレット 28
異なるヘッダー 155, 159
内部ファイルをUSBにコピー 68
波形 55
ヘッダー 155

Selectハードキー 45
Sequenceソフトキー 63, 155
Showソフトキー

Alpha Table 45
波形シーケンス 151
波形シーケンスのコンテンツ 151, 175

Signal Studio 3
Single Sweepソフトキー 51
Singleソフトキー 179
Sockets SCPIソフトキー 34

Source Settledソフトキー 52, 130
Spanソフトキー 94, 117
Specify Default Storage Path for User Mediaソフトキー 63
Squareソフトキー 130
Stateソフトキー 63
Step Dwellソフトキー 53, 125
Step Spacingソフトキー 53
Step/Knob Ratioソフトキー 30
Storage Typeソフトキー 65, 73
Store Custom Dig Mod Stateソフトキー 322
Store To Fileソフトキー 66, 67
Stored Segmentsソフトキー 63, 155
Subnet Maskソフトキー 33
Sumソフトキー 205
sweep
ソフトキー 51–60, 130
ハードキー 51

Sweepソフトキー 51–60, 68, 130
SWEEPハードキー 51
SWMANインジケーター 11
Sインジケーター 11

T
TCP 396, 397
TCP Keep Aliveソフトキー 33
TDMA
カスタム・デジタル変調、定義済み 338

TDMAデジタル変調 338
TETRAソフトキー 320, 324
Time/Dateソフトキー 30
Timer Triggerソフトキー 51, 125
Toggleソフトキー 175
Total Noiseソフトキー 247
Totalソフトキー 247
trigger
ハードキー 7

Triggeredソフトキー 130
Triggerソフトキー

& Run 179
Doublet 130
Key 51
Out Polarity 51
Triggered 130
ソース 178
タイプ 178

two toneソフトキー 372
two-toneソフトキー 372
Tインジケーター 11

U
UNLEVELインジケーター 11
UNLOCKインジケーター 11
Unspecifiedソフトキー 155
 405



索引

UNT、オプション 4
UNU、オプション 4
UNW、オプション 4
Up Directoryソフトキー 63, 65, 68
Update in Remoteソフトキー 28
urls 3, 31, 39, 392
USB

to BBG Memoryソフトキー 68
to Internal Storageソフトキー 68
キーボード、使用 127
接続メディア 73
ソフトキー
キーボード制御 127
ファイルマネージャー 63, 64
定義 396
デバイス・コネクター 15, 25
トラブルシューティング 387
ホスト・コネクター 5, 15, 25, 26

Userソフトキー
Current Directory As Default Path 65
Do Ca 98
Flatness 47, 49, 63
Flatness Correction 98
Span 94, 117
User 29
平坦度補正 68

Useソフトキー
As 67
Current Directory As Default Path 63, 73
USBメディア専用 63
内部ストレージ専用 63

Utilityソフトキー 41
Utilityハードキー 27

V
View Next Error Pageソフトキー 74
View Previous Error Pageソフトキー 74
VXI-11、有効化 34
VXT-11 SCPIソフトキー 34

W
Waveformソフトキー
シーケンス 151, 175
波形 51, 55
ライセンス 40
ランタイム・スケーリング 194

Web Serverソフトキー 34
WINITインジケーター 11

Z
Zoomソフトキー 166

あ
アクティブ
エントリー 397
エントリー領域 10
アドバンス、セグメント 181
アドレス、GPIB 32
アナログ変調 4, 75
設定 76, 81
アプリケーション・ノート

1410 372
アポディゼーション設定、FIRフィルター 221, 361
アルファ 398

い
位相クロック・タイミング 264
位相雑音

DACオーバーレンジとスケーリング 316
信号劣化 311
説明およびプロット 313
調整 315
イメージ 143
インジケーター 10
インストール・ガイド内容 xv
インターフェース

GPIB 32
LAN 33

う
ウィンドウ設定、FIRフィルター 221, 361

え
エディター、ビット・ファイル 326
エラー・メッセージ 74

DACオーバーレンジ 195, 200
ディスプレイ領域 12
メッセージ・フォーマット 74
タイプ 388
円形クリッピング 189, 192
エントリー、アクティブ 397

お
オーバーシュート 195
オーバーレンジ・エラー、DAC 195, 202, 316
オプション

430
ツートーン・モード 372
マルチトーン・モード 377

651/652/654
説明 4
ツートーン・モード 372
マルチトーン・モード 377

UNT 4
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UNU 4
UNW 4
有効化 27, 39
リソース 3
オプション250-259 237
オプションU01 106
内部チャンネル補正 106
オプションUNT

Mod On/Offハードキー 75
オフセット 143
出力、使用 121
オフセット2進値の使用 274, 289
オン/オフ・スイッチ 9

か
回転ノブ 45
ガイド、の内容 xv
外部

IおよびQ信号 207
基準発振器、使用 48
トリガー 184
トリガー・ソース 182, 184
変調源 79
メディア 73, 387
外部クロック・ソース選択 277, 285
外部ソフトキー

I/Q出力 205, 206
Input I Offset 142
Input Q Offset 142
外部 205
出力 208
入力 208
外部レベリング 109–116
ソフトキー 109
外部レベリング、設定 113
概要、信号発生器 1
ガウス
定義 395
ガウス・フィルター、デフォルトの読み込み 221, 361
ガウスAWGNを参照してください
拡張子、ファイル 67
角度、直角位相 143
カスタム

TDMAデジタル変調 338
カスタム・モード 318
カスタムARB 236, 318
カスタム任意波形発生器 4
カスタム変調
波形、追加 338
波形に追加 338
カタログ、ステート・ファイル 72
カラー・パレット、ディスプレイ 28

き
キー
正面パネル 5
数値 6
ヘルプ 44
無効化 393
キーボード、使用 127
黄色LED 9
機器
状態
レジスター参照データ・ストレージ
ステート
ソフトキー 68
波形へ関連付け 70
ファイル 69, 72
ファームウェア、アップグレード 31
機器、ユーザー平坦度補正 99, 100
機器セットアップ 229
基準、使用 122
基準、変調 398
基準振幅器チューニング・キー 31
基準振幅器のチューニング、内部 31
基準発振器、外部 48
輝度の調整 28
機能障害

I/Q調整 143
揮発性、定義 397
揮発性メモリー 146, 148
基本的な操作
基本操作を参照してください
機密
セキュリティーを参照
キャリア
フィードスルー 143
キャリア・フィードスルー、最小化 374
鏡像表、係数のコピー 217
共通の周波数基準図 258
極性、外部トリガー 180
極性、マーカー、設定 174

く
クイック・セットアップ
デフォルト・ソフトキー
設定 320, 324

矩形クリッピング 190, 193
矩形フィルター
定義 397
クリッピング
円形 189, 192
矩形 190, 193
ソフトキー 185
クロスオーバー・ケーブル 33
 407
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クロック・タイミング
並列インターリーブ・データ 262
並列データ 259
クロック・レート制限、ロジック・タイプ出力 254
クロック、サンプル・レート 18
クロック、周波数基準 257
クロック、周波数基準図 258
クロック・ソース
設定 277, 285
クロック・タイミング
位相および歪み 264
シリアル・データ 264
クロックゲート 292
クロック調整
位相および歪み 264

け
ゲーティッド・トリガー 180, 182
ケーブル
クロスオーバー 33
マルチBBG同期 228
ケーブル、100Base-T LAN 33
係数値、入力 216, 357
継続性設定
定義 397
リセット 44
消込説明 274, 289
源安定信号 52
検索、出力 118

こ
恒久設定
デフォルトの復元 29
工場デフォルト、復元 29, 33, 210
校正

I/Q 210
ソフトキー 210
広帯域AM 80
コサイン・フィルター
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